
Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Este guia descreve a configuração e funcionamento da Interchangeable Lens Digital Camera ILME-FR7/ILME-FR7K.

Consulte este manual e o manual de instruções para os dispositivos relacionados, conforme necessário.

Visão geral

Aplicações típicas

Configuração do sistema

Controlar um único aparelho utilizando o controlo remoto de infravermelhos fornecido

Controlar um único aparelho através de um tablet ou computador

Controlar um único aparelho através de um controlo remoto externo

Controlar vários aparelhos através de um controlo remoto externo

Localização e função das peças

Vista frontal

Vista traseira

Bloco de conectores

Vista lateral

Vista superior

Vista inferior

Apoio da objetiva

Localização e função das peças do controlo remoto de infravermelhos (fornecido)

Ecrã da Web App

Visão geral do ecrã da Web App

Estrutura da área comum de ecrãs

Estrutura do ecrã de operações em gravação

Estrutura do ecrã de operações em reprodução

Estrutura do ecrã de definições
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Preparação

Menu da câmara

Apresentação do ecrã da câmara

Montar o aparelho

Instalar na vertical num local fixo

Fixar na vertical num local alto e fixo

Fixação num teto

Instalar/remover uma objetiva

Precauções ao instalar/remover uma objetiva

Verificar os interruptores da objetiva

Precauções ao utilizar uma objetiva de zoom

Instalar uma objetiva

Remover uma objetiva

Cabos de ligação

Ligar a unidade a um dispositivo de rede através de ligação por cabo

Ligar uma fonte de alimentação

Usar alimentação AC

Utilizar alimentação PoE++

Repor o deslocamento/inclinação

Configurar antes da filmagem

Inicializar o aparelho usando a Web App

Aceder à Web App a partir de um browser da web

Inicializar o aparelho

Configurar o funcionamento básico

Preparar cartões de memória

Cartões de memória compatíveis

Inserir cartões de memória

Ejetar um cartão de memória
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Filmar

Formatar (Inicializar) cartões de memória

Verificar o tempo de gravação restante

Restaurar cartões de memória

Funcionamento básico

Iniciar/parar a gravação

Alternar entre cartões de memória

Verificar o áudio

Especificar dados de hora

Rever a gravação (Rec Review)

Ajustar o enquadramento

Ecrã de ajuste do enquadramento

Ajustar a direção de filmagem

Ajustar a direção de filmagem usando a Web App

Definir a velocidade operacional do deslocamento/inclinação

Definir a aceleração da operação de deslocamento/inclinação

Ajustar a direção de filmagem, usando o controlo remoto de infravermelhos fornecido

Ajustar o zoom

Definir o tipo de zoom

Ajustar o zoom através da Web App

Definir a velocidade operacional do zoom

Ajustar o zoom utilizando o controlo remoto de infravermelhos fornecido

Guardar/repor a posição de deslocamento/inclinação/zoom da câmara (posição da predefinição)

Calibrar uma objetiva com encaixe E

Guardar/repor a posição do deslocamento/inclinação e zoom e a definição de focagem através da Web App

Mudar as posições das predefinições usando a Web App

Substituir uma posição de predefinição guardada por uma nova posição, usando a Web App

Eliminar uma posição de predefinição guardada usando a Web App

Sincronizar a operação de deslocamento/inclinação e a operação de zoom/focagem ao restaurar uma posição de predefinição
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Alterar a velocidade de transição (Deslocamento-Inclinação/Zoom/Focagem) ao restaurar uma posição de predefinição

Guardar/repor a posição do deslocamento/inclinação e do zoom, usando o controlo remoto de infravermelhos fornecido

Gravar/reproduzir operações de enquadramento da câmara (deteção PTZ)

Gravar operações de enquadramento da câmara usando a Web App

Reproduzir operações de enquadramento da câmara usando a Web App

Eliminar operações de enquadramento gravadas pela câmara usando a Web App

Gravar operações de enquadramento da câmara, usando o controlo remoto de infravermelhos fornecido

Reproduzir operações de enquadramento da câmara, usando o controlo remoto de infravermelhos fornecido

Ajustar a focagem

Ecrã de ajuste da focagem

Ajustar manualmente a focagem (Focagem manual)

Ajustar manualmente através da Web App

Ajustar manualmente utilizando o controlo remoto de infravermelhos fornecido

Focar especificando uma posição de focagem (Spot Focus)

Utilizar temporariamente a focagem automática (focagem automática por seleção (AF))

Utilizar a focagem automática de filmagem única (focagem automática por seleção (AF-S))

Ajustar automaticamente a focagem (Focagem automática)

Ajustar automaticamente através da Web App

Ajustar automaticamente utilizando o controlo remoto de infravermelhos fornecido

Definir a área/posição de focagem automática (área de focagem)

Alterar rapidamente a área de focagem (definição de focagem)

Mover a moldura da área de focagem através da operação tátil (área de focagem tátil)

Ajustar a operação de focagem automática (velocidade de transição AF, sensibilidade de seguimento do motivo AF)

Definir manualmente o alvo de focagem automática (AF Assist) usando a Web App

Focar manualmente durante a focagem automática utilizando o controlo remoto de infravermelhos fornecido

Utilizar temporariamente a focagem manual durante a focagem automática (focagem manual por seleção)

Deteção através da deteção de rosto e olhos (Face/Eye Detection AF)

Detetar um motivo específico (função AF de deteção em tempo real)

Ajustar a luminosidade

4



Funções úteis

Ecrã de ajuste da luminosidade

Definir a sensibilidade de base

Definir o nível pretendido para o ajuste automático da luminosidade

Ajustar a íris

Ajustar automaticamente a íris

Ajustar manualmente a íris

Ajustar o ganho

Ajustar o ganho automaticamente

Ajustar manualmente o ganho

Ajustar o obturador

Ajustar o obturador automaticamente

Ajustar o obturador manualmente

Ajustar o nível de luz (Filtro ND)

Sobre o filtro ND

Ajustar no modo predefinido

Ajustar automaticamente no modo variável

Ajustar manualmente no modo variável

Ajustar para cores naturais (Equilíbrio de brancos)

Ecrã de ajuste do equilíbrio de brancos

Ajustar automaticamente o equilíbrio de brancos

Ajustar manualmente o equilíbrio de brancos

Executar o equilíbrio de brancos automático

Configurar o áudio para gravação

Ecrã de configuração de áudio

Definir o dispositivo de entrada de áudio

Ajustar automaticamente o nível de gravação de áudio

Ajustar manualmente o nível de gravação de áudio

Funcionamento do menu direto
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Botões atribuíveis

Câmara lenta e movimento rápido

Gravar vídeo intermitentemente (Interval Rec)

Gravar imagens em cache (Picture Cache Rec)

Gravar para os cartões de memória A e B em simultâneo (Gravação simultânea em 2 ranhuras)

Monitor do sinal de vídeo

Indicadores de clips

Compensação de respiração

Gravação proxy

Visão geral da gravação proxy

Gravar um proxy

Filmar com o aspeto pretendido

Visão geral de aspeto

Selecionar um aspeto

Importar um determinado aspeto base

Personalizar um aspeto

Guardar um aspeto

Eliminar um aspeto base

Filmar com ajuste de aspeto na pós-produção

Filmar com ajuste de aspeto na pós-produção

Aplicar uma LUT à saída HDMI e à transmissão

Alterar uma LUT

Alterar a distribuição de áreas escuras e claras na imagem gravada

Gravação RAW

Gravar vídeo RAW

Gravar vídeo RAW no modo de câmara lenta e movimento rápido

Ajustar bokeh (função de controlo de bokeh)

Ativar/desativar a função de controlo de bokeh
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Funções de rede

Ecrã de miniaturas

Menu da câmara e definições detalhadas

Ajustar o nível de bokeh

Guardar e carregar dados de configuração

Visão geral sobre guardar e carregar dados de configuração

Guardar um ficheiro ALL

Carregar um ficheiro ALL

Transferir ficheiros

Sobre a transferência de ficheiros

Inserir um destino para a transferência de um ficheiro

Selecionar um ficheiro e carregar

Carregar um ficheiro proxy num cartão de memória a partir do ecrã de miniaturas

Carregar um ficheiro original num cartão de memória a partir do ecrã de miniaturas

Verificar o estado da transferência de um ficheiro

Carregar através de um FTP seguro

Configurar a transmissão (streaming)

Sobre a transmissão

Definir o formato para transmissão

Definir o codec de vídeo para transmissão

Definir o codec de áudio para transmissão

Iniciar/parar a transmissão

Ecrã de miniaturas

Reproduzir clips e outras operações com clips

Reproduzir clips gravados

Operações em clips gravados

Configuração do menu da câmara

Utilizar o menu da câmara

Utilizar o menu da câmara
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Introduzir uma cadeia de caracteres

Menu User

User

Menu Edit User

Edit User

Menu Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Menu Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec
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SDI/HDMI Rec Control

Assignable Button

Menu Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Menu Pan-Tilt

P/T Acceleration

Menu TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Menu Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Menu Audio
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Audio Input

Audio Output

Menu Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Menu Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Menu Network

Wired LAN

File Transfer

Menu Maintenance

Language

Clock Set

Hours Meter

Definições do menu Shooting e valores predefinidos

Definições de ISO/Gain e valores predefinidos
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Menu web e definições detalhadas

Definições de AGC Limit e valores predefinidos

Definições da qualidade de imagem guardadas para cada modo de filmagem

Configuração do menu web

Operações do menu web

Menu Shooting

Focus

Menu Project

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Menu Paint/Look

Base Look

Menu Pan-Tilt

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Menu Monitoring

Output Format

Output Display

Menu Audio

Audio Input
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Audio Output

Menu Technical

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Menu Network

Camera Name

User

Wired LAN

File Transfer

FTP Server 1 a 3

SSL

Referer Check

Brute Force Attack Protection

Menu Stream

Stream

Video Stream

Audio Stream

Menu Maintenance

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log
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Ligação de dispositivo externo

Anexo

Service

EULA

Software

Ligar monitores externos e dispositivos de gravação

Ligar um RCP/MSU (opção)

Ligar com um RCP/MSU

Ligação ponto a ponto entre o aparelho e um RCP

Utilizar o aparelho num ambiente multicâmara com uma MSU/software de controlo remoto da câmara

Lista de funções compatíveis

Funcionamento usando um controlo remoto RM-IP500 (opcional)

Sobre o funcionamento utilizando um controlo remoto RM-IP500 (opção)

Ligar um controlo remoto RM-IP500

Sincronizar com um dispositivo externo

Sobre a sincronização com um dispositivo externo

Sincronizar a fase do sinal de vídeo (Genlock)

Bloquear o código de hora para outros dispositivos

Ligar um microfone externo ou dispositivo de áudio externo

Gerir/editar clips utilizando um computador

Emitir um sinal de fibra ótica

Ligar um sinal indicador

Emitir dados de seguimento (free-d)

Ligar um controlador da objetiva

Ajustar o zoom através de um controlador da objetiva

Precauções para utilização

Formatos de saída e limitações

Resolução de problemas

Mensagens de erro/aviso
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5-041-957-53(1) Copyright 2022 Sony Corporation

Lista de itens de menu

Itens guardados na posição predefinida

Diagramas de blocos

Atualizar o software da objetiva com encaixe E

Instalar a tampa do botão de libertação da objetiva

Licenças

Especificações

Marcas comerciais
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Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Configuração do sistema

Este aparelho pode ser combinado com dispositivos periféricos para formas várias configurações do sistema.

Objetiva com encaixe E1.

Adaptador para encaixe A LA-EA3 / LA-EA42.

Controlo remoto de infravermelhos (fornecido)3.

Cartões de memória CFexpress Type A/cartões de memória SDXC4.

Leitor de cartões CFexpress Type A/leitor de cartões SD5.

Microfone ECM-680S, ECM-678*, ECM-674*6.
É necessário um cabo de adaptador XLR EC-0.5X3F5M 3 pinos → 5 pinos.*

Adaptador AC (fornecido)7.

Monitor de vídeo8.

Controlo remoto RM-IP5009.
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Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Controlar um único aparelho utilizando o controlo remoto de infravermelhos
fornecido

Pode controlar um único aparelho remotamente, usando o controlo remoto de infravermelhos fornecido.

 Sinal de vídeo
 Fluxo do sinal

5-041-957-53(1) Copyright 2022 Sony Corporation

Controlo remoto de infravermelhos (fornecido)1.

Monitor de vídeo2.
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Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Controlar um único aparelho através de um tablet ou computador

Pode ligar um tablet ou computador ao aparelho e, de seguida, controlar o aparelho através de um browser da web.

 Sinal de vídeo
 Sinal do controlo remoto

  Fluxo do sinal

5-041-957-53(1) Copyright 2022 Sony Corporation

Monitor de vídeo1.

Tablet2.

Computador3.

Ponto de acesso4.
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Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Controlar um único aparelho através de um controlo remoto externo

Pode controlar o aparelho remotamente através de um controlo remoto.

 Sinal de vídeo
 Sinal do controlo remoto

  Fluxo do sinal

5-041-957-53(1) Copyright 2022 Sony Corporation

Monitor de vídeo1.

Controlo remoto RM-IP5002.
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Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Controlar vários aparelhos através de um controlo remoto externo

Pode controlar até 100 aparelhos remotamente através de um único controlo remoto.

 Sinal de vídeo
 Sinal do controlo remoto
 Sinal indicador/de contacto

  Fluxo do sinal

5-041-957-53(1) Copyright 2022 Sony Corporation

Monitor de vídeo1.

Comutador de vídeo2.

Comutador Ethernet3.

Controlo remoto RM-IP5004.
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Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vista frontal

Este tópico descreve a localização e a função das peças na parte frontal do aparelho.

Sugestão

Esta descrição diz respeito à ilustração do aparelho sem uma objetiva instalada.

Cabeça da câmara

Nota

Não sujeite a cabeça da câmara a fortes impactos.

1.

Luz de gravação/indicadora
Quando configurada como uma luz de gravação, a luz acende-se a vermelho durante a gravação para um cartão de
memória. A luz pisca quando o espaço livre restante no suporte de gravação é reduzido ou quando ocorre um erro.

2.
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Para mais pormenores, consulte “Mensagens de erro/aviso”.

Quando configurada como uma luz indicadora, a luz acende-se a vermelho ou verde durante de acordo com o sinal
indicador externo.

Para mais informações, consulte “Ligar um sinal indicador.”
Sensor de imagem

Nota

Não toque diretamente com as mãos.

3.

Botão de libertação da objetiva
Prima para remover a objetiva.

Para mais informações, consulte “Remover uma objetiva”.

4.

Contactos de sinalização da objetiva

Nota

Não toque diretamente com as mãos.

5.

Luz POWER6.

Luz NETWORK
O estado do aparelho é indicado pela combinação da cor do ecrã e do estado das luzes POWER e NETWORK
(acesas, a piscar, apagadas).

7.

Luz POWER Luz NETWORK Estado do aparelho

Acesa a verde*1
Acesa a verde Ativada (ligada à rede)

Apagada Ativada (desligada da rede)

A piscar a verde Apagada Processo de ativação em curso

Acesa a cor de
laranja

Apagada Estado de espera de alimentação

A piscar a amarelo Apagada Atualização de software em curso

A piscar
lentamente a cor
de laranja*2

A piscar
lentamente a
verde*2

O aparelho não pode funcionar normalmente. Para mais informações,
consulte o registo do sistema. Se o problema persistir mesmo após
colocar o aparelho no modo de espera ou desligar a alimentação e voltar
a ligar, contacte o representante de assistência Sony.

A piscar
rapidamente a cor
de laranja*3

A piscar
rapidamente a
verde*3

Ocorreu uma avaria no aparelho. Contacte o representante de
assistência Sony.

Pisca a verde quando um comando é recebido do controlo remoto de infravermelhos fornecido.*1

A piscar lentamente: uma vez por segundo*2

A piscar rapidamente: quatro vezes por segundo*3

Sensor do controlo remoto de infravermelhos
Recebe o sinal de controlo do controlo remoto de infravermelhos fornecido.

8.

Entrada de ar9.
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Tópico relacionado

Mensagens de erro/aviso

Ligar um sinal indicador

Remover uma objetiva

5-041-957-53(1) Copyright 2022 Sony Corporation

Nota

Não tape o caudal de ar. Caso contrário, poderá causar uma avaria.
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Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vista traseira

Este tópico descreve a localização e a função das peças na parte traseira do aparelho.

Tópico relacionado

Vista lateral

5-041-957-53(1) Copyright 2022 Sony Corporation

Alavanca de bloqueio da cabeça da câmara
Bloqueia o movimento para a frente/para trás da cabeça da câmara.

Nota

Coloque sempre na posição de bloqueio quando não estiver a mudar a objetiva.

Ao transportar o aparelho, retire sempre a objetiva e coloque na posição de bloqueio.

Desligue a alimentação do aparelho e bloqueie a cabeça da câmara horizontalmente através da alavanca de bloqueio de
deslocamento/inclinação antes de operar a alavanca de bloqueio para evitar ferimentos devido a entalamento dos dedos.
Para mais pormenores sobre a alavanca de bloqueio de deslocamento/inclinação, consulte “Alavanca de bloqueio de
deslocamento/inclinação”, em “Vista lateral”.

1.

Base deslizante2.
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Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Bloco de conectores

Este tópico descreve a localização e a função das peças no bloco de conectores do aparelho.

 Ligação à terra
Ligue à terra, ligando o terminal de terra a uma tomada de alimentação ou a um elétrodo de terra.

1.

Conector DC-IN (entrada DC padrão)
Ligue a um adaptador AC.

Nota

Não utilize um adaptador AC que não aquele fornecido. Ligar outro adaptador poderá causar um incêndio ou avaria.

2.

Conector  LAN (rede) (RJ-45)
Ligue um cabo de rede (categoria 5e ou superior) para comunicação de rede e fonte de alimentação PoE++*.

Estado de apresentação do LED da velocidade
Indica a velocidade da ligação de rede.

3.

PoE++: Power over Ethernet Plus Plus. Em conformidade com IEEE802.3bt (Type 4 Class 8). Para mais informações sobre a ligação,
consulte o manual de instruções do dispositivo da fonte de alimentação.

*
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Estado de apresentação do LED Link/ACT
Indica o estado da ligação de rede.

Nota

Ao ligar este produto à internet, ligue através de um sistema com uma função de proteção, tal como um router ou uma
firewall. Se ligado sem tal proteção, poderão ocorrer problemas de segurança.

Apresentação  Velocidade da ligação

Apagada
Ligação de 10 Mbps

Ligação de 100 Mbps

Acesa a cor de laranja Ligação de 1000 Mbps

Apresentação  Estado da ligação

 Apagada Sem ligação

A piscar a verde Ligação estabelecida, dados ativos

Acesa a verde Ligação ativa

Conector TC IN
Insere um sinal de código de hora de referência externo.

Para mais pormenores, consulte “Bloquear o código de hora para outros dispositivos”.

4.

Conector HDMI
Emite o vídeo a partir do aparelho como um sinal HDMI.

Para mais informações, consulte “Conector HDMI (conector Tipo A)” em “Ligar monitores externos e dispositivos
de gravação”.

5.

Parafuso de fixação da placa de fixação do cabo HDMI
Para evitar a remoção do cabo HDMI, instale a placa de fixação do cabo HDMI fornecida utilizando o parafuso de
fixação fornecido (M2,6×6) e instale o cabo HDMI utilizando uma abraçadeira ou banda disponível comercialmente.

Para mais informações sobre a instalação da placa de fixação do cabo HDMI, consulte “Cabos de ligação”.

6.

Conector OPTION
Utilize para ligar um sinal indicador a partir de um dispositivo externo ou um controlador da objetiva.

Para mais informações, consulte “Ligar um sinal indicador” e “Ligar um controlador da objetiva”.

7.

Fixador de cabo
Utilize para fixar o cabo do adaptador AC.

8.

Interruptor RESET
Prima durante, pelo menos, 5 segundos utilizando a ponta de uma caneta ou dispositivo semelhante para repor as
definições do aparelho para os valores predefinidos de fábrica.
Pode selecionar se repõe apenas as definições da ligação de rede ou todas as definições através do interruptor
SETUP 1.

9.

Conector de saída OPTICAL
Emite um sinal SDI convertido em formato ótico quando está ligado um módulo SFP+ (opção).

10.
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Para mais informações, consulte “Emitir um sinal de fibra ótica”.
Interruptores SETUP

Configura as definições seguintes.
Interruptor 1: define quais definições são repostas quando prime o interruptor RESET.

Interruptor 2: define se a fonte de alimentação +48 V (alimentação fantasma) é ligada/desligada quando é ligado
um dispositivo de entrada de áudio. A definição é aplicada imediatamente.
Esta função está ativada quando [Audio] > [Audio Input] > [AUDIO IN Select] está definido para [MIC] no menu da
câmara.

Nota

Colocar o interruptor 2 na posição ON e ligar um microfone que não é compatível com uma fonte +48 V poderá danificar o
dispositivo ligado. Verifique a definição antes de ligar o dispositivo.

Interruptor 3: ativa/desativa a comunicação VISCA over IP. As definições são aplicadas quando a câmara é ligada.
Coloque na posição ON para utilizar o aparelho quando ligado a um controlo remoto (RM-IP500).

Nota

Se a palavra-passe do administrador não tiver sido configurada, a comunicação VISCA over IP é desativada,
independentemente da definição do interruptor. Para mais informações sobre a configuração da palavra-passe do
administrador, consulte “Inicializar o aparelho”.

11.

Definição Descrição

OFF
(predefinição)

Repõe apenas as definições da ligação de rede. As definições de rede, definições de
segurança e as informações de utilizador (nome de utilizador e palavra-passe) do aparelho
serão repostas.

ON Repõe todas as definições para as predefinições.

Definição Descrição

OFF
(predefinição)

Não forneça alimentação +48 V (fonte de alimentação fantasma). Configure esta definição ao
utilizar um dispositivo de áudio externo (como um misturador), microfone dinâmico ou microfone
com uma bateria integrada.

ON
Forneça alimentação +48 V (fonte de alimentação fantasma) para um microfone compatível
com alimentação fantasma ligado ao conector AUDIO IN (CH-1 ou CH-2).

Definição Descrição

OFF (predefinição) Não responderá a comandos VISCA over IP.

ON Aceita comandos VISCA over IP.
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Tópico relacionado

Bloquear o código de hora para outros dispositivos

Ligar monitores externos e dispositivos de gravação

Cabos de ligação

Ligar um sinal indicador

Ligar um controlador da objetiva

Emitir um sinal de fibra ótica

Inicializar o aparelho

Sincronizar a fase do sinal de vídeo (Genlock)

Ligar um microfone externo ou dispositivo de áudio externo

5-041-957-53(1) Copyright 2022 Sony Corporation

Interruptor 4: muda as operações de deslocamento/inclinação enviadas a partir do controlo remoto de
infravermelhos. A definição é aplicada imediatamente.

Definição Descrição

OFF (predefinição) Funciona à velocidade normal.

ON Funciona à velocidade máxima.

Conector SDI OUT
Emite o vídeo a partir do aparelho como um sinal 12G/6G/3G/HD-SDI.
O aparelho também pode ser configurado para saída de sinal RAW.

Para mais informações, consulte “Conector SDI OUT (Tipo BNC)”, em “Ligar monitores externos e dispositivos de
gravação”.

12.

 Sensor do controlo remoto de infravermelhos (parte traseira)
Sensor de infravermelhos para o controlo remoto de infravermelhos fornecido.

13.

Ventoinha/saída de ar
Emite calor a partir do interior do aparelho.

Nota

Não tape a saída de ar. Caso contrário, poderá causar uma avaria.

Atente que a área próxima da saída de ar poderá ficar quente.

14.

Conector GENLOCK
Utilize para inserir um sinal de sincronização externo.

Para mais informações, consulte “Sincronizar a fase do sinal de vídeo (Genlock)”.

15.

Conector AUDIO IN (conector de 5 pinos tipo XLR)
Utilize para inserir o sinal a partir de um microfone externo ou dispositivo de áudio.
Funciona como um conector AUDIO IN CH-1 ou conector AUDIO IN CH-2.

Para mais pormenores, consulte “Ligar um microfone externo ou dispositivo de áudio externo”.

16.
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Vista lateral

Este tópico descreve a localização e a função das peças na parte lateral do aparelho.

Sugestão

Esta descrição diz respeito à ilustração do aparelho sem uma objetiva instalada.

Alavanca de bloqueio de deslocamento/inclinação
Bloqueia o mecanismo de deslocamento/inclinação do aparelho. Utilize nos seguintes casos.

Ao transportar ou embalar o aparelho.
Ao instalar ou remover uma objetiva. Para mais informações, consulte “Instalar uma objetiva” ou “Remover uma
objetiva”.
Ao usar uma objetiva incompatível com a operação de deslocamento/inclinação (tal como as objetivas Sony
SEL100400GM / SEL200600G / SEL400F28GM / SEL600F40GM).
Ao transportar o aparelho, retire sempre a objetiva e coloque na posição de bloqueio.

1.
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Tópico relacionado

Instalar uma objetiva

Remover uma objetiva

Inserir cartões de memória

Aceder à Web App a partir de um browser da web

5-041-957-53(1) Copyright 2022 Sony Corporation

Sugestão

O movimento de deslocamento/inclinação pode ser fixo nos seguintes ângulos.

Base deslizante2.

Orifícios roscados para dispositivos externos (4 localizações)
Para parafusos M3 com um comprimento até 6 mm.

Nota

Não use parafusos com comprimento superior a 6 mm. Caso contrário, poderá causar uma avaria.

3.

Indicador de acesso A4.

Indicador de acesso B
O indicador acende ou pisca quando o suporte de gravação é inserido.

Para mais informações, consulte “Inserir cartões de memória”.

5.

Ranhura (A) para cartões CFexpress Type A / SD6.

Ranhura (B) para cartões CFexpress Type A / SD
Utilize para inserir o suporte de gravação.

Para mais informações, consulte “Inserir cartões de memória”.

7.

Código QR para ligação de rede
Utilize ao configurar as definições iniciais.

Para mais informações, consulte “Aceder à Web App a partir de um browser da web”.

8.
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Vista superior

Este tópico descreve a localização e a função das peças na parte superior do aparelho.

Sugestão

Esta descrição diz respeito à ilustração do aparelho sem uma objetiva instalada.

5-041-957-53(1) Copyright 2022 Sony Corporation

Orifícios roscados para dispositivos externos (2 localizações)
Compatível com parafusos UNC 1/4-20 e para um tripé.
Comprimento máximo de 6 mm.

1.

ɸ (marca do sensor de imagem)
A marca do sensor de imagem encontra-se ao mesmo nível do sensor de imagem.
Para medir com precisão a distância entre o aparelho e o motivo, utilize a marca do sensor de imagem como ponto
de referência.

2.
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Vista inferior

Este tópico descreve a localização e a função das peças na parte inferior do aparelho.

Sugestão

Esta descrição diz respeito à ilustração do aparelho sem uma objetiva instalada.

Orifícios para parafusos de fixação do suporte de teto (6 posições, profundidade de rosca efetiva de 5,5 mm)
Ao fixar o aparelho num teto ou uma prateleira num local alto, instale o suporte de corpo (opção) na base do
aparelho utilizando os seis parafusos de fixação do suporte de corpo nestes orifícios roscados.

Para mais informações sobre a instalação, consulte “Fixar na vertical num local alto e fixo” e “Fixação num teto”.

1.

Parafusos de fixação do tripé (2 localizações)
Usados ao fixar o aparelho num tripé de câmara (opcional, parafusos UNC 1/4-20, com um comprimento até 5,5
mm).

Nota

2.
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Tópico relacionado

Fixar na vertical num local alto e fixo

Fixação num teto
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Não use parafusos com comprimento superior a 5,5 mm. Caso contrário, poderá causar uma avaria.
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Apoio da objetiva

Este tópico descreve a localização e a função das peças do apoio da objetiva do aparelho.

Sugestão

Esta descrição diz respeito à ilustração do aparelho sem uma objetiva instalada.

Haste do apoio da objetiva (2)
Apoia a objetiva.
Pode também ser utilizada para instalar acessórios de haste de Ø15 em geral.

1.
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Unidade de apoio da objetiva
O suporte da objetiva pode deslizar para a frente/para trás, em função da objetiva, e ser depois bloqueado.

2.

Parafuso de instalação da base de apoio da objetiva
Instale na base de apoio da objetiva. Pode ajustar o parafuso para cima/para baixo para corresponder à altura da
base de apoio da objetiva.

3.

Alavanca de aperto do apoio da objetiva (2 pontos)
Fixa a posição para a frente/para trás da unidade de apoio da objetiva.

4.

Alavanca de aperto do parafuso de instalação da base de apoio da objetiva
Fixa a posição vertical do parafuso de instalação da base de apoio da objetiva.

Sugestão

Se uma alavanca de aperto se encontrar numa posição que torna difícil rodar, solte a alavanca de aperto e rode-a para um
ângulo que tornará a operação mais simples. Quando se encontrar na posição pretendida, feche a alavanca de aperto.

A: alavanca de aperto do parafuso de instalação da base de apoio da objetiva
B: alavanca de aperto do apoio da objetiva

Nota

Para evitar que a unidade de apoio da objetiva interfira com a operação de deslocamento/inclinação, mova a unidade de
apoio da objetiva para cima contra a cabeça da câmara quando não estiver utilizar a unidade de apoio da objetiva e mova o
parafuso de instalação da base de apoio da objetiva para a posição mais alta (mais próxima da objetiva).

5.
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Localização e função das peças do controlo remoto de infravermelhos (fornecido)

Este tópico descreve a localização e a função das peças do controlo remoto de infravermelhos (fornecido).

Botão REC● (START/STOP gravação)
Prima para inciar ou parar a gravação.

1.

Botão MENU
Prima para mostrar ou ocultar o menu da câmara.

2.

Botões de controlo da GUI
Prima para efetuar operações no menu da câmara, nos diálogos de mensagens e que incluem botões e outras
funções de apresentação do ecrã.

3.

Botão CANC./BACK
Prima para cancelar uma definição ou para regressar ao ecrã anterior do menu da câmara do aparelho.

4.
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Bateria do controlo remoto de infravermelhos

O controlo remoto de infravermelhos precisa de duas pilhas AA (LR6).
Insira as pilhas no controlo remoto de infravermelhos, conforme mostrado no diagrama seguinte.

Botões de controlo de deslocamento e inclinação
Prima os botões de seta para controlar o deslocamento/inclinação da câmara. Prima o botão HOME para repor a
orientação da câmara virada para a frente.

5.

Botões de controlo da posição da predefinição
Prima continuamente o botão PRESET e prima um dos botões 1 a 3 para memorizar a direção da câmara, zoom e o
estado de ajuste da focagem no botão do número premido.
Prima um botão de número com definições memorizadas para aceder ao estado guardado.

6.

Botões de controlo de focagem
Utilize para ajustar a focagem.
Para ajustar a focagem automaticamente, prima o botão AF.
Para ajustar a focagem manualmente, prima o botão MF, prima o botão F (Distante) para focar em motivos distantes
ou o botão N (Próximo) para focar em motivos próximos.

7.

Botões atribuíveis 1 a 3
Executa as funções atribuídas aos botões atribuíveis através do menu da câmara.
Se atribuir a função [Direct Menu] a um botão atribuível, pode ajustar a exposição, o equilíbrio de brancos e outras
definições, usando os botões de controlo da GUI.

Para mais informações sobre a atribuição utilizando o menu da câmara, consulte “Botões atribuíveis”.

Para mais informações sobre o menu direto, consulte “Funcionamento do menu direto”.

8.

Botão  (alimentação)
Prima para ligar o aparelho ou para mudar a fonte de alimentação para o estado de espera.

9.

Botão THUMBNAIL
Apresenta o ecrã de miniaturas que mostra os clips gravados no cartão de memória do aparelho.

Para mais informações sobre o ecrã de miniaturas, consulte “Ecrã de miniaturas”.

Pode selecionar clips e controlar a reprodução no ecrã de miniaturas através dos botões de controlo da GUI.

Para mais informações sobre a seleção dos clips e o controlo da reprodução, consulte “Reproduzir clips
gravados” e “Operações em clips gravados”.

10.

Botão SLOT SEL (seleção da ranhura para cartões de memória (A)/(B))
Quando forem inseridos dois cartões de memória, prima o botão para alternar entre cartões de memória para
gravação.
Prima este botão enquanto o ecrã de miniaturas é apresentado para alternar entre os cartões de memória a
visualizar.

11.

Botão P/T RESET (reposição de deslocamento/inclinação)
Repõe as funções de deslocamento/inclinação. Prima o botão quando as luzes POWER e NETWORK estiverem a
piscar simultaneamente ou quando o botão [Execute Pan-Tilt Reset] é apresentado no painel de controlo do
enquadramento na Web App.

12.

Botões de controlo do zoom
Para aproximar, prima o botão T (teleobjetiva).
Para afastar, prima o botão W (grande angular).

13.
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Nota

Não utilize pilhas que não pilhas de manganês ou alcalinas uma vez que poderão rebentar.

Elimine as pilhas gastas de acordo com as leis e os regulamentos do país ou região.

Tópico relacionado

Botões atribuíveis

Funcionamento do menu direto

Ecrã de miniaturas

Reproduzir clips gravados

Operações em clips gravados

5-041-957-53(1) Copyright 2022 Sony Corporation
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Visão geral do ecrã da Web App

Ao ligar um tablet ou computador, pode deslocar/inclinar, aplicar zoom, gravar, reproduzir vídeo gravado e configurar o
aparelho a partir de um browser da web (doravante, esta função é referida como a “Web App”).

Para mais informações sobre o lançamento da Web App, consulte “Aceder à Web App a partir de um browser da
web”.

Nota

A Web App não é compatível com a saída de áudio da câmara.

Quando a Web App abre, aparece o ecrã de operações em gravação.

Ecrã de operações em gravação

Para mais informações sobre o ecrã de operações em gravação, consulte “Estrutura do ecrã de operações em
gravação”.
Os botões e ícones comuns ao ecrã de operações em gravação e ecrã de operações em reprodução são
apresentados na parte superior do ecrã.
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Para mais informações sobre a área comum dos ecrãs, consulte “Estrutura da área comum de ecrãs”.
Pode alternar entre ecrãs premindo os separadores de comutação de ecrã na área comum.

Ecrã de operações em reprodução

Prima o separador [Playback] para apresentar o ecrã de operações em reprodução.

Para mais informações sobre o ecrã de operações em reprodução, consulte “Estrutura do ecrã de operações em
reprodução”.

Ecrã de definições

Prima o separador [Settings] para apresentar o ecrã de definições (doravante referido como menu web).
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Nota

No menu web, as definições não são aplicadas até premir o botão [OK]. Se alterar as definições numa página com um [OK],
certifique-se de que prime o botão [OK].

Para mais informações sobre o ecrã de definições, consulte “Estrutura do ecrã de definições”.
Neste Guia de ajuda, o ecrã de definições da Web App é referido como o menu web.

Tópico relacionado
Aceder à Web App a partir de um browser da web

Estrutura do ecrã de operações em gravação

Estrutura da área comum de ecrãs

Estrutura do ecrã de operações em reprodução

Estrutura do ecrã de definições

5-041-957-53(1) Copyright 2022 Sony Corporation
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Estrutura da área comum de ecrãs

Este tópico descreve a estrutura da área comum de ecrãs.

Nome da câmara
Apresenta o nome da câmara.
Pode alterar o nome, usando [Network] > [Camera Name] no menu web.
A cor de fundo muda de acordo com o sinal indicador externo.

1.

Interruptor de alimentação
Quando o aparelho é ligado, é apresentado [Power ON]. Pode premir o interruptor e selecionar [Power Standby],
para definir a fonte de alimentação do aparelho para o estado de espera.
Quando é apresentado [Power Standby], pode premir o interruptor e selecionar [Power ON], para ligar a fonte de
alimentação do aparelho.

2.

Separadores de comutação do ecrã de funcionamento
Prima o separador para apresentar o ecrã de funcionamento correspondente.
Separador [Live]: apresenta o ecrã de operações em gravação.
Separador [Playback]: apresenta o ecrã de operações em reprodução.
Separador [Settings]: apresenta o ecrã de definições (menu web).

3.

Marca de notificações
Quando recebe uma mensagem, a indicação da marca muda conforme mostrado abaixo.

 (Notificações ativadas)
Tome a ação necessária, em função da mensagem apresentada no painel de imagem da câmara.

Nota

As mensagens não são apresentadas quando [Monitoring] > [Output Display] > [HDMI/Stream] está definido para [Off] no
menu web. Defina para [On], para verificar os conteúdos das mensagens.

4.

Botão  (Estado da câmara)
Prima o botão para apresentar as informações sobre o sinal de imagem gravada/imagem de saída da câmara,
informações sobre a objetiva e o estado do controlador da objetiva (opção) num ecrã separado.

5.
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Quando ocorre uma notificação relacionada com o controlador da objetiva (opção), a indicação muda conforme
mostrado abaixo.

Interruptor de bloqueio de operações no ecrã
 (Desbloqueio das operações): coloque o interruptor para a esquerda para controlar as operações no ecrã de

operações em gravação e ecrã de operações em reprodução.
 (Bloqueio das operações): coloque o interruptor para a direita para bloquear as operações no ecrã de

operações em gravação e ecrã de operações em reprodução para evitar ações acidentais.

6.
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Estrutura do ecrã de operações em gravação

Este tópico descreve a estrutura do ecrã de operações em gravação.

Painel de controlo das posições das predefinições
Apresenta a posição registada de uma predefinição, usando uma miniatura. Toque duas vezes na miniatura para
regressar à posição guardada na predefinição.

Para mais informações sobre as posições das predefinições, consulte “Guardar/repor a posição do
deslocamento/inclinação e zoom e a definição de focagem através da Web App”.
Para mais informações sobre a deteção PTZ, consulte “Gravar operações de enquadramento da câmara usando
a Web App”.

1.

Painel de imagem da câmara
Apresenta a atual imagem da câmara e o estado do aparelho.
Apresenta a mesma imagem da saída HDMI.
O estado seguinte é apresentado acima da imagem. É também apresentada uma moldura vermelha ou verde à volta
da imagem de acordo com o sinal indicador externo recebido.

2.
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Botão [Display]
Prima este botão para apresentar as informações da câmara na imagem.
Prima novamente enquanto as informações da câmara são apresentadas para ocultar as informações da câmara.

Além dos marcadores, alguns indicadores e mensagens relacionados com a focagem automática são apresentados
de acordo com o estado e estes não podem ser ocultados premindo o botão [Display].

Para mais informações sobre as informações da câmara apresentadas, consulte “Apresentação do ecrã da
câmara”.

N.º Apresentação Descrição

2-
1

Indicador do modo de focagem
Consulte “Indicador do modo de focagem” em “Apresentação do
ecrã da câmara”.

2-
2

Modo de gravação, ranhura A/B,
indicador do intervalo de gravação
Interval Rec

Consulte “Modo de gravação, ranhura A/B, indicador do intervalo
de gravação Interval Rec” em “Apresentação do ecrã da câmara”.

2-
3

Indicador do estado da transmissão
Apresentado durante a transmissão (apenas quando [Stream
Setting] está definido para [RTMP] ou [SRT-Caller]).

2-
4

Indicador do estado de funcionamento
da saída RAW

Apresenta o estado de saída do sinal RAW. Para mais
informações sobre RAW, consulte “Gravar vídeo RAW”.

2-
5

Indicador da capacidade restante do
suporte

Consulte “Indicador da capacidade restante do suporte” em
“Apresentação do ecrã da câmara”.

2-
6

Indicador da posição de zoom

Consulte “Indicador da posição de zoom” em “Apresentação do
ecrã da câmara”.
Quando um controlador da objetiva (opção) está ligado, é
apresentado . Se ocorrer um erro no controlador da objetiva
(opção), é apresentado .

2-
7

Indicador do modo AE/nível AE
Consulte “Indicador do modo AE/nível AE” em “Apresentação do
ecrã da câmara”.
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Botão de paragem da função AF de deteção em tempo real
Prima o botão para parar a deteção de um motivo.

Para mais informações, consulte “Detetar um motivo específico (função AF de deteção em tempo real)”.
Botão START/STOP gravação
Prima o botão para iniciar a gravação. Durante a gravação, o botão START/STOP gravação acende-se a vermelho.
Prima durante a gravação para parar a gravação.
Pode definir o interruptor Hold para o estado Hold para evitar uma operação acidental do botão START/STOP
gravação.

3.

Painel de configuração básica da câmara
Apresenta definições nos botões para as funções básicas necessárias para filmagem. Prima um botão para
apresentar o ecrã de configuração correspondente para cada função no painel de ajuste da configuração básica da
câmara abaixo (5).

4-1 [FPS]
4-2 [ISO/Gain / Exposure Index]
4-3 [Shutter]
4-4 [Iris]
4-5 [ND Filter]
4-6 [Scene File / Base Look/LUT]
4-7 [White Balance]

Para mais informações, consulte a descrição de cada função.

4.

Função Referência

FPS “Câmara lenta e movimento rápido”

ISO/Gain
“Definir a sensibilidade de base”, “Ajustar o ganho automaticamente” e “Ajustar manualmente o
ganho”, em “Ajustar o ganho”.

Exposure
Index

“Definir a sensibilidade de base” e “Alterar a distribuição de áreas escuras e claras na imagem
gravada”

Shutter
“Ajustar o obturador automaticamente” e “Ajustar o obturador manualmente”, em “Ajustar o
obturador”

Iris “Ajustar automaticamente a íris” e “Ajustar manualmente a íris”, em “Ajustar a íris”

ND Filter “Sobre o filtro ND”, em “Ajustar o nível de luz (Filtro ND)”

Scene File “Visão geral de aspeto” e outros tópicos, em “Filmar com o aspeto pretendido”

46



Função Referência

Base
Look/LUT

“Filmar com ajuste de aspeto na pós-produção”

White
Balance

“Ecrã de ajuste do equilíbrio de brancos”

Botões atribuíveis/Painel de ajuste da configuração básica da câmara
Apresenta botões atribuíveis durante o funcionamento normal. Prima os botões do painel de configuração básica da
câmara (item 4) para apresentar os itens de configuração correspondentes. Prima o botão [X] ou prima novamente o
botão do painel de configuração da câmara para regressar ao ecrã de botões atribuíveis.

Para mais informações sobre os botões atribuíveis, consulte “Botões atribuíveis”.
Para mais informações sobre o painel de ajuste da configuração básica da câmara, consulte a descrição de cada
função.

5.

Painel de controlo do enquadramento / Painel de controlo da GUI
Alterne entre o painel de controlo do enquadramento / painel de controlo da GUI, usando os separadores na parte
superior.
Pode premir o botão  (Fechar) no canto superior direito do ecrã para ocultar o painel de controlo para evitar uma
operação acidental. Se o painel de controlo não for apresentado, prima o botão  (Abrir) para o apresentar.
Use o painel de controlo do enquadramento para ajustar o enquadramento. Prima o separador 
(Deslocamento/inclinação/zoom) para apresentar o painel de controlo do enquadramento.

Para mais informações sobre a operação, consulte “Ajustar o enquadramento”.

Sugestão

A parte de joystick do painel de controlo do enquadramento é apresentada conforme ilustrado abaixo, quando a operação de
deslocamento/inclinação é desativada e quando é necessária a inicialização de deslocamento/inclinação.

Quando a operação de deslocamento/inclinação é bloqueada utilizando a alavanca de bloqueio de
deslocamento/inclinação

6.
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Quando a operação de deslocamento/inclinação não é inicializada

Quando a operação de deslocamento/inclinação necessita de ser reposta

Quando a operação de deslocamento/inclinação é desativada

Quando a operação de deslocamento/inclinação é inicializada ou necessita de ser reposta, pode aceder rapidamente ao
botão  (Reposição do deslocamento/inclinação) no painel de controlo da câmara, premindo a mensagem
apresentada por baixo do joystick.

Utilize o painel de controlo da GUI para controlar o menu da câmara, reproduzir clips e outras funções. Prima o
separador  (GUI da câmara) para apresentar o painel de controlo da GUI.
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Para mais informações sobre a operação, consulte “Utilizar o menu da câmara” e “Reproduzir clips gravados”.
Painel de controlo da câmara
Utilize para configurar as funções necessárias para utilizar a câmara.
Alterne entre os ecrãs a apresentar utilizando os separadores na parte superior.
Pode premir o botão  (Fechar) no canto superior direito do ecrã para ocultar o painel de controlo para evitar uma
operação acidental. Se o painel de controlo não for apresentado, prima o botão  (Abrir) para o apresentar.

Para mais informações, consulte a descrição de cada função.

Separador  (Main)
Apresenta os itens de configuração para as funções frequentemente utilizadas.
As funções de deslize superior e inferior podem ser utilizadas premindo o botão [▼] e selecionando a partir da lista
apresentada. Podem ser selecionadas as funções seguintes.

ND Filter
Iris
ISO*

Gain*

Exposure Index*

AE Level
Zoom Speed
Pan-Tilt Speed

Separador  (Focus)
Apresenta os itens de configuração relacionados com a focagem.

7.

Apresentado em função das definições do menu.*
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Separador  (Audio)

Apresenta os itens de configuração relacionados com o áudio.

Separador  (Stream)
Apresenta os itens de configuração relacionados com a transmissão.
Os itens apresentados variarão consoante a definição do formato de transmissão.
Quando definido para [RTMP] ou [SRT-Caller], a transmissão pode ser iniciada/parada neste ecrã.

Para mais pormenores, consulte “Sobre a transmissão” e outros tópicos, em “Configurar a transmissão
(streaming)”.
A informação de erro é apresentada se ocorrer uma falha na ligação. Para mais informações sobre as
informações de erro, consulte “Mensagens de erro/aviso”.
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Tópico relacionado

Guardar/repor a posição do deslocamento/inclinação e zoom e a definição de focagem através da Web App

Gravar operações de enquadramento da câmara usando a Web App

Apresentação do ecrã da câmara

Gravar vídeo RAW

Detetar um motivo específico (função AF de deteção em tempo real)

Câmara lenta e movimento rápido

Separador  (Others)
Apresenta os itens de configuração relacionados com outras funções.

Premir o botão [Full Screen Display] abre um novo separador no browser da web e apresenta a imagem do painel de
imagem da câmara em ecrã inteiro.
Apenas ocorre a apresentação da imagem; AF tátil e outras funções não estão disponíveis.

Nota

O ecrã de operações em gravação no separador original continua a funcionar. É aconselhável fechar o separador para
reduzir o número de ligações simultâneas se não for necessária qualquer operação.

Prima o botão  (Inicializar controlador da objetiva) para inicializar o controlador da objetiva (opção de
terceiros). Este botão só é ativado quando [Technical] > [Lens Controller] > [Zoom] > [Setting] está definido para [On]
no menu web.
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Definir a sensibilidade de base

Ajustar o ganho automaticamente

Ajustar manualmente o ganho

Alterar a distribuição de áreas escuras e claras na imagem gravada

Ajustar o obturador automaticamente

Ajustar o obturador manualmente

Ajustar automaticamente a íris

Ajustar manualmente a íris

Sobre o filtro ND

Visão geral de aspeto

Filmar com ajuste de aspeto na pós-produção

Ecrã de ajuste do equilíbrio de brancos

Botões atribuíveis

Reproduzir clips gravados

Utilizar o menu da câmara

Sobre a transmissão

Mensagens de erro/aviso

5-041-957-53(1) Copyright 2022 Sony Corporation
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Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Estrutura do ecrã de operações em reprodução

Este tópico descreve a estrutura do ecrã de operações em reprodução.

Painel de imagem da câmara
Apresenta a imagem de reprodução e as informações relacionadas. Quando a reprodução é parada, aparece o ecrã
da imagem da câmara.

1.
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1-1 Data e hora de filmagem
1-2 Indicador do estado de reprodução
1-3 Indicador do formato de reprodução (tamanho da imagem)
1-4 Indicador do formato de reprodução (codec)
1-5 Apresentação do nome do clip
1-6 Número do clip/número total de clips
1-7 Apresentação do nome da LUT
1-8 Indicador do estado de transmissão
1-9 Indicador do formato de reprodução (taxa de fotogramas e método de digitalização)
1-10 Indicador do aspeto de gravação

Painel de controlo de reprodução

Apresenta os botões de controlo da reprodução.

Botão [Display]
Prima para alternar entre a apresentação do ecrã na imagem.
Botão [Thumbnail]
Apresenta os clips gravados no cartão de memória no painel de imagem da câmara como miniaturas.

2.

Botão Função

Botão  (Reproduzir/Pausar) Reproduz um clip. Durante a reprodução, pausa o clip.

Botão  (Avanço rápido), botão
 (Recuo rápido)

Reproduz um clip a alta velocidade. Quando é premido um botão, a
velocidade de reprodução muda em três passos.

Botão  (Seguinte), botão 
(Anterior)

Salta para o início do clip ou para o clip anterior/seguinte.

Botão  (Parar) Para a reprodução.
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Tópico relacionado

Ecrã de miniaturas

Botões atribuíveis

Reproduzir clips gravados

5-041-957-53(1) Copyright 2022 Sony Corporation

Premir o botão [Thumbnail] durante a apresentação do ecrã de miniaturas fecha o ecrã de miniaturas e regressa à
imagem da câmara.

Para mais informações sobre o ecrã de miniaturas, consulte “Ecrã de miniaturas”.

Botão [Slot Select]
Alterna entre o suporte de gravação pretendido.

Botões atribuíveis
Apresenta os botões atribuíveis atribuídos a funções do aparelho.

Para mais informações sobre os botões atribuíveis, consulte “Botões atribuíveis”.

3.

Painel de controlo da GUI
Utilize o painel de controlo da GUI para controlar o menu da câmara, reproduzir clips e outras funções.

Para mais informações sobre a operação, consulte “Utilizar o menu da câmara” e “Reproduzir clips gravados”.

4.
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Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Estrutura do ecrã de definições

Utilize o ecrã de definições para configurar os vários itens de configuração da unidade, incluindo definições iniciais,
definições de rede, definições de filmagem/reprodução utilizando o menu web.

Nota

No menu web, como regra geral, as definições não são aplicadas até premir o botão [OK]. Se alterar as definições numa página
com um [OK], certifique-se de que prime o botão [OK].

Para mais informações sobre o ecrã de definições, consulte “Menu web e definições detalhadas”.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Menu da câmara

Prima o botão [Menu] no painel de controlo da GUI do ecrã de operações em gravação ou ecrã de operações em
reprodução, para apresentar o menu da câmara no painel de imagem da câmara.

Pode configurar as definições necessárias para filmagem e reprodução utilizando o menu da câmara.
Prima o botão [Menu] enquanto o menu da câmara é apresentado para ocultar o menu da câmara.
O menu da câmara é operado através do painel de controlo da GUI.

Para mais informações sobre o menu da câmara, consulte “Menu da câmara e definições detalhadas.”

Nota

Quando [Monitoring] > [Output Display] > [HDMI/Stream] está definido para Off no menu web (desativa a sobreposição de
informações no ecrã), o menu da câmara deixa de estar apresentado no painel de imagem da câmara. No entanto, tenha em
atenção que as operações do menu no painel de controlo da GUI continuam ativas. Para evitar operações inadvertidas, tenha o
cuidado de não efetuar qualquer operação de menu usando o painel de controlo da GUI quando [HDMI/Stream] está definido
para Off.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Apresentação do ecrã da câmara

Pode apresentar o estado e as definições do aparelho sobrepostos na imagem de saída da câmara. Pode definir as
saídas para as quais a apresentação do ecrã está ativada, usando [Monitoring] > [Output Display] no menu web.
Pode mostrar/ocultar as informações, usando o botão [Display]. Mesmo quando oculto, vai aparecer durante as
operações no menu direto.
Pode mostrar/ocultar itens individualmente, usando [Monitoring] > [Display On/Off] no menu da câmara.

Informações apresentadas no ecrã durante a filmagem

Indicador de carregamento/indicador de ficheiros restantes

Para mais pormenores sobre a transferência de ficheiros, consulte “Sobre a transferência de ficheiros” e outros
tópicos, em “Transferir ficheiros”.

1.

Indicador da área de focagem
Apresenta a área de focagem para focagem automática.

Para mais pormenores sobre a focagem automática, consulte “Ajustar automaticamente através da Web App” e
outros tópicos, em “Ajustar automaticamente a focagem (Focagem automática)”.

2.

Modo de gravação, ranhura A/B, indicador do intervalo de gravação Interval Rec

Para mais informações sobre Interval Rec, consulte “Gravar vídeo intermitentemente (Interval Rec)”.

3.

Apresentação Significado

●Rec Gravação

Stby Gravação em espera

Indicador da profundidade de campo4.
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Indicador do modo de digitalização do sensor de imagem
É apresentada uma marca  (sem correspondência) se não houver correspondência entre o tamanho do círculo da
imagem da objetiva e a definição do modo de digitalização do sensor de imagem para o tamanho da imagem real.
Quando o Imager Scan Mode está definido para FF, é apresentada uma marca “C” nos modos com um ângulo de
visão mais estreito (recortado).
O recorte ocorre nos seguintes modos.

Quando o formato de gravação é 3840×2160 e a taxa de fotogramas S&Q Motion é de 100 fps ou 120 fps
Quando [Codec] está definido para RAW ou RAW & XAVC-I e o formato de saída RAW é 3840×2160
Para mais informações sobre o modo de digitalização do sensor de imagem, consulte “Definir o modo de
digitalização do sensor de imagem” em “Configurar o funcionamento básico”.

5.

Indicador do estado de funcionamento da saída RAW
Apresenta o estado de saída do sinal RAW.

Para mais informações sobre RAW, consulte “Gravar vídeo RAW”.

6.

Indicador da taxa de fotogramas na filmagem em câmara lenta e movimento rápido

Para mais informações sobre câmara lenta e movimento rápido, consulte “Câmara lenta e movimento rápido”.

7.

Indicador da posição de focagem

Apresenta a posição de focagem

8.

Indicador do modo de focagem

AF de deteção de rosto/olhos

Para mais informações sobre a AF de deteção de rosto/olhos, consulte “Deteção através da deteção de rosto e
olhos (Face/Eye Detection AF)”.

9.

Apresentação Significado

Focus Hold Modo Focus Hold

MF Modo MF

AF Modo AF

 (Função AF de deteção em tempo real) Função AF de deteção em tempo real

Apresentação Significado

 (AF de deteção de rosto/olhos) Indica que a AF de deteção de rosto/olhos está ativa

 (AF apenas de rosto/olhos) Indica que AF de apenas rosto/olhos está ativa

 (Rosto detetado guardado) Indica que foi guardado um rosto detetado

 (AF pausada) Indica que a AF foi colocada em pausa*

Apresentado quando não existe um rosto detetado guardado e não é detetado qualquer rosto ou quando existe um rosto detetado
guardado, mas o rosto pretendido não é detetado.

*

Indicador da posição de zoom
Apresenta a posição de zoom no intervalo entre 0 (grande angular) e 99 (teleobjetiva) (se estiver instalada uma
objetiva compatível com a apresentação da definição do zoom).

10.
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Pode também alterar o indicador para uma apresentação de barra ou apresentação de distância focal, usando a
definição [Technical] > [Lens] > [Zoom Position Display] no menu da câmara.
Os itens seguintes são adicionados à apresentação quando Zoom de Imagem Clara está ativado.

Para mais pormenores sobre o zoom, consulte “Definir o tipo de zoom” e outros tópicos, em “Ajustar o zoom”.

Apresentação Significado

 (Zoom de Imagem Clara ativado) Zoom de Imagem Clara ativado

Valor de ampliação Ao utilizar Zoom de Imagem Clara

Indicador do modo de estabilização de imagem11.

Indicador de estado Rec Control da saída SDI/saída HDMI
Apresenta o estado de saída do sinal de controlo REC.

Para mais informações, consulte “Ligar monitores externos e dispositivos de gravação”.

12.

Indicador de focagem

Para mais pormenores, consulte “Utilizar a focagem automática de filmagem única (focagem automática por
seleção (AF-S))”, em “Ajustar a focagem”.

13.

Indicador da capacidade restante do suporte
Aparece um ícone  (proteção) se o cartão de memória estiver protegido contra escrita.

14.

Indicador do modo de equilíbrio de brancos15.

Apresentação Significado

 (ATW) Modo automático

 (ATW Hold) Modo automático pausado

W:P Modo predefinido

W:A Modo de memória A

Indicador de bloqueio externo do código de hora/apresentação dos dados de hora
Apresenta “EXT-LK” quando bloqueado para o código de hora de um dispositivo externo.

Para mais informações sobre o código de hora, consulte “Especificar dados de hora”.

16.

Indicador de filtro ND

Para mais informações sobre filtros ND, consulte “Ajustar o nível de luz (Filtro ND)”.
Para mais informações sobre o controlo de bokeh, consulte “Ajustar bokeh (função de controlo de bokeh)”.

17.

Apresentação Significado

 (A) Modo automático

 (B) Modo de controlo de bokeh

Indicador do ficheiro de cena18.
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Para mais pormenores sobre ficheiros de cenas, consulte “Visão geral de aspeto” e outros tópicos, em “Filmar
com o aspeto pretendido”.

Indicador de íris
Apresenta a posição da íris (valor F) (se estiver instalada uma objetiva que suporte a apresentação da definição da
íris).

Para mais pormenores sobre a íris, consulte “Ajustar automaticamente a íris” e “Ajustar manualmente a íris”.

19.

Indicador de aviso do nível de vídeo20.

Indicador de ganho
Apresenta o valor EI quando está no modo Cine EI/Cine EI Quick.

Para mais pormenores sobre o ganho, consulte “Ajustar o ganho automaticamente” e “Ajustar manualmente o
ganho”.
Para mais informações sobre o modo Cine EI/Cine EI Quick, consulte “Definir o modo de filmagem” em
“Configurar o funcionamento básico”.

21.

Apresentação Significado

 (A) Modo automático

L Modo predefinido L

 (Modo de ajuste temporário) Modo de ajuste temporário

 (B) Modo de controlo de bokeh

Apresentação do nome do clip
Apresenta o nome do clip em gravação ou a gravar de seguida.
Se estiver intermitente, existe uma incompatibilidade entre o último clip no suporte de gravação e as definições de
[Camera ID] ou [Reel Number]. Para mais informações, consulte a descrição de [Clip Name Format] > [Auto
Naming].

22.

Indicador do obturador

Para mais pormenores sobre o obturador, consulte “Ajustar o obturador automaticamente” e “Ajustar o obturador
manualmente”.

23.

Indicador do modo AE/nível AE

Para mais pormenores sobre a exposição automática (AE), consulte “Definir o nível pretendido para o ajuste
automático da luminosidade”.

24.

Indicador do nível
Apresenta o nível horizontal em incrementos de ±1° até ±15°.

25.

Medidor do nível de áudio
Apresenta o nível de áudio de cada canal.

26.

Monitor do sinal de vídeo
Apresenta uma forma de onda, vetorescópio e histograma.
A linha cor de laranja indica o valor definido do marcador do nível de luminosidade.
Nos modos de filmagem em Log, o tipo de LUT pretendida do monitor é apresentado acima do ecrã.

Par mais informações, consulte “Monitor do sinal de vídeo”.

27.
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Informações apresentadas no ecrã durante a reprodução

As informações seguintes são sobrepostas na imagem de reprodução.

Para mais informações sobre os modos de filmagem em Log, consulte “Definir o modo de filmagem” em
“Configurar o funcionamento básico”.

Indicador Base Sensitivity/Indicador Base ISO
No modo Custom, a sensibilidade de base definida é apresentada usando o botão [ISO/Gain / Exposure Index] no
painel de configuração básica da câmara ou [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] no menu da câmara.
Nos modos de filmagem em Log, a sensibilidade Base ISO definida é apresentada usando o botão
[ISO/Gain/Exposure Index] no painel de configuração básica da câmara ou [Shooting] > [ISO/Gain/EI] > [Base ISO]
no menu da câmara.

Para mais informações sobre a sensibilidade base, consulte “Selecionar a sensibilidade base”.
Para mais informações sobre os modos de filmagem em Log, consulte “Definir o modo de filmagem” em
“Configurar o funcionamento básico”.

28.

Indicador do aspeto de monitorização
Nos modos de filmagem em Log, apresenta a definição de LUT do monitor.

Para mais informações sobre a definição de LUT, consulte “Filmar com ajuste de aspeto na pós-produção” e os
tópicos relacionados.
Para mais informações sobre os modos de filmagem em Log, consulte “Definir o modo de filmagem” em
“Configurar o funcionamento básico”.

29.

Indicador do aspeto base/aspeto de gravação
Apresenta a definição do aspeto base.
Nos modos de filmagem em Log, apresenta o sinal de vídeo a gravar nos cartões de memória.

Para mais informações sobre o aspeto base, consulte “Visão geral de aspeto”, em “Filmar com o aspeto
pretendido”.
Para mais informações sobre os modos de filmagem em Log, consulte “Definir o modo de filmagem” em
“Configurar o funcionamento básico”.

30.

Indicador do estado proxy31.

Indicador do formato de gravação (codec)
Apresenta o nome do formato para gravar nos cartões de memória.
Defina o formato de gravação (codec), usando [Project] > [Rec Format] > [Codec] no menu web ou no menu da
câmara.

32.

Indicador do formato de gravação (taxa de fotogramas e método de digitalização)33.

Indicador do formato de gravação (tamanho da imagem)
Apresenta o tamanho da imagem para gravar nos cartões de memória.
Defina o formato de gravação (tamanho da imagem), usando [Project] > [Rec Format] > [Codec] no menu web ou no
menu da câmara.

34.

Sinal indicador
Apresenta uma moldura vermelha ou verde à volta da imagem de acordo com o sinal indicador externo recebido.

35.
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Tópico relacionado

Sobre a transferência de ficheiros

Ajustar automaticamente através da Web App

Gravar vídeo intermitentemente (Interval Rec)

Configurar o funcionamento básico

Gravar vídeo RAW

Câmara lenta e movimento rápido

Indicador de carregamento/indicador de ficheiros restantes1.

Número do clip2.

Indicador do estado de reprodução3.

Indicador do formato de reprodução (taxa de fotogramas e método de digitalização)4.

Indicador do formato de reprodução (tamanho da imagem)5.

Indicador do formato de reprodução (codec)6.

Indicador do suporte
Aparece um ícone  (proteção) se o cartão de memória estiver protegido contra escrita.

7.

Apresentação dos dados de hora8.

Apresentação do nome do clip9.

Indicador da assistência de visualização gama10.

Medidor do nível de áudio
Apresenta o nível do áudio de reprodução.

11.

Indicador do aspeto base/aspeto de gravação12.

Sinal indicador13.
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Deteção através da deteção de rosto e olhos (Face/Eye Detection AF)

Definir o tipo de zoom

Ligar monitores externos e dispositivos de gravação

Utilizar a focagem automática de filmagem única (focagem automática por seleção (AF-S))

Especificar dados de hora

Visão geral de aspeto

Ajustar automaticamente a íris

Ajustar manualmente a íris

Ajustar o ganho automaticamente

Ajustar manualmente o ganho

Ajustar o obturador automaticamente

Ajustar o obturador manualmente

Definir o nível pretendido para o ajuste automático da luminosidade

Monitor do sinal de vídeo

Filmar com ajuste de aspeto na pós-produção

Clip Name Format

5-041-957-53(1) Copyright 2022 Sony Corporation
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Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Instalar na vertical num local fixo

Este tópico descreve a fixação do aparelho numa secretária ou tripé.

Nota de instalação
Para proteger a objetiva e o bloco de conectores da objetiva do aparelho, mantenha a proteção e a tampa do
aparelho instalada até instalar a objetiva.
Para evitar a falha da objetiva, não segure pela objetiva durante o funcionamento.
Para evitar a falha do aparelho, não segure pela cabeça da câmara durante o funcionamento.

Verifique o espaço de instalação.

Ao fixar numa secretária
Fixe este aparelho numa superfície plana, tendo em consideração o espaço necessário para rodar a objetiva e os
cabos na parte traseira do aparelho.

Nota

Fixe num local estável que não esteja sujeito a vibrações. Os locais sujeitos a vibrações poderão causar vibrações na
imagem.

Se o aparelho tiver de ser fixado numa superfície inclinada, mantenha-o a ±15° da horizontal e tome medidas para evitar a
queda do aparelho.

Ao fixar num tripé
Instale o tripé no orifício para parafuso de fixação na parte inferior.
Utilize um parafuso de fixação do tripé com a dimensão seguinte de saliência da superfície de fixação e aperte com
uma chave de fenda.

A: parafusos de fixação do tripé 1/4-20 UNC, ISO 1222 (6,35 mm)

1

65



De seguida, instale a objetiva. Consulte “Instalar uma objetiva”, tendo em conta a informação em “Precauções ao
instalar/remover uma objetiva”, “Verificar os interruptores da objetiva” e “Precauções ao utilizar uma objetiva de zoom”.

Tópico relacionado

Precauções ao instalar/remover uma objetiva

Verificar os interruptores da objetiva

Precauções ao utilizar uma objetiva de zoom

Instalar uma objetiva

5-041-957-53(1) Copyright 2022 Sony Corporation

B: saliência (4,5 mm a 5,5 mm)

Não utilize parafusos de tripé para fixar o aparelho num local alto.

Nota

Selecione um tripé que não cairá mesmo quando a objetiva roda.
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Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Fixar na vertical num local alto e fixo

Este tópico descreve o procedimento para fixar o aparelho na vertical num local alto utilizando o suporte de teto (CIB-
PCM1 (opção)).

Para fixar o aparelho num local alto, consulte um contratante profissional.
Ao fixar num local elevado, certifique-se de que a superfície de fixação e o material de fixação (exceto os acessórios)
aguentam 200 kg ou mais e fixe o aparelho conforme o descrito neste Guia de ajuda. Se a fixação não for
suficientemente robusta, o aparelho poderá cair e causar ferimentos graves.
Prenda o cabo de aço de prevenção de quedas fornecido ao suporte de teto CIB-PCM1 (opcional), para evitar a
queda do aparelho.
Quando o aparelho é fixado num local alto, inspecione por folgas na fixação todos os anos. Encurte o intervalo de
inspeção de acordo com as condições de utilização.

Nota de instalação
Para proteger a objetiva e o bloco de conectores da objetiva do aparelho, mantenha a proteção e a tampa da
objetiva até instalar a objetiva.
Para evitar a falha da objetiva, não segure pela objetiva durante o funcionamento.
Para evitar a falha do aparelho, não segure pela cabeça da câmara durante o funcionamento.

Verifique os acessórios de fixação num local alto e o espaço de fixação.

Kit do suporte de teto CIB-PCM1 (opção)
Antes de iniciar, certifique-se de que dispõe das seguintes peças.

Suporte de corpo (1)
Suporte de teto (1)
Tampa de botão de libertação da objetiva (1)
Cabo de aço de prevenção de quedas (1)
Parafusos +PSW M3×8 (9)
Parafuso +PSW M4×8 em aço inoxidável para cabo de aço de prevenção de quedas (1)

1
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Nota

O cabo de aço de prevenção de quedas foi criado para fixar o aparelho quando suspenso. Não aplique qualquer carga
além da carga do aparelho.

Espaço de fixação
Consulte a imagem seguinte ao determinar o local e sentido de fixação, tendo em consideração o espaço
necessário para rodar a objetiva e os cabos na parte traseira do aparelho.

A: amplitude de movimento da cabeça da câmara (por exemplo, SEL70200GM2 (com SEL20TC ligado): Ø370)
B: suporte de teto (orifício na lateral da superfície de fixação (Ø150))
C: orifício de alinhamento da fixação

Nota

Fixe num local estável que não esteja sujeito a vibrações. Os locais sujeitos a vibrações poderão causar vibrações na
imagem.

Se o aparelho tiver de ser fixado numa superfície inclinada, mantenha-o a ±15° da horizontal e tome medidas para evitar a
queda do aparelho.

Deslize a alavanca de bloqueio de deslocamento/inclinação para a posição LOCK para bloquear o
deslocamento/inclinação da cabeça da câmara.

2
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Nota

Se o deslocamento/inclinação da cabeça da câmara não bloquear quando a alavanca de bloqueio se encontra na posição
LOCK, mova a cabeça da câmara até bloquear na posição.

Instale o suporte de corpo na parte inferior do aparelho utilizando os seis parafusos (M3×8) fornecidos.3
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Utilize os parafusos fornecidos. A utilização de parafusos que não os parafusos fornecidos poderá danificar o
interior do aparelho.

Instale o cabo de aço de prevenção de quedas no suporte de corpo.4
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A: cabo de aço fornecido　
B: parafuso Phillips (M4×8) fornecido
C: aro metálico do cabo de aço

Utilize o parafuso fornecido. A utilização de um parafuso que não o parafuso fornecido poderá reduzir a eficiência
da função do cabo de aço.

Instale o suporte de teto na superfície, tal como um prateleira, onde o aparelho será instalado.5

71



A: parede　
B: marca △ (direção de avanço da câmara)
C: orifício para cabos de ligação
D: prateleira ou outra superfície de fixação

Instale o cabo de aço de prevenção de quedas próximo da superfície de fixação.

Use um parafuso de sextavado interior M5 (3/16 de polegada) (opcional) e prenda-o a um objeto próximo da
prateleira ou superfície na qual o suporte de teto está instalado.

6
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A: cabo de aço　
B: parafuso de sextavado interior (M5, 3/16 polegadas)

Alinhe o orifício para parafuso 〇 na parte frontal do suporte de corpo com o orifício ◇ do suporte de teto,
insira o aparelho e fixe temporariamente o suporte de corpo no suporte de teto rodando o aparelho para a
direita.

7
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A: orifício 〇
B: orifício ◇

Instale o suporte de corpo e o suporte de teto utilizando os três parafusos (M3×8) de bloqueio da rotação
fornecidos.

8
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De seguida, instale a objetiva. Consulte “Instalar uma objetiva”, tendo em conta a informação em “Precauções ao
instalar/remover uma objetiva”, “Verificar os interruptores da objetiva” e “Precauções ao utilizar uma objetiva de zoom”.

Nota

Após instalar uma objetiva, certifique-se de que a objetiva está bem instalada.
A objetiva não tem qualquer proteção contra quedas. A Sony não é responsável pela queda de uma objetiva a partir do aparelho.

Tópico relacionado

Precauções ao instalar/remover uma objetiva

Verificar os interruptores da objetiva

Precauções ao utilizar uma objetiva de zoom

Instalar uma objetiva

Verifique o estado da fixação.

Especificamente, verifique os itens seguintes. 

Parafusos de fixação corretamente instalados.
Cabo de aço de prevenção de quedas corretamente instalado e não torcido.
Aparelho fixado nivelado (sem inclinação nem oscilações).
Aparelho não roda livremente quando rodado.

9
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Fixação num teto

Este tópico descreve o procedimento para fixar o aparelho num teto utilizando o suporte de teto (CIB-PCM1 (opção)).

Para fixar o aparelho num teto, consulte um contratante profissional.
Ao fixar num teto, certifique-se de que a superfície de fixação e o material de fixação (exceto os acessórios)
aguentam 200 kg ou mais e instale o aparelho, conforme o descrito neste Guia de ajuda. Se a fixação não for
suficientemente robusta, o aparelho poderá cair e causar ferimentos graves.
Prenda o cabo de aço de prevenção de quedas fornecido ao suporte de teto CIB-PCM1 (opcional), para evitar a
queda do aparelho.
Quando o aparelho é fixado num teto, inspecione por folgas na fixação todos os anos. Encurte o intervalo de
inspeção de acordo com as condições de utilização.

Nota de instalação
Para proteger a objetiva e o bloco de conectores da objetiva do aparelho, mantenha a proteção e a tampa da
objetiva até instalar a objetiva.
Para evitar a falha da objetiva, não segure pela objetiva durante o funcionamento.
Para evitar a falha do aparelho, não segure pela cabeça da câmara durante o funcionamento.

Verifique os acessórios de fixação no teto e o espaço de instalação.

Kit do suporte de teto CIB-PCM1 (opção)
Antes de iniciar, certifique-se de que dispõe das seguintes peças.

Suporte de corpo (1)
Suporte de teto (1)
Tampa de botão de libertação da objetiva (1)
Cabo de aço de prevenção de quedas (1)
Parafusos +PSW M3×8 (9)
Parafuso +PSW M4×8 em aço inoxidável para cabo de aço de prevenção de quedas (1)

1
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Nota

O cabo de aço de prevenção de quedas foi criado para fixar o aparelho quando suspenso. Não aplique qualquer carga
além da carga do aparelho.

Espaço de fixação
Consulte a imagem seguinte ao determinar o local e sentido de fixação, tendo em consideração o espaço
necessário para rodar a objetiva e os cabos na parte traseira do aparelho.

A: amplitude de movimento da cabeça da câmara (por exemplo, SEL70200GM2 (com SEL20TC ligado): Ø370)
B: suporte de teto (orifício na lateral do teto (Ø150))
C: orifício de alinhamento da fixação

Nota

Fixe num teto com resistência suficiente (como betão).

Para fixar o aparelho num teto com resistência insuficiente, forneça reforço suficiente.

Fixe num local estável que não esteja sujeito a vibrações. Os locais sujeitos a vibrações poderão causar vibrações na
imagem.

Se o aparelho tiver de ser fixado numa superfície inclinada, mantenha-o a ±15° da horizontal e tome medidas para evitar a
queda do aparelho.

O lado oposto ao orifício △ no suporte de teto é a direção de filmagem (lado frontal da câmara).

Deslize a alavanca de bloqueio de deslocamento/inclinação para a posição UNLOCK para desbloquear o
deslocamento/inclinação e rode a cabeça da câmara 180° na direção de inclinação.

2

Deslize a alavanca de bloqueio de deslocamento/inclinação para a posição LOCK para bloquear o
deslocamento/inclinação da cabeça da câmara.

3
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Cabeça da câmara rodada em 180°

Nota

Se o deslocamento/inclinação da cabeça da câmara não bloquear quando a alavanca de bloqueio se encontra na posição
LOCK, mova a cabeça da câmara até bloquear na posição.

Instale o suporte de corpo na parte inferior do aparelho utilizando os seis parafusos (M3×8) fornecidos.4
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Utilize os parafusos fornecidos. A utilização de parafusos que não os parafusos fornecidos poderá danificar o
interior do aparelho.

Instale o suporte de teto numa placa de fixação (opção) e, de seguida, instale a placa no teto.5
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A: suporte de teto
B: teto
C: placa de fixação
D: orifício △
Instale o suporte, de acordo com a orientação do suporte de teto
Atente que quando fixado num teto, a parte frontal da câmara encontra-se no lado oposto do suporte de teto em
comparação com uma fixação na vertical normal. Fixe corretamente consultando o diagrama que indica a direção
de fixação.

A: parte frontal para fixação vertical (orientação do orifício △)
B: parte frontal para fixação no teto

Nota

O material da superfície de fixação é da responsabilidade do cliente.

Instale o cabo de aço de prevenção de quedas no teto.6
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A: suporte de teto
B: parafuso de sextavado interior (M5, 3/16 polegadas)
C: cabo de aço (fornecido)
D: placa de fixação
E: teto

Puxe o cabo de aço de prevenção de quedas através do orifício no centro do suporte de teto e instale-o no
suporte de corpo.

Passe o cabo de aço de prevenção de quedas através do aro metálico do cabo de aço do suporte de corpo e
instale-o corretamente no suporte utilizando o parafuso (M4×8) em aço inoxidável fornecido.

A: cabo de aço fornecido
B: parafuso Phillips (M4×8) fornecido
C: aro metálico do cabo de aço

7
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Utilize o parafuso fornecido. A utilização de um parafuso que não o parafuso fornecido poderá reduzir a eficiência
da função do cabo de aço.

Nota

É aconselhável que uma pessoa segure no aparelho, conforme mostrado no diagrama seguinte enquanto outra pessoa fixa
o aparelho.

Não segure na cabeça da câmara ou na objetiva durante a montagem do aparelho. Se o aparelho tombar ou cair, existe o
risco de danos ou ferimentos.

Ao realizar as ligações elétricas, tenha cuidado para os conectores e cabos não ficarem em curto-circuito devido ao cabo
de aço de prevenção de quedas.

O suporte pode aguentar uma massa suspensa até 8,8 kg (incluindo a objetiva). Para evitar a queda do aparelho, não
exceda a capacidade de carga máxima.

Alinhe o orifício para parafuso (A) no suporte de corpo com o orifício ◇ (B) no suporte de teto, insira o
aparelho e rode-o cerca de 60 graus para a direita até o orifício para parafuso (A) e o orifício para parafuso
(C) estarem alinhados.

8
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A: orifício para parafuso no suporte de corpo
B: orifício para parafuso no suporte de teto (orifício ◇)
C: orifício para parafuso
D: teto
E: placa de fixação

Instale o suporte de corpo e o suporte de teto utilizando os três parafusos (M3×8) de bloqueio da rotação
fornecidos.

9
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De seguida, instale a objetiva. Consulte “Instalar uma objetiva”, tendo em conta a informação em “Precauções ao
instalar/remover uma objetiva”, “Verificar os interruptores da objetiva” e “Precauções ao utilizar uma objetiva de zoom”.

Nota

Para utilizar corretamente o deslocamento/inclinação quando o aparelho está fixado num teto, defina [Pan-Tilt] > [Direction] >
[Ceiling] para [On] no menu web.

Após instalar uma objetiva, certifique-se de que a objetiva está bem instalada.
A objetiva não tem qualquer proteção contra quedas. A Sony não é responsável pela queda de uma objetiva a partir do aparelho.

Tópico relacionado

Precauções ao instalar/remover uma objetiva

Verificar os interruptores da objetiva

Verifique o estado da fixação.

Especificamente, verifique os itens seguintes.

Parafusos de fixação corretamente instalados.
Cabo de aço de prevenção de quedas corretamente instalado e não torcido.
Aparelho fixado nivelado (sem inclinação nem oscilações).
Aparelho não roda livremente quando rodado.

10
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Precauções ao utilizar uma objetiva de zoom

Instalar uma objetiva

5-041-957-53(1) Copyright 2022 Sony Corporation
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Precauções ao instalar/remover uma objetiva

Não deixe a objetiva virada para o sol. A luz solar direta pode atravessar a objetiva, estar focada no aparelho e poderá
causar um incêndio.

Nota

Instale/remova uma objetiva com o aparelho desligado.

Uma objetiva é um componente de precisão. Não coloque a objetiva numa superfície com o encaixe da objetiva virado para
baixo. Instale a tampa do encaixe de objetiva fornecida.

Sugestão

Para mais informações sobre as objetivas suportadas pelo aparelho, contacte o seu representante de assistência Sony.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Verificar os interruptores da objetiva

As verificações e definições seguintes são necessárias, dependendo do tipo de objetiva.

Para uma objetiva com um interruptor de modo de focagem

Coloque o interruptor em AF/MF ou AF.
Se o interruptor estiver na posição MF ou Full MF, a focagem só pode ser ajustada através do anel da objetiva.

Nota

Ao utilizar uma objetiva com encaixe A, o ajuste manual de uma unidade de controlo remoto poderá não estar disponível.

Para uma objetiva com um interruptor de zoom

Coloque o interruptor na posição SERVO.
Quando o interruptor está na posição MANUAL, o zoom só pode ser ajustado através do anel de zoom. O controlo do
zoom a partir do aparelho não tem efeito.

Para uma objetiva com um interruptor Auto Iris

Coloque o interruptor na posição AUTO.
Quando não está na posição AUTO, a íris só pode ser ajustada utilizando o anel da objetiva. O funcionamento da íris a
partir do aparelho não tem efeito.

Para uma objetiva com um interruptor de estabilização de imagem

Coloque o interruptor na posição OFF.
Se o interruptor estiver na posição ON, poderá ocorrer um comportamento inesperado durante a operação de
deslocamento/inclinação.

SELP28135G

A: mova o anel de focagem para a posição para a frente (modo AF/MF).
B: coloque o interruptor ZOOM na posição SERVO.
C: coloque o anel de íris na posição “A” e o interruptor IRIS LOCK na posição LOCK.
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D: coloque o interruptor do estabilizador de imagem na posição OFF.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Precauções ao utilizar uma objetiva de zoom

Ao utilizar uma objetiva de zoom que não uma objetiva de zoom motorizado, a posição de zoom poderá mudar
consoante o ambiente de fixação. Fixe o anel de zoom em posição utilizando a fita de acordo com a finalidade de
utilização.

Fita de película plástica: 471 BLA 50 ou equivalente

5-041-957-53(1) Copyright 2022 Sony Corporation
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Instalar uma objetiva

Este tópico descreve como instalar uma objetiva com encaixe E ou objetiva com encaixe A.

Nota

Não transporte o aparelho com a objetiva ainda colocada.

Ao utilizar uma objetiva com encaixe A, a íris é definida manualmente e a focagem é definida para MF.

Deslize a alavanca de bloqueio de deslocamento/inclinação para a posição LOCK para bloquear o
deslocamento/inclinação da cabeça da câmara.

Nota

Se o deslocamento/inclinação da cabeça da câmara não bloquear quando a alavanca de bloqueio se encontra na posição
LOCK, mova a cabeça da câmara até bloquear na posição.

1

Rode a alavanca de aperto para o parafuso de instalação da base de apoio da objetiva para a esquerda para
desapertar o bloqueio, de seguida, mova o parafuso de instalação da base de apoio da objetiva para uma
posição que não interfira com a objetiva.

2
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A: correto
B: incorreto

Rode a alavanca de bloqueio da cabeça da câmara no sentido da seta para desbloquear a cabeça da
câmara.

Nota

Até a cabeça da câmara ser novamente bloqueada, existe um risco da cabeça da câmara poder mover-se devido ao seu
próprio peso. Apoie a cabeça da câmara com a mão enquanto efetua a tarefa.

3

Deslize a cabeça da câmara para a posição mais avançada.4
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Rode a alavanca de bloqueio da cabeça da câmara no sentido da seta para bloquear a cabeça da câmara.

Nota

Certifique-se de que a alavanca de bloqueio da cabeça da câmara não entra em contacto com outras peças para evitar
interferir com a operação de inclinação.

5

Remova a proteção e a tampa da o aparelho e da objetiva.6

Alinhe a marca de encaixe da objetiva (branca) com o aparelho, insira cuidadosamente a objetiva na cabeça
da câmara e, em seguida, rode a objetiva para a direita até ouvir um estalido de encaixe.

A: marcas de encaixe (brancas)

Nota

Para utilizar uma objetiva com encaixe A, instale um adaptador para encaixe de objetiva (opção) no aparelho e, de
seguida, instale a objetiva com encaixe A.

7

Rode a alavanca de bloqueio da cabeça da câmara no sentido da seta para desbloquear a cabeça da
câmara.

8
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Nota

Até a cabeça da câmara ser novamente bloqueada, existe um risco da cabeça da câmara poder mover-se devido ao seu
próprio peso. Apoie a cabeça da câmara com a mão enquanto efetua a tarefa.

Mantenha o equilíbrio para a frente/para trás da cabeça da câmara para que a base deslizante seja
horizontal.

Se estiver a utilizar uma das seguintes objetivas, pode equilibrar aproximadamente o aparelho e a objetiva
consultando a escala na base deslizante.

9

Posição da escala Nome da objetiva

0,5 SEL70200GM (com SEL20TC instalada)

1,7 SEL70200GM

2,0 SEL70200GM2 (com SEL20TC instalada)

3,0 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G

4,3 SEL70200G

94



Nota

Utilize a escala da base deslizante como uma referência para um equilíbrio aproximado.

Ao instalar a objetiva, efetue ajustes adequados no equilíbrio para que o aparelho não incline para trás e para a frente.

Ajuste o equilíbrio numa superfície horizontal.

Remova a unidade de apoio da objetiva ao utilizar o SELC1635G.

Posição da escala Nome da objetiva

5,0 ou superior SEL1224GM, SEL1635GM, SELP1635G, SELP18105G, SELP1020G

Rode a alavanca de bloqueio da cabeça da câmara no sentido da seta para bloquear a cabeça da câmara.

Nota

Certifique-se de que a alavanca de bloqueio da cabeça da câmara não entra em contacto com outras peças para evitar
interferir com a operação de inclinação.
Método de confirmação: deslize o bloqueio de deslocamento/inclinação para a posição UNLOCK, rode manualmente o
bloco da câmara de forma a estar virado para cima e confirme visualmente que não está em contacto com outras peças.
Se houver contacto, rode novamente a alavanca de bloqueio da cabeça da câmara no sentido da seta.

10

Rode as alavancas de aperto do apoio da objetiva para a esquerda para desapertar a unidade de apoio da
objetiva.

11
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A: alavanca de aperto do apoio da objetiva (2 pontos)
B: unidade de apoio da objetiva

Mova a unidade de apoio da objetiva para que a base de apoio da objetiva esteja alinhada com o parafuso
de instalação da base de apoio da objetiva, de seguida, rode o parafuso para a direita para fixar a base de
apoio.

Nota

Certifique-se de que a base de apoio da objetiva está perpendicular ao parafuso de instalação da base de apoio da
objetiva e, de seguida, aperte.

12

Rode a alavanca de aperto para o parafuso de instalação da base de apoio da objetiva para a direita para
bloquear o parafuso de instalação da base de apoio da objetiva.

A: parafuso de instalação da base de apoio da objetiva
B: orifício para parafuso de instalação
C: alavanca de aperto do parafuso de instalação da base de apoio da objetiva

Sugestão

Se uma alavanca de aperto se encontrar numa posição que torna difícil rodar, solte a alavanca de aperto e rode-a para um
ângulo que tornará a operação mais simples. Quando se encontrar na posição pretendida, feche a alavanca de aperto.

13
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Tópico relacionado
Calibrar uma objetiva com encaixe E

5-041-957-53(1) Copyright 2022 Sony Corporation

A: alavanca de aperto do parafuso de instalação da base de apoio da objetiva
B: alavanca de aperto do apoio da objetiva

Rode as duas alavancas de aperto do apoio da objetiva para a direita, para fixar a unidade de apoio da
objetiva.

14

Certifique-se de que ambas as alavancas estão apertadas e não soltas, a objetiva está instalada
corretamente e de que os interruptores da objetiva estão na posição certa.

Se uma alavanca estiver solta ou se a objetiva não estiver corretamente instalada, esta poderá cair e danificar-
se.
Ao utilizar uma objetiva de zoom motorizado com encaixe E, a objetiva também tem de ser calibrada em
separado para repor com exatidão as posições de zoom memorizadas na câmara como posições predefinidas.
Para mais informações, consulte “Calibrar uma objetiva com encaixe E.”

15

97



Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Remover uma objetiva

Remova uma objetiva utilizando o procedimento inverso de instalação da objetiva.

Nota

Segure bem na objetiva com a mão para evitar que caia.

Se outra objetiva não for imediatamente instalada, instale sempre a tampa do corpo.

Tópico relacionado

Instalar uma objetiva

5-041-957-53(1) Copyright 2022 Sony Corporation

Certifique-se de que o deslocamento/inclinação está bloqueado.1

Rode a alavanca de aperto para o parafuso de instalação da base de apoio da objetiva para a esquerda para
anular o bloqueio.

2

Remova o parafuso de instalação da base de apoio da objetiva na unidade de apoio da objetiva e mova-o
para uma posição que não interfira com a objetiva.

3

Desbloqueie a cabeça da câmara e deslize a cabeça da câmara para a posição mais avançada.

Para mais informações, consulte os passos 3 a 5 em “Instalar uma objetiva”.

4

Prima continuamente o botão de libertação da objetiva e rode a objetiva para a esquerda enquanto segura
na objetiva.

5

Com as marcas de encaixe (brancas) da câmara e a objetiva alinhadas, puxe a objetiva para a frente.6
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Cabos de ligação

Este tópico descreve as ligações dos cabos.

5-041-957-53(1) Copyright 2022 Sony Corporation

Ligue os cabos necessários aos conectores no painel traseiro.

Para evitar que o cabo HDMI seja removido, remova o parafuso de fixação da placa de fixação do cabo HDMI
(M2,6×6, preto) do bloco de conectores e instale a placa de fixação do cabo HDMI utilizando o parafuso de fixação.
Fixe o cabo HDMI à placa de fixação do cabo HDMI utilizando uma abraçadeira ou banda disponível
comercialmente.

A: parafuso de fixação da placa de fixação do cabo HDMI (M2,6×6, preto)
B: abraçadeira ou banda disponível comercialmente
A: placa de fixação do cabo HDMI (fornecida)

1

99



Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ligar a unidade a um dispositivo de rede através de ligação por cabo

Este tópico descreve a ligação do aparelho a um dispositivo de rede através de ligação por cabo.

5-041-957-53(1) Copyright 2022 Sony Corporation

Ligue o aparelho a um dispositivo de rede (como um ponto de acesso Wi-Fi ou concentrador de
comutação) utilizando um cabo LAN de categoria 5e ou superior.

1
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Usar alimentação AC

Este tópico descreve o procedimento para alimentar o aparelho através de alimentação AC.

Deslize a alavanca de bloqueio de deslocamento/inclinação para a posição LOCK para bloquear o
deslocamento/inclinação da cabeça da câmara.

1

Ligue o adaptador AC (fornecido) ao conector DC IN no aparelho e ligue o cabo de alimentação (fornecido)
a uma fonte de alimentação AC.

A: conector DC IN
B: cabo de alimentação
C: adaptador AC

2

Fixe o cabo do adaptador AC utilizando o fixador de cabo se pretender evitar que o cabo se desligue.

Desbloqueie o fixador de cabo, passe o cabo através do fixador, conforme mostrado abaixo e bloqueie o fixador.

3
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Nota

Não utilize um adaptador AC ou cabo de alimentação que não aqueles fornecidos com o aparelho. Ligar outro adaptador ou cabo
de alimentação poderá causar um incêndio ou avaria.

Não ligue nem utilize um adaptador AC num espaço confinado, tal como entre uma parede e mobília.

Não coloque as peças metálicas da ficha do adaptador AC em curto-circuito. Caso contrário, poderá causar uma avaria.

Ligue o adaptador AC à fonte de alimentação AC mais próxima. Se ocorrer um problema durante o funcionamento, desligue
imediatamente o cabo de alimentação da fonte de alimentação AC.

A: fixador de cabo
B: bloqueio do fixador de cabo
C: cabo do adaptador AC

Certifique-se de que a luz POWER na parte frontal do aparelho muda de verde intermitente para verde fixo e
de que o arranque está concluído.

Quando o aparelho tiver iniciado normalmente e estiver ligado à rede, a luz NETWORK acender-se-á a verde.

Ao utilizar uma objetiva não compatível com a operação de deslocamento/inclinação, bloqueie a alavanca de
bloqueio de deslocamento/inclinação e ignore os passos seguintes. Para mais informações sobre as objetivas
compatíveis com deslocamento/inclinação, contacte o seu representante de assistência Sony.

4

Deslize a alavanca de bloqueio de deslocamento/inclinação para a posição UNLOCK para desbloquear o
deslocamento/inclinação da cabeça da câmara.

5

Repõe o deslocamento/inclinação.

Para mais informações, consulte “Repor o deslocamento/inclinação”.

6
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Ao desligar o adaptador AC da unidade, segure a ficha e puxe-a a direito. Puxar pelo cabo poderá causar uma avaria.

Tópico relacionado
Repor o deslocamento/inclinação

5-041-957-53(1) Copyright 2022 Sony Corporation
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Utilizar alimentação PoE++

Quando o aparelho estiver ligado a um dispositivo de alimentação compatível com PoE++, a alimentação é fornecida ao
aparelho através de um cabo de rede disponível comercialmente.
Este método permite fornecer alimentação ao aparelho sem a necessidade de cabos da fonte de alimentação em
ambientes onde não exista uma tomada de alimentação perto da localização de fixação.

Deslize a alavanca de bloqueio de deslocamento/inclinação para a posição LOCK para bloquear o
deslocamento/inclinação da cabeça da câmara.

1

Ligue o aparelho e um dispositivo de alimentação compatível com PoE++, usando um cabo de rede normal.

A: cabo de rede
B: dispositivo de alimentação compatível com PoE++

2

Certifique-se de que a luz POWER na parte frontal do aparelho muda de verde intermitente para verde fixo e
de que o arranque está concluído.

Quando o aparelho tiver iniciado normalmente e estiver ligado à rede, a luz NETWORK acender-se-á a verde.

Nota

3
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Nota

O aparelho está em conformidade com IEEE802.3bt Tipo 4 Classe 8. Para mais informações sobre dispositivos de alimentação
compatíveis com PoE++ verificados, contacte o seu representante de assistência Sony.

O aparelho é compatível com autenticação LLDP, mas poderá ser necessário configurar dispositivos de rede (em conformidade
com IEEE802.3bt).

Não ligue um adaptador AC ao utilizar alimentação PoE++ com a autenticação LLDP ativada.

Se um adaptador AC e o dispositivo de alimentação PoE++ forem ligados ao mesmo tempo, a alimentação é fornecida pelo
adaptador AC.

Ao fornecer alimentação através de PoE++, utilize um cabo de rede de categoria 5e ou superior.

Aguarde cerca de 10 segundos após ligar novamente o aparelho quando alimentado através de PoE++.

Ao utilizar a alimentação PoE++, ligue o terminal de terra à terra.

Ao ligar através da alimentação PoE++, não passe os cabos pelo exterior.

Tópico relacionado
Repor o deslocamento/inclinação

5-041-957-53(1) Copyright 2022 Sony Corporation

Quando a alimentação é fornecido por PoE++, a autenticação inicial é efetuada durante o intervalo até o arranque estar
concluído.

Ao utilizar uma objetiva não compatível com a operação de deslocamento/inclinação, bloqueie a alavanca de bloqueio de
deslocamento/inclinação e ignore os passos seguintes. Para mais informações sobre as objetivas compatíveis com
deslocamento/inclinação, contacte o seu representante de assistência Sony.

Deslize a alavanca de bloqueio de deslocamento/inclinação para a posição UNLOCK para desbloquear o
deslocamento/inclinação da cabeça da câmara.

4

Repõe o deslocamento/inclinação.

Para mais informações, consulte “Repor o deslocamento/inclinação”.

5
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Repor o deslocamento/inclinação

Pode repor o deslocamento/inclinação, por exemplo, quando substitui a objetiva através do procedimento seguinte.

5-041-957-53(1) Copyright 2022 Sony Corporation

Deslize a alavanca de bloqueio do deslocamento/inclinação para a posição UNLOCK e certifique-se de que
o deslocamento/inclinação da cabeça da câmara está desbloqueado.

1

Execute a função de reposição do deslocamento/inclinação.

A reposição do deslocamento/inclinação pode ser executada a partir do controlo remoto de infravermelhos, Web
App ou controlo remoto RM-IP500 (opção).

Operação utilizando o controlo remoto de infravermelhos: prima o botão P/T RESET.
Operação utilizando a Web App: prima o botão  (Reposição do deslocamento/inclinação) no separador

 (Others) no painel de controlo da câmara no ecrã de operações em gravação.
Operação utilizando o RM-IP500: consulte o manual de instruções para o RM-IP500.

Nota

Executar a reposição do deslocamento/inclinação causa a rotação da cabeça da câmara e da objetiva. Certifique-se de
que a objetiva não está obstruída antes da execução.

O aparelho tem uma função que limita a amplitude de deslocamento/inclinação, mas esta função é desativada quando o
aparelho é ligado ou quando o deslocamento/inclinação é executado.

Sugestão

Quando a reposição do deslocamento/inclinação está concluída, o aparelho regressa à posição de pré-execução.

2
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Aceder à Web App a partir de um browser da web

Ao ligar o aparelho a um tablet ou computador, pode controlar e configurar o aparelho a partir de um browser da web.

Verifique se o tablet ou computador é compatível com as operações da Web App.

Nota

Se o ambiente exigido não for conseguido, ou dependendo da utilização do tablet/computador, a apresentação de vídeos
num navegador de internet poderá ser afetada de forma adversa.

A Web App deste aparelho utiliza JavaScript. Se utilizar software antivírus no tablet/computador, a página da web poderá
não ser apresentada corretamente.

1

Item Requisito

Apresentação
Recomendado 1080×810 píxeis ou superior
Tamanho do ecrã do tablet: recomendado 10
polegadas ou mais

Sistema operativo e browser da
web compatíveis

Windows

OS Windows 10 ou posterior

Browser da
web

Google Chrome

Mac

OS macOS 10.15 ou posterior

Browser da
web

Google Chrome
Safari

iPad

OS iPadOS 15 ou posterior

Browser da
web

Google Chrome
Safari

Android

OS Android 12 ou posterior

Browser da
web

Google Chrome

Certifique-se de que o aparelho, tablet ou computador e os dispositivos periféricos estão ligados.2

Certifique-se de que o aparelho e o tablet ou computador estão ligados por Wi-Fi ou ligação de área local
LAN por cabo.

3

Ligue ao aparelho a partir do navegador de internet do tablet ou computador.

Ligar usando um código QR
Leia o código QR impresso na tampa lateral do compartimento multimédia do aparelho, usando a câmara do tablet.

4
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Nota

Se o número da porta HTTP mudar do valor 80, insira “http://endereço IP do aparelho:número da porta” na barra de endereço.

Ao estabelecer ligação usando um código QR ou inserindo o URL na barra de endereço de um navegador de internet, use um
dispositivo compatível com mDNS*.

Sugestão

Consequentemente, pode aceder rapidamente ao aparelho utilizando a função de marcador do navegador de internet.

5-041-957-53(1) Copyright 2022 Sony Corporation

Abra a hiperligação apresentada no tablet.
O navegador de internet do tablet abre-se e apresenta o ecrã da Web App do aparelho.

Ligação através da introdução de um URL na barra de endereço de um navegador de internet.
Abra um navegador de internet no tablet ou computador e introduza o URL impresso na tampa lateral do
compartimento multimédia do aparelho.
O navegador de internet deve apresentar o ecrã da Web App do aparelho.

Ligação através da introdução do endereço IP na barra de endereço de um navegador de internet
Abra um navegador de internet no tablet ou computador e insira “http://endereço IP do aparelho” na barra de
endereço.
O navegador de internet deve apresentar o ecrã da Web App do aparelho.

mDNS: um protocolo de comunicação utilizado para determinar o endereço IP de um nome de anfitrião numa rede local.*
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Inicializar o aparelho

Certifique-se de que configura o aparelho através do procedimento seguinte ao utilizá-lo pela primeira vez.

Sugestão

Se a bateria de reserva ficar completamente descarregada, terá de configurar novamente a configuração inicial.

Ligue o aparelho a partir de um tablet ou computador e abra a Web App.

Quando o aparelho for utilizado pela primeira vez, ser-lhe-á solicitado que insira um nome de utilizador e palavra-
passe no navegador de internet. Insira as definições seguintes.

Nome de utilizador: admin
Palavra-passe: (deixe em branco)

Siga as instruções no ecrã para configurar a configuração inicial.

1

Insira o nome de utilizador e a palavra-passe de administrador (Administrator) e, em seguida, prima o botão
[OK].

1: insira o nome de utilizador do administrador.
2: defina a palavra-passe do administrador.
3: insira novamente a mesma palavra-passe para confirmação.

Nota

Os caracteres seguintes podem ser utilizados no nome de utilizador e palavra-passe. A palavra-passe deve conter, pelo
menos, uma letra maiúscula, uma letra minúscula e um algarismo, e deve ter entre 8 e 64 carateres.

Caracteres alfanuméricos

2
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Aparece o ecrã para as operações de filmagem. Continue para configurar o funcionamento básico do aparelho de
acordo com o modo de funcionamento.

Sugestão

Em alguns casos, como quando utiliza o aparelho com um tablet como um par, poderá ser mais fácil utilizar um endereço IP fixo
para o aparelho.

Símbolos (!$%`*+-./<=>?@[]^_{|}~)

O browser da web recarregará e ser-lhe-á solicitado que insira o nome de utilizador e a palavra-passe.

Insira o nome de utilizador e a palavra-passe configurados no passo 2.

Aparece o ecrã de configuração do idioma e do relógio.

3

Especifique os seguintes itens e prima o botão [OK].

[Language]
Selecione o idioma a utilizar na Web App e para a apresentação do ecrã da câmara. A alteração do idioma alterará
o idioma da apresentação da Web App.
[Date & Time Format]
Selecione o formato de apresentação da data e hora a partir das opções seguintes.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
“yyyy” indica o ano, “mm” indica o mês, “dd” indica o dia, “hh” indica a hora, “mm” indica o minuto e “ss” indica o
segundo, respetivamente.
[12 h/24 h]
Selecione [12 h] (formato de 12 horas) ou [24 h] (formato de 24 horas) para a apresentação da hora.
[Time Setting]
Selecione o método para definir a data/hora.
[Synchronize with PC]: sincronize com a data/hora do computador ou tablet.
[Manual setting]: defina manualmente. Quando este método é selecionado, aparecem os campos para inserir a
data e hora.
[Time Zone]
Selecione o fuso horário.

4
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Para definir um endereço IP fixo, primeiro desative [Network] > [Wired LAN] > [IPv4] > [DHCP] (interruptor deslizante na posição
esquerda) no menu web.

São apresentados os itens de configuração relacionados com um endereço IP fixo. Configure os itens e, em seguida, prima o
botão [OK] no ecrã.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Configurar o funcionamento básico

Este tópico descreve como configurar o aparelho para as operações básicas.

Definir o modo de filmagem

Pode selecionar o modo de filmagem do aparelho para corresponder ao fluxo de trabalho.

Modo Custom: crie imagens de forma flexível durante a filmagem.
Modos de filmagem em Log: grava conteúdo S-Log.

Modo Flexible ISO: as definições de exposição são definidas por ajustes do valor ISO que correspondem à cena
que está a ser filmada.
Modo Cine EI/Modo Cine EI Quick: utilize o aparelho de forma semelhante a uma câmara de vídeo (não criando
totalmente imagens ao filmar), com as gravações reveladas na pós-produção.

No modo Cine EI Quick, é automaticamente selecionada uma sensibilidade de base adequada à definição do índice de
exposição.
Mude o modo de gravação, usando [Project] > [Base Setting] > [Shooting Mode] no menu web ou no menu da câmara.

Modo Custom
Pode selecionar o padrão do vídeo.
Mude, usando [Project] > [Base Setting] > [Target Display] no menu web ou no menu da câmara.

[SDR(BT.709)]: filmagem de acordo com a norma de transmissão HD
[HDR(HLG)]: filmagem de acordo com a norma de transmissão 4K de próxima geração

Para mais pormenores, consulte “Visão geral de aspeto” e outros tópicos, em “Filmar com o aspeto pretendido”.

Modos de filmagem em Log Modo
(Flexible ISO/Modo Cine EI/Modo Cine EI Quick)
Nos modos de filmagem em Log, selecione a gama de cores base para sinais gravados e sinais de saída. A gama de
cores selecionada aqui é a gama de cores da saída de vídeo, quando as definições de [LUT On/Off] são definidas para
[MLUT Off].
Pode alterar a gama de cores, usando [Project] > [Cine EI/Flex.ISO Set] > [Color Gamut] no menu da câmara.

[S-Gamut3.Cine/SLog3]: gama de cores fácil de ajustar para cinema digital (DCI-P3).
[S-Gamut3/SLog3]: ampla gama de cores da Sony que abrange a gama de cores ITU-R BT.2020.

Para mais informações, consulte “Filmar com ajuste de aspeto na pós-produção”.
 
As funções suportadas em cada modo de filmagem são apresentadas na tabela seguinte.
●: suportado, –: não suportado

Custom Flexible ISO Cine EI Cine EI Quick

ISO/Gain ● ● – –

AGC ● ● – –

Base Sensitivity ● – – –
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Sugestão

No modo Cine EI Quick e modo Cine EI, a filmagem ocorre com uma sensibilidade ISO base sem usar o ganho para maximizar o
desempenho do sensor de imagem. A luminosidade é ajustada através de iluminação e do filtro ND para ajustar a quantidade de
luz que alcança o sensor de imagem.

Definir a frequência do sistema

Mude, usando [Project] > [Rec Format] > [Frequency] no menu web ou no menu da câmara. O aparelho poderá reiniciar
automaticamente após mudar, consoante o valor selecionado.

Nota

Não pode mudar a frequência do sistema durante a gravação ou reprodução.

Definir o modo de digitalização do sensor de imagem

Pode definir o tamanho da imagem real e a resolução do sensor de imagem.
Mude, usando [Project] > [Rec Format] > [Imager Scan Mode] no menu web ou no menu da câmara.
[FF]: tamanho completo.
[S35]: tamanho Super 35mm.

Nota

Não pode mudar o modo de digitalização do sensor de imagem durante a gravação ou reprodução.

Quando definido para S35, o formato de vídeo é limitado a 1920×1080.

Definir o codec

Pode definir o codec para gravação.
Mude, usando [Project] > [Rec Format] > [Codec] no menu web ou no menu da câmara.

Nota

Não pode mudar o codec durante a gravação ou reprodução.

Definir o formato de vídeo

Pode definir o formato de vídeo para a gravação e o formato de vídeo para a saída da câmara.

Custom Flexible ISO Cine EI Cine EI Quick

Base ISO – ● ● ● (associado a EI)

Exposure Index – – ● ●

Auto Shutter ● ● – –

ATW ● ● – –

LUT On/Off – ● ● ●

Scene File ● – – –

Paint/Look
(exceto Base Look)

● – – –

113



Mude o formato de vídeo para a gravação, usando [Project] > [Rec Format] > [Video Format] no menu web ou no
menu da câmara.
Mude o formato de saída dos conectores SDI OUT e HDMI OUT, usando [Monitoring] > [Output Format] no menu
web ou no menu da câmara.

Nota

Não pode mudar o formato de vídeo durante a gravação ou reprodução.

Poderão aplicar-se restrições ao sinal dos conectores SDI OUT e HDMI OUT, consoante a definição do formato de vídeo.

Tópico relacionado

Visão geral de aspeto

Filmar com ajuste de aspeto na pós-produção

5-041-957-53(1) Copyright 2022 Sony Corporation
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Cartões de memória compatíveis

O aparelho grava áudio e vídeo em cartões de memória CFexpress Type A (disponíveis em separado) ou cartões de
memória SDXC (disponíveis em separado) inseridos nas ranhuras para cartões. Os cartões de memória também são
utilizados para a gravação proxy.

Os cartões de memória CFexpress Type A

Utilize os cartões de memória CFexpress Type A* da Sony listados em “Suportes de gravação recomendados” no
aparelho.
Para mais informações sobre operações com suportes de outros fabricantes, consulte o manual de instruções do
suporte ou consulte as informações do fabricante.

Cartões de memória SDXC

Utilize os cartões de memória SDXC* listados em “Suportes de gravação recomendados” no aparelho.

Suportes de gravação recomendados

As condições de funcionamento garantidas vão variar consoante as definições Rec Format e Recording.

CFexpress Type A
Compatível com VPG400
Compatível com todos os formatos de gravação do aparelho.

SDXC
Compatível nas condições da tabela seguinte. “●” indica que a operação foi verificada e “–” indica que a operação não é
garantida.

RAW Out & XAVC-I, 4096×2160 Class 300, Normal mode

RAW Out & XAVC-I, 3840×2160 Class 300, Normal mode

Referidos como “cartões CFexpress” neste Guia de ajuda.*

Referidos como “cartões SD” neste Guia de ajuda.*

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●
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RAW Out & XAVC-I, 3840×2160 Class 300, S&Q (60 fps ou inferior)

RAW Out & XAVC-I, 3840×2160 Class 300, S&Q (100 fps, 120 fps)
Suportes verificados não disponíveis.

XAVC-I, 4096×2160 Class 300, Normal mode

XAVC-I, 4096×2160 Class 300, S&Q (60 fps ou inferior)

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●
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XAVC-I, 3840×2160 Class 300, Normal mode

XAVC-I, 3840×2160 Class 300, S&Q (60 fps ou inferior)

XAVC-I, 3840×2160 Class 300, S&Q (100 fps, 120 fps)
Suportes verificados não disponíveis.

XAVC-I, 1920×1080 Class 100, Normal mode

XAVC-I, 1920×1080 Class 100, S&Q (60 fps ou inferior)

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

24P – – – – – – ●

23.98P – – – – – – ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●
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XAVC-I, 1920×1080 Class 100, S&Q (100 fps, 120 fps)

XAVC-I, 1920×1080 Class 100, S&Q (150 fps, 180 fps)
Suportes verificados não disponíveis.

XAVC-I, 1920×1080 Class 100, S&Q (200 fps, 240 fps)
Suportes verificados não disponíveis.

XAVC-L, 3840×2160 420, Normal mode

XAVC-L, 3840×2160 420, S&Q (60 fps ou inferior)

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 3840×2160 420, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD50, Normal mode

XAVC-L, 1920×1080 HD50, S&Q (60 fps ou inferior)

XAVC-L, 1920×1080 HD50, S&Q (100 fps, 120 fps)

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – –

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 1920×1080 HD50, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD50, S&Q (200 fps, 240 fps)

XAVC-L, 1920×1080 HD35, Normal mode

XAVC-L, 1920×1080 HD35, S&Q (60 fps ou inferior)

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – ● ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P ● ● ● ● ● ● ●

25P ● ● ● ● ● ● ●

23.98P ● ● ● ● ● ● ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●
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XAVC-L, 1920×1080 HD35, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD35, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD35, S&Q (200 fps, 240 fps)

5-041-957-53(1) Copyright 2022 Sony Corporation

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – ● – ● ● ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – – – – ● ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Frequência do sistema Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Inserir cartões de memória

Este tópico descreve as precauções ao inserir cartões de memória.

Abra a tampa do suporte da secção da ranhura para cartões.1

Insira um cartão de memória.

Para cartões CFexpress, a etiqueta fica virada para cima.

Nota

Num aparelho montado no teto, a etiqueta fica virada para baixo.

Para cartões SD, a etiqueta fica virada para baixo.

Nota

Num aparelho montado no teto, a etiqueta fica virada para cima.

O indicador de acesso acende-se a vermelho, de seguida, muda para verde se o cartão for utilizável.

2
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Nota

O cartão de memória, a ranhura para cartões de memória e os dados de imagem no cartão de memória poderão ficar
danificados se o cartão for forçado na ranhura na orientação incorreta.

Ao gravar para suportes inseridos nas ranhuras A e B para cartões CFexpress Type A / SD, insira suportes em ambas as
ranhuras recomendadas para funcionamento com o formato da gravação.

5-041-957-53(1) Copyright 2022 Sony Corporation

Nota

Se o indicador de acesso piscar continuamente a vermelho e não mudar para verde, desligue temporariamente o aparelho
e remova e volte a inserir o cartão de memória.

Feche a tampa do suporte.3
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Ejetar um cartão de memória

Abra a tampa do suporte da secção da ranhura para cartões e prima ligeiramente o cartão de memória para ejetar o
cartão.

Nota

Se o aparelho for desligado ou se o cartão de memória for removido enquanto estiver a ser acedido, a integridade dos dados no
cartão não pode ser garantida. Todos os dados gravados no cartão poderão ser eliminados. Certifique-se sempre de que o
indicador de acesso está verde ou apagado antes de desligar o aparelho ou remover o cartão de memória.

Ao remover um cartão de memória imediatamente após a gravação estar concluída, o cartão de memória poderá estar quente,
mas isto não representa um problema.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Formatar (Inicializar) cartões de memória

Se for inserido um cartão de memória não formatado ou um cartão de memória formatado numa especificação diferente,
é apresentada a mensagem “Media Needs to be Formatted” no painel de imagem da câmara.
Formate o cartão utilizando o procedimento seguinte.

Nota

Formatar um cartão de memória apaga todos os dados, incluindo dados de vídeo gravados e ficheiros de configuração.

Poderão aparecer mensagens durante a execução consoante a duração do processo de formatação.

Se a formatação falhar
Os cartões de memória não suportados pelo aparelho não podem ser formatados.
É apresentada uma mensagem de aviso. Siga as instruções para substituir o cartão com um cartão de memória
suportado.

Para utilizar um cartão formatado no aparelho na ranhura de outro dispositivo
Primeiro, efetue uma cópia de segurança do cartão, de seguida, formate novamente o cartão dispositivo a utilizar.

5-041-957-53(1) Copyright 2022 Sony Corporation

Selecione [TC/Media] > [Format Media] no menu da câmara.1

Selecione Media(A) (ranhura A) ou Media(B) (ranhura B) e, em seguida, selecione o método de formatação
(Full Format ou Quick Format).

Aparece uma mensagem de confirmação.
[Full Format]: inicializa o suporte de gravação totalmente, incluindo a área dos dados e a informação de gestão
dos dados.
[Quick Format]: apenas inicializa a informação de gestão dos dados do suporte de gravação.

2

Selecione [Execute].

É apresentada uma mensagem durante a formatação e o indicador de acesso acende a vermelho.
Quando a formatação terminar, aparece uma mensagem de conclusão.

3
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Verificar o tempo de gravação restante

Durante a filmagem (gravação/espera), pode monitorizar a capacidade restante do cartão de memória em cada ranhura,
usando os indicadores de suporte restante das ranhuras A/B no painel de imagem da câmara.
O tempo de gravação restante é calculado a partir da capacidade restante do suporte em cada ranhura e o formato de
gravação atual (taxa de bits de gravação) e é apresentado em unidades de minutos.

Tempo de substituição do cartão de memória
Quando o tempo de gravação total restante nos dois cartões de memória for inferior a 5 minutos, aparece a mensagem
“Media Near Full” e a luz de gravação/indicadora começa a piscar, para o avisar.
Substitua por um suporte com espaço livre.
Se continuar a gravar até o tempo de gravação total restante chegar a zero, a mensagem muda para “Media Full” e a
gravação para.

Nota

Podem ser gravados até 600 clips, aproximadamente, num só cartão de memória.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Restaurar cartões de memória

Se, por qualquer motivo, ocorrer um erro num cartão de memória, o cartão tem de ser restaurado antes da utilização.
Quando carrega um cartão de memória que necessita de ser restaurado, aparece uma mensagem no painel de imagem
da câmara a perguntar se pretende restaurá-lo.

Restaurar um cartão
Selecione [Execute] usando os botões de setas no painel de controlo da GUI e, em seguida, prima o botão [Set].
É apresentada uma mensagem e o estado do progresso (%) durante a formatação e o indicador de acesso acende a
vermelho.
Quando o restauro terminar, aparece uma mensagem de conclusão.

Se o restauro falhar
Os cartões de memória nos quais ocorreram erros de memória não podem ser restaurados. É apresentada uma
mensagem de aviso. Siga as instruções para substituir o cartão de memória.
Os cartões de memória nos quais ocorreram erros de memória poderão ficar utilizáveis se forem novamente
formatados.
Em alguns casos, certos clips podem ser restaurados enquanto outros não podem. Os clips restaurados podem ser
reproduzidos normalmente.

Nota

Para o restauro do conteúdo gravado com este aparelho, certifique-se de que utiliza este aparelho.

O conteúdo gravado com um dispositivo que não este aparelho ou com outro aparelho de versão diferente (mesmo que seja o
mesmo modelo) não poderá ser restaurado com este aparelho.

Os clips com menos de 2 segundos não podem ser restaurados.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Iniciar/parar a gravação

Este tópico descreve como iniciar/parar a gravação.

Instale os dispositivos necessários e certifique-se de que a alimentação do aparelho e dos dispositivos
periféricos está a ser fornecida.

1

Insira o(s) cartão(ões) de memória.2

Verifique o estado da alimentação do aparelho no cano superior esquerdo do ecrã da Web App.

Quando a fonte de alimentação está ligada
Quando o aparelho é ligado, surge [Power ON] no interruptor de alimentação na parte superior do ecrã Web App.

A luz POWER acende-se na parte frontal do aparelho e aparece a imagem da câmara no ecrã de operações em
gravação da Web App.

Nota

Se a palavra-passe do administrador não tiver sido configurada, aparece um ecrã a solicitar-lhe a configuração da palavra-
passe. Consulte “Inicializar o aparelho”.

Quando a fonte de alimentação está no estado de espera.
Quando a fonte de alimentação do aparelho está no estado de espera, é apresentado [Power Standby] no botão de
alimentação na Web App.

Neste estado, prima o botão de alimentação e selecione [Power ON]. O aparelho liga, a luz POWER acende-se a
verde na parte frontal do aparelho e aparece a imagem da câmara no ecrã de operações em gravação da Web
App.

Sugestão

3
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Para mudar a fonte de alimentação do aparelho para o estado de espera
Prima o botão de alimentação na Web App e selecione [Power Standby] para definir a fonte de alimentação do aparelho
para o estado de espera.

Sugestão

Pode também definir a fonte de alimentação para o estado de espera através do botão de alimentação no controlo remoto de
infravermelhos fornecido.

Pode também ligar o aparelho através do botão de alimentação no controlo remoto de infravermelhos fornecido.

Prima o botão START/STOP gravação.

A gravação inicia e a luz de gravação/indicadora (2 localizações) do aparelho acende-se.
Durante a gravação, o botão START/STOP gravação acende-se. Além disso, é apresentado um ícone para o
suporte de gravação pretendido e [●Rec].

4

Para parar a gravação, prima novamente o botão START/STOP gravação.

A gravação para e a luz de gravação/indicadora (2 localizações) do aparelho apaga-se.
Durante o estado de espera de gravação, o botão START/STOP gravação não fica aceso. Além disso, é
apresentado um ícone para o suporte de gravação pretendido e [Stby].

Sugestão

Pode também iniciar/parar a gravação através do botão START/STOP gravação no controlo remoto de infravermelhos
fornecido.

5
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Tópico relacionado
Inicializar o aparelho

5-041-957-53(1) Copyright 2022 Sony Corporation
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Alternar entre cartões de memória

Quando estão inseridos dois cartões de memória, pode premir o botão [Slot Select] no painel de controlo da reprodução
da Web App para alternar entre os cartões de memória.

Sugestão

Pode também premir o botão SLOT SEL (ranhura para cartões de memória (A)/(B)) no controlo remoto de infravermelhos
fornecido para alternar entre cartões de memória.

Sobre o reencaminhamento da gravação

Durante a gravação, o aparelho muda automaticamente para o segundo cartão de memória imediatamente antes da
capacidade restante no primeiro cartão ser reduzida a zero (reencaminhamento da gravação). Pode continuar a
gravação de forma contínua ao mudar de cartão de memória substituindo o cartão de memória que está cheio por um
cartão de memória novo.

Nota

Não pode alternar entre cartões de memória durante o modo de reprodução. Além disso, a reprodução contínua de um clip
repartido por suportes na ranhura A e B não é suportada.

Sobre os dados gravados

Quando para a gravação, o vídeo, áudio e os dados associados do início ao fim da gravação são guardados como um
único “clip” num cartão de memória.

Nome do clip dos dados gravados

O nome de cada clip gravado pelo aparelho é atribuído automaticamente, usando [TC/Media] > [Clip Name Format] no
menu da câmara.

Duração máxima do clip

Até 6 horas por clip.
A duração máxima da gravação contínua é igual à duração máxima de um clip. Se o tempo de gravação exceder a
duração máxima de um clip, é automaticamente criado um clip novo e a gravação continua. O novo clip aparece como
um clip separado no ecrã de miniaturas.
São gravados vários clips sucessivamente durante o reencaminhamento da gravação, mas a gravação vai parar
automaticamente após cerca de 24 horas.

Nota

Não ejete um cartão de memória durante uma gravação para o mesmo. Durante a gravação, substitua apenas os cartões de
memória nas ranhuras para as quais o indicador de acesso à ranhura está desligado.

Quando a capacidade restante no cartão de memória em gravação for inferior a um minuto e estiver inserido um cartão de
memória gravável na outra ranhura, aparece uma mensagem “Will Switch Slots Soon”. A mensagem desaparece após mudar de
ranhura para cartões de memória.

O reencaminhamento da gravação poderá não funcionar se a gravação for iniciada quando a capacidade restante do cartão de
memória for inferior a um minuto. Para um reencaminhamento correto da gravação, certifique-se de que a capacidade restante
do cartão de memória é superior a um minuto antes de começar a gravação.
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O vídeo criado com a função de reencaminhamento da gravação do aparelho não pode ser reproduzido ininterruptamente no
aparelho.

Para combinar o vídeo criado com a função de reencaminhamento da gravação do aparelho, utilize o software “Catalyst Browse”.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Verificar o áudio

O áudio é emitido dos conectores SDI e HDMI do aparelho. Selecione a combinação de canais de áudio que são
emitidos a partir do conector HDMI, usando [Audio] > [Audio Output] > [HDMI/Stream Output CH] no menu da câmara.
CH1/CH2: combinação de CH1 e CH2
CH3/CH4: combinação de CH3 e CH4
Quando monitorizar o áudio na Web App, use o medidor do nível de áudio, no canto inferior direito da imagem da
câmara.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Especificar dados de hora

Este tópico descreve como definir os dados de hora.

Definir o código de hora

Defina o código de hora a gravar, usando [TC/Media] > [Timecode] no menu da câmara.

Definir bits de utilizador

Pode adicionar um número hexadecimal de 8 dígitos à imagem gravada como bits de utilizador. Pode também definir os
bits de utilizador para a hora atual. Defina usando [TC/Media] > [Users Bit] no menu da câmara.

Apresentar dados de hora

Defina o código de hora a apresentar, usando [TC/Media] > [TC Display] > [Display Select] no menu da câmara.
Premir um botão atribuível com [DURATION/TC/U-BIT] atribuído vai alternar a apresentação entre o código de hora, bits
de utilizador e duração, em sequência.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Rever a gravação (Rec Review)

Pode rever o último clip gravado no ecrã (revisão da gravação).

Nota

Rec Review não é suportado se o formato de vídeo for alterado após gravar um clip.

Definir a posição de início de Rec Review

Pode definir a posição de início da reprodução para uma das seguintes, usando [Technical] > [Rec Review] no menu da
câmara.

Últimos 3 segundos do clip
Últimos 10 segundos do clip
Início do clip

Sugestão

Se pretender rever um clip específico após gravar vários clips, prima o botão [Thumbnail], para visualizar o ecrã de miniaturas e
selecionar o clip para iniciar a reprodução.

Pode também premir o botão THUMBNAIL do controlo remoto de infravermelhos fornecido, para visualizar o ecrã de miniaturas.

Método Rec Review

Atribua antecipadamente a função Rec Review a um dos botões atribuíveis no painel de ajuste da configuração básica.

Para mais informações sobre a atribuição, consulte “Botões atribuíveis” em “Funções úteis”.

Pare a gravação e, de seguida, prima um botão atribuível atribuído à função Rec Review para iniciar a reprodução do
clip gravado previamente.
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O clip é reproduzido até ao fim, Rec Review termina e o aparelho regressa ao modo Stby (espera).

Parar Rec Review
Prima o botão atribuível ao qual tenha sido atribuído Rec Review ou prima o botão [Cancel/Back].
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Sugestão

Também pode premir o botão [Cancel/Back] do controlo remoto de infravermelhos fornecido, para visualizar a função Rec
Review.

Tópico relacionado

Botões atribuíveis

5-041-957-53(1) Copyright 2022 Sony Corporation
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Ecrã de ajuste do enquadramento

O enquadramento é ajustado usando as seguintes partes do ecrã de operações em gravação:

Nota

Dependendo da direção da câmara, da distância focal da objetiva e da posição de zoom, parte do aparelho ou cabos ligados ao
bloco de conectores poderão ser visíveis. Antes da filmagem, verifique o campo de visão para a objetiva e a distância focal que
está a utilizar. Pode também controlar a amplitude do deslocamento/inclinação, usando [Pan-Tilt] > [P/T Range Limit] no menu
web. Quando o aparelho é ligado ou a reposição do deslocamento/inclinação é executada, esta definição do limite de amplitude
é ignorada. Para mais informações, consulte [Pan-Tilt] > [P/T Range Limit] no menu web.

Sugestão

Também pode controlar o enquadramento usando o controlo remoto de infravermelhos fornecido.

5-041-957-53(1) Copyright 2022 Sony Corporation

Painel de controlo das posições das predefinições1.

Separador  (Main)/separador  (Others)2.

Painel de controlo do enquadramento3.
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Ajustar a direção de filmagem usando a Web App

Mover a câmara na horizontal denomina-se deslocamento e mover a câmara na vertical denomina-se inclinação.
Pode ajustar a direção de filmagem usando as operações de deslocamento/inclinação.

Sugestão

Se [Execute Pan-Tilt Reset] aparecer abaixo do joystick, ocorreu uma inconsistência nas informações de origem do controlo de
deslocamento/inclinação do aparelho. Execute a função de reposição do deslocamento/inclinação para atualizar as informações
de origem. Para mais informações, consulte “Repor o deslocamento/inclinação”.

Virar a traseira da câmara para a frente
Prima o botão  (Posição inicial de deslocamento/inclinação) no separador  (Others) no painel de controlo da
câmara.

Nota

Dependendo da direção da câmara, da distância focal da objetiva e da posição de zoom, parte do aparelho ou cabos ligados ao
bloco de conectores poderão ser visíveis. Antes da filmagem, verifique o campo de visão para a objetiva e a distância focal que
está a utilizar. Pode também controlar a amplitude do deslocamento/inclinação, usando [Pan-Tilt] > [P/T Range Limit] no menu
web. Quando o aparelho é ligado ou a reposição do deslocamento/inclinação é executada, esta definição do limite de amplitude
é ignorada. Para mais informações, consulte [Pan-Tilt] > [P/T Range Limit] no menu web.

Tópico relacionado

Repor o deslocamento/inclinação

Prima o separador  (Deslocamento/inclinação/zoom) no painel de controlo do enquadramento, para
apresentar o joystick.

1

Arraste o centro do joystick na direção de visualização pretendida, enquanto monitoriza o painel de
imagem da câmara.

A direção e a velocidade da câmara mudam em resposta à direção e ao nível de arrastamento.
Pode ajustar o deslocamento/inclinação com mais precisão premindo as áreas periféricas do joystick.

2
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Definir a velocidade operacional do deslocamento/inclinação

Pode alterar a velocidade da operação de deslocamento/inclinação, usando o controlo de deslize [Pan-Tilt Speed] no
painel de controlo da câmara, através do joystick no painel de controlo do enquadramento.

Nota

Se houver uma parede ou outro obstáculo na amplitude de movimento da câmara, tenha cuidado para não chocar contra a
câmara ou objetiva durante a operação de deslocamento/inclinação.

A aceleração de deslocamento/inclinação depende das características físicas, tais como o equilíbrio de peso da objetiva. Pode
alterar a definição de aceleração, usando [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] no menu web ou no menu da câmara.
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Prima o separador  (Main) no painel de controlo da câmara.1

Selecione o controlo de deslize [Pan-Tilt Speed] a partir da lista.

Se o controlo de deslize [Pan-Tilt Speed] não for apresentado, selecione um dos botões de seleção da função do
controlo de deslize, para apresentar o controlo de deslize.

2

Mova o cursor do controlo de deslize para a esquerda ou direita.

Mover o cursor para a esquerda diminui a velocidade operacional e mover o cursor para a direita aumenta a
velocidade operacional.

3
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Definir a aceleração da operação de deslocamento/inclinação

Pode definir a operação de aceleração em nove níveis, usando [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] no menu
web ou no menu da câmara. Aumente o valor para alterações mais rápidas na velocidade ou diminua o valor para
alterações mais graduais na velocidade.
Para maior reatividade ao operar o deslocamento/inclinação, selecione o valor no intervalo de 7 a 9.
Para maior precisão posicional no início/fim do movimento para a posição de uma predefinição, é aconselhável um valor
no intervalo de 1 a 6.

Para mais informações sobre as posições das predefinições, consulte “Guardar/repor a posição de
deslocamento/inclinação e zoom”.

Nota

Quando o valor é definido alto, a função poderá não funcionar corretamente se estiver instalada uma objetiva pesada. Verifique o
funcionamento antes da utilização.

Relação entre a definição de [Ramp Curve] e a operação de deslocamento/inclinação

Quando é utilizado o deslocamento/inclinação

Quando acede à posição de uma predefinição
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Ajustar a direção de filmagem, usando o controlo remoto de infravermelhos fornecido

Pode ajustar a direção de filmagem, usando os botões da operação de deslocamento/inclinação do controlo remoto de
infravermelhos fornecido.

Virar a traseira da câmara para a frente
Prima o botão HOME.

Nota

Dependendo da direção da câmara, da distância focal da objetiva e da posição de zoom, parte do aparelho ou cabos ligados ao
bloco de conectores poderão ser visíveis. Antes da filmagem, verifique o campo de visão para a objetiva e a distância focal que
está a utilizar. Pode também controlar a amplitude do deslocamento/inclinação, usando [Pan-Tilt] > [P/T Range Limit] no menu
web. Quando o aparelho é ligado ou a reposição do deslocamento/inclinação é executada, esta definição do limite de amplitude
é ignorada. Para mais informações, consulte [Pan-Tilt] > [P/T Range Limit] no menu web.
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Prima os botões de seta para controlar o deslocamento/inclinação.

Prima o botão de seta da direção de visualização pretendida enquanto monitoriza a imagem da câmara.
Para mover uma distância curta, prima brevemente o botão de seta.
Para mover uma distância longa, prima continuamente o botão de seta.
Para mover na diagonal, prima continuamente o botão  (seta para cima) ou  (seta para baixo) e prima o
botão  (seta para a esquerda) ou  (seta para a direita).

1
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Definir o tipo de zoom

Defina o tipo de zoom, usando [Technical] > [Zoom] > [Zoom Type] no menu da câmara.
O tipo de zoom vai variar consoante o tipo de objetiva instalado.

Nota

O Zoom de Imagem Clara não está disponível nos casos seguintes.

Quando [Shooting] > [S&Q Motion] > [Setting] está definido para On e a definição de [Frame Rate] no menu da câmara é
superior a 60 fps
Quando [Project] > [Rec Format] > [Codec] no menu da câmara está definido para [RAW] ou para uma opção que inclua RAW

Utilizar o interruptor de seleção SERVO/MANUAL numa objetiva repõe a ampliação do Zoom de Imagem Clara para 1×.

AF-S não é suportado durante o Zoom de Imagem Clara.

Zoom de Imagem Clara

O aparelho está equipado com uma função de zoom que utiliza o processamento de sinal da imagem denominado Zoom
de Imagem Clara. Quando o Zoom de Imagem Clara está ativado, o zoom é suportado mesmo para as objetivas com
distância focal fixa. Também pode ser utilizado para prolongar o alcance além do intervalo ótico numa objetiva de zoom
motorizado.
A proporção máxima de zoom através de Zoom de Imagem Clara varia consoante a resolução de gravação.

Para a resolução de gravação QFHD/4K: 1,5×
Para a resolução de gravação HD: 2×
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Tipo de objetiva instalada
Definição de [Zoom Type]

[Optical Zoom Only] [On(Clear Image Zoom)]

Objetiva com distância focal fixa /
Objetiva de zoom manual

O funcionamento do zoom não
é suportado.

Zoom de Imagem Clara suportado.

Objetiva de zoom motorizado
Apenas é suportado o zoom
ótico.

O zoom ótico e o Zoom de Imagem
Clara são suportados.
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Ajustar o zoom através da Web App

Pode ajustar o zoom do aparelho através do zoom ótico ou Zoom de Imagem Clara. Este tópico descreve como efetuar
ajustes através da Web App. Para mais informações sobre o Zoom de Imagem Clara, consulte “Definir o tipo de zoom”.

Nota

Dependendo da direção da câmara, da distância focal da objetiva e da posição de zoom, parte do aparelho ou cabos ligados ao
bloco de conectores poderão ser visíveis. Antes da filmagem, verifique o campo de visão para a objetiva e a distância focal que
está a utilizar. Pode também controlar a amplitude do deslocamento/inclinação, usando [Pan-Tilt] > [P/T Range Limit] no menu
web. Quando o aparelho é ligado ou a reposição do deslocamento/inclinação é executada, esta definição do limite de amplitude
é ignorada. Para mais informações, consulte [Pan-Tilt] > [P/T Range Limit] no menu web.

A velocidade de zoom e a precisão reais irão variar consoante a objetiva. Verifique o funcionamento antes da utilização.

Sugestão

Pode controlar o zoom de uma objetiva de zoom manual usando um controlador da objetiva (opção) que seja compatível com
este aparelho. Para mais informações, consulte “Ligar um controlador da objetiva” e “Ajustar o zoom através de um controlador
da objetiva”.

Tópico relacionado
Definir o tipo de zoom

Ligar um controlador da objetiva

Ajustar o zoom através de um controlador da objetiva

Prima o separador  (Deslocamento/inclinação/zoom) no painel de controlo do enquadramento, para
apresentar o painel de controlo do deslocamento/inclinação.

1

Deslize o cursor do controlo de deslize [Zoom] na direção [T] (teleobjetiva) ou [W] (grande angular), para
ajustar o zoom.

A velocidade do zoom varia com o movimento do controlo de deslize.

2
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Definir a velocidade operacional do zoom

Pode alterar a velocidade de operação do zoom do controlo de deslize [Zoom] no painel de controlo do enquadramento,
usando o controlo de deslize [Zoom Speed] no painel de controlo da câmara.

Nota

A velocidade de zoom e a precisão reais irão variar consoante a objetiva. Verifique o funcionamento antes da utilização.
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Prima o separador  (Main) no painel de controlo da câmara.1

Selecione o controlo de deslize [Zoom Speed] a partir da lista.

Se o controlo de deslize [Zoom Speed] não for apresentado, selecione um dos botões de seleção da função do
controlo de deslize, para apresentar o controlo de deslize.

 

2

Mova o cursor do controlo de deslize [Zoom Speed] para a esquerda ou direita.

Mover o cursor para a esquerda diminui a velocidade operacional e mover o cursor para a direita aumenta a
velocidade operacional.

3
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Ajustar o zoom utilizando o controlo remoto de infravermelhos fornecido

Pode ajustar o zoom do aparelho através do zoom ótico ou Zoom de Imagem Clara. Este tópico descreve como efetuar
ajustes utilizando o controlo remoto de infravermelhos fornecido. Para mais informações sobre o Zoom de Imagem
Clara, consulte “Definir o tipo de zoom”.

Nota

Dependendo da direção da câmara, da distância focal da objetiva e da posição de zoom, parte do aparelho ou cabos ligados ao
bloco de conectores poderão ser visíveis. Antes da filmagem, verifique o campo de visão para a objetiva e a distância focal que
está a utilizar. Pode também controlar a amplitude do deslocamento/inclinação, usando [Pan-Tilt] > [P/T Range Limit] no menu
web. Quando o aparelho é ligado ou a reposição do deslocamento/inclinação é executada, esta definição do limite de amplitude
é ignorada. Para mais informações, consulte [Pan-Tilt] > [P/T Range Limit] no menu web.

Sugestão

Pode controlar o zoom de uma objetiva de zoom manual usando um controlador da objetiva (opção) que seja compatível com
este aparelho. Para mais informações, consulte “Ligar um controlador da objetiva” e “Ajustar o zoom através de um controlador
da objetiva”.

Tópico relacionado

Definir o tipo de zoom

Ligar um controlador da objetiva

Ajustar o zoom através de um controlador da objetiva

5-041-957-53(1) Copyright 2022 Sony Corporation

Prima o botão do zoom para ajustar o zoom.

Prima o botão T (teleobjetiva) ou W (grande angular) enquanto monitoriza o ecrã para ajustar o zoom.
Para aproximar, prima o botão T.
Para afastar, prima o botão W.

1
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Calibrar uma objetiva com encaixe E

A calibragem corrige as diferenças na posição do zoom devido a diferenças nas objetivas individuais ao utilizar uma
objetiva de zoom motorizado com encaixe E.
Para calcular a posição do zoom com precisão, calibre a objetiva para corrigir as diferenças individuais na objetiva
através do procedimento seguinte.

Dados de calibragem
No máximo, podem ser guardados dados de calibragem de cinco objetivas no aparelho. Os dados mais antigos
serão substituídos quando uma 6ª objetiva ou posterior for calibrada.
Pode verificar se os dados de calibragem estão disponíveis para a objetiva instalada, premindo o botão  (Estado
da câmara) na área comum do ecrã da Web App e selecionando [Lens] > [Calibration Data].
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Se a objetiva tiver um interruptor SERVO/MANUAL, coloque na posição SERVO.

Nota

A objetiva não poderá receber instruções de zoom do aparelho se o interruptor estiver na posição MANUAL.

1

Execute a calibragem, usando [Technical] > [Lens] > [Lens Calibration] no menu da câmara.

Durante a calibragem, a objetiva de zoom move-se automaticamente e é medida.

2
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Guardar/repor a posição do deslocamento/inclinação e zoom e a definição de
focagem através da Web App

Pode guardar a posição do deslocamento/inclinação e zoom e a definição de focagem, e aceder a ela quando
necessário, usando a Web App (função de posição predefinida).

Para mais informações sobre os itens que podem ser guardados/repostos, consulte “Itens guardados na posição
predefinida”.

Nota

Uma posição predefinida não pode ser guardada se a proporção do Zoom de Imagem Clara exceder 1×.

Se a definição de [Pan-Tilt] > [P/T Direction] > [Ceiling] no menu web for alterada, todas as posições das predefinições
guardadas são eliminadas.

Defina o modo de assistência PTZ para [Pos.] na lista pendente na parte superior do painel de controlo das
posições das predefinições.

1

Determine a posição que pretende guardar, usando as operações de deslocamento/inclinação e zoom.2

Prima o botão [+] no painel de controlo das posições das predefinições.

A imagem com a posição guardada é apresentada no painel de controlo das posições das predefinições.

Sugestão

Se o painel de controlo das posições das predefinições não for apresentado, prima o botão  (Abrir) para o apresentar.

As posições são guardadas sequencialmente, a partir de [Preset1].

3
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Para cancelar a operação de restauro da posição da predefinição
Prima o botão  (Cancelar restauro) apresentado no painel de controlo das posições das predefinições durante a
operação de restauro das posições das predefinições para cancelar a operação de restauro. Use o joystick e o controlo
de deslize [Zoom] para ajustar o enquadramento.

Se houver predefinições não usadas numa sequência de predefinições, as posições serão guardadas nas predefinições
com as predefinições não utilizadas. Por exemplo, se as posições das predefinições forem guardadas em [Preset1] e
[Preset3], mas não em [Preset2], as próximas posições das predefinições serão guardadas em [Preset2] e depois em
[Preset4].

É possível guardar até 100 posições de predefinições.

Pode mudar o nome de cada posição de predefinição. Para mais informações, consulte “Mudar o nome das posições das
predefinições usando a Web App”.

Reponha uma posição guardada.

Prima duas vezes a miniatura da posição que pretende repor no painel de controlo da posição de predefinição,
para repor a posição correspondente.

Sugestão

Também pode repor uma posição premindo a imagem, premindo o botão  (Menu das posições das predefinições) que
aparece e selecionando [Recall].

A velocidade de transição para uma posição guardada é determinada pela definição de [Pan-Tilt] > [P/T Preset] > [Pan-Tilt]
> [Pan-Tilt Speed for Common] no menu web, quando a posição foi guardada. Pode também alterar a velocidade de
transição após guardar. Para mais informações, consulte “Alterar a velocidade de transição (Deslocamento-
Inclinação/Zoom/Focagem) ao restaurar uma posição de predefinição”

O nível de alteração na posição do deslocamento/inclinação ao mover para uma posição de predefinição pode ser
ajustado, usando a velocidade de transição e as definições de [Ramp Curve]. Para mais informações, consulte “Alterar a
velocidade de transição (Deslocamento-Inclinação/Zoom/Focagem)” e “Definir a aceleração da operação de
deslocamento/inclinação”.

Se aceder a uma predefinição diferente durante a reprodução da predefinição, a operação da primeira predefinição
acedida para e começa a operação da predefinição subsequentemente acedida.

Nota

Se a temperatura do ambiente tiver mudado significativamente entre o momento em que uma posição de predefinição foi
guardada e o momento em que é reproduzida, poderá ocorrer um desvio no enquadramento.

Enquanto uma posição de predefinição está a ser restaurada, não pode efetuar quaisquer operações para além de
restaurar ou cancelar a posição da predefinição.

4
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Tópico relacionado

Itens guardados na posição predefinida

Mudar as posições das predefinições usando a Web App

Alterar a velocidade de transição (Deslocamento-Inclinação/Zoom/Focagem) ao restaurar uma posição de
predefinição

Definir a aceleração da operação de deslocamento/inclinação
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Mudar as posições das predefinições usando a Web App

Pode mudar o nome das posições das predefinições guardadas.

5-041-957-53(1) Copyright 2022 Sony Corporation

Defina o modo de assistência PTZ para [Pos.] na lista pendente na parte superior do painel de controlo das
posições das predefinições.

1

Prima a posição da predefinição cujo nome pretende mudar.

O botão  (Menu das posições das predefinições) aparece no canto superior direito da imagem.

2

Prima o botão  (Menu das posições das predefinições) e selecione [Rename] a partir do menu
apresentado.

3

Insira um novo nome de predefinição.4
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Substituir uma posição de predefinição guardada por uma nova posição, usando a
Web App

É possível substituir uma posição de predefinição guardada por uma posição nova.
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Defina o modo de assistência PTZ para [Pos.] na lista pendente na parte superior do painel de controlo das
posições das predefinições.

1

Determine a posição que pretende guardar, usando as operações de deslocamento/inclinação e zoom.2

Prima a imagem da posição que pretende substituir no painel de controlo das posições de predefinições.

O botão  (Menu das posições das predefinições) aparece no canto superior direito da imagem.

3

Prima o botão  (Menu das posições das predefinições) e selecione [Replace] a partir do menu
apresentado.

A nova posição substitui a definição atual.

4
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Eliminar uma posição de predefinição guardada usando a Web App

Pode eliminar as posições das predefinições guardadas.

5-041-957-53(1) Copyright 2022 Sony Corporation

Defina o modo de assistência PTZ para [Pos.] na lista pendente na parte superior do painel de controlo das
posições das predefinições.

1

Prima a imagem da posição que pretende eliminar no painel de controlo das posições de predefinições.

O botão  (Menu das posições das predefinições) aparece no canto superior direito da imagem.

2

Prima o botão  (Menu das posições das predefinições) e selecione [Delete] a partir do menu
apresentado.

A posição guardada é eliminada.

3
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Sincronizar a operação de deslocamento/inclinação e a operação de zoom/focagem
ao restaurar uma posição de predefinição

Pode sincronizar a operação de deslocamento/inclinação e a operação de zoom ao restaurar uma posição de
predefinição guardada para um enquadramento mais suave.

Sugestão

Pode especificar previamente as definições utilizadas para registar uma posição de predefinição. Defina [Pan-Tilt] > [P/T Preset]
> [Default] > [Zoom Sync] para [On] no menu web.

Quando [Pan-Tilt] > [P/T Preset] > [Speed Select] está definido para [Common], todas as posições das predefinições serão
repostas à velocidade definida usando [Pan-Tilt] > [P/T Preset] > [Common Speed].

Após a conclusão do movimento de zoom, a câmara move-se para a posição de focagem guardada.

Após a conclusão do movimento, [AF Transition Speed] regressa à sua definição original.

Defina o modo de assistência PTZ para [Pos.] na lista pendente na parte superior do painel de controlo das
posições das predefinições.

1

Prima a imagem da posição da predefinição cuja velocidade de transição pretende alterar.

O botão  (Menu das posições das predefinições) aparece no canto superior direito da imagem.

2

Prima o botão  (Menu das posições das predefinições) e selecione [Edit…] a partir do menu apresentado.

Aparece o ecrã de configuração para a posição da predefinição selecionada.

3

Deslize o interruptor [Zoom Sync] para a direita para ligar a função e prima o botão [OK].

Da próxima vez que uma posição guardada for reposta, a câmara irá mover-se à velocidade configurada.

4
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Alterar a velocidade de transição (Deslocamento-Inclinação/Zoom/Focagem) ao
restaurar uma posição de predefinição

Pode alterar a velocidade de transição (operação de deslocamento/inclinação, operação de zoom, operação de
focagem) ao restaurar uma posição de predefinição guardada.

Sugestão

Quando [Pan-Tilt] > [P/T Preset] > [Speed Select] está definido para [Common], todas as posições serão repostas à velocidade
definida, usando [Pan-Tilt] > [P/T Preset] > [Common Speed].

Após a conclusão do movimento de zoom, a câmara move-se para a posição de focagem guardada.

Após a conclusão do movimento, [AF Transition Speed] regressa à sua definição original.

Defina [Pan-Tilt] > [P/T Preset] > [Speed Select] para [Separate] no menu web.1

Defina o modo de assistência PTZ para [Pos.] na lista pendente na parte superior do painel de controlo das
posições das predefinições.

2

Prima a imagem da posição da predefinição cuja velocidade de transição pretende alterar.

O botão  (Menu das posições das predefinições) aparece no canto superior direito da imagem.

3

Prima o botão  (Menu das posições das predefinições) e selecione [Edit…] a partir do menu apresentado.

Aparece o ecrã de configuração para a posição da predefinição selecionada.

4

Defina as velocidades de transição (Deslocamento-Inclinação/Zoom/Focagem) que pretende alterar usando
os controlos de deslize ou introduza os valores diretamente e prima o botão [OK].

Da próxima vez que uma posição guardada for reposta, a câmara irá mover-se à velocidade configurada.

5
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Guardar/repor a posição do deslocamento/inclinação e do zoom, usando o controlo
remoto de infravermelhos fornecido

Pode guardar a posição do deslocamento/inclinação e do zoom e aceder a ela, quando necessário, usando o controlo
remoto de infravermelhos fornecido.

Tópico relacionado
Alterar a velocidade de transição (Deslocamento-Inclinação/Zoom/Focagem) ao restaurar uma posição de
predefinição

Ajuste o deslocamento/inclinação e o zoom da câmara.1

Defina o modo de assistência PTZ para [Pos.] na lista pendente na parte superior do painel de controlo das
posições das predefinições na Web App.

2

Prima continuamente o botão PRESET e prima um dos botões de 1 a 3.

A posição é guardada.

3

Reponha uma posição guardada.

Prima um dos botões 1 a 3 para restaurar essa posição da predefinição.

Sugestão

A velocidade de transição ao restaurar uma posição de predefinição é determinada pelo valor [Pan-Tilt] > [P/T Preset] >
[Pan-Tilt Speed] guardado no menu web. Pode alterar a velocidade de transição após guardar um valor. Para mais
informações, consulte “Alterar a velocidade de transição (Deslocamento-Inclinação/Zoom/Focagem) ao restaurar uma
posição de predefinição”

4
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Gravar operações de enquadramento da câmara usando a Web App

Pode gravar as operações de enquadramento da câmara usando a Web App.

Ajuste a posição inicial de funcionamento da câmara.1

Defina o modo de assistência PTZ para [Trace] na lista pendente na parte superior do painel de controlo
das posições das predefinições.

2

Prima o botão [+] no painel de controlo das posições das predefinições.

É adicionada uma miniatura e a câmara passa para o estado de gravação em espera.

Sugestão

3
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Sugestão

O tempo de gravação restante é apresentado na parte superior do painel de imagem da câmara durante a gravação.

Nota

As operações de enquadramento gravadas serão eliminadas se mudar para a fixação no teto

Mudar a frequência do sistema poderá eliminar as operações de enquadramento gravadas.

A operação de zoom não é gravada quando um controlador de objetiva está ligado.

A duração máxima para gravar uma única operação de enquadramento é de 3 minutos. A gravação para automaticamente
quando a duração da gravação atinge os 3 minutos.

A gravação de uma operação de enquadramento não pode ser iniciada se a proporção de Zoom de Imagem Clara for superior a
1×.

Se a câmara for controlada a partir de outro dispositivo enquanto grava uma operação de enquadramento, as operações do
outro dispositivo também serão gravadas. Para mais informações sobre operações de gravação utilizando um controlo remoto de
terceiros, contacte o respetivo fabricante.

As definições de focagem e de qualidade de imagem não são gravadas por esta função.

Pode premir o botão  (Fechar) na miniatura para sair do estado de gravação em espera e voltar ao funcionamento
normal.

Inicie a operação de enquadramento utilizando o joystick e o controlo de deslize [Zoom].

A gravação começa a partir do momento que a operação de enquadramento é iniciada.

4

Prima o botão  (Parar gravação) na miniatura para parar a gravação.5
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As operações de deslocamento/inclinação/zoom gravadas durante a gravação de uma operação de enquadramento não podem
ser reproduzidas exatamente durante a reprodução de enquadramento.

Se, depois de gravar uma operação de enquadramento, definir o limite da amplitude de deslocamento/inclinação usando [Pan-
Tilt] > [P/T Range Limit] no menu web, o limite da amplitude de deslocamento/inclinação não será aplicado durante a reprodução
do enquadramento. Se pretender utilizar uma operação de enquadramento e a função de limite de deslocamento/inclinação em
conjunto, defina o limite da amplitude de deslocamento/inclinação antes de gravar a operação de enquadramento.

As operações de enquadramento gravadas não podem ser reproduzidas quando a saída de vídeo RAW está selecionada.

As operações de enquadramento gravadas não podem ser reproduzidas quando o sinal de vídeo não está a ser emitido pelo
conector de saída SDI.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Reproduzir operações de enquadramento da câmara usando a Web App

Pode reproduzir uma operação de enquadramento gravada pela câmara usando a Web App.

Defina o modo de assistência PTZ para [Trace] na lista pendente na parte superior do painel de controlo
das posições das predefinições.

1

Selecione uma miniatura com a operação de enquadramento que pretende reproduzir.

O botão  (Preparar) aparece na miniatura.

2

Prima o botão  (Preparar).

A câmara move-se para a posição inicial da operação de enquadramento e muda para o estado de reprodução em
espera.

3

Prima o botão  (Reproduzir) na miniatura.4
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Sugestão

A reprodução de enquadramento inicia.
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No estado de reprodução em espera e durante a reprodução, pode cancelar a reprodução e voltar ao funcionamento normal
efetuando qualquer uma das seguintes operações.

Prima o botão  (Parar) na miniatura ou no painel de controlo das posições das predefinições.
Utilize o joystick.
Utilize o controlo de deslize [Zoom].

O tempo de reprodução decorrido é apresentado na parte superior do painel de imagem da câmara durante a reprodução.

Nota

Poderá ocorrer um comportamento inesperado se a definição do Zoom de Imagem Clara for diferente entre a gravação e a
reprodução das operações de enquadramento.

A reprodução da operação de zoom não é suportada quando um controlador da objetiva está ligado. Utilizar o zoom interromperá
a reprodução das operações de enquadramento.

Durante a reprodução da operação de enquadramento, alterar o limite da amplitude de deslocamento/inclinação usando [Pan-
Tilt] > [P/T Range Limit] no menu web não tem qualquer efeito. Defina o limite da amplitude de deslocamento/inclinação antes de
gravar uma operação de enquadramento.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Eliminar operações de enquadramento gravadas pela câmara usando a Web App

Pode eliminar as operações de enquadramento gravadas pela câmara usando a Web App.

5-041-957-53(1) Copyright 2022 Sony Corporation

Defina o modo de assistência PTZ para [Trace] na lista pendente na parte superior do painel de controlo
das posições das predefinições.

1

Selecione uma miniatura com a operação de enquadramento que pretende eliminar.

O botão  (menu Deteção) aparece na miniatura.

2

Prima o botão  (menu Deteção).

Aparece o menu.

3

Selecione [Delete] a partir do menu apresentado.

A operação de enquadramento selecionada é eliminada.

4
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Gravar operações de enquadramento da câmara, usando o controlo remoto de
infravermelhos fornecido

Pode gravar operações de enquadramento da câmara usando o controlo remoto de infravermelhos fornecido.

Para mais informações sobre a reprodução de uma operação de enquadramento gravada, consulte “Reproduzir
operações de enquadramento da câmara usando o controlo remoto de infravermelhos fornecido”

Nota

A duração máxima para gravar uma única operação de enquadramento é de 3 minutos. A gravação para automaticamente
quando a duração da gravação atinge os 3 minutos.

Se a câmara for controlada a partir de outro dispositivo enquanto grava uma operação de enquadramento, a operação do outro
dispositivo também será gravada como parte da operação de enquadramento.

Se a qualidade da imagem for ajustada durante a gravação de uma operação de enquadramento, essa alteração não é gravada.

Tópico relacionado

Reproduzir operações de enquadramento da câmara, usando o controlo remoto de infravermelhos fornecido

5-041-957-53(1) Copyright 2022 Sony Corporation

Aceda ao ecrã de operações em gravação da Web App.1

Defina o modo de assistência PTZ para [Trace] na lista pendente na parte superior do painel de controlo
das posições das predefinições.

2

Ajuste a posição de início de funcionamento da câmara usando o controlo remoto de infravermelhos.3

Prima continuamente o botão PRESET e prima um dos botões POSITION de 1 a 3.

A câmara muda para o estado de gravação em espera.

4

Execute a operação de enquadramento que pretende gravar.5

Para terminar a gravação, prima continuamente o botão PRESET e prima o botão POSITION selecionado no
passo 4.

6
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Reproduzir operações de enquadramento da câmara, usando o controlo remoto de
infravermelhos fornecido

Pode reproduzir uma operação de enquadramento gravada pela câmara usando o controlo remoto de infravermelhos
fornecido.

Nota

Utilizar o deslocamento/inclinação/zoom da câmara irá interromper a reprodução.

Tópico relacionado

Gravar operações de enquadramento da câmara, usando o controlo remoto de infravermelhos fornecido

5-041-957-53(1) Copyright 2022 Sony Corporation

Aceda ao ecrã de operações em gravação da Web App.1

Defina o modo de assistência PTZ para [Trace] na lista pendente na parte superior do painel de controlo
das posições das predefinições.

2

Selecione e prima um dos botões POSITION de 1 a 3 para o qual foi gravada uma operação de
enquadramento.

O deslocamento/inclinação/zoom da câmara move-se para a posição de início da reprodução.

3

Depois de a câmara se mover para a posição inicial de reprodução, prima novamente o mesmo botão
POSITION.

A reprodução inicia.

4
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Ecrã de ajuste da focagem

A focagem é ajustada através das seguintes partes do ecrã de operações em gravação.

5-041-957-53(1) Copyright 2022 Sony Corporation

Painel de imagem da câmara
Pode ajustar a focagem tocando na imagem da câmara. Pode desativar a operação tátil na Web App, desligando o
interruptor [Touch Focus] no separador  (Focus) no painel de controlo da câmara.

1.

Painel de controlo da câmara – separador  (Focus)2.

Painel de controlo da GUI3.
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Ajustar manualmente através da Web App

Pode ajustar a focagem manualmente, por exemplo nos seguintes casos:

Motivos parcialmente escurecidos por gotas de água
Motivos com baixo contraste contra o fundo
Motivos mais afastados do que os motivos próximos

Nota

A focagem manual não pode ser controlada a partir da Web App enquanto a operação de zoom estiver em curso.

Sugestão

Pode também utilizar a focagem automática quando o ajuste manual é o principal método de funcionamento. Para mais
informações, consulte “Definir manualmente o alvo de focagem automática (AF Assist) usando a Web App”.

Tópico relacionado

Verificar os interruptores da objetiva

Definir manualmente o alvo de focagem automática (AF Assist) usando a Web App

5-041-957-53(1) Copyright 2022 Sony Corporation

Se a objetiva estiver equipada com um interruptor seletor de focagem, regule o interruptor para a posição
“AF/MF” ou “AF”.

Nota

Se o interruptor estiver na posição “Full MF” ou “MF”, a focagem da objetiva não pode ser controlada a partir do aparelho.
Consulte “Para uma objetiva com um interruptor de modo de focagem”, em “Verificar os interruptores da objetiva”.

1

Deslize o interruptor [Auto Focus] para a esquerda no painel de controlo da câmara, para desativar a
focagem automática.

É ativado o modo de focagem manual.

 (MF)

2

Ajuste através do controlo de deslize na parte inferior do separador  (Focus).3
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Ajustar manualmente utilizando o controlo remoto de infravermelhos fornecido

Pode ajustar manualmente a focagem utilizando o controlo remoto de infravermelhos fornecido.

Sugestão

Pode também utilizar a focagem automática quando o ajuste manual é o principal método de funcionamento. Para mais
informações, consulte “Focar manualmente durante a focagem automática utilizando o controlo remoto de infravermelhos
fornecido”.

Tópico relacionado

Focar manualmente durante a focagem automática utilizando o controlo remoto de infravermelhos fornecido

5-041-957-53(1) Copyright 2022 Sony Corporation

Prima o botão MF no controlo remoto de infravermelhos.1

Ajuste manualmente a focagem através do botão F (Distante) e o botão N (Próximo).

Para focar num motivo distante, prima o botão F.
Para focar num motivo próximo, prima o botão N.

2
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Focar especificando uma posição de focagem (Spot Focus)

No modo de focagem manual, pode especificar a posição onde pretende ajustar a focagem no painel de imagem da
câmara.

Nota

A função Spot Focus não funciona se a objetiva estiver definida para focagem manual.

Sugestão

No modo Spot Focus, pode premir um botão atribuível ao qual tenha sido atribuído [Push AF/MF], para suspender
temporariamente o Spot Focus e ativar a focagem automática enquanto o botão estiver premido. A focagem regressa à focagem
manual quando solta o botão.

5-041-957-53(1) Copyright 2022 Sony Corporation

Defina [Shooting] > [Focus] > [Touch Function in MF] para [Spot Focus] no menu web ou no menu da
câmara.

1

Para ativar, deslize o interruptor [Touch Focus] no separador  (Focus) para a direita.2

Para desativar, deslize o interruptor [Auto Focus] no separador  (Focus) para a esquerda.3

Especifique a posição de focagem.

O marcador Spot Focus aparece e a imagem é ajustada para estar focada nessa posição.

Exemplo de especificar a posição através da operação tátil

4
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Utilizar temporariamente a focagem automática (focagem automática por seleção
(AF))

No modo de focagem manual, pode ajustar temporariamente a focagem usando a focagem automática, premindo o
botão [Push AF/MF] para ativar a focagem automática enquanto o botão estiver premido.
Isto é útil quando pretende mover a focagem lentamente de um motivo para outro durante a focagem manual.

Nota

A função de focagem automática por seleção não funciona se a objetiva estiver definida para focagem manual.

Sugestão

A mesma operação é possível usando um botão atribuível ao qual tenha sido atribuído [Push AF/MF].

5-041-957-53(1) Copyright 2022 Sony Corporation

Defina [Shooting] > [Focus] > [Push AF Mode] para [AF] no menu da câmara.1

Para desativar, deslize o interruptor [Auto Focus] no separador  (Focus) para a esquerda.2

Prima o botão [Push AF/MF].

A focagem automática fica ativa enquanto o botão é premido.

A focagem automática por seleção é desativada e a focagem regressa à focagem manual quando solta o botão.

3
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Utilizar a focagem automática de filmagem única (focagem automática por seleção
(AF-S))

Pode premir o botão [Push AF/MF] no modo de focagem manual, para focar automaticamente a alta velocidade.
Esta função é conveniente quando foca um motivo antes da filmagem.

Nota

A função de focagem automática por seleção não funciona se a objetiva estiver definida para focagem manual.

A moldura da área de focagem não fica oculta quando usa o botão [Display].

Defina [Shooting] > [Focus] > [Push AF Mode] para [Single-shot AF(AF-S)] no menu web ou no menu da
câmara.

1

Especifique a posição para a qual pretende ajustar a focagem, usando [Shooting] > [Focus] > [Focus Area
(AF-S)] no menu da câmara.

Sugestão

Pode alterar a posição, premindo um botão atribuível ao qual tenha sido atribuído [Focus Setting], para apresentar uma
moldura cor de laranja em redor da área de focagem e selecionar uma posição através da operação tátil.

2

Para desativar, deslize o interruptor [Auto Focus] no separador  (Focus) para a esquerda.3

Prima o botão [Push AF/MF].

Se soltar o botão antes da conclusão da focagem, a focagem automática por seleção parará.

Durante a focagem automática por seleção, o estado da focagem é apresentado pelo indicador de focagem.
Aceso: a focagem é fixada na posição de focagem.
Intermitente: fora de focagem. Uma vez que o aparelho não irá focar de forma automática, altere a composição e
as definições de focagem, para conseguir focar.
A focagem regressa à focagem manual quando solta o botão.

4
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Durante a operação de Zoom de Imagem Clara, a posição da moldura [Focus Area (AF-S)] não pode ser definida. Durante o
funcionamento com focagem automática por seleção, a operação AF também dá prioridade à parte central.

Sugestão

A mesma operação é possível usando um botão atribuível ao qual tenha sido atribuído [Push AF/MF].

Também pode atribuir [Push AF Mode] a um botão atribuível.

Também pode atribuir [Focus Area (AF-S)] a um botão atribuível.

Pode mostrar/ocultar a moldura da área de focagem, usando [Monitoring] > [Display On/Off] > [Focus Area Ind.(AF-S)] no menu
da câmara.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Ajustar automaticamente através da Web App

O aparelho utiliza AF de deteção de fases para focagem de alta velocidade e AF de contraste para focagem de alta
precisão.
A combinação destes dois métodos AF proporciona focagem automática com alta velocidade e alta precisão.

Nota

É necessária uma objetiva que suporte focagem automática.

Consoante as condições de filmagem, a precisão poderá não ser obtida.

A focagem não pode ser ajustada automaticamente numa objetiva com encaixe A.

Sugestão

No modo de focagem automática, pode ajustar a focagem usando o controlo de deslize Focus no painel de controlo da câmara.
Para mais informações, consulte “Definir manualmente o alvo de focagem automática (AF Assist) usando a Web App”.

Tópico relacionado
Verificar os interruptores da objetiva

Definir manualmente o alvo de focagem automática (AF Assist) usando a Web App

5-041-957-53(1) Copyright 2022 Sony Corporation

Se a objetiva estiver equipada com um interruptor seletor de focagem, regule o interruptor para a posição
“AF/MF” ou “AF”.

Nota

Se o interruptor estiver na posição “Full MF” ou “MF”, a focagem da objetiva não pode ser controlada a partir do aparelho.
Consulte “Para uma objetiva com um interruptor de modo de focagem”, em “Verificar os interruptores da objetiva”.

1

Para ativar, deslize o interruptor [Auto Focus] para a direita no painel de controlo da câmara.

É ativado o modo de focagem automática.

 (AF)

2
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Ajustar automaticamente utilizando o controlo remoto de infravermelhos fornecido

Pode ajustar automaticamente a focagem utilizando o controlo remoto de infravermelhos fornecido.

Nota

Pode também utilizar a focagem automática quando o ajuste manual é o principal método de funcionamento. Para mais
informações, consulte “Focar manualmente durante a focagem automática utilizando o controlo remoto de infravermelhos
fornecido”.

Tópico relacionado

Focar manualmente durante a focagem automática utilizando o controlo remoto de infravermelhos fornecido

5-041-957-53(1) Copyright 2022 Sony Corporation

Prima o botão AF no controlo remoto de infravermelhos.

A focagem num motivo é ajustada automaticamente.

1
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Definir a área/posição de focagem automática (área de focagem)

Pode definir a área pretendida para focagem automática e ajustar a focagem para essa área.

Prima o botão [Menu] no painel de controlo da GUI, para abrir o menu da câmara.1

Defina a área pretendida para a focagem automática, usando [Shooting] > [Focus] > [Focus Area] no menu
da câmara.

[Wide]:
Pesquisa um motivo num ângulo amplo da imagem durante a focagem. Não é apresentada uma moldura.

[Zone]:
Pesquisa automaticamente uma posição de focagem na zona especificada.
Após a seleção, especifique a posição, usando os botões de setas no painel de controlo da GUI.

Pode regressar à posição central premindo de forma contínua o botão [Set].
[Flexible Spot]:
Foca numa posição especificada na imagem.

2
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Nota

A moldura da área de focagem não fica oculta quando usa o botão [Display] no painel de imagem da câmara.

Durante o Zoom de Imagem Clara, a área de focagem está definida para [Wide] (fixa).

Sugestão

Pode mostrar/ocultar a moldura da área de focagem, usando [Monitoring] > [Display On/Off] > [Focus Area Indicator] no menu da
câmara.

5-041-957-53(1) Copyright 2022 Sony Corporation

Após a seleção, especifique a posição, usando os botões de setas no painel de controlo da GUI.

Pode regressar à posição central premindo de forma contínua o botão [Set].
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Alterar rapidamente a área de focagem (definição de focagem)

Pode alterar rapidamente a posição e o tamanho da área de focagem automática durante a filmagem, atribuindo [Focus
Setting] a um botão atribuível.

Para mais informações sobre os botões atribuíveis, consulte “Botões atribuíveis”.

A operação varia consoante a definição da área de focagem.

Quando [Shooting] > [Focus] > [Focus Area] está definido para [Flexible Spot] ou [Zone] no
menu da câmara

Pode alterar a posição da área de focagem, premindo um botão atribuível ao qual tenha sido atribuído [Focus
Setting] e ajustando através dos botões de setas no painel de controlo da GUI. Pode repor a posição da área de
focagem no centro enquanto ajusta a posição, premindo o botão [Set].
Pode alterar o tamanho da área de focagem, premindo um botão atribuível ao qual tenha sido atribuído [Focus
Setting]. Após alterar o tamanho, pode alterar a posição da área de focagem, premindo o botão [Set]. Depois de
concluído, prima um botão atribuível ao qual tenha sido atribuído [Focus Setting], para regressar ao ecrã original.

Quando [Shooting] > [Focus] > [Focus Area] está definido para [Wide] no menu da câmara

Pode alterar o tamanho da área de focagem, premindo um botão atribuível ao qual tenha sido atribuído [Focus Setting].
A posição também pode ser alterada, alterando primeiro o tipo para [Flexible Spot] ou [Zone].

Sugestão

Quando [Shooting] > [Focus] > [Push AF Mode] está definido para [Single-shot AF(AF-S)] no menu da câmara e o interruptor
[Auto Focus] está na posição Off (modo de focagem manual), pode alterar a posição da área de focagem [Focus Area (AF-S)].

A moldura da área de focagem é apresentada a cor de laranja quando a posição da área de focagem pode ser alterada.

Tópico relacionado
Botões atribuíveis

5-041-957-53(1) Copyright 2022 Sony Corporation
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Mover a moldura da área de focagem através da operação tátil (área de focagem tátil)

Pode alterar a posição da área de focagem, premindo um botão atribuível ao qual tenha sido atribuído [Focus Setting],
para alterar a apresentação da área de focagem para cor de laranja e, em seguida, mover a moldura da área de
focagem, usando a operação tátil no painel de imagem da câmara.
Toque no ecrã para mover a área de focagem, com a área de focagem centrada na posição tocada. Arraste no ecrã para
mover a área de focagem para a posição traçada pelo dedo.

Sugestão

Pode ativar/desativar a área de focagem tátil no ecrã de filmagem, usando um botão atribuível ao qual tenha sido atribuído
[Focus Setting].

Toque em qualquer posição.

A posição tocada torna-se o centro da área de focagem.

1

Arraste para mover a área de focagem, traçando a posição do dedo.2
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Nota

Se tocar numa posição ou arrastar a área de focagem para uma posição que exceda o intervalo de definição, a área de focagem
é definida para a extremidade superior/inferior/esquerda/direita do intervalo de definição.

Esta função não está disponível nas circunstâncias seguintes.

Quando o interruptor [Touch Focus] está desligado no painel de controlo da câmara
Quando a moldura da área de focagem é apresentada a cinzento ou não é apresentada

5-041-957-53(1) Copyright 2022 Sony Corporation
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Ajustar a operação de focagem automática (velocidade de transição AF, sensibilidade
de seguimento do motivo AF)

Pode ajustar a operação de focagem automática alterando a velocidade de transição e a sensibilidade de seguimento do
motivo.

Definir a velocidade de transição AF

Pode definir a velocidade de acionamento da focagem para quando o motivo mudar, usando o botão [AF Transition
Speed] no painel de controlo da câmara.

Selecione a velocidade do intervalo [Speed 1] (Lento) a [Speed 7] (Rápido) em incrementos de 1. Prima o botão < para
diminuir o valor (mais lenta) ou o botão > para aumentar o valor (mais rápida).
Quando definida para baixa velocidade, a focagem move-se lentamente quando o motivo a focar muda, permitindo a
filmagem com uma impressão expressão de imagem.
Quando definida para alta velocidade, a focagem alterna rapidamente entre motivos. No exemplo abaixo, a focagem
muda rapidamente do edifício em segundo plano para a pessoa que caminha em primeiro plano. O motivo que entra na
moldura é imediatamente focado, tornando esta definição ideal para a filmagem de documentários que exige uma
focagem rápida.

Sensibilidade de seguimento do motivo AF

Pode definir a sensibilidade para alterações entre objetos, usando [AF Subj. Shift Sens.] no painel de controlo da
câmara.
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Selecione a sensibilidade do intervalo [Sens 1] (Fixo) a [Sens 5] (Reativo) em incrementos de 1. Prima o botão < para
diminuir o valor (mudança lenta) ou o botão > para aumentar o valor (mudança rápida).
Quando definida para uma sensibilidade baixa, a focagem não segue prontamente se outro motivo se mover para a
frente do motivo focado.

Quando definida para um sensibilidade alta, a focagem muda para dar prioridade ao motivo que se move à frente.

Sugestão

Se [AF Speed/Sens.] for atribuído a um botão atribuível, as barras de nível para ajustar os valores são apresentadas no painel
de imagem da câmara pela seguinte ordem, sempre que prime o botão, permitindo-lhe alterar as definições da velocidade de
transição AF e da sensibilidade de seguimento do motivo AF.
Velocidade de transição AF → Sensibilidade de seguimento do motivo AF → Sem apresentação…

5-041-957-53(1) Copyright 2022 Sony Corporation
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Definir manualmente o alvo de focagem automática (AF Assist) usando a Web App

Depois de mudar e ajustar a focagem manualmente, pode passar o controlo da focagem para focagem manual, para um
ajustamento fino da focagem.

Nota

No estado AF assist, mudar a focagem é difícil, independentemente da definição de [Shooting] > [Focus] > [AF Subj. Shift Sens.]
no menu da câmara.

O estado AF Assist é cancelado pelo seguinte.

Quando o motivo focado através do controlo de deslize [Focus] já não está visível
Ao mudar para focagem manual
Quando o AF de deteção em tempo real é iniciado

Sugestão

O estado AF Assist pode ser rapidamente cancelado, usando um botão atribuível ao qual tenha sido atribuído [Push AF/MF].

O AF de deteção em tempo real para quando o controlo de deslize [Focus] é utilizado.

Defina [Shooting] > [Focus] > [AF Assist] para [On] no menu da câmara.1

Defina [Shooting] > [Focus] > [AF Assist Control] para [On] no menu web.2

Para ativar, deslize o interruptor [Auto Focus] para a direita no painel de controlo da câmara.

É ativado o modo de focagem automática.

3

Defina o alvo da focagem, usando o controlo de deslize [Focus] no painel de controlo da câmara.

[Near]: foca um motivo próximo.
[Far]: foca um motivo distante.

No estado AF Assist, um motivo a distância definido com o controlo de deslize [Focus] será focado de forma
automática.

4
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No modo Face/Eye Only AF, a focagem automática foca o rosto mais próximo da posição de focagem do controlo de deslize
[Focus].

5-041-957-53(1) Copyright 2022 Sony Corporation
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Focar manualmente durante a focagem automática utilizando o controlo remoto de
infravermelhos fornecido

Quando [Shooting] > [Focus] > [AF Assist] está definido para [On] no menu da câmara, pode usar o botão F (Distante) e
o botão N (Próximo) no controlo remoto de infravermelhos fornecido, mesmo durante a focagem automática, para
ajustar a focagem num motivo.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Utilizar temporariamente a focagem manual durante a focagem automática (focagem
manual por seleção)

Prima o botão [Push AF/MF] no modo de focagem automática, para focar manualmente enquanto o botão estiver
premido. A focagem regressa à focagem automática quando solta o botão.
Isto permite-lhe parar temporariamente a focagem automática e focar manualmente quando algo que não o motivo de
filmagem se atravessa à frente do motivo.

Sugestão

A mesma operação é possível usando um botão atribuível ao qual tenha sido atribuído [Push AF/MF].

5-041-957-53(1) Copyright 2022 Sony Corporation
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Deteção através da deteção de rosto e olhos (Face/Eye Detection AF)

O aparelho consegue detetar os rostos e olhos das pessoas como alvo a detetar e, de seguida, ajustar a focagem nos
rostos e olhos na área de focagem.
Quando os rostos são detetados, são apresentadas as molduras de deteção de rosto/olhos. Quando a focagem
automática é possível, as molduras mudam para branco e a deteção é iniciada. Quando são detetados olhos e a
focagem é ajustada, a moldura de deteção de rosto/olhos é apresentada nos olhos. Quando são detetadas várias
pessoas, é automaticamente determinado o motivo principal.
Esta função só está disponível quando o modo de focagem é o modo AF ou durante a focagem automática por seleção.

Sugestão

Quando a área de focagem está definida para [Zone] ou [Flexible Spot] e os rostos ou olhos ficam sobrepostos na área de
focagem especificada, as molduras de deteção de rosto/olhos mudam para branco e o aparelho foca automaticamente nesses
rostos/olhos..

Quando a focagem automática por seleção (AF-S) é utilizada, as molduras de deteção de rosto/olhos para os rostos/olhos que
estão focados mudam para verde.

Definição usando o botão [Face/Eye Detection AF] no painel de controlo da câmara

Prima o botão [Face/Eye Detection AF] e defina a operação AF de deteção de rosto/olhos.

[Face/Eye Only AF]: a câmara deteta os rostos/olhos dos motivos (pessoas) e foca e deteta apenas os rostos/olhos.
Enquanto não for detetado um rosto ou olho, a AF é parada temporariamente e é apresentado o ícone  (Pausa da
focagem automática do modo AF de apenas rosto/olhos). Este modo é eficiente quando pretende focar automaticamente
e detetar apenas os rostos/olhos.
[Face/Eye Priority AF]: a câmara deteta os rostos/olhos dos motivos (pessoas) e dá prioridade à focagem/deteção dos
rostos/olhos. Quando um rosto ou olho não é detetado, a focagem faz-se no modo AF (predefinição).
[AF]: a função AF de deteção de rostos/olhos é desativada.

Nota

Durante o funcionamento com focagem automática por seleção, [Face/Eye Priority AF] é ativado, mesmo se [Face/Eye Only AF]
estiver selecionado.

Quando o interruptor [Auto Focus] está na posição Off, a AF de deteção de rosto/olhos é desativada (exceto durante a operação
de focagem automática por seleção).
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Se desligar a câmara de vídeo enquanto [Face/Eye Only AF] estiver selecionado, o modo muda automaticamente para
[Face/Eye Priority AF] quando a câmara for novamente ligada.

Sugestão

Pode também definir a operação AF de deteção de rosto/olhos usando [Shooting] > [Focus] > [Face/Eye Detection AF] no menu
da câmara.

Ocultar as molduras de deteção de rosto/olhos
Pode mostrar/ocultar as molduras de deteção de rosto/olhos, usando [Monitoring] > [Display On/Off] > [Face/Eye
Detection Frame] no menu da câmara.

Nota

As molduras de deteção de rosto/olhos verdes são apresentadas para rostos e olhos focados através de focagem automática por
seleção (AF-S) e não são ocultadas usando o botão [Display] ou quando [Face/Eye Detection Frame] está definido para [Off].

Alternar a operação AF de deteção de rosto/olhos utilizando um botão atribuível
Atribua [Face/Eye Detection AF] a um botão atribuível. Depois, pode alternar a operação AF de deteção de rosto/olhos
pela ordem [Face/Eye Priority AF], [Face/Eye Only AF] e [AF], de cada vez que premir o botão.

Definir através do menu direto

Pode também definir a operação AF de deteção de rosto/olhos através do menu direto.

Para mais informações sobre o menu direto, consulte “Funcionamento do menu direto”.

Tópico relacionado

Funcionamento do menu direto

5-041-957-53(1) Copyright 2022 Sony Corporation
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Detetar um motivo específico (função AF de deteção em tempo real)

Pode manter a focagem num motivo, especificando o motivo através da operação tátil ou selecionando uma moldura de
deteção de rosto no painel de controlo da câmara.
Quando um motivo for selecionado, será apresentada uma moldura branca de deteção e a deteção terá início.

Sugestão

A deteção ocorre em toda a área da imagem, independentemente da definição da área de focagem.

Quando [Shooting] > [Focus] > [Touch Function in MF] está definido para [Tracking AF] no menu web ou no menu da câmara, é
possível usar a função AF de deteção em tempo real, mesmo com a focagem no modo MF.

As seguintes ações ocorrem para o alvo de deteção, dependendo da definição do modo de operação AF de deteção de
rosto/olhos.

[Face/Eye Only AF] ou [Face/Eye Priority AF]: focar e detetar um motivo específico.
Se o alvo de deteção for uma pessoa e houver uma deteção de rosto/olhos, a câmara foca-se nesse rosto/olhos.
Se houver uma deteção de rosto/olhos, o rosto detetado é guardado. Ao ser guardado, é apresentado um  (ícone de
rosto detetado guardado).

Nota

Se o AF de deteção for iniciado durante o foco manual, o rosto detetado não será guardado.

[AF]: utilize para focar e detetar um motivo específico. A deteção de rosto/olhos não ocorre, mesmo se o alvo de
deteção for uma pessoa.

Nota

A função AF de deteção em tempo real não funciona se a objetiva estiver definida para focagem manual.

Iniciar a função AF de deteção em tempo real

Quando um motivo específico for indicado como alvo de deteção, a deteção desse alvo terá início.

Especificar através da operação tátil
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Deslize o interruptor [Touch Focus] no separador  (Focus) no painel de controlo da câmara para a direita para ativar,
em seguida, toque no motivo pretendido a detetar em qualquer um dos seguintes estados.

Com a focagem manual ou durante a focagem manual por seleção e quando [Shooting] > [Focus] > [Touch Function
in MF] está definido para [Tracking AF] no menu web ou no menu da câmara
Durante a focagem automática ou a focagem automática por seleção (AF)

Especificar através de seleção da moldura de deteção de rosto
Mova o cursor de seleção de rosto (sublinhado cor de laranja) para o motivo pretendido para detetar, usando os botões
de setas no painel de controlo da GUI e, em seguida, prima o botão [Set].

A: molduras de deteção de rosto (cinzento)
B: moldura de deteção
C: cursor de seleção de moldura (cor de laranja)

Nota

Durante a focagem manual, a deteção não pode ser iniciada através da seleção de moldura de deteção de rosto.

Sugestão

Também pode alterar o alvo a detetar durante a deteção em tempo real AF.

Parar a função AF de deteção em tempo real

Prima o botão  (paragem da função AF de deteção em tempo real).

Sugestão

A função AF de deteção em tempo real para nos seguintes casos:

Quando o interruptor [Auto Focus] ou o controlo AUTO/MANUAL da objetiva está ativado
Quando o modo de focagem for alterado
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Quando AF assist é executado
Quando a definição da área de focagem ou a função AF de deteção de rosto/olhos for alterada
Quando um botão atribuível ao qual tenha sido atribuído a [Push AF/MF] é premido
Quando o alvo da deteção não estiver no ecrã ou quando o motivo estiver desfocado durante alguns segundos

Quando um rosto detetado for guardado (quando o (ícone de rosto detetado guardado) for apresentado), a função AF de
deteção em tempo real é retomada quando o rosto detetado guardado entrar na área da imagem. Para eliminar o rosto detetado,
pare a função AF de deteção em tempo real, como acima indicado.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Ecrã de ajuste da luminosidade

Pode ajustar a luminosidade ajustando a íris, ganho, velocidade do obturador e ajustando o nível de luz através de filtros
ND nos seguintes painéis de controlo do ecrã de operações em gravação da Web App. Pode também ajustar
automaticamente a luminosidade.

Nota

O ganho não pode ser ajustado quando [Shooting Mode] está definido para [Cine EI Quick] ou [Cine EI]. Além disso, a
luminosidade não pode ser ajustada automaticamente através da velocidade do obturador quando definida para [Cine EI Quick]
ou [Cine EI]. O ajuste automático da luminosidade através da íris e filtro ND é suportado.

Sugestão

Painel de controlo da câmara – separador  (Main)1.

Painel de configuração básica da câmara
Apresenta o estado da definição nos botões para as funções básicas necessárias para filmagem. Prima um botão
para apresentar o ecrã de configuração correspondente para cada função no painel de ajuste da configuração básica
da câmara abaixo.

2.

Painel de ajuste da configuração básica da câmara
Apresenta o painel de ajuste para o item de configuração selecionado no painel de configuração básica da câmara.

3.
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O modo Cine EI é um modo para filmar com uma sensibilidade de base sem usar o ganho para maximizar o desempenho do
sensor de imagem. A luminosidade é ajustada através de iluminação e do filtro ND para ajustar a quantidade de luz que alcança
o sensor de imagem. Para mais informações sobre Exposure Index (EI), consulte “Alterar a distribuição de áreas escuras e
claras na imagem gravada”.

Tópico relacionado

Alterar a distribuição de áreas escuras e claras na imagem gravada

5-041-957-53(1) Copyright 2022 Sony Corporation
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Definir a sensibilidade de base

Pode definir a sensibilidade de base antes de começar a ajustar a luminosidade.

Quando [Shooting Mode] está definido para [Custom]

Prima o botão [ISO/Gain] no painel de configuração básica da câmara e defina [Base Sensitivity] no painel de ajuste de
ISO/ganho para [High] ou [Low].
Selecione [Low] em condições de iluminação normais e selecione [High] em condições de baixa iluminação.
Ecrã quando [AGC] está desativado

Ecrã quando [AGC] está ativado

Quando [Shooting Mode] está definido para [Flexible ISO] ou [Cine EI]

Prima o botão [Base ISO/Exposure Index] no painel de configuração básica da câmara e defina [Base ISO] no painel de
ajuste Base ISO/Exposure Index para [ISO 12800] ou [ISO 800].
Selecione [ISO 800] em condições de iluminação normais e selecione [ISO 12800] em condições de baixa iluminação.

Sugestão
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Também pode definir isto no separador  (Main) no painel de controlo da câmara.

Também pode definir usando [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] ou [Base ISO] no menu da câmara.

Também pode atribuir [Base ISO/Sensitivity] a um botão atribuível.

No modo de filmagem [Cine EI Quick], a sensibilidade de base é definida automaticamente de acordo com a definição do índice
de exposição.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Definir o nível pretendido para o ajuste automático da luminosidade

O nível pretendido para o ajuste automático da luminosidade é definido usando o controlo de deslize [AE Level] no
painel de controlo da câmara.

5-041-957-53(1) Copyright 2022 Sony Corporation

Prima o separador  (Main) no painel de controlo da câmara.

Se o controlo de deslize [AE Level] não for apresentado, selecione um dos botões de seleção da função do
controlo de deslize e, em seguida, selecione o controlo de deslize [AE Level] a partir da lista.

Surge o controlo de deslize [AE Level].

1

Defina o nível pretendido utilizando o controlo de deslize.

Mova o cursor do controlo de deslize para a esquerda para tornar a imagem mais escura. Mova o cursor do
controlo de deslize para a esquerda para tornar a imagem mais clara.

Sugestão

Também pode definir usando [Shooting] > [Auto Exposure] > [Level] no menu da câmara.

2
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Ajustar automaticamente a íris

Pode ajustar a luminosidade de modo automático, em função do motivo. É necessária uma objetiva compatível.

Nota

A íris não pode ser ajustada automaticamente numa objetiva com encaixe A.

Sugestão

Também pode atribuir [Auto Iris] a um botão atribuível.

5-041-957-53(1) Copyright 2022 Sony Corporation

Se estiver instalada uma objetiva com interruptor Auto Iris, regule o interruptor para AUTO.1

Prima o botão [Iris] no painel de configuração básica da câmara.

A moldura do botão [Iris] muda para cor de laranja.

Surge o painel de ajuste Iris.

2

Deslize o interruptor [Auto] para a direita, para o ligar.

A íris passa para o modo de ajuste automático. O valor de ajuste automático da íris é apresentado no lado direito
do interruptor.

3
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Ajustar manualmente a íris

Pode ajustar a luminosidade manualmente.

Para ajustar temporariamente a íris de forma automática
Também pode premir o botão [Push Auto] no painel de ajuste Iris, para ajustar a íris automaticamente enquanto o botão
estiver premido.

Se estiver instalada uma objetiva com interruptor Auto Iris, regule o interruptor para AUTO.

Nota

Quando o interruptor Auto Iris da objetiva está definido para MANUAL, as funções [Auto Iris] e [Push Auto Iris] no aparelho
não têm efeito. Os ajustes manuais da íris no aparelho também não têm efeito.

1

Prima o botão [Iris] no painel de configuração básica da câmara.

A moldura do botão [Iris] muda para cor de laranja.

Surge o painel de ajuste Iris.

2

Deslize o interruptor [Auto] para a esquerda para desativar.

A íris passa para o modo de ajuste manual.

3

Ajuste a íris usando o controlo de deslize [Iris] ou os botões de ajuste [Iris].

Sugestão

As definições do controlo de deslize e do botão de ajuste estão associadas.

Também pode atribuir a íris ao controlo de deslize no separador  (Main) no painel de controlo da câmara.

4
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Sugestão

Prima um botão atribuível ao qual tenha sido atribuída a função [Push Auto Iris], para ajustar a íris automaticamente enquanto o
botão estiver premido.
A íris regressa ao modo manual quando soltar o botão.

5-041-957-53(1) Copyright 2022 Sony Corporation

204



Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ajustar o ganho automaticamente

Pode ajustar a luminosidade automaticamente, usando a definição de ganho, quando [Shooting Mode] está definido
para [Custom] ou [Flexible ISO].

5-041-957-53(1) Copyright 2022 Sony Corporation

Defina [Project] > [Shooting Mode] para [Custom] no menu web ou no menu da câmara.1

Prima o botão [ISO/Gain] no painel de configuração básica da câmara.

A moldura do botão [ISO/Gain] muda para cor de laranja.

Surge o painel de ajuste ISO/Gain.

2

Deslize o interruptor [AGC] para a direita, para o ligar.

O ganho passa para o modo de ajuste automático. O valor do ganho ajustado automaticamente é apresentado no
lado direito do interruptor.

Sugestão

Também pode realizar a mesma ação, definindo [Shooting] > [Auto Exposure] > [AGC] para [On] no menu da câmara.

Também pode atribuir [AGC] a um botão atribuível.

3
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Ajustar manualmente o ganho

Pode ajustar a luminosidade manualmente, usando a definição de ganho, quando [Shooting Mode] está definido para
[Custom] ou [Flexible ISO].
Pode controlar o ganho quando pretender ajustar a exposição enquanto utiliza uma definição da íris fixa ou quando
pretender impedir um aumento do ganho devido a AGC.

Para ajustar temporariamente a íris de forma manual
Também pode ajustar o ganho temporariamente, atribuindo [ISO/Gain] a um botão de seleção de função do controlo de
deslize no separador  (Main) no painel de controlo da câmara e usando o controlo de deslize.
Isto é útil quando pretender ajustar a exposição um passo sem alterar o campo de visão.
O resultado do ajuste devolve o valor predefinido configurado usando [ISO/Gain<L>], depois de realizadas quaisquer
das operações seguintes:

Defina [Project] > [Shooting Mode] para [Custom] no menu web ou no menu da câmara.1

Prima o botão [ISO/Gain] no painel de configuração básica da câmara.

A moldura do botão [ISO/Gain] muda para cor de laranja.

Surge o painel de ajuste ISO/Gain.

2

Deslize o interruptor [AGC] para a esquerda para desativar.

O ganho passa para o modo de ajuste manual.

3

Ajuste o ganho usando o controlo de deslize [ISO/Gain] ou os botões de ajuste [ISO/Gain].

Sugestão

As definições do controlo de deslize e do botão de ajuste estão associadas.

4
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Mudar os itens de ajuste de ISO/Gain
Mudar a sensibilidade de base
Colocar o interruptor AGC na posição On
Mudar a fonte de alimentação do aparelho para o estado de espera

Para ajustar temporariamente o ganho de forma automática, utilizando um botão atribuível
Prima um botão atribuível ao qual tenha sido atribuída a função [Push AGC], para ajustar o ganho automaticamente
enquanto o botão estiver premido.
O ganho regressa ao modo manual quando soltar o botão.
O resultado do ajuste devolve o valor predefinido configurado usando [ISO/Gain<L>], depois de realizadas quaisquer
das operações seguintes:

Mudar os itens de ajuste de ISO/Gain
Mudar a sensibilidade de base
Colocar o interruptor AGC na posição On
Mudar a fonte de alimentação do aparelho para o estado de espera

Nota

Esta função não pode ser executada quando[Shooting] > [Iris] > [Bokeh Control] está definido para [On] no menu da câmara.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Ajustar o obturador automaticamente

Pode ajustar o obturador automaticamente, como resposta à luminosidade da imagem.

5-041-957-53(1) Copyright 2022 Sony Corporation

Prima o botão [Shutter] no painel de configuração básica da câmara.

A moldura do botão [Shutter] muda para cor de laranja.

Surge o painel de ajuste Shutter.

1

Prima o botão [Shutter Type] e selecione [Auto] a partir da lista.

Sugestão

Também pode realizar a mesma ação, definindo [Shooting] > [Auto Exposure] > [Auto Shutter] para [On] no menu da
câmara.

Também pode atribuir [Auto Shutter] a um botão atribuível.

2

208



Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ajustar o obturador manualmente

Pode ajustar o obturador manualmente.

Prima o botão [Shutter] no painel de configuração básica da câmara.

A moldura do botão [Shutter] muda para cor de laranja.

Surge o painel de ajuste Shutter.

1

Prima o botão [Shutter Type] e selecione [Speed] a partir da lista.2

Ajuste o obturador usando o controlo de deslize [Speed] ou os botões de ajuste [Speed].

Para ajustar o tempo de exposição para corresponder ao intervalo de fotogramas, selecione [Off] no passo 2.
Também pode definir um valor fixo, usando [ECS] (frequência), ou ajustá-lo automaticamente, usando [Auto].
Exemplo: definir através de [ECS] (frequência)

Sugestão

As definições do controlo de deslize e do botão de ajuste estão associadas.

Para usar [Angle] em vez de [Speed] ou [Off], defina [Shooting] > [Shutter] > [Mode] para [Angle] no menu da câmara.

3

209



5-041-957-53(1) Copyright 2022 Sony Corporation

210



Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sobre o filtro ND

Em condições onde a iluminação é muito forte, pode definir a luminosidade adequada alterando o filtro ND.
Ao filmar um motivo bem iluminado, fechar demasiado a íris poderá causar desfocagem devido a difração, produzindo
uma imagem que começa a desfocar (fenómeno típico nas câmaras). Pode eliminar este efeito para obter melhores
resultados de filmagem, utilizando o filtro ND.
O aparelho possui os seguintes modos de filtro ND:
Modo predefinido

Ver “Ajustar no modo predefinido”.

Modo variável (ajuste automático)

Ver “Ajustar automaticamente no modo variável”.

Modo variável (ajuste manual)

Ver “Ajustar manualmente no modo variável”.

Tópico relacionado

Ajustar no modo predefinido

Ajustar automaticamente no modo variável

Ajustar manualmente no modo variável

5-041-957-53(1) Copyright 2022 Sony Corporation
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Ajustar no modo predefinido

Pode selecionar previamente três valores do fator de transmissão do filtro ND e alternar rapidamente entre eles
enquanto filma.

Sugestão

Quando é premido um botão atribuível ao qual tenha sido atribuída a função [ND Filter Position], o filtro ND muda pela sequência
[Clear] → [Preset1] → [Preset2] → [Preset3] → [Clear].

5-041-957-53(1) Copyright 2022 Sony Corporation

Defina [Shooting] > [ND Filter] > [Mode] para [Preset] no menu da câmara.1

Prima o botão [ND Filter] no painel de configuração básica da câmara.

A moldura do botão [ND Filter] muda para cor de laranja.

Surge o painel de ajuste ND Filter.

2

Prima o botão [ND Filter] e selecione um dos seguintes da lista:

[Clear]: sem filtro ND.
[Preset1]: fator de transmissão definido por [Shooting] > [ND Filter] > [Preset1] no menu da câmara.
[Preset2]: fator de transmissão definido por [Shooting] > [ND Filter] > [Preset2] no menu da câmara.
[Preset3]: fator de transmissão definido por [Shooting] > [ND Filter] > [Preset3] no menu da câmara.

Quando selecionar [Preset1] a [Preset3] para o filtro ND, o valor do fator de transmissão é apresentado ao lado do
nome do filtro ND.

3
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Ajustar automaticamente no modo variável

Pode ativar o ajuste de exposição automática, utilizando o filtro ND.

Nota

Quando o filtro ND muda de ou para [Clear] durante a filmagem, a moldura do filtro ND é apresentada na imagem e é emitido um
som de aviso.

Sugestão

Também pode atribuir [Auto ND Filter] a um botão atribuível e premir o botão para alternar entre [Auto] e [Manual].

5-041-957-53(1) Copyright 2022 Sony Corporation

Defina [Shooting] > [ND Filter] > [Mode] para [Variable] no menu da câmara.1

Prima o botão [ND Filter] no painel de configuração básica da câmara.

A moldura do botão [ND Filter] muda para cor de laranja.

Surge o painel de ajuste ND Filter.

2

Prima o botão [ND Filter] e selecione [Auto] a partir da lista.

O valor do fator de transmissão do filtro ND ajustado automaticamente é apresentado ao lado do botão [ND Filter].
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Ajustar manualmente no modo variável

Pode efetuar o ajuste de exposição manual, utilizando o filtro ND.

Para ajustar temporariamente de forma automática
Pode atribuir [Push Auto ND] a um botão atribuível e ligar temporariamente o filtro ND automático enquanto o botão
estiver premido. Soltar o botão desliga novamente o filtro ND automático.
Defina o filtro ND para [Manual].

Nota

Quando o filtro ND muda de ou para [Clear] durante a filmagem, a moldura do filtro ND é apresentada na imagem e é emitido um
som de aviso.

Defina [Shooting] > [ND Filter] > [Mode] para [Variable] no menu da câmara.1

Prima o botão [ND Filter] no painel de configuração básica da câmara.

A moldura do botão [ND Filter] muda para cor de laranja.

Surge o painel de ajuste ND Filter.

2

Prima o botão [ND Filter] e selecione [Manual] a partir da lista.3

Ajuste o fator de transmissão do filtro ND, usando o controlo de deslize [ND Filter] ou os botões de ajuste
[ND Filter].

Sugestão

As definições do controlo de deslize e do botão de ajuste estão associadas.

Também pode ajustar o filtro ND no separador  (Main) no painel de controlo da câmara.

4
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Sugestão

Também pode atribuir [ND Filter Position] a um botão atribuível e premir o botão para alternar entre [Manual] e [Clear].

Também pode premir o botão [Push Auto] no painel de ajuste ND Filter, para ligar o filtro ND automático enquanto o botão estiver
premido.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Ecrã de ajuste do equilíbrio de brancos

Pode ajustar o equilíbrio de brancos utilizando o ecrã de operações em gravação da Web App, para obter um equilíbrio
de brancos que dê um ar mais natural à imagem.

5-041-957-53(1) Copyright 2022 Sony Corporation

Painel de configuração básica da câmara1.

Painel de ajuste da configuração básica da câmara
Apresenta o painel de ajuste para o item de configuração selecionado no painel de configuração básica da câmara.

2.
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Ajustar automaticamente o equilíbrio de brancos

Pode obter um equilíbrio de brancos com ajuste sempre adequado, utilizando ATW (seguimento automático do equilíbrio
de brancos).
Quando ATW está ativo, o equilíbrio de brancos é ajustado automaticamente quando a temperatura de cor da fonte de
luz muda.

Nota

O ATW não pode ser usado quando [Shooting Mode] está definido para [Cine EI] ou [Cine EI Quick].

Poderá não ser possível ajustar a cor adequada através de ATW, dependendo das condições de iluminação e do motivo.
Exemplos:

Quando uma só cor domina o motivo, tal como o céu, mar, solo ou flores.
Quando a temperatura de cor é extremamente alta ou baixa.

Se a velocidade de seguimento automático de ATW for baixa ou o efeito apropriado não puder ser obtido, prima o botão [WB
SET] para executar o equilíbrio de brancos automático.

Sugestão

No modo ATW, pode selecionar a velocidade de resposta a partir de cinco passos (1, 2, 3, 4, 5), usando [Shooting] > [White
Setting] > [ATW Speed] no menu da câmara. Quanto mais baixo o número, maior a velocidade de resposta.

Pode congelar a definição atual do equilíbrio de brancos, atribuindo a função [ATW Hold] a um botão atribuível e premindo esse
botão atribuível para pausar temporariamente o ATW no modo ATW.

5-041-957-53(1) Copyright 2022 Sony Corporation

Prima o botão [White Balance] no painel de configuração básica da câmara.

A moldura do botão [White Balance] muda para cor de laranja.

Surge o painel de ajuste White Balance.

1

Prima o botão [White Mode] e selecione [ATW] a partir da lista.2
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Ajustar manualmente o equilíbrio de brancos

Pode ajustar o equilíbrio de brancos manualmente.

Prima o botão [White Balance] no painel de configuração básica da câmara.

A moldura do botão [White Balance] muda para cor de laranja.

Surge o painel de ajuste White Balance.

1

Prima o botão [White Mode] e selecione um dos seguintes da lista:

[Memory A(T/T)]

[Memory A(R/B)]

[Preset]

2

Ajuste o equilíbrio de brancos utilizando os controlos de deslize ou os botões de ajuste.

Sugestão

As definições do controlo de deslize e do botão de ajuste estão associadas.

A diferença entre [Memory A(T/T)] e [Memory A(R/B)] é que o eixo de ajuste é diferente, mas os resultados de ajuste estão
associados.

Para [Memory A(T/T)]
Este modo ajusta o equilíbrio de brancos guardado na memória A, ajustando a temperatura de cor (Temp) e Tint.
Pode definir a temperatura de cor por incrementos de 20 K, no intervalo de 2000 a 5600 K. Os valores superiores a
5600 K podem ser definidos a intervalos iguais ao valor de alteração de cor (mired), entre 5580 e 5600 K.

3
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Premir o botão [Reset] no lado direito de [Temp] ou [Tint] repõe a definição correspondente para o valor
predefinido.
Para [Memory A(R/B)]
Este modo ajusta o equilíbrio de brancos guardado na memória A, ajustando R Gain e B Gain.
Premir o botão [Reset] repõe a correspondente definição de ganho para o valor predefinido.
Para [Preset]
Este modo ajusta a temperatura de cor para um valor predefinido.
Pode definir o valor em incrementos de 100 K.
No modo predefinido, também pode atribuir [Preset White Select] a um botão atribuível e premir o botão para
alterar para um valor predefinido pré-configurado.
[Custom]: 3200 K → 4300 K → 5600 K → 6300 K → 3200 K….
[Flexible ISO], [Cine EI], [Cine EI Quick]: 3200 K → 4300 K → 5500 K → 3200 K…
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Executar o equilíbrio de brancos automático

No modo de memória A, o equilíbrio de brancos a guardar é ajustado automaticamente.

Prima o botão [White Balance] no painel de configuração básica da câmara.

A moldura do botão [White Balance] muda para cor de laranja.

Surge o painel de ajuste White Balance.

1

Prima o botão [White Mode] e selecione [Memory A(T/T)] ou [Memory A(R/B)] a partir da lista.

[Memory A(T/T)]

[Memory A(R/B)]

2

Coloque papel branco (ou outro objeto) num local com a mesma fonte de iluminação e condições do
motivo, de seguida, faça zoom no papel para mostrar branco no ecrã.

3

Ajuste a luminosidade.

Ajuste a íris, utilizando o procedimento descrito em “Ajustar manualmente a íris”.

4

Prima o botão [WB SET] no painel de ajuste do equilíbrio de brancos.

[Memory A(T/T)]

[Memory A(R/B)]

5
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Nota

Se o ajuste não for bem sucedido, é apresentada uma mensagem de erro no ecrã durante cerca de três segundos. Se a
mensagem de erro persistir após repetidas tentativas para definir o equilíbrio de brancos, contacte o seu representante de
assistência Sony.

Sugestão

Também pode executá-lo no modo ATW. Pode usar isso quando pretender ajustar rapidamente o equilíbrio de brancos durante o
funcionamento em ATW. Após o ajuste, o modo regressa ao funcionamento ATW normal.

Tópico relacionado

Ajustar manualmente a íris

5-041-957-53(1) Copyright 2022 Sony Corporation

Se o equilíbrio de brancos automático for executado no modo de memória, o resultado do ajuste automático é
guardado na memória A.
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Ecrã de configuração de áudio

Pode ajustar o nível de áudio a gravar pelo aparelho no ecrã de operações em gravação da Web App. Configure os
interruptores no bloco de conectores do aparelho e configure o áudio usando o menu da câmara ou menu web.

5-041-957-53(1) Copyright 2022 Sony Corporation

Painel de controlo da câmara – separador  (Audio)1.
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Definir o dispositivo de entrada de áudio

Defina os interruptores seguintes em função do dispositivo ligado ao conector AUDIO IN.

Nota

O áudio não é gravado no modo Interval Rec nem no modo de câmara lenta e movimento rápido.

5-041-957-53(1) Copyright 2022 Sony Corporation

Quando um microfone está ligado, defina o interruptor SETUP 2 no bloco de conectores na traseira do
aparelho.

CH-1 e CH-2 têm definições comuns.

1

Definição Descrição

OFF
(predefinição)

Selecione quando usar um microfone dinâmico ou um microfone alimentado a bateria. Isto
desliga a fonte de alimentação fantasma de +48 V e define a entrada LINE ou MIC como a
fonte de áudio CH-1 e CH-2.

ON
Selecione quando usar um microfone compatível com uma fonte de alimentação fantasma de
+48 V. Isto liga a fonte de alimentação fantasma de +48 V e define o microfone compatível
com uma fonte de alimentação fantasma como a fonte de áudio CH-1 e CH-2.

Defina o tipo de dispositivo ligado, usando [Audio] > [Audio Input] > [AUDIO IN Select] no menu da câmara.2

Selecione a entrada de áudio, usando [Audio] > [Audio Input] > [CH1 Input Select] para [CH4 Input Select]
no menu web ou no menu da câmara.

3
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Ajustar automaticamente o nível de gravação de áudio

Defina o canal para o qual pretende ajustar o nível de gravação de áudio automaticamente para [Auto] na página [Audio]
do menu web, ou definindo [Audio] > [Audio Input] > [CH1 Level Control] para [CH4 Level Control] no menu da câmara.
Os canais especificados para ajuste automático são indicados por um ícone  (Auto) ao lado dos canais
correspondentes no separador  (Audio) do ecrã de operações em gravação.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Ajustar manualmente o nível de gravação de áudio

Pode ajustar a gravação de áudio manualmente.

5-041-957-53(1) Copyright 2022 Sony Corporation

Defina o canal para o qual pretende ajustar o nível de gravação de áudio manualmente para [Manual] na
página [Audio] do menu web, ou defina [Audio] > [Audio Input] > [CH1 Level Control] para [CH4 Level
Control] no menu da câmara.

1

Prima o separador  (Audio) no painel de controlo da câmara.2

No ecrã [Audio], no painel de controlo da câmara, defina o nível de gravação de áudio, usando o controlo
de deslize ou os botões de ajuste para o canal cujo nível de gravação de áudio pretende ajustar
manualmente.

Nota

Os canais para os quais é apresentado o ícone  (Auto) são ajustados automaticamente. As alterações aos valores
usando o controlo de deslize ou os botões não são aplicadas ao áudio gravado.

Sugestão

As definições do controlo de deslize e do botão de ajuste em cada fila estão associadas.

Pode verificar o nível de gravação de áudio em tempo real, utilizando o respetivo medidor de nível no ecrã de filmagem.
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Funcionamento do menu direto

Pode verificar o estado e as definições do aparelho apresentados sobrepostos à imagem da câmara e selecionar e
alterar as definições, utilizando os botões de controlo da GUI no controlo remoto de infravermelhos.
É possível configurar os itens seguintes:
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]
[ND Filter Position]
[Auto ND Filter]
Valor [ND Filter]
[Auto Iris]
Valor [Iris]
[AGC]
Valor [Gain]
Valor [ISO]
[Exposure Index]
[Shutter Type]
[Auto Shutter]
Valor [Shutter]
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] e [Frame Rate]

Sugestão

Também pode realizar esta mesma função usando um botão atribuível e o painel de controlo da GUI da Web App.

Prima um botão atribuível ao qual tenha sido atribuído [Direct Menu] no controlo remoto de infravermelhos.

Por predefinição, o botão [Direct Menu] está atribuído ao botão atribuível 1.
Apenas os itens no ecrã que podem ser configurados através do menu direto são selecionáveis com o cursor cor
de laranja.

1

Desloque o cursor para o item que pretende definir, usando os botões de setas no painel de controlo da
GUI e, em seguida, prima o botão [Set].

É apresentado um menu ou o item é apresentado num fundo branco.

2

Selecione uma definição usando os botões de setas e, em seguida, prima o botão [Set].

O menu ou o fundo branco desaparece e a nova definição é apresentada com um cursor cor de laranja.
Para sair do menu direto, prima novamente o botão atribuível ao qual tenha sido atribuído [Direct Menu] ou
aguarde 3 segundos sem efetuar qualquer ação.
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Botões atribuíveis

Existem dez botões atribuíveis na Web App do aparelho, aos quais pode atribuir funções.
Os botões atribuíveis são apresentados no ecrã de operações em gravação e no ecrã de operações em reprodução.

Nota

A lista dos botões atribuíveis não é apresentada durante a configuração das definições no painel de operações básicas da
câmara do ecrã de operações em gravação. Para terminar a operação, prima o botão [X] no canto superior direito do painel de
ajuste.

As funções seguintes estão atribuídas aos botões por predefinição:
Botão 1: [Direct Menu]
Botão 2: [Focus Setting]
Botão 3: [Rec Review]

Os botões 1 a 3 são equivalentes aos botões com os mesmos números no controlo remoto de infravermelhos
fornecido.

Botão 4: [Push Auto ND]
Botão 5: [Crop Select]
Botão 6: [Marker]
Botão 7: [Video Signal Monitor]
Botão 8: [Clip Flag OK]
Botão 9: [Color Bars]
Botão Focus Hold: [Focus Hold]

O botão Focus Hold é equivalente ao botão Focus Hold numa objetiva com encaixe E.

Para alterar a função de um botão
Use [Project] > [Assignable Button] no menu da câmara.
Quando altera uma atribuição, a apresentação da lista do botão atribuível é alterada.
Para mais informações sobre as funções atribuíveis, consulte “Assignable Button”, em “Menu da câmara e definições
detalhadas”.

Tópico relacionado
Assignable Button
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Câmara lenta e movimento rápido

Quando o formato de gravação está definido para os valores seguintes, pode especificar valores diferentes para a taxa
de fotogramas de filmagem e a taxa de fotogramas de reprodução.
A tabela seguinte mostra as taxas de fotogramas configuráveis.

Frequência do sistema: 59.94/50/29.97/25/23.98; modo de digitalização do sensor de imagem: FF

Frequência do sistema: 59.94/50/29.97/25/23.98; modo de digitalização do sensor de imagem: S35

Frequência do sistema: 24; modo de digitalização do sensor de imagem: FF

Nota

Câmara lenta e movimento rápido não pode ser definido durante a gravação, reprodução ou enquanto o ecrã de miniaturas é
apresentado.

A gravação de áudio não é suportada no modo de câmara lenta e movimento rápido.

As funções de íris automática e de obturador automático estão desativadas no modo de câmara lenta e movimento rápido.

A focagem automática tem as seguintes limitações no modo de câmara lenta e movimento rápido.

Limitações devido ao modelo da objetiva, à frequência do sistema e à taxa de fotogramas de filmagem

Codec Formato de vídeo Taxas de fotogramas configuráveis

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I

4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

Codec Formato de vídeo Taxas de fotogramas configuráveis

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

Codec Formato de vídeo Taxas de fotogramas configuráveis

XAVC-I 4096×2160P 1–60
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A função de focagem automática é temporariamente desativada se a íris estiver definida para F18 ou superior.

Para mais informações sobre a utilização da saída RAW, consulte “Gravar vídeo RAW”.

Tópico relacionado

Gravar vídeo RAW

5-041-957-53(1) Copyright 2022 Sony Corporation

Objetiva Sony Frequência do sistema Disponibilidade de AF

Além de SEL16F28 – Compatibilidade com 7 fps ou superior

SEL16F28

59,94/29,97/23,98 Compatibilidade com 30, 60, 120, 240 fps

50,00/25,00 Compatibilidade com 25, 50, 100, 200 fps

24,00 Não suportado
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Gravar vídeo intermitentemente (Interval Rec)

A função Interval Rec permite-lhe captar vídeo com intervalo de tempo para a memória interna do aparelho. Esta função
é uma forma eficiente de filmar motivos de movimento lento.
Quando inicia a gravação, o aparelho grava automaticamente um número especificado de fotogramas (Number of
Frames) num intervalo de tempo especificado (Interval Time).

A: intervalo de filmagem (Interval Time)
B: número de fotogramas numa só gravação (Number of Frames)

Nota

Apenas uma função de gravação especial, tal como gravação Interval Rec pode ser utilizada a qualquer momento.

Se for ativado outro modo de gravação especial quando Interval Rec está em utilização, Interval Rec é automaticamente
desativado.

O modo Interval Rec é automaticamente desativado após alterar as definições do sistema, tal como o formato de vídeo.

As definições de Interval Rec não podem ser alteradas durante a gravação, ou reprodução ou quando o ecrã de miniaturas é
apresentado.

Limitações durante a gravação
O áudio não é gravado.
Não é possível rever a gravação (Rec Review).

Se o aparelho for desligado durante a gravação
Quando a fonte de alimentação para o aparelho for regulada para o estado de espera, o suporte é acedido durante
vários segundos para gravar as imagens armazenadas na memória até esse momento e, de seguida, a alimentação
passa automaticamente para o estado de espera.
Se o cabo de alimentação DC for desligado, se a alimentação for desligada do adaptador AC ou se a alimentação
PoE++ for desligada, as filmagens efetuadas até esse momento podem ser perdidas (máximo 10 segundos). É
conveniente ter cuidado com estas situações.

Definir o número de fotogramas e o intervalo entre filmagens
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Defina [Project] > [Interval Rec] > [Setting] para [On] no menu web e defina [Number of Frames] e [Interval Time].
O aparelho sai do modo Interval Rec quando é desligado, mas as definições de [Number of Frames] e [Interval Time]
mantêm-se. Não necessita de voltar a definir da próxima vez que filmar no modo Interval Rec.

Sugestão

Também pode definir usando [Project] > [Interval Rec] no menu da câmara.

Começar a filmar

Prima o botão de gravação START/STOP para iniciar a gravação. “Int●Rec” e “Int●Stby” surgem alternadamente.

Parar de filmar

Pare a gravação.
Quando a filmagem termina, os dados do vídeo armazenados na memória até esse ponto são gravados no suporte.
Para sair do modo Interval Rec, efetue uma das seguintes operações:

Mude a fonte de alimentação do aparelho para o estado de espera.
No modo de espera da gravação, defina [Project] > [Interval Rec] > [Setting] para [Off].

Além disso, o modo Interval Rec é automaticamente desativado quando o aparelho é reiniciado.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Gravar imagens em cache (Picture Cache Rec)

A função Picture Cache Rec permite gravar vídeo retroativamente, quando começa uma gravação mantendo uma
memória interna em cache de uma determinada duração durante a filmagem.

Definir o tamanho da cache

Defina [Project] > [Picture Cache Rec] > [Setting] para [On] no menu web e defina o tamanho da cache, usando [Cache
Size].

Nota

O modo Picture Cache Rec não pode ser utilizado em combinação com Interval Rec, gravação simultânea de 2 ranhuras ou
gravação proxy. Se Picture Cache Rec estiver definido para On, estes outros modos de gravação especiais são obrigatoriamente
definidos para Off.

O modo Picture Cache Rec não pode ser selecionado durante a gravação ou se Rec Review estiver a ser executado.

Se Picture Cache Rec estiver definido para On, o código de hora é gravado no modo [Free Run], mesmo que esteja definido
para [Regen] ou [Rec Run].

A definição de [Output Format] pode não ser configurável no modo Picture Cache Rec. Se isso ocorrer, defina temporariamente o
modo Picture Cache Rec para Off, e, em seguida, altere a definição.

Sugestão

O tempo da cache pode ser mais curto, dependendo do formato de gravação. Verifique a hora apresentada em [Project] >
[Picture Cache Rec] > [Cache Rec Time] no menu web.

Também pode definir usando [Project] > [Picture Cache Rec] no menu da câmara.

Pode também alternar [Picture Cache Rec] entre On e Off, usando um botão atribuível.

Iniciar o modo Picture Cache Rec

Quando [Picture Cache Rec] está definido para On, “●Cache” (● é de cor verde) aparece.
Quando premir o botão de gravação START/STOP, a gravação terá início e o vídeo será guardado nos cartões de
memória a partir do vídeo guardado na memória da cache.

Nota

Se alterar o formato de gravação ou o aspeto básico, o vídeo guardado até esse ponto será eliminado da memória da cache e
um novo vídeo será guardado na cache. Como resultado, a gravação da cache de imagens antes da alteração do formato não
será possível, mesmo que a gravação comece de imediato após a alteração do formato.

Definição de [Cache Size] Tempo da cache (aproximado)

[Short] 5 segundos

[Medium] 10 segundos

[Long] 20 segundos

[Max] Valor máximo de cada formato de gravação
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Se o modo Picture Cache Rec for ativado ou desativado imediatamente após inserir um cartão de memória, os dados da cache
podem não ser guardados no cartão.

Os vídeos são guardados na memória da cache quando a função Picture Cache Rec está definida para On. Os vídeos anteriores
à ativação da função para On não são colocados em cache.

Os vídeos não são guardados na memória da cache quando um cartão de memória estiver a ser acedido, como, por exemplo,
em reproduções, Rec Review ou na visualização de miniaturas. A gravação na cache de imagens de vídeos durante este período
não é possível.

Cancelar Picture Cache Rec

Defina [Project] > [Picture Cache Rec] > [Setting] para [Off] no menu web, ou prima um botão atribuível ao qual tenha
sido atribuída a função [Picture Cache Rec].
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Gravar para os cartões de memória A e B em simultâneo (Gravação simultânea em 2
ranhuras)

Pode gravar para os cartões de memória A e B em simultâneo, definindo [Project] > [Simul Rec] > [Setting] para [On] no
menu web ou no menu da câmara.

Gravar separadamente nos cartões de memória A e B

É possível iniciar/parar a gravação de forma independente em cada cartão de memória, usando o botão de gravação
START/STOP ou o botão [2nd Rec START/STOP] no separador  (Others).
Por predefinição, os dois botões iniciam/param simultaneamente as gravações nos cartões de memória A e B.
Quando os botões estão definidos para controlar a gravação em cartões de memória diferentes, o controlo de
iniciar/parar gravação [SDI/HDMI Rec Control] acompanha o estado de gravação da ranhura A.

Alterar a definição

Defina o seguinte, usando [Project] > [Simul Rec] > [Rec Button Set] no menu da câmara.
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Definição de [Rec
Button Set] Botões e cartões de memória

Rec Button:<Slot A>
<Slot B>
2nd Rec Button:
<Slot A> <Slot B>

Inicia/para a gravação nos cartões de memória A e B em simultâneo, utilizando qualquer um
dos botões.

Rec Button:<Slot A>
2nd Rec Button:
<Slot B>

O botão de gravação START/STOP inicia/para a gravação no cartão de memória A e o botão
[2nd Rec START/STOP] no separador  (Others) inicia/para a gravação no cartão de
memória B.

Rec Button:<Slot B>
2nd Rec Button:
<Slot A>

O botão de gravação START/STOP inicia/para a gravação no cartão de memória B e o botão
[2nd Rec START/STOP] no separador  (Others) inicia/para a gravação no cartão de
memória A.
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Monitor do sinal de vídeo

Pode definir o tipo de sinal de vídeo a apresentar no painel de imagem da câmara para forma de onda, vetorescópio ou
histograma, usando [Monitoring] > [Video Signal Monitor] > [Setting] no menu da câmara.
A linha cor de laranja indica os valores definidos de [Level Marker 1] e [Level Marker 2].
Pode também atribuir a função [Video Signal Monitor] a um botão atribuível.

Apresentação do alvo de monitorização
Nos modos de filmagem em Log, a definição da gama de cores ou a informação da definição de LUT do monitor são
apresentadas no canto superior direito do monitor de sinal de vídeo, para indicar o monitor pretendido.
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Indicadores de clips

Pode adicionar um indicador de clip [OK] a um clip, premindo um botão atribuível ao qual tenha sido atribuída a função
[Clip Flag OK] e selecionando [Add OK].
Pode eliminar um indicador de clip [OK], premindo duas vezes o botão e selecionando [Delete Clip Flag].

Sugestão

Também pode adicionar um indicador de clip usando [Thumbnail] > [Set Clip Flag] no menu da câmara.

O ecrã de miniaturas pode ser apresentado ordenado por tipo de indicador de clip (ecrã de miniaturas do clip filtrado). Para mais
pormenores, consulte “Operações em clips gravados”, no “Ecrã de miniaturas”.

Tópico relacionado

Operações em clips gravados
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Compensação de respiração

Pode definir se efetua ou não a compensação de respiração da objetiva, através de [Technical] > [Lens] > [Breathing
Compensation] no menu da câmara.
Esta função corrige o fenómeno que ocorre nas alterações de ângulo da visualização quando a posição da focagem
varia.
Se a compensação de respiração for executada, uma parte da imagem é recortada eletronicamente, para manter um
ângulo de visualização constante e evitar o fenómeno de respiração.

Nota

Se a compensação de respiração for ativada, o ângulo de visualização e a qualidade da imagem podem sofrer ligeiras
alterações.

Dependendo da objetiva, pode não ser possível corrigir a alteração do ângulo de visualização se a compensação de respiração
for ativada.

Não é possível executar a compensação se a objetiva não for compatível com a compensação de respiração.

Esta função é definida para Off (fixa) nos seguintes casos:

Quando [Technical] > [Lens] > [Distortion Comp.] está definido para [Off] no menu da câmara
Quando [Shooting] > [S&Q Motion] > [Setting] está definido para [On] no menu web ou no menu da câmara.
Quando [Project] > [Rec Format] > [Codec] está definido para [RAW] ou [RAW & XAVC-I] no menu web ou no menu da
câmara.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Visão geral da gravação proxy

Esta função permite-lhe gravar dados proxy de baixa resolução, ao mesmo tempo que grava um vídeo de dados
originais de alta resolução.

Para mais informações sobre os cartões de memória compatíveis, a formatação de cartões de memória e a
verificação da capacidade restante, consulte “Cartões de memória compatíveis”, em “Preparar cartões de memória”.

Sobre o ficheiro gravado
A extensão do nome do ficheiro é “.mp4”.
O código de hora também é gravado simultaneamente.

Destino de armazenamento do ficheiro gravado
O ficheiro gravado é armazenado no diretório seguinte.

Sobre o nome do ficheiro
O nome do ficheiro consiste no nome do clip gravado no cartão de memória e num sufixo “S03”.
Para saber mais sobre nomes de clips, consulte [TC/Media] > [Clip Name Format] no menu da câmara.

Tópico relacionado

Cartões de memória compatíveis
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Suporte de gravação Caminho da pasta

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub
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Gravar um proxy

Pode começar a gravar logo que a opção de gravação proxy esteja ativada.

Parar a filmagem
Pare a gravação.

Para definir o canal de áudio para a gravação proxy
Defina o canal de áudio para a gravação de dados proxy, usando [Project] > [Proxy Rec] > [Audio Channel] no menu da
câmara.
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Defina [Project] > [Proxy Rec] > [Setting] para [On] no menu web ou no menu da câmara.1

Insira um cartão de memória numa ranhura para cartões CFexpress Type A/SD.

Nos cartões CFexpress, insira com a etiqueta virada para cima.
Para cartões SD, insira com a etiqueta virada para baixo.

Nota

Proxy Rec não pode ser definido para On ao mesmo tempo que S&Q Motion ou Interval Rec. Quando Proxy Rec é definido
para On, estes outros modos de gravação são obrigatoriamente definidos para Off.

2

Prima o botão START/STOP gravação.

A gravação proxy tem início.

Nota

Se o aparelho for desligado ou se o cartão de memória for removido enquanto estiver a ser acedido, a integridade dos
dados no cartão não pode ser garantida.
Todos os dados gravados no cartão de memória poderão ser eliminados. Certifique-se sempre de que o indicador de
acesso do cartão de memória está apagado antes de desligar o aparelho ou remover o cartão de memória.

Certifique-se de que o cartão de memória não sai ao inseri-lo ou removê-lo.

3
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Visão geral de aspeto

Quando o aparelho está no modo Custom, pode adicionar ajustes ao preto, à matriz e a outros parâmetros, para criar
um “aspeto” baseado no aspeto base.

Pode também selecionar rapidamente um aspeto diferente, guardando combinações diferentes das definições em
ficheiros de cena.
O aparelho é fornecido com um total de sete aspetos predefinidos.
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Selecionar um aspeto

Este tópico descreve como selecionar um aspeto.

Certifique-se de que [Project] > [Base Setting] > [Shooting Mode] está definido para [Custom] no menu web
ou no menu da câmara.

Sugestão

No modo [Custom], o botão [ISO/Gain] e o botão [Scene File] são apresentados no painel de configuração básica da
câmara.

1

Prima o botão [Scene File] no painel de configuração básica da câmara.

A moldura do botão [Scene File] muda para cor de laranja.

Surge o painel de ajuste Scene File.

2

Prima o botão [Scene File] no painel de ajuste e, a partir da lista, selecione um ficheiro de cena com o
aspeto pretendido.

As predefinições seguintes estão configuradas por predefinição:

Sugestão

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]

Ficheiro Scene 1 [S-Cinetone] [HLG Live]

Ficheiro Scene 2 [Standard] [HLG Natural]

Ficheiro Scene 3 [Still] (Não registado)

Ficheiro Scene 4 [ITU709] (Não registado)

Ficheiro Scene 5 [709tone] (Não registado)

Ficheiros Scene 6 a 16 (Não registado) (Não registado)
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Também pode selecionar um aspeto usando [Paint/Look] > [Scene File] > [Recall] no menu da câmara. Também pode
aceder a um aspeto predefinido através de [Scene File] > [Preset Recall].

Nota

A predefinição do ficheiro de cena 5 está definida para [709tone] com a versão de software 2.0 ou posterior. É apresentado
quando [Maintenance] > [Reset] > [Factory Default] no menu web é executado.
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Importar um determinado aspeto base

Pode importar um ficheiro 3D LUT, criado num computador ou noutro dispositivo, como um aspeto base. Podem ser
importados até 16 ficheiros.
Formato do ficheiro: ficheiro CUBE (*.cube) para 3D LUT de 17 ou 33 matrizes criada com Catalyst Browse, RAW
Viewer ou DaVinci Resolve* (por Blackmagic Design Pty. Ltd.).

Gama de cores de entrada/Gama: [S-Gamut3.Cine/S-Log3] ou [S-Gamut3/S-Log3]

Ajustar para subexposição

Verificado com Resolve V9.0, V10.0 e V11.0.*

Guarde o ficheiro 3D LUT no dispositivo que estiver a executar a Web App.1

Abra [Paint/Look] > [Base Look] no menu web.

Surge uma lista de aspetos base registados.

2

Prima o botão [Import] na fila para a qual pretende importar o ficheiro.

Surge a caixa de diálogo para seleção do ficheiro.

3

Selecione o ficheiro 3D LUT preparado.

O ficheiro 3D LUT importado torna-se o aspeto base para o aparelho.

4

Selecione o ficheiro 3D LUT importado, usando [Paint/Look] > [Base Look] > [Select] no menu da câmara.5

Configure [Paint/Look] > [Base Look] > [Input] e [Output] no menu da câmara, de modo a corresponder aos
atributos do ficheiro 3D LUT importado.

6
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Se houver uma tendência para subexposição quando a exposição automática é selecionada ao usar o aspeto base
importado, ajuste o aspeto através de [Paint/Look] > [Base Look] > [AE Level Offset] no menu web.

Nota

A simples importação de um ficheiro 3D LUT não afeta a imagem. Carregue o ficheiro 3D LUT importado, usando [Paint/Look] >
[Base Look] > [Select] no menu da câmara.

Se [Input] não for definido corretamente, não será obtido o aspeto certo.

As definições dos itens de menu [Input], [Output] e [AE Level Offset] são aplicadas ao aspeto base, usando [Select]. Se forem
importados vários ficheiros 3D LUT, selecione cada ficheiro 3D LUT usando [Select] e configure [Input], [Output] e [AE Level
Offset] individualmente para cada ficheiro.

As definições configuradas [Input], [Output] e [AE Level Offset] são guardadas para cada ficheiro 3D LUT.

As opções de seleção do aspeto base/LUT para os ficheiros 3D LUT importados são comuns a [SDR(BT.709)], [HDR(HLG)] e
aos modos de filmagem em Log, mas as conversões da gama de cores e de gama não são efetuadas segundo esses modos.

Os ficheiros 3D LUT não são eliminados quando [Maintenance] > [Reset] > [All Reset (except for Network Settings)] é executado
no menu web.

Um  (erro ao anexar ficheiro 3D LUT) apresentado à frente do ecrã [Base Look Name] indica que os ficheiros 3D LUT não
podem ser anexados aos clips gravados nos modos de filmagem em Log. Importe novamente o ficheiro 3D LUT.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Personalizar um aspeto

Pode personalizar o aspeto com base no aspeto base, usando os controlos de deslize [Master Black], [R Black] e [B
Black] no painel de ajuste Scene File, no painel de configuração básica da câmara, e [Paint/Look] > [Matrix] e outros
itens de configuração no menu da câmara.
Ligue o aparelho a um televisor ou monitor e ajuste a qualidade de imagem, enquanto observa a imagem no televisor ou
monitor.

1: controlo de deslize/botões de ajuste [R Black]
2: controlo de deslize/botões de ajuste [B Black]
3: controlo de deslize/botões de ajuste [Master Black]

Nota

Quando importa um ficheiro 3D LUT e o aplica à imagem, o aspeto pretendido definido no ficheiro 3D LUT não será obtido, se
[Paint/Look] > [Matrix] e as outras definições além das referentes ao aspeto base no menu da câmara forem alteradas.

Também pode repor todas as definições personalizadas, usando [Paint/Look] > [Reset Paint Settings] > [Reset without Base
Look] no menu da câmara.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Guardar um aspeto

Pode guardar o aspeto atual como ficheiro de cena na memória interna, usando [Paint/Look] > [Scene File] > [Store] no
menu da câmara.
Pode aceder rapidamente a um aspeto guardado, usando o painel de ajuste Scene File ou através de operações do
menu direto.

Nota

Se selecionar outro aspeto sem guardar o aspeto atual, o aspeto atual é eliminado.

Sugestão

Pode substituir os ficheiros de cena predefinidos. Para repor um ficheiro de cena predefinido, carregue o aspeto a repor, usando
[Paint/Look] > [Scene File] > [Preset Recall] no menu da câmara e, em seguida, guarde o ficheiro de cena, usando [Scene File] >
[Store].

Para eliminar um aspeto guardado
Pode eliminar um ficheiro de cena guardado na memória interna, usando [Paint/Look] > [Scene File] > [Delete] no menu
da câmara.

Sugestão

Depois de eliminado, esse ficheiro deixa de ser apresentado no painel de ajuste Scene File ou no menu direto.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Eliminar um aspeto base

Pode eliminar individualmente os ficheiros 3D LUT importados, usando [Paint/Look] > [Base Look] > [Delete] no menu da
câmara.
Pode eliminar todos os ficheiros 3D LUT importados, usando [Paint/Look] > [Base Look] > [Delete All] no menu da
câmara.

Nota

Antes de eliminar, certifique-se de que o aspeto base não está a ser utilizado em algum ficheiro de cena. Se for eliminado um
aspeto base que está a ser utilizado, o aspeto dos ficheiros de cena correspondentes será incorreto.

Os ficheiros 3D LUT importados não são eliminados quando [Maintenance] > [Reset] > [All Reset (except for Network Settings)] é
executado no menu web.

Um aspeto base eliminado deixa de poder ser utilizado como uma LUT no modo de filmagem em Log.
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Filmar com ajuste de aspeto na pós-produção

Ao utilizar o aparelho nos modos de filmagem em Log*1 e gravar as gradações de modo uniforme das áreas escuras
para as áreas claras, pode efetuar ajustes finos, tais como repor localmente as gradações das áreas escuras e das
áreas claras, na pós-produção.
No entanto, ao visualizar as imagens gravadas num monitor convencional, o contraste geral vai parecer baixo, tornando
a focagem e os ajustes da exposição difíceis.
Pode aplicar uma LUT ao monitor pretendido no aparelho, para auxiliar vários ajustes durante a filmagem. Também pode
aplicar a LUT utilizada ao filmar automaticamente na reprodução para verificar rapidamente o resultado final.
As LUT são aplicadas pelos sistemas seguintes. No entanto, apenas uma LUT pode ser aplicada.

Entrada SDI
Saída e transmissão HDMI
Clip proxy gravado no suporte de gravação
Clip de alta resolução (principal) gravado no suporte de gravação
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* Termo genérico para o modo Flexible ISO/modo Cine EI/modo Cine EI Quick1

250



Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Aplicar uma LUT à saída HDMI e à transmissão

Pode aplicar uma LUT à saída HDMI e à transmissão.

Nota

A imagem no painel de imagem da câmara na Web App também é incluída na imagem de transmissão.

Sugestão

Isto também pode definir usando [Shooting] > [LUT On/Off] > [HDMI/Stream] no menu da câmara.

A saída SDI pode ser definida da mesma forma.

Para vídeo no suporte de gravação, pode definir isto usando [Shooting] > [LUT On/Off] > [Internal Rec] e [Proxy] no menu da
câmara.

Um  (erro ao anexar ficheiro 3D LUT) apresentado à frente do ecrã [Base Look/LUT] indica que os ficheiros 3D LUT não
podem ser anexados aos clips gravados nos modos de filmagem em Log. Importe novamente o ficheiro 3D LUT.
Este ícone também é apresentado quando a ação de anexar falha devido a um congestionamento temporário do processamento.

Certifique-se de que [Project] > [Base Setting] > [Shooting Mode] está definido para [Flexible ISO], [Cine EI]
ou [Cine EI Quick] no menu web ou no menu da câmara.

Sugestão

Nos modos de filmagem em Log, o botão [Base ISO/Exposure Index] e o botão [Base Look/LUT] são apresentados no
painel de configuração básica da câmara.

1

Prima o botão [Base Look/LUT] no painel de configuração básica da câmara.

A moldura do botão [Base Look/LUT] muda para cor de laranja.

Surge o painel de ajuste Base Look/LUT.

2

Selecione [HDMI/Stream] > [MLUT].3
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Alterar uma LUT

Pode alterar a LUT que pretende aplicar.

Sugestão

O aparelho disponibiliza [s709], [709(800%)] e [S-Log3] como LUT predefinidas.

Pode também importar e aplicar um ficheiro 3D LUT. Para mais pormenores, consulte “Importar um determinado aspeto base” e
“Eliminar um aspeto base”.

Isto também pode definir usando [Paint/Look] > [Base Look] > [Select] no menu da câmara.

Tópico relacionado
Importar um determinado aspeto base

Eliminar um aspeto base
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Prima o botão [Base Look/LUT] no painel de configuração básica da câmara.

A moldura do botão [Base Look/LUT] muda para cor de laranja.

Surge o painel de ajuste Base Look/LUT.

1

Prima o botão [Base Look/LUT] e selecione o aspeto base a aplicar.2
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Alterar a distribuição de áreas escuras e claras na imagem gravada

Nos modos Cine EI e Cine EI Quick, pode alterar a distribuição de áreas escuras e áreas claras se, por exemplo,
pretender dar prioridade ao tom das áreas escuras sobre as áreas claras, alterando Exposure Index a partir da
sensibilidade de base.

Prima o botão [Base Look/LUT] no painel de configuração básica da câmara.

A moldura do botão [Base Look/LUT] muda para cor de laranja.

Surge o painel de ajuste Base Look/LUT.

1

Selecione [HDMI/Stream] > [MLUT].

Uma LUT é aplicada à saída HDMI e à transmissão.

2

Prima o botão [Base ISO/Exposure Index] no painel de configuração básica da câmara.

A moldura do botão [Base ISO/Exposure Index] muda para cor de laranja.

Surge o painel de ajuste Base ISO/Exposure Index.

3

Ajuste o índice de exposição em função da distribuição pretendida de áreas escuras e claras, usando o
controlo de deslize [Exposure Index] ou os botões de ajuste [Exposure Index].

Para [Cine EI]

Para [Cine EI Quick]
A sensibilidade de base é definida automaticamente de acordo com o índice de exposição especificado.

4
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Sugestão

Isto também pode definir usando [Shooting] > [ISO/Gain/EI] > [Exposure Index] no menu da câmara.

A saída SDI pode ser usada da mesma forma.

O segundo valor numérico da definição indica quantos passos da informação de luminosidade são atribuídos para áreas claras
(luminosidade superior a 18% de cinzento). As áreas mais claras do que estas estão demasiado expostas.
Exemplo: em “400EI/5.0E,” são atribuídos 5,0 passos no lado claro.

Pode também utilizar isto como um guia para verificar o tom das áreas escuras e claras durante a filmagem. Não se esqueça de
regressar ao valor EI original após verificar a exposição. Além disso, no modo Cine EI Quick, tenha cuidado para não afetar
negativamente a sensibilidade de base.

5-041-957-53(1) Copyright 2022 Sony Corporation

Ajuste a iluminação e/ou o filtro ND, de modo a que a saída de imagem da câmara a partir de [HDMI/Stream]
tenha a exposição adequada.

5
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Gravar vídeo RAW

Pode gravar a saída do sinal de vídeo RAW a partir do conector SDI OUT do aparelho para um gravador externo
compatível.
Os formatos de saída RAW suportados são mostrados abaixo.

Frequência do sistema [Codec] [RAW Output Format]

59.94 / 50 / 29.97 / 25 / 23.98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

Ligue um gravador RAW externo ao conector SDI OUT do aparelho.1

Defina [Project] > [Base Setting] > [Shooting Mode] para [Cine EI], [Cine EI Quick] ou [Flexible ISO] no menu
web ou menu da câmara.

2

Defina o ângulo de visualização (Apenas FF), usando [Project] > [Rec Format] > [Imager Scan Mode] no
menu web ou no menu da câmara.

3

Defina [Project] > [Rec Format] > [Codec] para [RAW] no menu web ou no menu da câmara.

Ao selecionar [RAW & XAVC-I], irá gravar simultaneamente vídeo para o gravador RAW externo e vídeo para os
cartões de memória no aparelho.

4

Defina a resolução, usando [Project] > [Rec Format] > [RAW Output Format] no menu web ou no menu da
câmara.

5

Certifique-se de que o gravador externo está ligado e, de seguida, prima o botão START/STOP gravação no
ecrã de operações em gravação.

O estado da gravação de vídeo RAW é indicado por um ícone no painel de imagem da câmara.

6
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Nota

Quando a gravação é iniciada num gravador externo, sem utilizar o botão START/STOP gravação no ecrã de operações em
gravação, os clips poderão não ser gravados corretamente.

5-041-957-53(1) Copyright 2022 Sony Corporation

Nota

O sinal de controlo da gravação é emitido a partir do conector SDI OUT do aparelho, mas não é possível obter o estado do
gravador externo. Do mesmo modo, o aparelho poderá indicar que uma gravação de vídeo RAW está em curso quando o
gravador externo não está, de facto, a gravar. Verifique o indicador no gravador externo para obter o estado de
funcionamento correto.
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Gravar vídeo RAW no modo de câmara lenta e movimento rápido

Pode gravar vídeo RAW no modo de câmara lenta e movimento rápido.

Para mais informações sobre as taxas de fotogramas suportadas para a filmagem, consulte “Câmara lenta e
movimento rápido”.

Tópico relacionado
Câmara lenta e movimento rápido
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Ativar/desativar a função de controlo de bokeh

Pode ajustar o nível de bokeh facilmente, associando o filtro ND e o ganho à operação da íris.

Ativar/desativar a função de controlo de bokeh

Esta função apenas pode ser ativada quando ajustar a exposição manualmente. Defina o filtro ND para o modo variável
e, de seguida, defina a íris, o ganho, o obturador e o filtro ND para ajuste manual.
Pode alternar entre ativar e desativar a função de controlo de bokeh, usando [Shooting] > [Iris] > [Bokeh Control] no
menu da câmara.
Quando a função de controlo de bokeh estiver definida para On, é apresentado um ícone  (B) nos indicadores de filtro
ND e de ganho.

Nota

Esta função apenas é ativada em objetivas com encaixe E com capacidade de comunicação com o aparelho.

O efeito máximo desta função pode ser obtido utilizando uma objetiva com encaixe E da Sony.

A função de controlo de bokeh é definida para Off se for executada uma das seguintes operações:

Se o aparelho estiver desligado
Se a íris, o ganho, o obturador ou o filtro ND estiver definido para Auto
Se o modo de filmagem for alterado
Se o filtro ND estiver modo Limpar ou Predefinido
Se a objetiva for removida
Se o aparelho for reiniciado, por exemplo após alterar a frequência

Sugestão

Também pode atribuir a função [Bokeh Control] a um botão atribuível e alternar a função de controlo de bokeh entre On e Off,
usando o botão.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Ajustar o nível de bokeh

Ajuste as definições nos passos 2 a 4, conforme necessário.

Nota

A aparência pode variar dependendo da velocidade da operação, objetiva, definições de filmagem e motivo, e o brilho também
pode ser alterado. Recomendamos que faça um teste antes de filmar.

O brilho pode ser alterado se a direção da operação da íris for alterada, tal como a abertura da íris após ser encerrada ou
quando a íris for encerrada após a abertura. Neste caso, ajuste um pouco mais do que o necessário e dê alguns passos para
trás, verifique o brilho e comece a filmar. Por exemplo, se quiser abrir a íris com uma abertura F8 e quiser desfocar o fundo,
primeiro feche a abertura após F8 e volte a F8, verifique o brilho e comece a filmar.

Efetue lentamente as operações de controlo de bokeh. Se precisar de acelerar a operação, experimente ajustar gradualmente
enquanto verifica as alterações da imagem.

Sugestão

Quando a função de controlo de bokeh está definida para On, o filtro ND e o ganho operam em conjunto para desviar as
alterações de exposição devidas ao ajuste da íris, permitindo-lhe alterar o nível de bokeh.

O controlo de bokeh está associado ao filtro ND em resposta à operação íris. Quando o filtro ND já não puder ser alterado, o
ganho estará associado.

No modo MF, recomendamos que primeiro abra a íris e depois ajuste a focagem.

Se usar o filtro ND automático da função de controlo de bokeh, o filtro ND segue as alterações ao brilho do motivo.

Apresentar durante a operação de ligação de ganho
Quando a função de controlo de bokeh está definida para On, o ganho poderá ser alterado quando a íris for ajustada.
Quando a ligação do ganho estiver ativa e o ganho for alterado, surge uma mensagem no topo do ecrã e o ícone  (B)
no indicador de ganho fica intermitente.

Defina a função de controlo de bokeh para On.1

Abra totalmente a íris.2

Defina o filtro ND para 1/128.3

Defina o ganho para 0 dB e utilize a iluminação para obter a exposição correta.4

Ajuste a focagem.5

Ajuste a íris.

O nível de bokeh é alterado.

6
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Visão geral sobre guardar e carregar dados de configuração

Pode guardar as definições do aparelho como dados de configuração, através da Web App. Isso permite-lhe aceder
rapidamente ao conjunto adequado de definições de menu para a situação atual.
Com este aparelho, pode guardar quase todas as definições relacionadas com as funções da câmara, com a exceção
da nota seguinte, como um ficheiro ALL (ficheiro com todas as definições).

Nota

As definições da função de rede e a informação de autenticação não são guardadas. Para mais pormenores sobre os itens
guardados, consulte “Lista de itens de menu”.

Tópico relacionado

Lista de itens de menu
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Guardar um ficheiro ALL

Este tópico descreve como guardar um ficheiro ALL.
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Abra [Project] > [All File] no menu web.1

Prima o botão [Save All File] > [Save].

O browser da web transferirá momentaneamente um ficheiro denominado all-file.ALL.

2

Especifique um local e um nome de ficheiro para o ficheiro all-file.ALL transferido e, em seguida, guarde o
ficheiro.

Para mais informações sobre operações com ficheiros, consulte o manual de instruções do seu dispositivo.

3
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Carregar um ficheiro ALL

Este tópico descreve como carregar um ficheiro ALL.

Nota

O aparelho vai reiniciar automaticamente após carregar dados de configuração. Após reiniciar, recarregue a página no browser
da web.
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Abra [Project] > [All File] no menu web.1

Prima o botão [Load All File] > [Load].

Surge a caixa de diálogo para abrir ficheiros no dispositivo que estiver a executar a Web App.

2

Abra o ficheiro que pretende carregar.

Para mais informações sobre operações com ficheiros, consulte o manual de instruções do seu dispositivo.

3

Quando surgir o ecrã para confirmação do nome do ficheiro carregado, prima o botão [OK].4

Quando surgir o ecrã com o resultado da execução, prima o botão [OK].5

Aguarde que o aparelho reinicie e, de seguida, volte a ligar a Web App.6
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Sobre a transferência de ficheiros

Pode carregar um ficheiro proxy ou um ficheiro original gravado no aparelho para um servidor na internet ou um servidor
numa rede local.

Nota

Quando a fonte de alimentação é definida para o estado de espera, as transferências de ficheiros são colocadas em espera,
apesar de o aparelho continuar ligado.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Inserir um destino para a transferência de um ficheiro

Pode inserir um servidor de destino para a transferência, antes de iniciar a transferência do ficheiro.

Selecione [Network] > [File Transfer] > [Default Upload Server] > [Server Settings1] (ou [Server Settings2],
[Server Settings3]) no menu web.

Sugestão

O nome da opção selecionada irá mudar, em função de [Display Name] configurado no passo seguinte.

1

Configure os itens seguintes para [Network] > [FTP Server 1] a [FTP Server 3] no menu web.

[Display Name]
Insira o nome do servidor a apresentar na lista da tarefa de transferência quando selecionar um servidor de destino
para a transferência.
[Service]
Apresenta o tipo de servidor.
[FTP]: servidor FTP
[Host Name]
Insira o endereço ou o nome de anfitrião do servidor.
[Port]
Insira o número da porta do servidor a ligar.
[User Name]
Insira o nome do utilizador.
[Password]
Insira a palavra-passe.
[Passive Mode]
Ative/desative o modo passivo.
[Destination Directory]
Insira o nome do diretório no servidor de destino.

Nota

Se forem inseridos carateres inválidos no servidor de destino em [Destination Directory], os ficheiros serão transferidos
para o diretório de base do utilizador. Os carateres inválidos variam consoante o servidor.

[Using Secure Protocol]
Defina se pretende efetuar um carregamento FTP seguro.
[Root Certificate]
Carregue/apague um certificado.
[Load]: carregue um certificado CA. Carrega certificados em formato PEM.
[Clear]: elimine o certificado CA.
[None]: não carregue nem apague um certificado.

Nota

Ajuste o relógio do aparelho para a hora certa antes de importar um certificado CA.

Ao gravar em XAVC-I 4096×2160P/3840×2160P 59.94/50P, não é possível selecionar [Load].

2
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[Root Certificate Status]: apresenta o estado de carregamento do certificado.
[Reset]: repõe as definições de Server Settings para as predefinições.
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Carregar um ficheiro proxy num cartão de memória a partir do ecrã de miniaturas

Pode carregar um ficheiro proxy num cartão de memória a partir do ecrã de miniaturas.

Nota

Podem ser importadas até 200 tarefas de transferência.

5-041-957-53(1) Copyright 2022 Sony Corporation

Prima o botão [Thumbnail] no ecrã de operações em gravação da Web App.

O visor muda da imagem da câmara para o ecrã de miniaturas.

1

Selecione [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip] no menu da câmara.

Para transferir todos os ficheiros proxy simultaneamente, selecione [Transfer Clip (Proxy)] > [All Clips].
Os clips podem ser transferidos do ecrã de miniaturas ou do ecrã de miniaturas do clip filtrado.

2

Selecione o clip que pretende transferir, usando o botão [Set] e, em seguida, prima o botão [Menu].

Aparece um ecrã de confirmação de transferência.

3

Selecione [Execute].

O ficheiro proxy correspondente ao clip selecionado é registado como uma tarefa de transferência e o
carregamento tem início.
Quando a tarefa de transferência é registada com sucesso, aparece o ecrã de resultado da transferência.

4

Prima o botão [OK].5
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Carregar um ficheiro original num cartão de memória a partir do ecrã de miniaturas

Pode carregar um ficheiro original num cartão de memória a partir do ecrã de miniaturas.

Nota

Podem ser importadas até 200 tarefas de transferência.
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Prima o botão [Thumbnail] no ecrã de operações em gravação da Web App.

O visor muda da imagem da câmara para o ecrã de miniaturas.

1

Selecione [Thumbnail] > [Transfer Clip] > [Select Clip] no menu da câmara.

Para transferir todos os ficheiros originais simultaneamente, selecione [Transfer Clip] > [All Clips].
Os clips podem ser transferidos do ecrã de miniaturas ou do ecrã de miniaturas do clip filtrado.

2

Selecione o clip que pretende transferir, usando o botão [Set] e, em seguida, prima o botão [Menu].

Aparece um ecrã de confirmação de transferência.

3

Selecione [Execute].

O ficheiro original correspondente ao clip selecionado é registado como uma tarefa de transferência e o
carregamento tem início.
Quando a tarefa de transferência é registada com sucesso, aparece o ecrã de resultado da transferência.

4

Prima o botão [OK].5
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Verificar o estado da transferência de um ficheiro

Pode verificar o estado da transferência de um ficheiro, selecionando [Network] > [File Transfer] > [View Job List] no
menu da câmara.

Nota

Podem ser importadas até 200 tarefas de transferência.

As tarefas de transferência são retidas quando o aparelho é colocado no estado de espera, mas podem ser perdidos até 10
minutos de informação sobre o progresso recente se a alimentação for desligada por quaisquer outros meios.

Se ocorrer um erro durante a transferência de ficheiro, a transferência de um clip com o mesmo nome de um clip transferido
poderá não ser retomada dependendo das definições e do estado do servidor de destino da transferência. Neste caso, verifique
as definições e o estado do servidor de destino da transferência.

Sugestão

Se [Network] > [File Transfer] > [Auto Upload (Proxy)] estiver definido para [On] no menu da câmara e houver uma ligação de
rede, os ficheiros proxy são automaticamente carregados para o servidor especificado, usando [Default Upload Server] quando a
gravação terminar.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Carregar através de um FTP seguro

Pode carregar ficheiros com encriptação através de FTPS no modo Explicit (FTPES) para a ligação ao servidor de
ficheiros de destino.
Para uma transferência FTP segura, defina [Using Secure Protocol] para [On] nas definições do servidor de ficheiros de
destino e carregue um certificado.

Para mais pormenores sobre a configuração, consulte “Inserir um destino para a transferência de um ficheiro”.

Tópico relacionado

Inserir um destino para a transferência de um ficheiro
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Sobre a transmissão

O aparelho pode transmitir, em simultâneo, o vídeo e o áudio que sai através do conector HDMI.

Nota

Para usar a transmissão como vídeo principal, defina [Monitoring] > [Output Display] > [SDI] para [On] e [HDMI/Stream] para [Off]
no menu web, e monitorize o estado da câmara num monitor SDI.

Se o monitor ligado ao conector HDMI não for compatível com o formato de saída HDMI configurado através do menu
[Monitoring], no menu web ou no menu da câmara, a imagem da câmara não será apresentada na Web App. O vídeo da
transmissão também não pode ser emitido.

A resolução da transmissão não pode ser definida como superior à resolução do sinal de saída HDMI.

Quando é visualizada por vários utilizadores, a imagem pode ficar distorcida, dependendo das definições do codec.

O aparelho suporta os seguintes métodos de transmissão. Os codecs de vídeo disponíveis para seleção são
apresentados entre parênteses.

RTSP (H.264, H.265)
RTMP (H.264)*1

SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Configure a definição do formato de transmissão, a definição do codec de vídeo e a definição do codec de áudio por
esta ordem.

●: Enabled, –: Disabled

Sugestão

A imagem no painel de imagem da câmara na Web App é também um sistema de transmissão.

Formato de transmissão
Definição de codec

Video Stream 1 Video Stream 2 Video Stream 3 Audio Stream

RTSP
●
video 1

●*2

vídeo 2
– ●

RTMP ● – – ●*1

SRT ● – – ●

NDI|HX
●
Main

●
Sub

– ●

Web App – – ● –

RTMP pode ser selecionado quando [Stream] > [Audio Stream] está definido para [On] no menu web.*1

Quando a frequência do sistema é 59.94 ou 50 e o formato de saída HDMI é 3840×2160 ou superior, a saída de vídeo 2 não está disponível.*2
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Definir o formato para transmissão

Defina o formato de transmissão, usando [Stream] > [Stream] > [Stream Setting] > [Setting] no menu web.

Quando [Setting] está definido para [RTSP]

Na transmissão RTSP, a imagem de uma única câmara pode ser visualizada simultaneamente por até cinco utilizadores.
Pode definir até dois modos de codec de vídeo.
[Port Number]
Define o número da porta a utilizar para a transmissão RTSP. O valor predefinido é 554.
A alteração da definição faz reiniciar o servidor RTSP.
[Time Out]
Especifica o limite de tempo do comando Keep-Alive para a transmissão RTSP. O limite de tempo pode ser definido no
intervalo entre 0 e 600 segundos. O valor predefinido é 60 segundos.
Quando definido para 0 segundos, o imite de tempo devido ao comando Keep-Alive não acontece.
[Authentication]
Define se é necessária autenticação.
[Video Port Number 1], [Video Port Number 2]
Especifica o número da porta para comunicações de dados de imagem a usar para a transmissão de RTSP unidifusão.
O valor predefinido para Video Port Number 1 é 51000. O valor predefinido para Video Port Number 2 é 53000.
Especifica um número par no intervalo entre 1024 e 65534. O número definido aqui e o número ímpar subsequente,
obtido pela adição de 1, tornam-se os dois números das portas usadas para as comunicações e o controlo de dados de
imagem.
[Video Port Number 1] e [Video Port Number 2] correspondem a [Stream] > [Video Stream] > [Video Stream 1] e [Video
Stream 2].
[Audio Port Number]
Especifica o número da porta para comunicações de dados de áudio a usar para a transmissão de RTSP unidifusão. O
valor predefinido é 57000. Especifica um número par no intervalo entre 1024 e 65534. O número definido aqui e o
número ímpar subsequente, obtido pela adição de 1, tornam-se os dois números das portas usadas para as
comunicações e o controlo de dados de áudio.

Quando [Setting] está definido para [RTMP]

O único modo de codec de vídeo que pode ser usado para RTMP é H.264. Para utilizar RTMP, [Stream] > [Audio
Stream] tem ser definido para [On] no menu web.
[Server URL]
Define o URL de destino do carregamento. Especifique uma cadeia de caracteres que comece por “rtmp://” ou “rtmps://”.
[Stream Key]
Introduza a chave de transmissão obtida no site que está a utilizar. Premir o botão [Clear] irá apagar a introdução.

Nota

Tenha cuidado ao utilizar a chave de transmissão. Se a chave de transmissão for conhecida por terceiros, existe o risco de
falsificação da transmissão.

[Root Certificate]
Importa o certificado de raiz necessário para a transmissão através do protocolo RTMPS. Para importar o certificado de
raiz, prima o botão [Load] e selecione um certificado de raiz. Prima o botão [OK] na caixa de diálogo para seleção do
ficheiro para importar o ficheiro selecionado para o aparelho. Se existir um certificado de raiz importado no aparelho, o
certificado de raiz será atualizado. Para eliminar um certificado de raiz importado, prima o botão [Delete] no ecrã de
configuração. O estado do certificado de raiz é apresentado em [Root Certificate Status].
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Nota

Importe o certificado de raiz exigido pelo serviço de transmissão.

Quando [Setting] está definido para [SRT-Caller] ou [SRT-Listener]

O modo de codec de vídeo é apenas H.264.
[Destination]
Apresentado quando o modo de transmissão está definido para [SRT-Caller]. Define o URL de destino da ligação.
[Port Number]
Apresentado quando o modo de transmissão está definido para [SRT-Listener]. Define o número da porta para ouvir. O
valor predefinido é 4201.
[Latency]
Define a latência, no intervalo entre 20 e 8000 ms. O valor predefinido é 120.
[TTL]
Define o valor de TTL, no intervalo entre 1 e 255. O valor predefinido é 64.
[Encryption]
Seleciona o método de encriptação. Selecione Off, AES128 ou AES256. O valor predefinido é Off.
[Passphrase]
Define a frase-passe usada para a encriptação. Se premir o botão [Clear], a frase-passe configurada será reposta.
[ARC]
Para ativar a função Adaptive Rate Control, defina para On.
Quando a função Adaptive Rate Control está ativada, é possível reduzir as interrupções na imagem causadas pelo
congestionamento da linha de comunicação.

Quando [Setting] está definido para [NDI|HX]

O aparelho está em conformidade com NDI|HX versão 2, da NewTek.
Para usar NDI|HX, é necessário adquirir uma chave de licença.
Adquirir uma chave de licença
Adquirir no seguinte URL da NewTek:
https://www.newtek.com/ndihx/products/upgrade/

Nota

Transfira o controlador NDI|HX mais recente e instale-o num produto NewTek.

Para mais pormenores sobre o registo e a utilização de NDI|HX, consulte o manual de instruções do produto NewTek.

[License]
Apresenta a informação de licença de uma licença ativada.
[Source Name]
Apresenta o nome da fonte.
[Group]
Para ativar a função de agrupamento NDI, defina para On.
[Group Name]: define o nome do grupo NDI. É possível configurar diversas definições, separadas por vírgulas.
[Discovery Server 1], [Discovery Server 2]
Define o servidor NDI Discovery 1 e o servidor NDI Discovery 2.
[Reliable UDP Mode]
Para ativar o modo Reliable UDP, defina para On.
[Multicast Mode]
Para ativar a transmissão multidifusão, defina para On.
[Multicast Prefix]: define o prefixo a usar para a transmissão multidifusão.
[Multicast Netmask]: define a máscara de rede que determina o intervalo do endereço multidifusão.
[Multicast TTL]: define o valor de TTL para a transmissão multidifusão, no intervalo entre 1 e 256. O valor predefinido é
3.
[Multi-TCP Mode]
Para ativar o modo Multi-TCP, defina para On.
[Unicast UDP Mode]
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Para ativar o modo Unicast UDP, defina para On.

Sobre serviços e software de terceiros
Podem ser aplicáveis diferentes termos de utilização.

O fornecimento de serviços e atualizações de software poderá ser interrompido ou terminado sem aviso prévio.
A descrição dos serviços e do software está sujeita a alterações sem aviso prévio.
Pode ser necessário efetuar um registo e uma subscrição independentes.

A Sony declina qualquer responsabilidade por eventuais reclamações feitas por utilizadores ou terceiros, devidas à
utilização de serviços e software de outras empresas.
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Definir o codec de vídeo para transmissão

Defina o codec de vídeo, usando [Stream] > [Video Stream] no menu web

[Video Stream 1], [Video Stream 2], [Video Stream 3]
Pode definir até três modos de codec de imagem. Configure as definições seguintes de forma independente para cada
modo de imagem.
[Video Stream 3] é usado para o visor do painel de imagem da câmara da Web App.

Nota

Quando [Stream] > [Stream Setting] > [Setting] está definido para [RTMP], [SRT-Caller] ou [SRT-Listener], algumas das
definições [Video Stream 1], [Video Stream 2] e [Video Stream 3] ([Codec], [Size], [Frame Rate], [Bit Rate Compression Mode])
têm valores predefinidos.

[Codec 1], [Codec 2], [Codec 3]
Selecione [H.264], [H.265] ou [Off]. Tenha em atenção que [Codec 1] não pode ser definido para [Off]. Além disso,
[Codec 3] está definido para [JPEG] (fixo).

Nota

Os sintomas seguintes podem ocorrer, dependendo da combinação de diversas definições, tais como o tamanho da imagem, a
taxa de fotogramas e a taxa de bits de [Codec 1], [Codec 2] e [Codec 3].

Maior latência do vídeo.
Saltos nos fotogramas durante a reprodução de vídeo.
Áudio intermitente.
Resposta lenta da câmara a diversos comandos.
Resposta lenta da câmara a operações a partir de um controlo remoto.
Lentidão na visualização no monitor e em operações de configuração.

Se detetar estes sintomas, reduza os valores do tamanho da imagem e os parâmetros da taxa de fotogramas e da taxa de bits,
ou altere os valores ou outros parâmetros de configuração para resolver a questão.

Quando [Stream] > [Stream Setting] > [Setting] está definido para [RTMP], [SRT-Caller] ou [SRT-Listener], [Codec 1] está
definido para [H.264] (fixo). [Codec 2] está definido para [Off] (fixo).

Quando o tamanho da imagem ou a frequência do sistema da saída HDMI é alterado, [Codec 2] é definido para [Off].

[Size 1], [Size 2], [Size 3]
Seleciona o tamanho de imagem a transmitir a partir da câmara.
As opções de tamanho de imagem disponíveis variam, em função do tamanho de imagem da saída HDMI.

Nota

Quando o tamanho de imagem ou a frequência do sistema da saída HDMI é alterado, é selecionado o tamanho de imagem
máximo.

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
Define a taxa de fotogramas da imagem.
As unidades “fps” indicam o número de fotogramas transmitidos por segundo.
As opções de taxa de fotogramas disponíveis variam, em função do tamanho de imagem da saída HDMI.
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Nota

Quando o tamanho de imagem ou a frequência do sistema da saída HDMI é alterado, é selecionada a taxa de fotogramas
máxima.

[I-Picture Mode 1], [I-Picture Mode 2]
Define o método para especificação do intervalo de inserção de I-picture para H.264 e H.265 como [Time] ou [Frame].
Não pode ser definido para [Codec 3].
[Time]: define o intervalo de inserção de I-picture como um tempo.
[Frame]: define o intervalo de inserção de I-picture como um número de fotogramas.
[I-Picture Interval 1], [I-Picture Interval 2]
Define o intervalo de inserção de I-picture em unidades de segundos. Define um valor no intervalo entre 1 e 5 segundos.
O valor predefinido é 1 segundo.
Não pode ser definido para [Codec 3].
[I-Picture Ratio 1], [I-Picture Ratio 2]
Define o intervalo de inserção de I-picture para H.264 e H.265 como um número de fotogramas, no intervalo entre 15 e
300. O valor predefinido é 300 fotogramas.
Não pode ser definido para [Codec 3].
[Profile 1], [Profile 2]
Define o perfil de codec de imagem H.264 ou H.265.
[H.264]: selecione o perfil [high], [main] ou [baseline].
[H.265]: selecione o perfil [main] ou [main10]. Quando os dois codecs de vídeo estão ativados, apenas está disponível a
opção de seleção de perfil [main].
A eficiência de compressão de imagem aumenta pela ordem [high], [main] e [baseline]. Selecione um perfil suportado
pelo seu sistema.
Quando [H.265] está definido para [main10], o funcionamento é em [main10] quando a saída HDMI é YCrCb, ou em
[main] quando a saída HDMI é RGB.
Não pode ser definido para [Codec 3].
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
Selecione [CBR] ou [VBR].
Para manter uma taxa de bits constante, selecione [CBR]. Para manter a qualidade da imagem, selecione [VBR].
Não pode ser definido para [Codec 3].

Nota

As taxas de fotogramas e de bits efetivamente transmitidas pode diferir dos valores definidos, em função do tamanho de
imagem, da cena de filmagem, do ambiente da rede, entre outros fatores.

Quando [Stream] > [Stream Setting] > [Setting] está definido para [RTMP], [SRT-Caller] ou [SRT-Listener], [Bit Rate Compression
Mode 1] está definido para [CBR] (fixo).

[Bit Rate 1], [Bit Rate 2]
Pode definir a taxa de bits por transmissão de vídeo, quando [Bit Rate Compression Mode] está definido para [CBR].
Definir uma taxa de bits elevada permite-lhe transmitir vídeo com uma qualidade de imagem elevada.
Não pode ser definido para [Codec 3].
[Quality 1], [Quality 2], [Quality 3]
Define a qualidade de imagem, no intervalo entre 1 e 10. Um valor de 10 define a qualidade de imagem máxima. O valor
predefinido é 6.
Para [Quality 1] e [Quality 2], pode definir a qualidade de imagem H.264, definindo [Bit Rate Compression Mode] para
[VBR] e [Codec] para [H.264]. Pode definir a qualidade de imagem H.265, definindo [Bit Rate Compression Mode] para
[VBR] e [Codec] para [H.265].

5-041-957-53(1) Copyright 2022 Sony Corporation
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Definir o codec de áudio para transmissão

Defina o codec de vídeo, usando [Stream] > [Audio Stream] no menu web.
[Setting]
Para ativar a transmissão de áudio, defina para On.

Nota

Para selecionar RTMP, defina sempre previamente para On .

[Codec]
Seleciona o tipo de codec a usar para transmitir áudio.
[AAC (256kbps)]: selecione para dar prioridade à qualidade do som.
[AAC (128kbps)]: selecione para dar prioridade à capacidade de dados.
Esta definição não tem efeito no clip gravado pelo aparelho ou no sinal de áudio incorporado no sinal HDMI/SDI.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Iniciar/parar a transmissão

Para [RTSP], [SRT-Listener] e [NDI|HX]

O aparelho espera por um pedido de entrega de transmissão.
Execute uma aplicação do cliente para ver transmissão e aceda ao URL mostrado na tabela seguinte.
Insira os valores para o nome de utilizador e a palavra-passe configurados no aparelho.

<camera_address>: endereço IP do aparelho
<Port>: porta Listener configurada usando [Port Number]

Nota

A reprodução não é garantida em todos os dispositivos ou aplicações.

Para [RTMP] e [SRT-Caller]

Prima o botão [Stream now] no separador  (Stream) do ecrã de operações em gravação, para começar a
transmissão. O botão muda para [Stop stream] e o ícone [Stream] surge na parte superior do painel de imagem da
câmara.
Prima o botão [Stop stream] durante a transmissão, para parar a transmissão. O botão regressa a [Stream now] e o
ícone [Stream] na parte superior do painel de imagem da câmara desaparece.

Nota

A reprodução não é garantida em todos os dispositivos ou aplicações.

5-041-957-53(1) Copyright 2022 Sony Corporation

Formato de
transmissão URL

RTSP
Video Stream 1 rtsp://<camera_address>:<Port>/video1

Video Stream 2 rtsp://<camera_address>:<Port>/video2

SRT-Listener srt://<camera_address>:<Port>

NDI|HX
Para saber qual o dispositivo cliente compatível com NDI|HX, consulte as instruções de
funcionamento.
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Ecrã de miniaturas

Quando prime o botão [Thumbnail] no ecrã de operações em reprodução ou o botão THUMBNAIL no controlo remoto de
infravermelhos, os clips gravados no cartão de memória são apresentados no painel de imagem da câmara. Esta
apresentação no painel de imagem da câmara é designado ecrã de miniaturas.
Pode selecionar um clip no ecrã de miniaturas e iniciar a reprodução desse clip.
Premir o botão [Thumbnail] durante a apresentação do ecrã de miniaturas fecha esse ecrã e regressa à apresentação
da imagem da câmara.

Nota

Apenas os clips gravados no formato de gravação atualmente selecionado são apresentados no ecrã de miniaturas. Se um clip
gravado previsto não for apresentado, verifique o formato de gravação. Preste atenção a este facto antes de formatar (inicializar)
o suporte.

Disposição do ecrã

A miniatura de um clip selecionado é apresentada com um fundo cor de laranja.
A informação do clip selecionado é apresentada na parte inferior do ecrã.
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Cartão de memória selecionado
Se o cartão de memória estiver protegido contra escrita, surge um ícone de cadeado.

1.

Número do clip/número total de clips2.

Miniatura (imagem de índice)
Apresenta a imagem de índice de um clip. Quando é gravado um clip, o primeiro fotograma é automaticamente
definido como a imagem de índice.
As informações de clip/fotograma são apresentadas abaixo da miniatura. Pode alterar a informação apresentada,
usando [Thumbnail] > [Customize View] > [Thumbnail Caption] no menu da câmara.

3.

Nome do clip
Apresenta o nome do clip selecionado.

4.

Formato de gravação
Apresenta o formato do ficheiro do clip selecionado.

5.

Informações de gravação especial
Apresenta o modo de gravação apenas se o clip tiver sido gravado com um modo de gravação especial.
Para clips em câmara lenta e movimento rápido, a taxa de fotogramas é apresentada à direita.

6.

Duração do clipe7.

Data de criação8.
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Reproduzir clips gravados

Pode reproduzir clips gravados quando o aparelho está no modo de espera de gravação (Stby).
Este tópico descreve como reproduzir clips gravados, usando o painel de controlo da GUI.

Insira o cartão de memória para reproduzir.1

Prima o botão [Thumbnail].

Surgem as miniaturas do clip.

2

Use os botões de setas no painel de controlo da GUI para mover o cursor para a miniatura do clip que
pretende reproduzir.

3
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Nota

Poderá haver uma quebra momentânea da imagem ou apresentação de imagem fixa no limite entre clips. Não pode utilizar o
aparelho durante este período.

Quando seleciona um clip no ecrã de miniaturas e inicia a reprodução, poderá haver uma distorção momentânea da imagem no
início do clip. Para ver o início do clip sem distorção, pause a reprodução, prima o botão  (Anterior) para regressar ao início

Nota

Não é possível selecionar os clips por toque.

Prima o botão [Set] no painel de controlo da GUI.

A reprodução começa do início do clip selecionado.

4

Use o painel de controlo de reprodução como pretender.

Sugestão

Também pode controlar o funcionamento usando o painel de controlo da GUI.

Reproduzir: prima o botão [Set].
Pausa na reprodução: prima o botão [Set] durante a reprodução. Prima novamente para regressar à reprodução normal.
Saltar para o início do clip/início do clip seguinte: prima o botão da esquerda/direita.
Avanço/Recuo rápido: prima e mantenha premido o botão da esquerda/direita. A reprodução regressa à velocidade
normal quando soltar o botão.
Parar a reprodução: prima o botão [Cancel/Back].

5

Botão Função

Botão  (Reproduzir/Pausar) Reproduz um clip. Durante a reprodução, pausa o clip.

Botão  (Avanço rápido), botão
 (Recuo rápido)

Reproduz um clip a alta velocidade. Quando é premido um botão, a
velocidade de reprodução muda em três passos.

Botão  (Anterior), botão 
(Seguinte)

Salta para o início do clip ou para o clip anterior/seguinte.

Botão  (Parar) Para a reprodução e muda para o ecrã de filmagem.
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do clip e inicie novamente a reprodução.
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Operações em clips gravados

No ecrã de miniaturas, pode operar os clips ou verificar as propriedades dos clips, usando o menu [Thumbnail] no menu
da câmara.
Prima o botão [Menu] no ecrã de operações em reprodução, para apresentar o menu da câmara no painel de imagem
da câmara.
Pode realizar as operações seguintes, usando o menu [Thumbnail] no menu da câmara.
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Sugestão

Também pode premir o botão [Menu] no ecrã de operações em gravação, para apresentar o menu da câmara.

Operações usando o menu [Thumbnail] no menu da câmara
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Selecione uma função para executar, usando os botões de setas no painel de controlo da GUI, e, em seguida, prima o
botão [Set].
Prima o botão [Cancel/Back] para regressar ao ecrã anterior.

Nota

Alguns itens não podem ser selecionados dependendo do estado quando o menu foi apresentado.

Itens de menu para operações com clips

O menu [Thumbnail] no menu da câmara tem os seguintes itens de menu relacionados com operações com clips.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

Para mais informações sobre cada item do menu, consulte “Menu [Thumbnail]”.

Para apresentar o ecrã de propriedades do clip
Selecione [Thumbnail] > [Display Clip Properties] no menu da câmara, para apresentar o ecrã de propriedades do clip.
Prima o botão  (Anterior) ou o botão  (Seguinte) para saltar para o clip anterior/seguinte.

Para adicionar indicadores de clips
Pode adicionar indicadores de clips (marca OK, NG ou KP) a clips para filtrar a apresentação dos clips com base nos
respetivos indicadores.
Selecione a miniatura para o clip ao qual pretende adicionar um indicador de clip e, em seguida, selecione o indicador
de clip, usando [Thumbnail] > [Set Clip Flag] no menu da câmara.

Sugestão

Para adicionar indicadores de clips, também pode usar um botão atribuível, ao qual tenha sido atribuída a função de indicador de
clip.

Para apresentar o ecrã de miniaturas do clip filtrado
Selecione [Thumbnail] > [Filter Clips] no menu da câmara e selecione um tipo de indicador de clip, para apresentar
apenas os clips com o indicador especificado.
Para apresentar todos os clips, selecione [All].
Também pode premir o botão [Display], para ordenar a apresentação de miniaturas por indicadores.

Para eliminar clips
Pode eliminar clips dos cartões de memória.
Selecione [Thumbnail] > [Delete Clip] > [Select Clip] ou [All Clips] no menu da câmara.
[Select Clip]: elimina o clip selecionado. É possível selecionar vários clips.
[All Clips]: elimina todos os clips apresentados.

Definição Indicador de clip adicionado

[Add OK] OK

[Add NG] NG

[Add KEEP] KP
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Para alterar as informações apresentadas no ecrã de miniaturas
Pode alterar as informações sobre o clip/fotograma apresentadas por baixo da miniatura.
Selecione [Thumbnail] > [Customize View] > [Thumbnail Caption] no menu da câmara e, em seguida, selecione a
informação a apresentar.
[Date Time]: apresenta a data e a hora em que o clip foi criado e modificado pela última vez.
[Time Code]: apresenta o código de hora.
[Duration]: apresenta a duração do clip.
[Sequential Number]: apresenta um número sequencial em cada miniatura.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Configuração do menu da câmara

Quando é premido o botão [Menu] no painel de controlo da GUI ou o botão MENU no controlo remoto de infravermelhos,
é apresentado no painel de imagem da câmara o menu da câmara para configuração de diversas definições
necessárias para a filmagem e reprodução.

O menu inclui os menus seguintes:

Configuração do menu

Menu [User]
Contém itens de menu configurados pelo utilizador.
Pode ser editado usando [Edit User Menu].
Menu [Edit User]
Contém itens de menu para editar o menu [User].
Menu [Shooting]
Contém definições relacionadas com a filmagem.
Menu [Project]
Contém definições de projeto básicas.
Menu [Paint/Look]
Contém definições relacionadas com a qualidade de imagem.
Menu [Pan-Tilt]
Contém definições relacionadas com deslocamento/inclinação.
Menu [TC/Media]
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Contém definições relacionadas com os códigos de hora e o suporte de gravação.
Menu [Monitoring]
Contém definições relacionadas com a saída de vídeo e a apresentação no ecrã.
Menu [Audio]
Contém definições relacionadas com o áudio.
Menu [Thumbnail]
Contém definições relacionadas com a apresentação de miniaturas.
Menu [Technical]
Contém definições para os itens técnicos.
Menu [Network]
Contém definições relacionadas com as redes.
Menu [Maintenance]
Contém definições dos dispositivos, tais como relógio e idioma.

Configuração e hierarquia do menu da câmara

Nível 1 Nível 2

User
(predefinições)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom

Lens

Edit User Menu
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Nível 1 Nível 2

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

292



Nível 1 Nível 2

Pan-Tilt P/T Acceleration

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output

Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

293



5-041-957-53(1) Copyright 2022 Sony Corporation

Nível 1 Nível 2

Network
Wired LAN

File Transfer

Maintenance

Language

Clock Set

Hours Meter
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Utilizar o menu da câmara

Quando é premido o botão [Menu] no painel de controlo da GUI ou o botão MENU no controlo remoto de infravermelhos,
é apresentado no painel de imagem da câmara o menu da câmara para configuração de diversas definições
necessárias para a filmagem e reprodução.
O menu é operado usando botões no painel de controlo da GUI.

Botão[Menu]: prima para apresentar o menu da câmara. Para ocultar o menu, prima novamente enquanto o menu da
câmara está apresentado.
Botões de setas: prima os botões de setas para mover o cursor para cima/baixo/esquerda/direita no menu da câmara,
para selecionar itens ou definições do menu.
Botão [Set]: prima para aplicar o item selecionado.
Botão [Cancel/Back]: prima para regressar ao menu anterior. Uma alteração não concluída é cancelada.

Nota

Alguns itens não podem ser selecionados dependendo do estado quando o menu foi apresentado.

Definir opções de menu

Desloque o cursor para o item que pretende definir, usando os botões de setas no painel de controlo da GUI, e, em
seguida, prima o botão [Set] para aplicar a definição.

A área de seleção do item de menu apresenta até oito linhas. Se as opções disponíveis para um item não puderem
ser apresentadas ao mesmo tempo, percorra o ecrã movendo o cursor para cima/baixo.
Para itens secundários com uma ampla gama de definições (por exemplo, −99 a +99), a área de definições não é
apresentada. A definição atual é destacada para indicar que o valor pode ser alterado.
Selecionar [Execute] para uma função executa a função correspondente.
Selecionar um item que exija confirmação antes da execução vai ocultar temporariamente o menu e apresentar uma
mensagem de confirmação. Verifique a mensagem e, de seguida, selecione se executa ou cancela a função.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Introduzir uma cadeia de caracteres

Quando seleciona um item, tal como um nome de ficheiro, que exige a introdução de caracteres, aparece o ecrã de
introdução de caracteres.

5-041-957-53(1) Copyright 2022 Sony Corporation

Prima os botões de setas no painel de controlo da GUI, para selecionar o tipo de caráter e aplicar a
definição.

[ABC]: caracteres alfabéticos maiúsculos
[abc]: caracteres alfabéticos minúsculos
[123]: caracteres numéricos
[!#$]: caracteres especiais

1

Selecione um caráter e, em seguida, prima o botão [Set] para aplicar a definição.

O cursor move-se para o campo seguinte.
[Space]: introduz um carácter de espaço na posição do cursor.
[←] [→]: desloca a posição do cursor.
[BS]: elimina o carácter à esquerda do cursor (tecla de retrocesso).

2

Depois de terminar, prima o botão [Done] para aplicar a definição.

A cadeia de caracteres é confirmada e o ecrã de introdução de caracteres desaparece.

3
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User

Este tópico descreve a função e as definições de cada item de menu.

Nota

Pode adicionar e remover itens de menu no menu [User], usando o menu [Edit User]. É possível configurar até 20 itens.
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Item Descrição

Base Setting Item Project > Base Setting

Focus Item Shooting > Focus

S&Q Motion Item Shooting > S&Q Motion

LUT On/Off Item Shooting > LUT On/Off

Simul Rec Item Project > Simul Rec

Proxy Rec Item Project > Proxy Rec

Interval Rec Item Project > Interval Rec

Picture Cache Rec Item Project > Picture Cache Rec

Assignable Button Item Project > Assignable Button

Scene File Item Project > Scene File

Base Look Item Paint/Look > Base Look

P/T Acceleration Item Pan-Tilt > P/T Acceleration

Clip Name Format Item TC/Media > Clip Name Format

Format Media Item TC/Media > Format Media

Video Signal Monitor Item Monitoring > Video Signal Monitor

Marker Item Monitoring > Marker

Zoom Item Technical > Zoom

Lens Item Technical > Lens

Edit User Menu Apresenta o menu Edit User.
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Edit User

O menu [Edit User] é apresentado no nível superior, quando [Edit User Menu] está selecionado no menu [User].

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Add Item
Adicionar um item ao menu
[User]

– –
Adiciona um item de menu de nível 2 ao menu
[User].

Customize Reset
Repor os itens no menu
[User]

– –
Repõe as predefinições dos itens de menu
registados no menu [User].

Item de menu de nível 2
selecionado durante a edição

Delete –
Elimina o item de menu de nível 2 registado a
partir do menu [User].

Move –
Reorganiza os itens de menu registados no
menu [User].

Edit Sub Item –
Edita (regista/elimina) o item de menu
secundário de nível 3 registado no menu
[User].
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ISO/Gain/EI

Define as definições de ganho.

Item Definição do item secundário Predefinição Descrição

Mode ISO/dB dB
Seleciona o modo de
definição de ganho.

ISO/Gain<L>

Para mais pormenores sobre
definições, consulte “Definições de
ISO/Gain e valores predefinidos”.

– Define o valor predefinido
de ganho <L>.

Exposure
Index<L>

Quando Base ISO está definido para
ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E
Quando Base ISO está definido para
ISO 12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Quando Base ISO está
definido para ISO 800:
800EI / 6.0E
Quando Base ISO está
definido para ISO 12800:
12800EI / 6.0E

Define o valor de Exposure
Index<L>.

Shockless
Gain

On / Off Off
Liga/desliga a função de
ganho anti-choque.

Base
Sensitivity

High / Low Low
Define a sensibilidade de
base para o modo Custom.
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Tópico relacionado
Definições de ISO/Gain e valores predefinidos
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Item Definição do item secundário Predefinição Descrição

Base ISO ISO 12800 / ISO 800 ISO 800
Define a sensibilidade ISO
base para o modo Cine
EI/Flexible ISO.
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ND Filter

Define os valores predefinidos para o filtro ND.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Mode Preset / Variable Variable Seleciona o modo de filtro ND.

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/4 Define o valor 1 predefinido para o filtro ND.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/16 Define o valor 2 predefinido para o filtro ND.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/64 Define o valor 3 predefinido para o filtro ND.
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Shutter

Define o funcionamento do obturador eletrónico.
Usado para filmar com nitidez motivos em movimento rápido.

Item Definição do item secundário Predefinição Descrição

Mode Speed/Angle Speed

Seleciona o modo para definir a
velocidade do obturador em
segundos (Speed) ou como um
ângulo do obturador (Angle).

Shutter
Speed
On/Off

On / Off Off

Define se, quando o modo Speed
está selecionado, o tempo de
exposição segue o valor de [Shutter
Speed] ou é definido como
exposição máxima.

Shutter
Speed

64F a 1/8000
As definições disponíveis variam, em função
da frequência de fotogramas do formato de
vídeo selecionado.
59.94P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F
/ 3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 /
1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
50P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 /
1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
29.97P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F
/ 3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 1/100 /
1/120 / 1/125 / 1/250 / 1/500 / 1/1000 / 1/2000
/ 1/4000 / 1/8000
25P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 1/100 /
1/120 / 1/125 / 1/250 / 1/500 / 1/1000 / 1/2000
/ 1/4000 / 1/8000
24P/23.98P: 64F / 32F / 16F / 8F / 7F / 6F / 5F
/ 4F / 3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 1/60 /
1/96 / 1/100 / 1/120 / 1/125 / 1/250 / 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000

59.94P:
1/60
50P: 1/50
29.97P: 1/30
25P: 1/25
24P/23.98P:
1/24

Define a velocidade do obturador,
quando o modo Speed está
selecionado.

Shutter
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F /
2F / 360.0° / 300.0° / 270.0° / 240.0° / 216.0° /
210.0° / 180.0° / 172.8° / 150.0° / 144.0° /
120.0° / 90.0° / 86.4° / 72.0° / 45.0° / 30.0° /
22.5° / 11.25° / 5.6°

180.0°
Define o ângulo do obturador,
quando o modo Angle está
selecionado.

ECS On/Off On / Off Off
Liga/desliga a função Extended
Clear Scan.
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Item Definição do item secundário Predefinição Descrição

ECS
Frequency

23.99 a 8000
As definições disponíveis variam, em função
da frequência de fotogramas do formato de
vídeo selecionado.

59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Define a frequência ECS quando
Mode está definido para ECS.
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Iris

Estabelece as definições da íris.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Bokeh Control On / Off Off Ativa/desativa a função de controlo de bokeh.
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Auto Exposure

Define as definições de ajuste da exposição automática.

Item Definição do item secundário Predefinição Descrição

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 /
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 /
±0 / −0.25 / −0.5 / −0.75 / −1.0 / −1.25 /
−1.5 / −1.75 / −2.0 / −2.25 / −2.5 / −2.75 /
−3.0

±0
Define o nível de luminosidade para a
exposição detetada automaticamente.

Mode Backlight / Standard / Spotlight Standard

Define o modo de funcionamento do ajuste
automático da exposição.
Backlight: modo Backlight (modo para
escurecimento reduzido de um motivo,
quando o motivo está retroiluminado)
Standard: modo Standard
Spotlight: modo Spotlight (modo para
brancos recortados reduzidos, quando o
motivo está iluminado pelo foco)

Speed −99 a +99 ±0 Define a velocidade de ajuste do ajuste
automático da exposição.

AGC On / Off Off
Liga/desliga a função AGC (controlo
automático de ganho).

AGC Limit

Para mais pormenores sobre
definições, consulte “Definições de
AGC Limit e valores predefinidos”.

– Define o ganho máximo da função AGC.

AGC Point F2.8 / F4 / F5.6 F2.8
Define o valor de paragem F da íris no qual
o funcionamento AGC tem início quando a
função AGC está On.

Auto
Shutter

On / Off Off
Liga/desliga a função de controlo
automático do obturador.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 1/2000
Define a velocidade mais rápida do
obturador da função de obturador
automático.

A.SHT
Point

F5.6 / F8 / F11 / F16 F11
Define o valor de paragem F da íris onde o
funcionamento do obturador automático
inicia.

Clip High
light

On / Off Off
Liga/desliga a função que ignora as áreas
mais claras para proporcionar uma
resposta mais plana a elevada luminância.
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Definições de AGC Limit e valores predefinidos
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Item Definição do item secundário Predefinição Descrição

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 1

Define o intervalo de medição da luz para
ajustar automaticamente a exposição de
acordo com a luminosidade do motivo.
(Não disponível ao ajustar a exposição
manualmente)

Detect
Window
Indication

On / Off Off
Liga/desliga a indicação do intervalo de
medição da luz.

Custom
Width

40 a 999 500
Define a largura do intervalo de medição
da luz.

Custom
Height

70 a 999 500
Define a altura do intervalo de medição da
luz.

Custom H
Position

−479 a +479 ±0
Define a posição horizontal do intervalo de
medição da luz.

Custom V
Position

−464 a +464 ±0
Define a posição vertical do intervalo de
medição da luz.
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White

Define as definições do equilíbrio de brancos.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do
item secundário Predefinição Descrição

Preset
White

2000K a 15000K 3200K Define o valor predefinido do equilíbrio de brancos.

Color
Temp <A>

2000K a 15000K 3200K

Define a temperatura de cor do equilíbrio de brancos guardada na
memória A.

Nota

Uma vez que Color Temp é recortado a 2000K e 15000K durante o
funcionamento de R Gain/B Gain, poderá não ser possível apresentar
o valor de Color Temp correto para o valor de R Gain/B Gain.

Tint<A> −99 a +99 ±0

Define o valor Tint do equilíbrio de brancos guardado na memória de
brancos A.

Nota

Uma vez que Tint é recortado a ± 99 durante o funcionamento de R
Gain/B Gain, poderá não ser possível apresentar o valor correto de
tint para o valor de R Gain/B Gain.

R Gain
<A>

−99.0 a +99.0 ±0.0
Define o valor de ganho R do equilíbrio de brancos guardado na
memória A.

B Gain
<A>

−99.0 a +99.0 ±0.0
Define o valor de ganho B do equilíbrio de brancos guardado na
memória A.
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White Setting

Ajusta as definições do equilíbrio de brancos.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Shockless
White

Off / 1 / 2 / 3 2

Define a velocidade de resposta do equilíbrio de brancos ao
mudar o modo de equilíbrio de brancos.
Off: muda instantaneamente.
1 a 3: muda mais lentamente quanto maior for número.

ATW Speed 1 / 2 / 3 / 4 / 5 3
Define a velocidade de resposta no modo ATW.
A velocidade de resposta máxima é 1 e a velocidade de
resposta mínima é 5.
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Offset White

Define as definições de desvio do equilíbrio de brancos.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Offset White <A> On / Off Off
Seleciona se adiciona (On) ou não adiciona (Off) um valor
de desvio ao equilíbrio de brancos na memória A.

Offset Color
Temp<A>

−99 a +99 ±0
Define o desvio da temperatura de cor a adicionar ao
equilíbrio de brancos na memória A, quando [Offset White
<A>] está definido para On.

Offset Tint<A> −99 a +99 ±0
Define o desvio do valor de tint a adicionar ao equilíbrio de
brancos na memória A, quando [Offset White <A>] está
definido para On.

Offset
White<ATW>

On / Off On
Seleciona se adiciona (On) ou não adiciona (Off) um valor
de desvio ao equilíbrio de brancos ATW.

Offset Color
Temp<ATW>

−99 a +99 ±0
Define o desvio da temperatura de cor a adicionar ao
equilíbrio de brancos ATW, quando [Offset White<ATW>]
está definido para On.

Offset Tint<ATW> −99 a +99 ±0
Define o desvio do valor de tint a adicionar ao equilíbrio de
brancos ATW, quando [Offset White<ATW>] está definido
para On.
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Focus

Define as definições de focagem.

Item Definição do item
secundário Predefinição Descrição

AF
Transition
Speed

1(Slow) / 2 / 3 / 4 /
5 / 6 / 7(Fast)

5
Define a velocidade de acionamento da focagem para quando
o motivo muda durante a focagem automática.

AF Subj.
Shift Sens.

1(Locked On) / 2 / 3
/ 4 / 5(Responsive)

5(Responsive)
Define a sensibilidade para alterar a focagem do motivo
durante a focagem automática.

Focus Area
Wide / Zone /
Flexible Spot Wide

Define a área alvo para focagem automática e focagem
automática por seleção (AF).

Consulte “Ajustar automaticamente a focagem (Focagem
automática)” e “Definir a área/posição de focagem
automática (área de focagem)”.

Wide: pesquisa um motivo num ângulo amplo da imagem
durante a focagem.
Zone: pesquisa automaticamente um ponto de focagem
dentro da zona especificada.
Flexible Spot: foca numa posição especificada na imagem.

Focus Area
(AF-S)

Flexible Spot Flexible Spot
Define a área alvo para focagem automática por seleção (AF-
S).

Face/Eye
Detection
AF

Face/Eye Only AF /
Face/Eye Priority
AF / Off

Face/Eye
Priority AF

Ativa/desativa AF de deteção de rostos.

Consulte “Deteção através da deteção de rosto e olhos
(Face/Eye Detection AF)”.

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Define o modo de focagem automática por seleção.

Touch
Function in
MF

Tracking AF/Spot
Focus Tracking AF

Define a operação quando toca na imagem da câmara no
ecrã de operações em gravação da Web App no modo MF.

AF Assist On / Off On

Quando definido para On, permite-lhe substituir
temporariamente a focagem automática e definir a focagem
manualmente.

Consulte “Definir manualmente o alvo de focagem
automática (AF Assist) usando a Web App” e “Focar
manualmente durante a focagem automática utilizando o
controlo remoto de infravermelhos fornecido”.
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Tópico relacionado
Definir a área/posição de focagem automática (área de focagem)

Deteção através da deteção de rosto e olhos (Face/Eye Detection AF)

Definir manualmente o alvo de focagem automática (AF Assist) usando a Web App

Focar manualmente durante a focagem automática utilizando o controlo remoto de infravermelhos fornecido
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S&Q Motion

Estabelece as definições do modo de câmara lenta e movimento rápido (consulte “Câmara lenta e movimento rápido”).

Tópico relacionado
Câmara lenta e movimento rápido

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Setting On / Off Off
Liga/desliga o modo de câmara lenta e movimento
rápido.

Frame
Rate

1fps a 60fps / 100fps / 120fps /
150fps / 180fps / 200fps / 240fps

–

Define a taxa de fotogramas para filmagem em
câmara lenta e movimento rápido.

Nota

As definições disponíveis variam consoante a
frequência do sistema selecionada, codec e formato
de vídeo.
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LUT On/Off

Define as definições LUT.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

SDI MLUT On / MLUT Off MLUT Off
Seleciona se aplica a Monitor LUT ao vídeo de
saída SDI.

HDMI/Stream MLUT On / MLUT Off MLUT Off
Seleciona se aplica Monitor LUT ao vídeo de saída
HDMI e de transmissão.

Proxy MLUT On / MLUT Off MLUT Off
Seleciona se aplica Monitor LUT ao vídeo de
gravação proxy.

Internal Rec MLUT On / MLUT Off MLUT Off
Seleciona se aplica Monitor LUT ao vídeo de
gravação principal.

LUT On/Off Button
Target

SDI / HDMI/Stream / SDI
& HDMI/Stream

HDMI/Stream
Define a saída pretendida, controlada por um
botão atribuível ao qual foi atribuído LUT On/Off.
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Noise Suppression

Define as definições da supressão de ruído.

Sugestão

As definições de [Setting(Custom)] e [Level(Custom)] são refletidas na definição de [Target Display].
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Item Definição do item
secundário Predefinição Descrição

Setting(Custom) On / Off On
Liga/desliga a função de supressão de ruído no
modo Custom.

Level(Custom) Low / Mid / High Mid
Define o nível de supressão de ruído no modo
Custom.

Setting (Cine EI/Flex.
ISO)

On / Off Off
Liga/desliga a função de supressão de ruído no
modo de filmagem em Log.

Level (Cine EI/Flex.
ISO)

Low / Mid / High Mid
Define o nível de supressão de ruído no modo de
filmagem em Log.
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Flicker Reduce

Define as definições de correção da cintilação.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Mode Auto / On / Off Off Define o modo de correção da cintilação.

Frequency 50Hz / 60Hz 60Hz
Define a frequência da fonte de alimentação que fornece a
iluminação que está a causar a cintilação.
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SteadyShot

Define as definições de estabilização da imagem.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Setting
Active / Standard /
Off

Off

Define a função de estabilização da imagem.

Nota

Ativada quando é instalada uma objetiva compatível.

Quando definido para Active ou Standard, poderá ocorrer um
comportamento inesperado durante a operação de
deslocamento/inclinação.

316



Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Base Setting

Define as definições base.

Tópico relacionado

Configurar o funcionamento básico

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Shooting
Mode

Custom / Flexible ISO / Cine
EI Quick / Cine EI

Custom

Define o modo de filmagem.

Consulte “Definir o modo de filmagem” na secção
“Configurar o funcionamento básico”.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Define a gama de cores da gravação/saída no modo
Custom.
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Rec Format

Define as definições do formato de gravação.

Definições de [RAW Output Format]

Os valores predefinidos são apresentados a negrito.
As condições nas quais não é possível definir [RAW Output Format] foram omitidas.

Definições de [Video Format]

Item Definição do item secundário Predefinição Descrição

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94 Seleciona a frequência do sistema.

Imager Scan
Mode

FF / S35 FF Seleciona o tamanho do sensor de imagem.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Define o codec de gravação/reprodução de
clips.

Nota

Quando [Imager Scan Mode] está definido
para [S35], [RAW] e [RAW & XAVC-I] não
podem ser selecionados.

RAW Output
Format

As definições disponíveis variam,
em função da definição de
[Frequency].

Consulte “Definições de [RAW
Output Format]” abaixo.

–

Define o tamanho da imagem RAW a enviar
para um gravador RAW externo.

Nota

Quando [Codec] está definido para [RAW &
XAVC-I], a definição de [Video Format] muda
em interligação com a definição de [RAW
Output Format].

Video
Format

As definições disponíveis variam,
em função das definições de
[Frequency], [Imager Scan Mode] e
[Codec].

Consulte “Definições de [Video
Format]” abaixo.

– Define o tamanho de imagem e a taxa de bits.

Frequency Imager Scan Mode Codec Definição

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Os valores predefinidos são apresentados a negrito.
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Frequency Imager Scan Mode Codec Definição

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Cine EI/Flex.ISO Set

Estabelece as definições do modo de filmagem em Log (consulte “Definir o modo de filmagem”, em “Configurar o
funcionamento básico”).

Tópico relacionado

Configurar o funcionamento básico

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Color
Gamut

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-
Gamut3.Cine/SLog3

Define a gama de cores para os modos de
filmagem em Log ([Flexible ISO], [Cine EI Quick],
[Cine EI]).

Embed
LUT File

On / Off On
Ativa/desativa a gravação de metadados do
ficheiro 3D LUT (ficheiro CUBE).
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Simul Rec

Estabelece as definições para o modo de gravação simultânea em 2 ranhuras (consulte “Gravar para os cartões de
memória A e B em simultâneo (Gravação simultânea em 2 ranhuras)”).
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Item Definição do item secundário Predefinição Descrição

Setting On / Off Off
Liga/desliga o modo de
gravação simultânea em
duas ranhuras.

Rec
Button
Set

Rec Button:<Slot A> <Slot B> 2nd Rec Button:
<Slot A> <Slot B> / Rec Button:<Slot A> 2nd
Rec Button:<Slot B> / Rec Button:<Slot B> 2nd
Rec Button:<Slot A>

Rec Button:<Slot A>
<Slot B> 2nd Rec Button:
<Slot A> <Slot B>

Designa os botões de
gravação usados para
controlar cada suporte de
gravação.
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Proxy Rec

Estabelece as definições para o modo de gravação proxy (consulte “Gravação proxy”).

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Setting On / Off Off Liga/desliga o modo de gravação proxy.

Audio
Channel

CH1/CH2 / CH3/CH4 CH1/CH2
Seleciona o canal de áudio para gravar dados
proxy.
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Interval Rec

Estabelece as definições para o modo de gravação com intervalos (consulte “Gravar vídeo intermitentemente (Interval
Rec)”).

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Setting On / Off Off

Liga/desliga o modo de gravação
com intervalo. (Definir este modo
para On vai definir todos os outros
modos especiais para Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20
/ 30 / 40 / 50 (sec)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20
/ 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (hour)

1

Define o intervalo entre gravações
no modo de gravação Interval Rec
(quando Interval Rec está definido
para On).

Number
of
Frames

1frame / 2frames / 3frames / 6frames /
9frames / 12frames
As definições disponíveis variam, em
função da frequência de fotogramas do
formato de vídeo selecionado.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Define o número de fotogramas a
gravar por gravação no modo de
gravação Interval Rec (quando
Interval Rec está definido para
On).
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Picture Cache Rec

Estabelece as definições para o modo de gravação na cache de imagens (consulte “Gravar imagens em cache (Picture
Cache Rec)”).

Tópico relacionado

Gravar imagens em cache (Picture Cache Rec)

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Setting On / Off Off Ativa/desativa a função de cache de imagens.

Cache
Size

Short / Medium /
Long / Max

Max
Define o tempo de acumulação de imagens na memória da
cache de imagens (tempo de gravação na cache de imagens).

Cache Rec
Time

– –
Apresenta o tempo de acumulação de imagens na memória da
cache de imagens (tempo de gravação na cache de imagens).
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SDI/HDMI Rec Control

Define as definições de controlo da gravação SDI/HDMI.
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Item Definição do item
secundário Predefinição Descrição

Setting
Off / SDI/HDMI
Remote I/F /
Parallel Rec

Off

Define o controlo de iniciar/parar gravação de um dispositivo externo
ligado, através do sinal de saída SDI/HDMI.
Off: não use o controlo remoto.
SDI/HDMI Remote I/F: controlo de iniciar/parar gravação de um
dispositivo externo ligado, quando não existe um suporte inserido no
aparelho. Não sincronizado com precisão de fotograma com o suporte
no aparelho.
Parallel Rec: controlo de iniciar/parar gravação de um dispositivo
externo ligado, quando existe um suporte inserido no aparelho.
Sincronizado com precisão de fotograma com o suporte no aparelho.

Nota

Para um controlo usando o sinal de saída HDMI, defina [TC/Media] >
[HDMI TC Out] > [Setting] para [On] no menu da câmara.
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Assignable Button

Define a atribuição de funções a botões atribuíveis (<1> a <9>) e [Focus Hold Button].
É possível atribuir as funções seguintes:
[Off]: sem funções atribuídas.
[Base ISO/Sensitivity]: muda a sensibilidade base do sensor de imagem.
[AGC]: liga/desliga a função AGC.
[Push AGC]: ativa a função AGC enquanto o botão estiver premido.
[ND Filter]

No modo variável: ajusta o fator de transmissão do filtro ND. Prima e mantenha premido para alternar entre
Clear/Manual/Auto.
No modo predefinido: prima e mantenha premido para alternar entre predefinições.

[ND Filter Position]: muda os filtros ND.
[Auto ND Filter]: ativa/desativa a função de filtro ND automático.
[Push Auto ND]: ativa a função de filtro ND automático enquanto o botão estiver premido.
[Auto Iris]: liga/desliga a função de íris.
[Push Auto Iris]: ativa a função de íris automática enquanto o botão estiver premido.
[Bokeh Control]: ativa/desativa a função de controlo de bokeh.
[Auto Shutter]: ativa/desativa a função de obturador automático.
[AE Level/Mode]: ajusta o nível AE. Prima e mantenha premido para ativar o modo AE.
[Backlight]: alterna entre Backlight e Standard.
[Spotlight]: alterna entre Spotlight e Standard.
[Preset White Select]: muda o valor do modo de equilíbrio de brancos predefinido.
[ATW]: liga/desliga a função ATW.
[ATW Hold]: pausa o funcionamento da função ATW.
[AF Speed/Sens.]: muda a definição da velocidade da transição AF e a definição da sensibilidade de seguimento de
motivo AF.
[Focus Setting]: define a área de focagem.
[Face/Eye Detection AF]: muda as definições AF de deteção de rosto.
[Push AF Mode]: muda a definição do modo Push AF.
[Push AF/MF]: no modo de focagem MF, ativa AF enquanto o botão estiver premido. No modo de focagem AF, ativa MF
enquanto o botão é premido.
[Focus Hold]: no modo de focagem AF, a focagem mantém-se fixa enquanto o botão estiver premido.
[S&Q Motion]: liga/desliga o modo de câmara lenta e movimento rápido. Define a taxa de fotogramas de filmagem
quando premido continuamente.
[LUT On/Off]: liga/desliga a função LUT. A alternância do motivo é definida usando [Shooting] > [LUT On/Off] > [LUT
On/Off Button Target].
[SteadyShot]: alterna entre Active, Standard e Off.
[Crop Select]: muda Imager Scan Mode. A alternância é ativada dentro do intervalo, sem alterar o formato de gravação.
[Rec]: inicia/para a gravação
[Picture Cache Rec]: liga/desliga o modo de gravação na cache de imagens.
[Rec Review]: ativa/desativa a função de revisão da gravação.
[Clip Flag OK]: executa Add OK. Prima duas vezes para executar Delete Clip Flag.
[Clip Flag NG]: executa Add NG. Prima duas vezes para executar Delete Clip Flag.
[Clip Flag Keep]: executa Add KEEP. Prima duas vezes para executar Delete Clip Flag.
[Slot Select]: alterna entre as ranhuras de memória (A) e (B).
[Color Bars]: liga/desliga as barras de cor.
[DURATION/TC/U-BIT]: alterna entre Time Code, Users Bit e Duration.
[Display]: liga/desliga os indicadores do ecrã.
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[Lens Info]: muda o indicador da profundidade de campo.
[Video Signal Monitor]: muda o monitor do sinal de vídeo (tal como um monitor de forma de onda).
[Marker]: liga/desliga a função de marcador.
[Thumbnail]: apresenta/fecha o ecrã de miniaturas.
[Auto Upload (Proxy)]: liga/desliga a transferência automática do ficheiro proxy.
[Direct Menu]: apresenta/fecha o menu direto.
[User Menu]: apresenta/fecha o menu User.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Scene File

Estabelece as definições relacionadas com os ficheiros de cenas (consulte “Filmar com o aspeto pretendido”).
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Item Definição do item secundário Predefinição Descrição

Recall – –

Carrega um ficheiro Scene armazenado
na memória interna e aplica as definições
como as definições atuais de qualidade
da imagem.

Store – –
Guarda o estado de qualidade da
imagem atual como um ficheiro Scene na
memória interna.

Delete – –
Elimina um ficheiro Scene na memória
interna.

Preset
Recall

Quando Shooting Mode está definido para
Custom e Target Display está definido para
SDR(BT.709): S-Cinetone / Standard / Still /
ITU709 / 709tone
Quando Shooting Mode está definido para
Custom e Target Display está definido para
HDR(HLG): HLG Live/HLG Natural

–

Aplica definições (não graváveis)
predefinidas de qualidade de imagem
como as definições atuais de qualidade
da imagem.
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Base Look

Define as definições relacionadas com o aspeto base.
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Item Definição do item secundário Predefinição Descrição

Select

Quando Shooting Mode está definido
para Custom e Target Display está
definido para SDR(BT.709): S-Cinetone /
Standard / Still / ITU709 / 709tone / User1
a User16
Quando Shooting Mode está definido
para Custom e Target Display está
definido para HDR(HLG): HLG Live /
HLG Natural / User1 a User16
Quando Shooting Mode está definido
para os modos de filmagem em Log:
s709 / 709(800) / S-Log3 / User1 a User16

Quando Shooting Mode está
definido para Custom e Target
Display está definido para
SDR(BT.709): S-Cinetone
Quando Shooting Mode está
definido para Custom e Target
Display está definido para
HDR(HLG): HLG Live
Quando Shooting Mode está
definido para os modos de
filmagem em Log: s709

Seleciona um aspeto
base.

Delete – –
Elimina o aspeto base
selecionado.

Delete
All

– – Elimina todos os
aspetos base.

Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 S-Gamut3.Cine/SLog3

Define a gama de
entrada para o aspeto
base selecionado,
usando [Select].

Output BT.709 / HLG BT.709

Define a gama de cor
de saída para o aspeto
base selecionado,
usando [Select].

AE
Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV / 5/3EV
/ 2EV

0EV

Define o valor de
referência da exposição
para o aspeto base
selecionado, usando
[Select].
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Reset Paint Settings

Repõe as definições do menu [Paint/Look] exceto o aspeto base.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Reset without Base
Look

Execute/Cancel –
Repõe as definições do menu [Paint/Look] exceto
o aspeto base.
Execute: execute a função.

330



Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Black

Define as definições de preto.
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Item Definição do item secundário Predefinição Descrição

Master Black −99.0 a +99.0 ±0.0 Define o nível de preto principal.

R Black −99.0 a +99.0 ±0.0 Define o nível de preto R.

B Black −99.0 a +99.0 ±0.0 Define o nível de preto B.
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Knee

Define as definições de correção de ângulo.
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Item Definição do item
secundário Predefinição Descrição

Setting

Quando Target Display
está definido para
SDR(BT.709): On / Off / ---
Quando Target Display
está definido para
HDR(HLG): On / Off / ---

Quando Target Display
está definido para
SDR(BT.709):Off
Quando Target Display
está definido para
HDR(HLG): Off

Liga/desliga a função de correção de
ângulo.

Nota

Apenas ativado quando [Base Look] >
[Select] está definido para [Standard],
[ITU709], [709tone], [HLG Live] ou [HLG
Natural].

Auto
Knee

Quando Target Display
está definido para
SDR(BT.709): On / Off / ---
Quando Target Display
está definido para
HDR(HLG): On / Off / ---

Quando Target Display
está definido para
SDR(BT.709):On
Quando Target Display
está definido para
HDR(HLG): Off

Ativa/desativa a função de ângulo
automático.

Nota

Apenas ativado quando [Base Look] >
[Select] está definido para [Standard],
[ITU709] ou [709tone].

Point 75% a 109% 90% Define o ponto de ângulo.

Slope −99 a +99 ±0 Define a inclinação de ângulo.
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Detail

Define as definições de ajuste dos detalhes.
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Item Definição do item
secundário Predefinição Descrição

Setting On / Off On Liga/desliga a função de detalhes.

Level −7 a +7 ±0 Define o nível de detalhe.

Manual
Setting

On / Off / --- Off Liga/desliga a função de ajuste manual dos detalhes.

H/V Ratio −2 a +2 ±0

Define o equilíbrio entre o detalhe horizontal (H) e vertical (V)
para ajuste manual dos detalhes.

Nota

Este item varia consoante a versão de software.*1

B/W
Balance

Type1 / Type2 /
Type3 / Type4 /
Type5

Type3
Define o equilíbrio entre o detalhe de preto (B) para áreas de
baixa luminância e o detalhe de branco (W) para áreas de alta
luminância para ajuste manual dos detalhes.

Limit 0 a 7 7
Define o nível de limite do detalhe para o ajuste manual dos
detalhes.

Crispening 0 a 7 0
Define o nível de definição do detalhe para o ajuste manual dos
detalhes.

High Light
Detail

0 a 4 0
Define o nível de detalhe das áreas de alta luminância para o
ajuste manual dos detalhes.

Na versão de software 1.00, o item de menu é [V/H Balance]. Na versão de software 1.10 ou posterior, o item de menu é [H/V Ratio]. O intervalo
de definição não é alterado de −2 para 0 para +2, no entanto, o efeito na qualidade de imagem é diferente.
Versão de software 1.00: quanto maior for o valor definido, maior será o detalhe horizontal (H).
Versão de software 1.10 ou posterior: quanto maior for o valor definido, maior será o detalhe vertical (V).
Após atualizar a versão de software 1.00 para 1.10 ou posterior, [All File], [Scene File] e outras definições são transferidas mas com a
polaridade invertida (a qualidade de imagem é mantida).
Se tiver registado o item de menu [V/H Balance] no menu [User], será automaticamente substituído pelo item de menu [H/V Ratio] no menu
[User] após atualizar o software.

*1
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Matrix

Define as definições de correção da matriz.
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Item Definição do item
secundário Predefinição Descrição

User Matrix On / Off Off
Liga/desliga a função de correção da matriz de
utilizador.

User Matrix
Level

−99 a +99 ±0 Ajusta a saturação de cor da imagem inteira.

User Matrix
Phase

−99 a +99 ±0 Ajusta o tom de cor (fase) da imagem inteira.

User Matrix R-G −99 a +99 ±0
Define uma matriz de utilizador R-G definida pelo
utilizador.

User Matrix R-B −99 a +99 ±0
Define uma matriz de utilizador R-B definida pelo
utilizador.

User Matrix G-R −99 a +99 ±0
Define uma matriz de utilizador G-R definida pelo
utilizador.

User Matrix G-B −99 a +99 ±0
Define uma matriz de utilizador G-B definida pelo
utilizador.

User Matrix B-R −99 a +99 ±0
Define uma matriz de utilizador B-R definida pelo
utilizador.

User Matrix B-G −99 a +99 ±0
Define uma matriz de utilizador B-G definida pelo
utilizador.
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Multi Matrix

Define as definições de correção multi-matriz.
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Item Definição do item secundário Predefinição Descrição

Setting On / Off Off
Liga/desliga a função de correção Multi
Matrix.

Reset Execute / Cancel –
Repõe a tonalidade e a saturação de cada
cor de eixo para os valores predefinidos.

Axis
B / B+ / MG− / MG / MG+ / R / R+ / YL− /
YL / YL+ / G− / G / G+ / CY / CY+ / B−

B Seleciona Axis.

Hue −99 a +99 ±0 Define a tonalidade da cor utilizada para a
correção Multi Matrix.

Saturation −99 a +99 ±0
Define a saturação da cor utilizada para a
correção Multi Matrix.
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P/T Acceleration

Estabelece definições relacionadas com a aceleração para operações de deslocamento/inclinação.
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Item Definição do item
secundário Predefinição Descrição

Ramp
Curve

1 a 9 8
Define a aceleração/desaceleração para operações de
deslocamento/inclinação. Quanto maior o número, mais elevada a
aceleração.
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Timecode

Define as definições do código de hora.
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Item Definição do item
secundário Predefinição Descrição

Mode Preset / Regen / Clock Preset

Define o modo de funcionamento do código de hora.
Preset: começa a funcionar a partir de um valor predefinido.
Regen: começa a funcionar a partir do código de hora do fim
do clip anterior.
Clock: utiliza o relógio interno como código de hora.

Run Rec Run / Free Run Rec Run
Rec Run: apenas funciona durante a gravação.
Free Run: sempre em funcionamento, independentemente da
operação de gravação.

Setting – –
Define o código de hora para um valor arbitrário.
Set: defina o valor.

Reset Execute / Cancel –
Repõe o código de hora para 00:00:00:00.
Execute: execute a função.

TC
Format DF/NDF DF

Define o formato do código de hora.
DF: perda de fotograma
NDF: sem perda de fotograma
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TC Display

Define as definições da apresentação dos dados de hora.
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Item Definição do item secundário Predefinição Descrição

Display Select Timecode / Users Bit / Duration Timecode Muda a apresentação dos dados de hora.
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Users Bit

Define as definições relacionadas com os bits de utilizador.
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Item Definição do item
secundário Predefinição Descrição

Mode Fix / Time Fix

Define o modo de bits de utilizador.
Fix: usa um valor fixo arbitrário em bits de utilizador.
Time: usa a hora, o minuto e o segundo atuais em bits de
utilizador.

Setting – – Define os bits de utilizador para um valor arbitrário.
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HDMI TC Out

Define definições relacionadas com a saída do código de hora através de HDMI.
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Item Definição do item
secundário Predefinição Descrição

Setting On / Off Off
Define se emite o código de hora para dispositivos para outros
fins, através de HDMI.
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Clip Name Format

Define definições relacionadas com o nome e a eliminação de clips.
Quando [Auto Naming] está definido para [Cam ID + Reel#], os primeiros quatro caracteres dos nomes dos clips são
determinados para cada suporte de gravação. Quando é inserido um novo suporte de gravação ou quando o último clip
no suporte de gravação não corresponde às definições [Camera ID] ou [Reel Number], o nome do clip fica intermitente
para fins de notificação.
Quando [Auto Naming] está definido para [Title], pode utilizar uma cadeia de caracteres arbitrária como a primeira parte
dos nomes dos clips.

Item Definição do item
secundário Predefinição Descrição

Auto
Naming

Cam ID + Reel# / Title

Seleciona o formato de nome do clip.
Cam ID + Reel#: ID da câmara + Número do rolo + Número
do disparo + Data + Cadeia aleatória
Title: cadeia arbitrária especificada por [Title Prefix] + número
do clip

Camera
ID

A a Z A

Define a ID da câmara utilizada ao gerar nomes de clips.

Nota

Apenas configurável quando [Auto Naming] está definido para
[Cam ID + Reel#].

Reel
Number

001 a 999 001

Define a parte do número do rolo utilizada ao gerar nomes de
clips.

Nota

Apenas configurável quando [Auto Naming] está definido para
[Cam ID + Reel#].

Camera
Position

C/L/R C

Define a parte do primeiro carácter do Número do disparo
utilizado ao gerar nomes de clips.

Nota

Apenas configurável quando [Auto Naming] está definido para
[Cam ID + Reel#].
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Para definir [Title Prefix]

Tópico relacionado

Introduzir uma cadeia de caracteres

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Title Prefix

nnn_ (nnn são os
últimos 3 dígitos do
número de série)
(máx. visor de 7 dígitos)

nnn

Define a parte do título (4 a 46 caracteres) do nome do clip.
Abre um ecrã de introdução da cadeia de caracteres.

Para mais informações sobre a definição de títulos e o
ecrã de introdução de caracteres, consulte “Definir o
título” abaixo e “Introduzir uma cadeia de caracteres”.

Nota

Apenas configurável quando [Auto Naming] está definido para
[Title].

Number
Set

0001 a 9999 0001

Define o sufixo de número de 4 dígitos do nome do clip.

Nota

Apenas configurável quando [Auto Naming] está definido para
[Title].

Defina o caráter a inserir na posição do cursor na área [Title Prefix], a partir da área de seleção de
carateres, usando os botões de setas no painel de controlo da GUI (o caráter fica destacado) e, em seguida,
prima o botão [Set] no painel de controlo da GUI.

O carácter selecionado é inserido e o cursor move-se para a direita.

1

Repita o passo 1 para definir o título.

Use [BS], conforme necessário.

2

Após definir o título, prima o botão [Done] para fechar o ecrã de introdução de caracteres.

Para mais pormenores sobre o funcionamento do ecrã de introdução de caracteres, consulte “Introduzir uma
cadeia de caracteres”.

É possível selecionar os caracteres seguintes:
!#$%()+,-.;=@[ ]^_~ espaço
0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3
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Update Media

Atualiza o ficheiro de gestão dos cartões de memória (consulte “Restaurar cartões de memória”).

Tópico relacionado

Restaurar cartões de memória

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Media(A) Execute / Cancel –
Atualiza o ficheiro de gestão no cartão de memória na
ranhura A.
Execute: execute a função.

Media(B) Execute / Cancel –
Atualiza o ficheiro de gestão no cartão de memória na
ranhura B.
Execute: execute a função.
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Format Media

Formata (inicia) os cartões de memória (consulte “Formatar (Inicializar) cartões de memória”).

Tópico relacionado
Formatar (Inicializar) cartões de memória

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Media(A) Full Format / Quick Format / Cancel – Formata o cartão de memória na ranhura A.

Media(B) Full Format / Quick Format / Cancel – Formata o cartão de memória na ranhura B.
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Media Life

Apresenta a vida útil restante dos cartões de memória.

Nota

Necessita de cartões de memória que suportem a apresentação da vida útil restante.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Media(A) – –
Apresenta a vida útil restante do cartão de memória na
ranhura A.

Media(B) – –
Apresenta a vida útil restante do cartão de memória na
ranhura B.
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Output Format

Define as definições do formato de saída.

Tópico relacionado
Formatos de saída e limitações

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

SDI Para mais pormenores sobre as definições, consulte
“Formatos de saída e limitações”.

– Define a resolução de saída
SDI e HDMI.HDMI –
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Display On/Off

Define as definições do item de apresentação.
Para mostrar um item de apresentação, selecione On. Para ocultar um item de apresentação, selecione Off.

Item Definição do item secundário Predefinição

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On
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Item Definição do item secundário Predefinição

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Timecode On / Off On

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On
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Video Signal Monitor

Estabelece as definições do monitor do sinal de vídeo.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Setting
Off / Waveform / Vector /
Histogram

Off Define o tipo de monitor do sinal de vídeo.

Level Marker
1

0% a 109% 70%
Define o nível de luminância de Level marker
1.

Level Marker
2

0% a 109% 100%
Define o nível de luminância de Level marker
2.
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Marker

Define as definições de apresentação do marcador.

Item Definição do item secundário Predefinição Descrição

Setting On / Off On
Liga/desliga a apresentação de todos os
marcadores.

Color
White / Yellow / Cyan / Green /
Magenta / Red / Blue

White Seleciona a cor do sinal do marcador.

Center
Marker

1 / 2 / 3 / 4 / Off Off Seleciona o marcador central.

Safety Zone On / Off Off Liga/desliga o marcador da zona de segurança.

Safety Area 80% / 90% / 92.5% / 95% 90%
Seleciona o tamanho do marcador da zona de
segurança (como uma percentagem do tamanho
de ecrã total).

Aspect
Marker

Line / Mask / Off Off Seleciona o tipo do marcador de aspeto.

Aspect
Mask

0 a 15 12 Define o nível do sinal de vídeo fora do marcador.

Aspect
Safety Zone

On / Off Off Liga/desliga o marcador da zona de segurança do
aspeto.

Aspect
Safety Area

80% / 90% / 92.5% / 95% 90%
Seleciona o tamanho do marcador da zona de
segurança do aspeto (como uma percentagem do
tamanho de ecrã total).

Aspect
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 /
17:9 / 1.66:1 / 1.85:1 / 2.35:1 /
2.39:1 / Custom

2.39:1
Define o modo ao apresentar o marcador de
aspeto.

Custom
Aspect
Ratio

Insira um valor à escolha. 01.00:01.00

Define a relação de aspeto para um valor
arbitrário.

Nota

Ativado quando [Aspect Select] está definido
para [Custom].

Guide
Frame

On / Off Off Liga/desliga a apresentação da moldura guia.

100%
Marker

On / Off Off Liga/desliga o marcador de 100%.
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Item Definição do item secundário Predefinição Descrição

User Box On / Off Off
Liga/desliga a apresentação do marcador da
caixa de utilizador.

User Box
Width

3 a 479 240
Define a largura do marcador da caixa de
utilizador (distância do centro às extremidades
esquerda e direita).

User Box
Height

3 a 269 135
Define a altura do marcador da caixa de utilizador
(distância do centro às extremidades superior e
inferior).

User Box H
Position

−476 a +476 0
Define a posição horizontal do centro do
marcador da caixa de utilizador.

User Box V
Position

−266 a +266 0
Define a posição vertical do centro do marcador
da caixa de utilizador.
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Audio Input

Define as definições de entrada de áudio.

Item Definição do item
secundário Predefinição Descrição

AUDIO IN
Select

MIC / LINE MIC
Seleciona o tipo de dispositivo ligado ao conector AUDIO
IN.

Phantom
Power +48V

On / Off Off Apresenta o estado da alimentação fantasma +48 V.

CH1 Input
Select

AUDIO IN CH1
AUDIO IN
CH1

Apresenta a fonte de entrada para gravação no canal 1.

CH2 Input
Select

AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN
CH2

Muda a fonte de entrada para gravação no canal 2.

CH3 Input
Select

Off / AUDIO IN CH1
AUDIO IN
CH1

Muda a fonte de entrada para gravação no canal 3.

CH4 Input
Select

Off / AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN
CH2

Muda a fonte de entrada para gravação no canal 4.

AUDIO IN
CH1 MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Define o nível de gravação de referência para a entrada de
microfone XLR de AUDIO IN CH1.

AUDIO IN
CH2 MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Define o nível de gravação de referência para a entrada de
microfone XLR de AUDIO IN CH2.

Line Input
Reference

+4dB / 0dB / −3dB /
EBUL

+4dB
Seleciona o nível de entrada de referência quando [AUDIO
IN Select] está definido para LINE.

Reference
Level

−20dB / −18dB /
−16dB / −12dB /
EBUL

−20dB
Seleciona o nível de gravação do sinal de tom de referência
1 kHz.

CH1 Wind
Filter

On / Off Off
Ativa/desativa o filtro de redução do vento para gravação no
canal 1.

CH2 Wind
Filter

On / Off Off
Ativa/desativa o filtro de redução do vento para gravação no
canal 2.

CH3 Wind
Filter

On / Off Off
Ativa/desativa o filtro de redução do vento para gravação no
canal 3.

CH4 Wind
Filter

On / Off Off Ativa/desativa o filtro de redução do vento para gravação no
canal 4.

CH1 Level
Control

Auto / Manual Auto
Seleciona o ajuste automático ou manual do nível de
entrada de áudio para gravação no canal 1.
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Item Definição do item
secundário Predefinição Descrição

CH2 Level
Control

Auto / Manual Auto
Seleciona o ajuste automático ou manual do nível de
entrada de áudio para gravação no canal 2.

CH3 Level
Control

Auto / Manual Auto
Seleciona o ajuste automático ou manual do nível de
entrada de áudio para gravação no canal 3.

CH4 Level
Control

Auto / Manual Auto
Seleciona o ajuste automático ou manual do nível de
entrada de áudio para gravação no canal 4.

CH1 Input
Level

0 a 99 49 Define o nível de entrada para gravação no canal 1.

CH2 Input
Level

0 a 99 49 Define o nível de entrada para gravação no canal 2.

CH3 Input
Level

0 a 99 49 Define o nível de entrada para gravação no canal 3.

CH4 Input
Level

0 a 99 49 Define o nível de entrada para gravação no canal 4.

Master Input
Level

0 a 99 99 Define o nível de entrada do áudio principal.

Limiter Mode
Off / −6dB / −9dB /
−12dB / −15dB /
−17dB

Off
Seleciona a característica do limitador para sinais de
entrada grandes ao ajustar manualmente o nível de entrada
do áudio.

CH1&2 AGC
Mode

Mono / Stereo Stereo
Define o modo de ajuste automático do nível para gravação
do canal 1 e canal 2. Quando definido para Stereo, AGC
está ligado entre canais.

CH3&4 AGC
Mode

Mono / Stereo Stereo
Define o modo de ajuste automático do nível para gravação
do canal 3 e canal 4. Quando definido para Stereo, AGC
está ligado entre canais.

AGC Spec
−6dB / −9dB / −12dB
/ −15dB / −17dB

−6dB Seleciona a característica AGC.

1kHz Tone on
Color Bars

On / Off Off

Liga/desliga o sinal do tom de referência 1 kHz ao
apresentar barras de cores.

Nota

Quando definido para [On], o sinal do tom de referência de
1 kHz está definido para gravação nos canais 3 e 4, mesmo
que [CH3 Input Select] e [CH4 Input Select] estejam
definidos para [Off].
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Audio Output

Define as definições de saída de áudio.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

HDMI/Stream
Output CH

CH1/CH2 / CH3/CH4 CH1/CH2
Define a combinação de canais de áudio para a
saída HDMI/transmissão.
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Display Clip Properties

Apresenta o ecrã de propriedades do clip.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Display Clip Properties – – Apresenta o ecrã de propriedades do clip.
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Set Clip Flag

Define as definições de indicador de clip.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Add OK – – Adiciona um indicador OK.

Add NG – – Adiciona um indicador NG.

Add KEEP – – Adiciona um indicador KEEP.

Delete Clip Flag – – Elimina todos os indicadores.
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Lock/Unlock Clip

Define as definições de proteção dos clips.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Select Clip – – Seleciona e bloqueia/desbloqueia um clip.

Lock All Clips – – Bloqueia todos os clips.

Unlock All Clips – – Desbloqueia todos os clips.
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Delete Clip

Elimina clips.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Select Clip – – Elimina o clip selecionado.

All Clips – – Elimina todos os clips.
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Transfer Clip

Transfere clips.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Select
Clip

– – Transfere os clips selecionados.

All Clips – –

Transfere todos os clips.

Nota

Podem ser importadas até 200 tarefas de
transferência.

359



Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Transfer Clip (Proxy)

Transfere os clips proxy.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Select
Clip

– –
Transfere clips proxy correspondentes para os clips
selecionados.

All Clips – –

Transfere clips proxy correspondentes para todos os clips.

Nota

Podem ser importadas até 200 tarefas de transferência.
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Filter Clips

Define definições dos clips a apresentar.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

OK – – Apresenta apenas clips com um indicador OK.

NG – – Apresenta apenas clips com um indicador NG.

KEEP – – Apresenta apenas clips com um indicador KEEP.

None – – Apresenta apenas clips sem um indicador.

All – –
Apresenta todos os clips, independentemente de terem ou não
indicadores.
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Customize View

Muda a vista do ecrã de miniaturas.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Thumbnail
Caption

Date Time / Time Code / Duration /
Sequential Number

Time Code
Muda as informações apresentadas
abaixo das miniaturas.
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Color Bars

Define as definições das barras de cor.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Setting On / Off Off Liga/desliga as barras de cor.

Type ARIB / 100% / 75% / SMPTE ARIB Seleciona o tipo de barra de cor.
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Genlock

Configura a apresentação do estado de Genlock (consulte “Sincronizar a fase do sinal de vídeo (Genlock))”.

Tópico relacionado
Sincronizar a fase do sinal de vídeo (Genlock)

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Reference Internal / External(HD) / External(SD) – Apresenta o tipo de sinal de referência Genlock.

364



Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Tally

Estabelece as definições para a luz de gravação/indicadora (consulte “Ligar um sinal indicador”).

Tópico relacionado
Ligar um sinal indicador

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Tally Lamp
Brightness

High / Low / Off High Define a luminosidade da luz de gravação/indicadora.

G Tally Lamp Enable / Disable Enable Ativa/desativa a luz G Tally.

Tally Control External / Internal Internal

Seleciona o alvo para aceitar a informação de controlo da
luz de gravação/indicadora do aparelho.
External: controlo da luz indicadora a partir do exterior da
câmara.
Internal: controlo através da operação de gravação da
câmara.
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Rec Review

Estabelece as definições de revisão da gravação (consulte “Rever a gravação (Rec Review)”).

Tópico relacionado

Rever a gravação (Rec Review)

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Setting 3s / 10s / Clip 3s
Define o tempo para reprodução de clips gravados para
revisão da gravação.
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Zoom

Estabelece as definições de zoom (“Ajustar o zoom”).

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Zoom Type Optical Zoom Only / On(Clear Image Zoom) Optical Zoom Only Define o tipo de zoom.
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Lens

Define as definições relacionadas com as objetivas.

Tópico relacionado
Compensação de respiração

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Lens Calibration Execute / Cancel –
Executa a função que corrige as diferenças na posição
do zoom devidas a diferenças nas objetivas individuais,
ao usar uma objetiva de zoom motorizado.

Zoom Ring
Direction

Left(W)/Right(T) /
Right(W)/Left(T)

Left(W)/Right(T)

Define a direção de funcionamento do anel de zoom.

Nota

Ativado apenas ao utilizar uma objetiva com encaixe E
compatível com alteração da direção do anel de zoom.

Shading
Compensation

Auto / Off Auto Define a compensação automática de sombras.

Chroma
Aberration Comp.

Auto / Off Auto
Define a compensação automática de aberrações
cromáticas.

Distortion Comp. Auto / Off Auto Define a compensação automática de distorções.

Breathing
Compensation

Auto / Off Off
Define a compensação de respiração da objetiva.

Consulte “Compensação de respiração”.

Distance Display Meter / Feet Meter
Define as unidades de apresentação para informações
sobre a objetiva e a posição de focagem.

Zoom Position
Display

Focal Length /
Number / Bar

Focal Length
Define o formato de apresentação para a posição de
zoom.
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APR

Executa APR.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

APR Execute / Cancel –

Executa APR (Automatic Pixel Restoration) para ajuste automático
do sensor de imagem.
Execute: execute a função.

Nota

Instale sempre a tampa da objetiva antes de executar APR.
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Wired LAN

Define as definições relacionadas com as ligações da LAN por cabo.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

HTTP Port – 80 Apresenta a porta de acesso HTTP.

Detail
Settings

– – Apresenta propriedades da ligação LAN por cabo.

DHCP
On / Off

On Apresenta se DHCP está ativado (On) ou desativado (Off).

IP Address –
Apresenta o endereço IP do aparelho, quando [DHCP] está
definido para [Off].

Subnet Mask –
Apresenta a máscara de sub-rede do aparelho, quando
[DHCP] está definido para [Off].

Gateway –
Apresenta o gateway predefinido quando [DHCP] está
definido para [Off].

DNS Auto
On / Off

On Apresenta a definição de aquisição automática de DNS.
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File Transfer

Estabelece as definições relacionadas com as transferências de ficheiros (consulte “Sobre a transferência de ficheiros”).

Tópico relacionado

Sobre a transferência de ficheiros

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do
item secundário Predefinição Descrição

Auto Upload
(Proxy)

On / Off Off Ativa/desativa o carregamento automático do ficheiro proxy.

Default
Upload
Server

Server Settings1
a 3 > Display
Name

–

Seleciona o servidor de carregamento para ficheiros. O servidor
selecionado aqui torna-se o destino automático de carregamento
para ficheiros proxy e o destino de carregamento para ficheiros a
partir do ecrã de miniaturas.
Apresenta as definições de [Display Name] configuradas em
[Server Settings1 a 3].

Clear
Completed
Jobs

Execute / Cancel –
Apaga as tarefas de transferências concluídas da lista.
Execute: execute a função.

Clear All
Jobs

Execute / Cancel –
Apaga todas as tarefas de transferências da lista.
Execute: execute a função.

View Job List – – Apresenta a lista de tarefas de transferência.
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Language

Define o idioma de apresentação.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Select – –
Define o idioma de apresentação.
Set: defina o valor.
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Clock Set

Define as definições do relógio interno.

Nota

Quando esta definição for alterada a partir do menu da câmara, desligue a fonte de alimentação para o aparelho e reinicie o
mesmo. Poderá ocorrer um comportamento inesperado se a espera de alimentação for iniciada através do controlo remoto de
infravermelhos ou Web App.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Time Zone UTC -12:00 a UTC +14:00 –
Define a diferença horária de UTC em unidades de 30
minutos.

Date
Mode

YYMMDD / MMDDYY /
DDMMYY

YYMMDD

Seleciona o formato de apresentação para datas.
YYMMDD: ano, mês, dia
MMDDYY: mês, dia, ano
DDMMYY: dia, mês, ano

12H/24H 12H / 24H 24H
Seleciona o formato de apresentação do relógio.
12H: modo de 12 horas
24H: modo de 24 horas

Date – –
Define a data atual.
Set: defina o valor.

Time – –
Define a hora atual.
Set: defina o valor.
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Hours Meter

Apresenta o tempo de funcionamento acumulado.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Hours(System) – –
Apresenta as horas acumuladas de utilização (não
podem ser repostas).

Hours(Reset) – –
Apresenta as horas acumuladas de utilização (podem
ser repostas).

Reset Execute / Cancel –
Repõe em 0 o tempo de funcionamento acumulado.
Execute: execute a função.
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Definições de ISO/Gain e valores predefinidos

A amplitude das definições e dos valores predefinidos de [ISO/Gain<L>] variam, em função das definições de [Mode],
[Base Look] > [Select] e [Base Sensitivity].
Os valores predefinidos são apresentados a negrito nas tabelas.

Quando [Mode] está definido para [ISO]

Quando [Base Look] > [Select] está definido para [S-Cinetone], [Standard], [ITU709], [709tone], ou
[Still]

Quando [Base Look] > [Select] está definido para [HLG Live] ou [HLG Natural]

Quando [ISO/Gain/EI] > [Base Sensitivity] está
definido para [Low]

Quando [ISO/Gain/EI] > [Base Sensitivity] está
definido para [High]

ISO 320
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Quando [Base Look] > [Select] está definido para [User1] a [User16]

Quando [Mode] está definido para [dB]

É possível configurar um valor entre -3dB e +30dB, em incrementos de 1 dB.
O valor predefinido é 0 dB.
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Quando [ISO/Gain/EI] > [Base Sensitivity] está
definido para [Low]

Quando [ISO/Gain/EI] > [Base Sensitivity] está
definido para [High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 128000
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Quando [ISO/Gain/EI] > [Base Sensitivity] está
definido para [Low]

Quando [ISO/Gain/EI] > [Base Sensitivity] está
definido para [High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Definições de AGC Limit e valores predefinidos

A amplitude das definições e dos valores predefinidos do menu [AGC Limit] variam, em função das definições de [Mode],
[Base Look] > [Select] e [Base Sensitivity].
Os valores predefinidos são apresentados a negrito nas tabelas.

Quando [Mode] está definido para [ISO]

Quando [Base Look] > [Select] está definido para [S-Cinetone], [Standard], [ITU709], [709tone], ou
[Still]

Quando [Base Look] > [Select] está definido para [HLG Live] ou [HLG Natural]

Quando [ISO/Gain/EI] > [Base Sensitivity] está
definido para [Low]

Quando [ISO/Gain/EI] > [Base Sensitivity] está
definido para [High]

ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Quando [Base Look] > [Select] está definido para [User1] a [User16]

Quando [Mode] está definido para [dB]

Pode selecionar entre 3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB.
O valor predefinido é 15dB.
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Quando [ISO/Gain/EI] > [Base Sensitivity] está
definido para [Low]

Quando [ISO/Gain/EI] > [Base Sensitivity] está
definido para [High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Quando [ISO/Gain/EI] > [Base Sensitivity] está
definido para [Low]

Quando [ISO/Gain/EI] > [Base Sensitivity] está
definido para [High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Definições da qualidade de imagem guardadas para cada modo de filmagem

O estado atual dos itens de configuração relacionados com a qualidade de imagem é guardado para cada um dos
modos de filmagem seguintes. Quando altera o modo de filmagem, as definições correspondentes que são guardadas
para o modo de filmagem pretendido são aplicadas.

Apresentação pretendida no modo Custom SDR(BT.709)
Apresentação pretendida no modo Custom HDR(HLG)
Filmagem em Log (Cine EI, Cine EI Quick, Flexible ISO)

Os itens de configuração relacionados com a qualidade de imagem que são guardados para cada modo de filmagem
são mostrados nas tabelas seguintes.
“Sim” indica uma definição que é guardada e “Não” indica uma definição que não é guardada. “Sim” em diversas
colunas indica definições em comum.

Item

Modo de filmagem

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Menu
Filmagem

ISO/Gain/EI

ISO/Gain Sim1) Sim Não

Exposure Index Não Não Sim Sim

Base Sensitivity Sim Não

Base ISO Não Sim4) Não3) Sim4)

White

Preset White Sim Sim

Além dos
mencionados acima

Sim

White Setting Sim

Offset White Sim Não

LUT On/Off Não Sim

Noise
Suppression

Setting(Custom) Sim Sim Não

Level(Custom) Sim Sim Não

Setting (Cine EI/Flex.
ISO)

Não Sim

Level (Cine EI/Flex.
ISO)

Não Sim
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Item

Modo de filmagem

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Menu
Paint/Look

Base Look

Select Sim Sim Sim

Input2) Sim

Output2) Sim

Desvio do nível AE2) Sim

Black Sim Sim Não

Knee

Auto Knee Sim Não Não

Além dos
mencionados acima

Sim Sim Não

Detail Sim Sim Não

Matrix Sim Sim Não

Multi Matrix Sim Sim Não

São guardadas definições de sensibilidade ISO separadas para o modo Custom SDR(BT.709) e HDR(HLG).1)

As definições são guardadas para cada Aspeto base e não dependem do modo de filmagem.2)

A sensibilidade ISO de base altera-se em conjunto com o índice de exposição.3)

Valor de definição comum nos modos de filmagem Flexible ISO e Cine EI.4)
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Configuração do menu web

Prima o separador de alternância do ecrã de operações [Settings], para apresentar o ecrã de definições.
Utilize o ecrã de definições para configurar os vários itens de configuração da unidade, incluindo definições iniciais,
definições de rede, definições de filmagem/reprodução utilizando o menu web.

O menu inclui os menus seguintes:

Configuração e hierarquia do menu

Nível 1 Descrição do nível 1 Nível 2

Shooting Contém definições relacionadas com a filmagem. Focus
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Nível 1 Descrição do nível 1 Nível 2

Project Contém definições de projeto básicas.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look Contém definições relacionadas com a qualidade de imagem. Base Look

Pan-Tilt Contém definições relacionadas com deslocamento/inclinação.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring
Contém definições relacionadas com a saída de vídeo e a apresentação
no ecrã.

Output Format

Output Display

Audio Contém definições relacionadas com o áudio. Audio

Technical Contém definições para os itens técnicos.

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network Contém definições relacionadas com as redes.

Camera Name

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

Referer Check

Brute Force Attack
Protection
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Nota

[Accessibility] apenas está disponível em modelos para a América do Norte.

5-041-957-53(1) Copyright 2022 Sony Corporation

Nível 1 Descrição do nível 1 Nível 2

Stream Contém definições relacionadas com a transmissão.

Stream

Video Stream

Audio Stream

Maintenance Contém definições dos dispositivos, tais como relógio e idioma.

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software
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Operações do menu web

Prima o separador de alternância do ecrã de operações [Settings], para apresentar o ecrã de definições para configurar
os vários itens de configuração do aparelho, incluindo definições iniciais, definições de rede e definições de
filmagem/reprodução, usando o menu web.
A configuração das definições no menu web pode ser efetuada num tablet, utilizando o ecrã tátil, ou num computador,
utilizando o rato.
Prima o menu para obter os itens que pretende configurar, para apresentar os itens de configuração e as respetivas
definições nesse menu.

Método de configuração

Seleção do valor

Menu (nível 1)1.

Menu (nível 2)2.

Definições3.
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Prima o botão de opção para um item. O botão de opção do item selecionado é apresentado a cor de laranja.

Ligar/desligar item

Prima o interruptor para ativar/desativar o item. O interruptor fica cor de laranja quando o item está ativado e branco
quando está desativado.

Seleção do valor a partir de uma lista

Prima o botão descendente e selecione um item a partir da lista apresentada.

Seleção de valor numérico

Prima < ou > para alterar o valor numérico. Se o valor numérico ficar sublinhado, também pode introduzir um valor
numérico diretamente.

Introdução de carácter/número

Configuração num menu independente
Prima o botão para efetuar operações de configuração num ecrã independente.

Mensagem de orientação

Apresenta informação que o ajuda a configurar algumas definições e mensagens que chamam a atenção do utilizador.

Guardar uma definição

Depois de terminar a configuração de uma definição, prima o botão [OK] para guardar a definição.
Prima o botão [Cancel] para eliminar as alterações a uma definição e regressar à definição anterior.
Prima o botão [Reload] para atualizar o que é apresentado no ecrã.

Nota
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Se premir o botão [Reload] antes de guardar uma definição, as alterações a essa definição serão eliminadas.

Se avançar para outra página antes de guardar uma definição, as alterações a essa definição serão eliminadas.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Focus

Define as definições de focagem.

Tópico relacionado

Definir manualmente o alvo de focagem automática (AF Assist) usando a Web App

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Define o modo de focagem automática por seleção.

Touch
Function in
MF

Tracking AF / Spot
Focus

Tracking AF
Define a operação quando o ecrã de imagem da câmara é
tocado no modo MF.

AF Assist
Control

On / Off On

Quando definido para [On], pode usar o controlo de deslize da
focagem na Web App durante a focagem automática, para
ajustar a posição da focagem.

Para mais informações, consulte “Definir manualmente o alvo
de focagem automática (AF Assist) usando a Web App”.

Nota

Este item apenas fica ativado quando [AF Assist] está definido
para [On] no menu da câmara.
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Base Setting

Define as definições base.

Tópico relacionado

Configurar o funcionamento básico

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Shooting
Mode

Custom / Flexible ISO / Cine EI
Quick / Cine EI

Custom

Define o modo de filmagem.

Consulte “Modo de filmagem” na secção
“Configurar o funcionamento básico”.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Define a gama de cores da gravação/saída no modo
Custom.
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Rec Format

Define as definições do formato de gravação.

Definições de [RAW Output Format]

Item Definição do item secundário Predefinição Descrição

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94

Seleciona a frequência do sistema.

Nota

Se a frequência for alterada, a câmara
reinicia-se. Após reiniciar, recarregue a
página no browser da web.

Imager Scan
Mode

FF / S35 FF Seleciona o tamanho do sensor de imagem.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Define o codec de gravação/reprodução de
clips.

Nota

Quando [Imager Scan Mode] está definido
para [S35], [RAW] e [RAW & XAVC-I] não
podem ser selecionados.

RAW Output
Format

As definições disponíveis variam,
em função da definição de
[Frequency].

Consulte “Definições de [RAW
Output Format]” abaixo.

–

Define o tamanho da imagem RAW a enviar
para um gravador RAW externo.

Nota

Quando [Codec] está definido para [RAW &
XAVC-I], a definição de [Video Format] muda
em interligação com a definição de [RAW
Output Format].

Video
Format

As definições disponíveis variam,
em função das definições de
[Frequency], [Imager Scan Mode] e
[Codec].

Consulte “Definições de [Video
Format]” abaixo.

– Define o tamanho da imagem.

Frequency Imager Scan Mode Codec Definição

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

389



Os valores predefinidos são apresentados a negrito.
As condições nas quais não é possível definir [RAW Output Format] foram omitidas.

Definições de [Video Format]

Os valores predefinidos são apresentados a negrito.

5-041-957-53(1) Copyright 2022 Sony Corporation

Frequency Imager Scan Mode Codec Definição

24 FF RAW / RAW & XAVC-I 4096×2160

Frequency Imager Scan Mode Codec Definição

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Simul Rec

Estabelece as definições para o modo de gravação simultânea em 2 ranhuras (consulte “Gravar para os cartões de
memória A e B em simultâneo (Gravação simultânea em 2 ranhuras)”).

Tópico relacionado

Gravar para os cartões de memória A e B em simultâneo (Gravação simultânea em 2 ranhuras)

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Setting On / Off Off
Liga/desliga a função de gravação simultânea e define o
suporte de destino da gravação.

Rec Button
Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B Apresenta a atribuição do botão de gravação para cada
suporte de gravação.
Defina [Project] > [Simul Rec] > [Rec Button Set] no menu
da câmara.

2nd Rec
Button

Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B
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Proxy Rec

Estabelece as definições para o modo de gravação proxy (consulte “Gravação proxy”).

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Setting On / Off Off Liga/desliga o modo de gravação proxy.
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Interval Rec

Estabelece as definições para o modo de gravação com intervalos (consulte “Gravar vídeo intermitentemente (Interval
Rec)”).

Tópico relacionado

Gravar vídeo intermitentemente (Interval Rec)

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Setting On / Off Off

Liga/desliga o modo de gravação
com intervalo. (Definir este modo
para On vai definir todos os outros
modos especiais para Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20
/ 30 / 40 / 50 (sec)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20
/ 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (hour)

1

Define o intervalo entre gravações
no modo de gravação Interval Rec
(quando Interval Rec está definido
para On).

Number
of
Frames

1frame / 2frames / 3frames / 6frames /
9frames / 12frames
As definições disponíveis variam, em
função da frequência de fotogramas do
formato de vídeo selecionado.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Define o número de fotogramas a
gravar por gravação no modo de
gravação Interval Rec (quando
Interval Rec está definido para
On).
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Picture Cache Rec

Estabelece as definições para o modo de gravação na cache de imagens (consulte “Gravar imagens em cache (Picture
Cache Rec)”).

Tópico relacionado

Gravar imagens em cache (Picture Cache Rec)

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Setting On / Off Off Ativa/desativa a função de cache de imagens.

Cache
Size

Short / Medium /
Long / Max

Max
Define o tempo de acumulação de imagens na memória da
cache de imagens (tempo de gravação na cache de imagens).

Cache Rec
Time

– –
Apresenta o tempo de acumulação de imagens na memória da
cache de imagens (tempo de gravação na cache de imagens).
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All File

Efetua operações em ficheiros ALL (consulte “Guardar e carregar dados de configuração”).

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Load All
File

– –

Carregue um ficheiro ALL no aparelho, a partir do dispositivo que
está a executar a Web App.

Nota

Quando um ficheiro ALL é carregado no aparelho, ele reinicia-se.
Após reiniciar, recarregue a página no browser da web.

Save All
File – –

Guarde as definições do aparelho no dispositivo que está a
executar a Web App como ficheiro ALL.
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Base Look

Pode carregar um aspeto base para o aparelho.
É apresentada no ecrã uma lista dos aspetos base disponíveis. O aspeto base atualmente aplicado é indicado por um
marcador ● à esquerda do número do aspeto base.

[No.]: número do aspeto base
[Base Look Name]: nome do aspeto base
[Input]: sinal de entrada do aspeto base
[Output]: sinal de saída do aspeto base
[AE Level Offset]: valor de desvio de referência da exposição do aspeto base

Para adicionar um aspeto base
Prima o botão [Import] para importar um novo aspeto base. Siga as instruções no ecrã.
Após a importação, defina valores adequados para [Input], [Output] e [AE Level Offset]. Para mais pormenores, consulte
“Importar um determinado aspeto base”.

Tópico relacionado
Importar um determinado aspeto base

5-041-957-53(1) Copyright 2022 Sony Corporation
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P/T Speed

Estabelece definições relacionadas com a velocidade de deslocamento/inclinação.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do
item secundário Predefinição Descrição

Speed
Step

Normal /
Extended

Extended

Define o número de passos de velocidade da ação de
deslocamento/inclinação.
Normal: a velocidade pode ser especificada num intervalo com 24
níveis. Use esta definição por questões de compatibilidade com
câmaras remotas da Sony.
Extended: a velocidade pode ser especificada num intervalo com 50
níveis.

Speed
Mode

Normal / Slow Normal

Define o modo de velocidade da ação de deslocamento/inclinação.
Apenas ativado quando [Speed Step] está definido para [Normal].
Normal: funciona num intervalo de velocidade normal (do mínimo ao
máximo (60 graus/segundo)).
Slow: funciona num intervalo de velocidade baixa (do mínimo ao
máximo (40 graus/segundo)).
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P/T Acceleration

Estabelece definições relacionadas com a velocidade de deslocamento/inclinação.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Acceleration 1 a 9 8
Define a aceleração/desaceleração para operações de
deslocamento/inclinação. Quanto maior o número, mais elevada
a aceleração.
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P/T Range Limit

Estabelece definições relacionadas com a limitação da amplitude de deslocamento/inclinação.
Defina os limites para o funcionamento de deslocamento/inclinação através do ecrã seguinte.

Nota

Quando o aparelho é ligado ou a reposição do deslocamento/inclinação é executada, esta definição do limite de amplitude é
ignorada. Esta função não pode ser usada para evitar obstáculos na proximidade do aparelho.

Defina o interruptor [Setting] para a posição On.

A função de limite para o funcionamento de deslocamento/inclinação fica ativada.

1

Verifique a imagem, utilizando os controlos de deslocamento/inclinação da câmara.2

Para definir as posições nas quais limitar a operação, prima o botão [Left], [Right], [Up], [Down] > [Set
Current Value] nessas posições.

[Left]: lado esquerdo da câmara
[Right]: lado direito da câmara
[Up]: lado superior da câmara

3
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Nota

As posições da câmara fora das posições de limite não podem ser guardadas como predefinições.

Se a definição de [Pan-Tilt] > [P/T Direction] > [Ceiling] for alterada, as definições de posição de limite configuradas são repostas
nas predefinições.

A definição não pode ser alterada durante a reprodução, durante a apresentação de miniaturas, quando ocorre um erro de
deslocamento/inclinação, quando deslocamento/inclinação não tiver sido inicializado ou quando deslocamento/inclinação está
bloqueado.

5-041-957-53(1) Copyright 2022 Sony Corporation

[Down]: lado inferior da câmara

As posições de limite são definidas e apresentadas como valores numéricos (ângulo).
Para cancelar um limite, prima o botão [Reset] para as posições individuais.

Prima o botão [OK].

A operação de deslocamento/inclinação é restringida, para se manter dentro das posições de limite configuradas.

4
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P/T Direction

Estabelece definições relacionadas com a direção de deslocamento/inclinação.

Nota

Quando é aplicada uma definição alterada de [Ceiling], todas as posições predefinidas são eliminadas, uma vez que as
coordenadas de deslocamento/inclinação ficariam invertidas.

A amplitude da ação de deslocamento/inclinação altera-se, tal como ilustra o diagrama seguinte, em função da definição
de [Ceiling].

A: Quando [Ceiling] está definido para [Off]
B: Quando [Ceiling] está definido para [On]

Item
Definição do

item
secundário

Predefinição Descrição

Ceiling On / Off Off

Quando o aparelho está montado numa secretária, defina para [Off].
Quando o aparelho está montado num teto, defina para [On]. Quando
[Ceiling] está definido para [On], [Pan Direction] é automaticamente
definida para [Opposite].

Pan
Direction

Normal /
Opposite

Normal Define a direção da ação de deslocamento. Depois de a definição ter
sido alterada, a direção da ação inverte-se.

Tilt
Direction

Normal /
Opposite

Normal
Define a direção da ação de inclinação. Depois de a definição ter sido
alterada, a direção da ação inverte-se.
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P/T Preset

Estabelece as definições relacionadas com as predefinições da câmara.

Pan-Tilt
Define a velocidade para as predefinições.

Default
Define os valores predefinidos que são configurados quando uma posição de predefinição é guardada.
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Item Definição do item
secundário Predefinição Descrição

Pan-Tilt Speed
Setting Way

Separate /
Common

Separate
Define se as velocidades predefinidas são configuradas de
forma independente ou usam uma definição comum.

Pan-Tilt Speed
for Common

1 a 50 50

Define a velocidade comum para as predefinições.

Nota

Se for definido um valor de 25 ou mais quando [Pan-Tilt] > [P/T
Speed] > [Speed Step] está definido para [Normal], é usada a
velocidade de ação máxima de 24.

Item Definição do item
secundário Predefinição Descrição

Pan-Tilt Speed
for Separate

1 a 50 50
Define a velocidade para as predefinições quando o método
de seleção da velocidade da predefinição está definida para
[Separate].

Zoom Sync On / Off On
Define se a operação de deslocamento/inclinação e a
operação de zoom são sincronizadas ao restaurar uma
posição de predefinição.

Zoom Speed 0 a 32767 32767 Define a velocidade do zoom.

Focus Recall On / Off On Define se as definições de focagem são restauradas.

MF Speed 0 a 32767 32767 Define a velocidade de focagem para a focagem manual.
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Output Format

Define as definições do formato de saída.

Tópico relacionado
Formatos de saída e limitações
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Item Definição do item secundário Predefinição Descrição

SDI Para mais pormenores sobre as definições, consulte
“Formatos de saída e limitações”.

– Define a resolução de saída
SDI e HDMI.HDMI –
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Output Display

Estabelece as definições relacionadas com os sinais de saída.
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Item Definição do item
secundário Predefinição Descrição

SDI On / Off Off
Define se as informações de menu e de estado são integradas
no sinal de saída SDI.

HDMI/Stream On / Off On

Define se o menu e o estado são integrados no sinal de saída
HDMI.

Nota

Esta definição também é aplicada à imagem do sinal de saída
HDMI, à imagem de saída de transmissão e à imagem no painel
de imagem da câmara na Web App.
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Audio Input

Estabelece definições relacionadas com a entrada de áudio de CH1 a CH4.

Define o nível de entrada do áudio principal. O nível de entrada de áudio principal é usado para todos os canais de 1 a
4.
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Item Definição do item
secundário Predefinição Descrição

Level
Control

Auto / Manual Auto
Seleciona o ajuste automático ou manual do nível
de entrada de áudio.

Level 0 a 99 49 Define o nível de entrada.

Input
Select

AUDIO IN CH1 / AUDIO IN
CH2 / Off

CH1 e CH3: AUDIO
IN CH1
CH2 e CH4: AUDIO
IN CH2

Define a fonte de entrada do áudio.

Nota

CH1 está definido para [AUDIO IN CH1] (fixo).

Wind Filter On / Off Off
Ativa/desativa o filtro de redução do ruído do
vento.

Item Definição do item secundário Predefinição Descrição

Master 0 a 99 99 Define o nível de entrada principal.
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Audio Output

Estabelece as definições relacionadas com a saída de áudio.

Nota

Esta definição também é aplicada ao áudio de saída da transmissão.
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Item Definição do item
secundário Predefinição Descrição

HDMI/Stream
Output CH

CH1/CH2 / CH3/CH4 CH1/CH2
Define a combinação de canais de áudio para a
saída HDMI/transmissão.
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Tracking Data Output

Define as definições relacionadas com a saída de informações de seguimento (em conformidade com o protocolo free-
d).
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Item Definição do item
secundário Predefinição Descrição

Transfer Mode
Off / Always / On
Demand

Off
Seleciona o método de saída das informações de
seguimento.

Camera ID 0 a 255 255 Define a ID do aparelho.

Destination
Address

Endereço IPv4 –
Quando [Transfer Mode] está definido para [Always], define o
endereço IP de destino das informações de seguimento.

Destination
Port

1024 a 65534 40000
Quando [Transfer Mode] está definido para [Always], define o
número da porta de destino das informações de seguimento.

Listen Port 1024 a 65534 40000
Quando [Transfer Mode] está definido para [On Demand],
define o número da porta no aparelho para ouvir os pedidos
dos clientes.
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Tally

Estabelece as definições para a luz de gravação/indicadora (consulte “Ligar um sinal indicador”).

Tópico relacionado

Ligar um sinal indicador
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Item Definição do item
secundário Predefinição Descrição

Tally Lamp
Brightness

High / Low / Off High Define a luminosidade da luz de gravação/indicadora.

G Tally Lamp Enable / Disable Enable Ativa/desativa a luz G Tally.

Tally Control External / Internal Internal
Seleciona o alvo para aceitar a informação de controlo da
luz de gravação/indicadora do aparelho.
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IR Remote

Estabelece as definições relacionadas com o controlo remoto de infravermelhos.
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Item Definição do item
secundário Predefinição Descrição

Setting On / Off On
Ativa/desativa o funcionamento do aparelho a partir do controlo
remoto de infravermelhos.
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RCP/MSU

Configura a definição quando um RCP/MSU (opção) está ligado.
Para mais informações, consulte “Ligar um RCP/MSU (opção)”.

Nota

Configure as definições no RCP/MSU, conforme necessário.

É necessária uma MSU para um sistema multicâmara.

Ao usar várias unidades MSU, defina uma unidade MSU como a principal e defina todas as outras unidades MSU como clientes.
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Item Definição do item
secundário Predefinição Descrição

CNS Mode
Off / Bridge / MCS /
PC Control

Off Define o modo de ligação para o RCP/MSU.

Master IP
Address

Endereço IPv4 0.0.0.0
Define o endereço IP do dispositivo principal ao criar um
sistema multicâmara baseado em LAN.

Camera No. Camera No. (1 a 96) 1 Define um número de câmara único no sistema ao criar um
sistema multicâmara baseado em LAN.
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Lens Controller

Define as definições para um controlador da objetiva ligado (opção).
Para mais informações, consulte “Ligar um controlador da objetiva.”

Nota

Quando [Setting] for alterada, o aparelho irá reiniciar. Recarregue a página no browser da web.
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Item
Definição do

item
secundário

Predefinição Descrição

Setting On / Off Off Define se utiliza o controlador da objetiva (opção).

Mode 0 a 15 0

Define o modo de funcionamento do controlador da objetiva (opção).
Estão disponíveis valores no intervalo de 0 a 15, mas os valores reais
que podem ser selecionados variam consoante o controlador da
objetiva (opção). Para mais informações, consulte o manual de
instruções do controlador da objetiva.

Reverse On / Off Off Inverte a direção de rotação do controlador da objetiva (opção).

Initialize – – Inicializa o controlador da objetiva (opção).
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Camera Name

Estabelece as definições relacionadas com o nome da câmara (nome do aparelho).

É possível inserir até oito (0 a 8) dos carateres seguintes para Camera Name.
Caracteres alfanuméricos
Símbolos (espaço !#$`*+-./;<=>?@[\]^_`{|})
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Item Definição do item secundário Predefinição Descrição

Camera Name – FR7 Define o nome da câmara.
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User

Estabelece as definições relacionadas com o acesso do utilizador ao aparelho.

Definições relacionadas com utilizadores administradores (Administrator) (obrigatório)

Definições relacionadas com utilizadores gerais (User 1 a User 9) (opcional)
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Item Definição do item
secundário Predefinição Descrição

User Name – admin Define o nome de utilizador.

Current
Password

– –
Quando pretender alterar a palavra-passe, introduza a
palavra-passe atual.

New Password – – Introduza a nova palavra-passe.

Re-Type
Password

– –
Introduza outra vez a nova palavra-passe, para
confirmação.

Item Definição do item
secundário Predefinição Descrição

User Name – – Define o nome de utilizador.

Current
Password

– –
Quando pretender alterar a palavra-passe, introduza a
palavra-passe atual.

New Password – – Introduza a nova palavra-passe.

Re-Type
Password – –

Introduza outra vez a nova palavra-passe, para
confirmação.
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Wired LAN

Status
Apresenta o estado da rede.

IPv4
Estabelece as definições relacionadas com a rede IPv4.

Item Definição do item
secundário Predefinição Descrição

Host Name – – Apresenta o nome de anfitrião.

MAC Address – – Apresenta o endereço MAC do aparelho.

Ethernet Status – –
Apresenta a velocidade de comunicação
atual.

IP Address – – Apresenta o endereço IP do aparelho.

Subnet Mask – – Apresenta a máscara de subrede do aparelho.

Gateway – –
Apresenta o gateway predefinido IPv4 do
aparelho.

Primary DNS Server – –
Apresenta o servidor DNS principal do
aparelho.

Secondary DNS
Server

– –
Apresenta o servidor DNS secundário do
aparelho.

IPv6 Address 1 – – Apresenta o endereço IPv6 1 do aparelho.

IPv6 Address 2 – – Apresenta o endereço IPv6 2 do aparelho.

IPv6 Gateway – –
Apresenta o gateway predefinido IPv6 do
aparelho.

Link-local IPv6
Address

– – Apresenta o endereço IPv6 local do aparelho.

Item Definição do item
secundário Predefinição Descrição

DHCP On / Off On Ativa/desativa a função [DHCP].

IP Address – –
Define o endereço IPv4 quando [DHCP] está definido para
Off.

Subnet
Mask

– –
Define a máscara de sub-rede quando [DHCP] está
definido para Off.
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IPv6
Estabelece as definições relacionadas com a rede IPv6.

Common
Estabelece as definições comuns às redes IPv4/IPv6.
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Item Definição do item
secundário Predefinição Descrição

Gateway – –
Define o gateway IPv4 predefinido quando [DHCP] está
definido para Off.

Item Definição do item
secundário Predefinição Descrição

Obtain an IP Address
Automatically

On / Off On
Ativa/desativa a aquisição automática de endereço
IPv6.

IP Address – –
Define o endereço IPv6 quando [Obtain an IP
Address Automatically] está definido para Off.

Prefix Length – – Define o prefixo quando [Obtain an IP Address
Automatically] está definido para Off.

Gateway – –
Define o gateway IPv6 predefinido quando [Obtain an
IP Address Automatically] está definido para Off.

Item Definição do item
secundário Predefinição Descrição

HTTP Port 80, 1024 a 65534 80 Define o número da porta HTTP.

DNS Auto On / Off On
Define se os endereços DNS são obtidos do servidor
DHCP.

Primary DNS
Server

Endereço IPv4/IPv6 –
Define o servidor DNS principal quando [DNS Auto]
está definido para Off.

Secondary DNS
Server

Endereço IPv4/IPv6 –
Define o servidor DNS secundário quando [DNS
Auto] está definido para Off.

416



Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

File Transfer

Define as definições relacionadas com as transferências de ficheiros.
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Item Definição do
item secundário Predefinição Descrição

Auto
Upload
(Proxy)

On / Off Off Ativa/desativa o carregamento automático do ficheiro proxy.

Default
Upload
Server

Server Settings1
a 3 > Display
Name

Server
Settings1

Seleciona o servidor de carregamento para ficheiros. O servidor
selecionado aqui torna-se o destino automático de carregamento
para ficheiros proxy e o destino de carregamento para ficheiros a
partir do ecrã de miniaturas.
Apresenta as definições de [Display Name] configuradas em
[Server Settings1 a 3].
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FTP Server 1 a 3

Estabelece as definições relacionadas com as transferências de ficheiros por FTP.
As definições são comuns ao FTP Server 1 a 3.
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Item Definição do item
secundário Predefinição Descrição

Display Name – –
Define o nome de apresentação mostrado no menu de
configuração do destino da transferência.

Service – – Apresenta o tipo de servidor.

Host Name – –
Define o nome do anfitrião do servidor de destino da
transferência.

Port
21, 990, 1024 a
65534

21
Define o nome da porta do servidor de destino da
transferência.

User Name – –
Define o nome de utilizador para autenticação da ligação
do servidor de destino da transferência.

Password – –
Define a palavra-passe de autenticação da ligação do
servidor de destino da transferência.

Passive Mode On / Off Off Ativa/desativa o modo passivo.

Destination
Directory

– – Define o nome do diretório de destino da transferência.

Using Secure
Protocol

On / Off Off
Define se usa (On) ou não usa (Off) a transferência FTP
segura.

Root Certificate – –

Carrega o certificado de raiz para transferências FTP
seguras.
Prima o botão [Load] e selecione um certificado de raiz
no ecrã apresentado.
Prima o botão [Delete] para eliminar o certificado de raiz
carregado.

Root Certificate
Status

– –
Apresenta o estado de carregamento do certificado de
raiz.

Reset – –
Repõe as definições de [Server Settings] para as
predefinições.
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SSL

Estabelece as definições relacionadas com SSL.

SSL
Ativa/desativa a função SSL.

SSL Server Authentication
Estabelece as definições relacionadas com a autenticação SSL do servidor.

Item Definição do item secundário Predefinição Descrição

Function
Disable / Enable / Enable (Allow HTTP connection for some
clients)

Disable
Ativa/desativa a função
SSL.

Item Definição do item
secundário Predefinição Descrição

Certificate
Options

Use a self-signed
certificate (For test use) /
Use an external certificate

–
Define o método de instalação do certificado SSL do
servidor.

Status – –
Apresenta a validade do certificado SSL do servidor,
quando [Certificate Options] está definido para [Use
a self-signed certificate (For test use)].

Issuer DN – –

Apresenta o nome específico do emissor do
certificado SSL do servidor, quando [Certificate
Options] está definido para [Use a self-signed
certificate (For test use)].

Subject DN – –

Apresenta o nome específico do recetor do
certificado SSL do servidor, quando [Certificate
Options] está definido para [Use a self-signed
certificate (For test use)].

Available Period – –

Apresenta o período de validade do certificado SSL
do servidor, quando [Certificate Options] está
definido para [Use a self-signed certificate (For test
use)].

Extended Key
Usage

– –
Apresenta o método de utilização de Extended Key,
quando [Certificate Options] está definido para [Use
a self-signed certificate (For test use)].

Delete – –

Este botão apenas é apresentado quando [Certificate
Options] está definido para [Use a self-signed
certificate (For test use)].
Elimina o certificado SSL do servidor instalado.
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Item Definição do item
secundário Predefinição Descrição

Import – –
Instala um certificado SSL do servidor externo a
partir de uma lista, quando [Certificate Options] está
definido para [Use an external certificate].

Private Key
Password

– –

Define a palavra-passe para a informação da chave
privada do certificado SSL do servidor, quando
[Certificate Options] está definido para [Use an
external certificate].

Reset – –
Este botão desativa a apresentação da palavra-
passe da chave privada, para introdução de uma
palavra-passe nova.

Self-Signed
Certificate
Generation

– –

Prima o botão [Generate] para gerar um certificado
autoassinado, quando [Certificate Options] está
definido para [Use a self-signed certificate (For test
use)].
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Referer Check

Estabelece as definições relacionadas com verificações Referer.

Exception List
Estabelece as definições relacionadas com a lista de exceções de Referer check.

Item Definição do item secundário Predefinição Descrição

Setting On / Off On Ativa/desativa a função Referer check.

Item Definição do item
secundário Predefinição Descrição

No. 1 a 10 – Define o número de exceção a partir da lista.

Host
Name

– – Define o nome de anfitrião da exceção.

Port
Number

– – Define o número de porta da exceção.

Set – – Prima para registar a exceção configurada na lista de exceções.

Delete – –
Selecione uma exceção que pretende eliminar e, de seguida,
prima o botão para eliminar a exceção registada a partir da lista de
exceções.
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Brute Force Attack Protection

Estabelece as definições relacionadas com a prevenção de ataques de força bruta.

Quando um atacante é detetado, é apresentada a informação com a lista de atacantes.
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Item Definição do item
secundário Predefinição Descrição

Setting On / Off On Ativa/desativa a função [Brute Force Attack Protection].

Count 3 a 100 8
Define o número de tentativas que será considerado como um
ataque.
Ativado quando [Setting] está definido para On.

Release
Mode

Always / Timer Timer

Define a condição para libertação.
Ativado quando [Setting] está definido para On.
Always: não eliminar da lista de atacantes.
Timer: eliminar da lista de atacantes após o tempo para libertação
usando [Release Time] se ter esgotado.

Release
Time

30 a 86400
segundos

60

Define o tempo para libertação.
Ativado quando [Setting] está definido para On.
Quando Release Mode está definido para [Timer], as entradas são
eliminadas da lista de atacantes após o tempo para libertação se
ter esgotado.
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Stream

Estabelece as definições de transmissão (consulte “Sobre a transmissão”).

Stream Setting
Estabelece as definições relacionadas com o protocolo de transmissão.

Nota

Para utilizar RTMP, defina previamente [Stream] > [Audio Stream] > [Setting] para [On].

RTSP
Os itens seguintes são apresentados quando [Stream Setting] está definido para [RTSP].
Estabelece as definições relacionadas com a transmissão RTSP.

RTMP
Os itens seguintes são apresentados quando [Stream Setting] está definido para [RTMP].
Define as definições relacionadas com a transmissão RTMP.

Item Definição do item secundário Predefinição Descrição

Setting
RTSP / RTMP / SRT-Caller / SRT-Listener / NDI|HX /
Off

RTSP
Seleciona o protocolo de
transmissão.

Item Definição do item
secundário Predefinição Descrição

Port Number 554, 1024 a 65534 554 Define o número da porta RTSP.

Time Out 0 a 600 60
Define o limite de tempo do comando Keep Alive para
transmissão RTSP.

Authentication On / Off On Ativa/desativa a função de autenticação RTSP.

Video Port
Number 1

1024 a 65534 51000
Define o número da porta para envio do vídeo 1 para
transmissão RTSP unidifusão.

Video Port
Number 2

1024 a 65534 53000
Define o número da porta para envio do vídeo 2 para
transmissão RTSP unidifusão.

Audio Port
Number

1024 a 65534 57000
Define o número da porta para envio de áudio para
transmissão RTSP unidifusão.

Item Definição do item
secundário Predefinição Descrição

Server URL – – Define o URL de destino da ligação RTMP ou RTMPS.

Stream Key – – Define a chave de transmissão obtida do servidor RTMP.
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SRT
Os itens seguintes são apresentados quando [Stream Setting] está definido para [SRT-Caller] ou [SRT-Listener].
Estabelece as definições relacionadas com a transmissão SRT.

NDI|HX
Os itens seguintes são apresentados quando [Stream Setting] está definido para [NDI|HX].
Estabelece as definições relacionadas com NDI|HX.

Item Definição do item
secundário Predefinição Descrição

Root
Certificate

– –

Carrega o certificado de raiz necessário para a ligação ao
servidor RTMP.
Prima o botão [Load] e selecione um certificado de raiz
no ecrã apresentado.
Prima o botão [Delete] para eliminar o certificado de raiz
carregado.
O estado é apresentado em [Root Certificate Status].

Item Definição do item
secundário Predefinição Descrição

Destination – –
Define o URL de destino da ligação quando o aparelho
está a funcionar como chamador.

Port
Number

1024 a 65534 4201
Define o número de porta para ouvir quando o aparelho
está a funcionar como recetor.

Latency 20 a 8000 ms 120 Define a latência.

TTL 1 a 255 64 Define o valor de TTL.

Encryption Off / AES128 / AES256 Off Ativa/desativa a encriptação e define o método de
encriptação.

Passphrase
0 ou cadeia de 10 a 79
caracteres

0
Define a frase-passe usada para a encriptação.
Prima Reset para eliminar a frase-passe inserida.

ARC On / Off On Liga/desliga a função Adaptive Rate Control.

Item Definição do item
secundário Predefinição Descrição

License – –
Apresenta o estado de instalação da chave de licença
NDI.

Source Name – – Apresenta o nome da fonte NDI.

Group On / Off Off Ativa/desativa a função de agrupamento NDI.

Group Name – –
Apresentado quando a função de agrupamento NDI
está definida para On.
Define o nome do grupo.

Discovery
Server 1

– – Define o servidor NDI Discovery 1.
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Tópico relacionado
Sobre a transmissão
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Item Definição do item
secundário Predefinição Descrição

Discovery
Server 2

– – Define o servidor NDI Discovery 2.

Multicast Mode On / Off Off Ativa/desativa a transmissão multidifusão.

Multicast Prefix 239.255.0.0 239.255.0.0
Apresentado quando [Multicast Mode] está definido para
On.
Define o prefixo a usar para a transmissão multidifusão.

Multicast
Netmask

255.255.0.0 255.255.0.0

Apresentado quando [Multicast Mode] está definido para
On.
Define a máscara de rede que determina o intervalo do
endereço multidifusão.

Multicast TTL 1 a 256 3
Apresentado quando [Multicast Mode] está definido para
On.
Define o valor de TTL para a transmissão multidifusão.

Multi-TCP
Mode

On / Off Off Ativa/desativa o modo Multi-TCP.

Unicast UDP
Mode

On / Off On Ativa/desativa o modo Unicast UDP.
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Video Stream

Estabelece as definições relacionadas com os codecs de vídeo para transmissão.

Video Stream 1
Estabelece as definições relacionadas com o codec de vídeo 1.

Item Definição do item secundário Predefinição Descrição

Codec 1 H.264 / H.265 H.264 Define o codec da imagem 1.

Size 1
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360

1920×1080
Define o tamanho de imagem da
imagem 1.

Frame Rate 1

Para mais pormenores sobre as taxas
de fotogramas suportadas, consulte
“Definir o codec de vídeo para
transmissão”.

–
Define a taxa de fotogramas da
imagem 1.

I-Picture Mode 1 Time / Frame Time

Define o intervalo de inserção de
IDR-Frame para a imagem 1 como
um tempo ou um número de
fotogramas.

I-Picture Interval
1

1 / 2 / 3 / 4 / 5 s 1

Apresentado quando [I-Picture Mode
1] está definido para Time.
Define o intervalo de inserção de
IDR-Frame para H.264 e H.265
como um tempo.

I-Picture Ratio 1 15 a 300 fotogramas 30

Apresentado quando [I-Picture Mode
1] está definido para Frame.
Define o intervalo de inserção de
IDR-Frame para H.264 e H.265
como um número de fotogramas.

Profile 1
H.264: high / main / baseline
H.265: main / main10

H.264: high Define o perfil de H.264 ou H.265.

Bit Rate
Compression
Mode 1

CBR / VBR VBR
Define o modo de compressão da
taxa de bits da imagem 1.

Bit Rate 1
512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 / 24000
/ 32000 / 50000 / 64000 / 80000 kbps

16000

Apresentado quando [Bit Rate
Compression Mode 1] está definido
para On.
Define o valor alvo da taxa de bits
quando o modo de compressão da
taxa de bits está definido para CBR.
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Video Stream 2
Estabelece as definições relacionadas com o codec de vídeo 2.

Item Definição do item secundário Predefinição Descrição

Quality 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6
Define a qualidade de H.264 ou
H.265.

Item Definição do item secundário Predefinição Descrição

Codec 2 H.264 / H.265 / Off Off Define o codec da imagem 2.

Size 2
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360 /
512×270

1920×1080
Define o tamanho de imagem da
imagem 2.

Frame Rate 2

Para mais pormenores sobre as
taxas de fotogramas suportadas,
consulte “Definir o codec de vídeo
para transmissão”.

–

Apresentado quando [Codec 2] não
está definido para Off.
Define a taxa de fotogramas da
imagem 2.

I-Picture Mode 2 Time / Frame Time

Apresentado quando [Codec 2] não
está definido para Off.
Define o intervalo de inserção de IDR-
Frame para a imagem 2 como um
tempo ou um número de fotogramas.

I-Picture Interval
2

1 / 2 / 3 / 4 / 5 s 1

Apresentado quando, ao mesmo
tempo, [Codec 2] não está definido
para Off e [I-Picture Mode 2] está
definido para [Time].
Define o intervalo de inserção de IDR-
Frame para H.264 e H.265 como um
tempo.

I-Picture Ratio 2 15 a 300 fotogramas 30

Apresentado quando, ao mesmo
tempo, [Codec 2] não está definido
para Off e [I-Picture Mode 2] está
definido para [Frame].
Define o intervalo de inserção de IDR-
Frame para H.264 e H.265 como um
número de fotogramas.

Profile 2
H.264: high / main / baseline
H.265: main

– Define o perfil de H.264 ou H.265.

Bit Rate
Compression
Mode 2

CBR / VBR VBR

Apresentado quando [Codec 2] não
está definido para Off.
Define o modo de compressão da taxa
de bits da imagem 2.
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Video Stream 3
Estabelece as definições relacionadas com o codec de vídeo 3.

Tópico relacionado
Definir o codec de vídeo para transmissão

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Bit Rate 2

512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 /
24000 / 32000 / 50000 / 64000 / 80000
kbps

8000

Apresentado quando, ao mesmo
tempo, [Codec 2] não está definido
para Off e [Bit Rate Compression Mode
2] está definido para [On].
Define o valor alvo da taxa de bits
quando o modo de compressão da taxa
de bits está definido para CBR.

Quality 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6

Apresentado quando, ao mesmo
tempo, [Codec 2] está definido para
H.264 e [Bit Rate Compression Mode 2]
está definido para Off.
Define a qualidade de H.264 ou H.265.

Item Definição do item secundário Predefinição Descrição

Codec 3 JPEG JPEG
Define o codec da
imagem 3.

Size 3 1280×720 / 1024×540 / 640×360 1280×720
Define o tamanho de
imagem da imagem 3.

Frame
Rate 3

Para mais pormenores sobre as taxas de fotogramas
suportadas, consulte “Definir o codec de vídeo para
transmissão”.

–
Define a taxa de
fotogramas da imagem
3.

Quality 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Define a qualidade.
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Audio Stream

Estabelece as definições relacionadas com o codec de áudio para transmissão.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Setting On / Off Off Liga/desliga a saída de áudio para transmissão.

Codec AAC (128kbps) / AAC (256kbps) AAC (128kbps)
Apresentado quando [Setting] está definido para On.
Define o codec de áudio para transmissão.
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Language

Define o idioma de apresentação.

Nota

Os idiomas disponíveis poderão variar consoante o país ou a região.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Language – – Define o idioma de apresentação.
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Accessibility

Define as definições relacionadas com a leitura por áudio (texto em voz).

Nota

Esta função só está disponível em modelos vendidos na América do Norte. A função do leitor de ecrã só pode ser utilizada
quando o idioma está definido para Inglês (a partir da data de lançamento).

Ative a função de leitura do ecrã do navegador de internet no dispositivo onde está a Web App.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Screen
Reader

On / Off Off 
Ativa/desativa a função de leitura do ecrã no painel
de imagem da câmara da Web App.

Speech
Rate

Slow2 / Slow1 / Normal / Fast1 /
Fast2 / Fast3 / Fast4

Normal
Define a velocidade da função do leitor de ecrã.
É lida uma passagem de amostra em voz alta à
velocidade configurada.

Speech
Volume

1 a 15 7

Define o volume da função de leitura do ecrã da
Web App.
É lida em voz alta uma amostra de texto, com o
volume configurado.
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Clock Set

Define as definições do relógio interno.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item secundário Predefinição Descrição

Current Date
& Time

– – Apresenta a hora atual configurada no aparelho.

PC Clock – –
Apresenta a hora atual do tablet ou computador
utilizador para a configuração.

Date & Time
Format

yyyy-mm-dd hh:mm:ss / mm-dd-
yyyy hh:mm:ss / dd-mm-yyyy
hh:mm:ss

yyyy-mm-dd Define o formato de apresentação da data e hora.

12 h / 24 h 12 h / 24 h 24 h
Define a hora para o formato de apresentação de
12 horas/24 horas.

Time Setting
Keep current setting /
Synchronize with PC / Manual
setting / Synchronize with NTP

– Define o método de configuração da data e hora.

yy-mm-dd
hh:mm:ss

yy: 19 a 37
mm: 01 a 12
dd: 01 a 31
hh: 00 a 23
mm: 00 a 59
ss: 00 a 59 (segundos)

–
Apresentado quando [Time Setting] está definido
para Manual setting.
Define manualmente a data e hora.

NTP Auto On / Off Off

Apresentado quando [Time Setting] está definido
para Synchronize with NTP.
Define se o endereço IP do servidor NTP é obtido
do servidor DHCP.

NTP Server
Endereço IPv4/IPv6 ou nome de
anfitrião

–

Apresentado quando, ao mesmo tempo, [Time
Setting] está definido para [Synchronize with NTP]
e [NTP Auto] está definido para Off.
Especifica o servidor NTP para sincronização da
hora.

Time Zone UTC -12:00 a UTC +14:00 – Seleciona o fuso horário.
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Reset

Inicializa o aparelho.

Reboot
Reinicia o aparelho.

Reset
Repõe as definições do aparelho.

Item Definição do item secundário Predefinição Descrição

Reboot Execute –

Reinicia o aparelho.
Execute: execute a função.

Nota

Após reiniciar, recarregue a página no browser da web.

Item Definição do item
secundário Predefinição Descrição

All Reset (except for
Network Settings)

Execute –

Repõe as definições do aparelho (exceto as
definições de rede).
Execute: execute a função.

Nota

Os aspetos de base importados e os ficheiros LUT
não são eliminados.

Network Reset Execute –

Repõe as definições de rede do aparelho.
Execute: execute a função.

Nota

Após executar Network Reset, o aparelho reinicia.
Após reiniciar, recarregue a página no browser da
web.

Factory Default Execute –

Repõe o estado predefinido de fábrica das definições
do aparelho.
Execute: execute a função.

Nota

Após executar Factory Default, o aparelho reinicia.
Após reiniciar, recarregue a página no browser da
web.
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Information

Apresenta as informações da câmara e objetiva. Também utilizado para atualizar o software.

Camera
Apresenta informações da câmara e atualiza o software.

Lens
Apresenta informações da objetiva e atualiza o software.

Item Definição do item
secundário Predefinição Descrição

Model
Name

– – Apresenta o nome do modelo da câmara.

Serial
Number

– – Apresenta o número de série da câmara.

Version
Number – – Apresenta a versão de software da câmara.

Version Up – –

Prima o botão [Choose File] e siga as instruções no ecrã,
para atualizar o software da câmara.

Nota

Após atualizar, o aparelho reiniciará. Após reiniciar,
recarregue a página no browser da web.

Item Definição do item
secundário Predefinição Descrição

Model
Name

– – Apresenta o nome do modelo da objetiva.

Serial
Number

– – Apresenta o número de série da objetiva.

Version
Number

– – Apresenta a versão de software da objetiva.
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Tópico relacionado

Atualizar o software da objetiva com encaixe E

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Version Up – –

Prima o botão [Choose File] e siga as instruções no ecrã,
para atualizar o software da objetiva.

Para mais informações, consulte “Atualizar o software da
objetiva com encaixe E”.

Nota

Após atualizar a objetiva, o aparelho reiniciará. Após reiniciar,
recarregue a página no browser da web.
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System Log

Define as definições relacionadas com o System Log.

O registo obtido é apresentado da seguinte forma.

Tópico relacionado

Atualizar o software da objetiva com encaixe E

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical, Warning
& Info

Define o nível para adicionar uma gravação ao
registo do sistema.

Log Size 200 a 1024 1024
Define o tamanho do registo a guardar no registo do
sistema.

Download
as File – –

Prima o botão [Download] e guarde o registo do
sistema num tablet ou computador, a partir do ecrã
apresentado.
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HTTP Access Log

Define as definições relacionadas com o HTTP Access Log.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do item
secundário Predefinição Descrição

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical, Warning
& Info

Define o nível para adicionar uma gravação ao
registo de acesso HTTP.

Log Size 200 a 1024 1024
Define o tamanho do registo a guardar no registo de
acesso HTTP.

Download
as File – –

Prima o botão [Download] e guarde o registo de
acesso HTTP num tablet ou computador, a partir do
ecrã apresentado.
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Service

Obtém informações do dispositivo sobre o aparelho. Utilize quando contactar o seu representante de assistência Sony.

5-041-957-53(1) Copyright 2022 Sony Corporation

Item Definição do
item secundário Predefinição Descrição

I agree to download
device information.

– –

Coloque aqui uma marca de verificação para aceitar a
obtenção de informações do dispositivo e prima o botão
[OK].
Prima o botão apresentado [Download]. O browser da web
transferirá momentaneamente um ficheiro denominado
deviceinformation.dat.

Nota

Após transferir, o aparelho reiniciará. Reinicie
manualmente se o aparelho não reiniciar automaticamente.
Após reiniciar, recarregue a página no browser da web.
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EULA

Apresenta o Contrato de Licença de Utilizador Final (End User License Agreement − EULA).

5-041-957-53(1) Copyright 2022 Sony Corporation
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Software

Apresenta a licença do software.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Ligar monitores externos e dispositivos de gravação

Para apresentar/reproduzir imagens gravadas num monitor externo, defina o tipo de saída de vídeo para o monitor
externo e utilize um cabo adequado para o monitor a ligar.
Pode também ligar um gravador externo e gravar o sinal de saída do aparelho.
Pode apresentar as mesmas informações que estão visíveis no painel de imagem da câmara, tais como informações de
estado e menus, num monitor externo. Defina o tipo de sistema pretendido para apresentação do ecrã para On, usando
[Monitoring] > [Output Display] no menu web.

Nota

Se o monitor ligado ao conector HDMI não for compatível com o formato de saída HDMI configurado através do menu
[Monitoring], no menu web ou no menu da câmara, a imagem da câmara não será apresentada na Web App. O vídeo da
transmissão também não pode ser emitido.

Pode definir [Output Display] > [SDI] e [HDMI/Stream] para [Off], mas isso impedirá a utilização do menu da câmara e das
funções que dependem da apresentação do ecrã. Além disso, as notificações de erro do aparelho serão limitadas às luzes
(acesas ou a piscar) e à apresentação da marca de notificação no canto superior direito na Web App. Para conhecer o estado
detalhado, defina [Output Display] para [On].

Sugestão

Por predefinição, [Output Display] > [SDI] está definido para [Off] e [HDMI/Stream] está definido para [On]. Para utilizar a
transmissão como vídeo principal, defina [SDI] para [On] e [HDMI/Stream] para [Off], e monitorize o estado da câmara num
monitor SDI.

Conector SDI OUT (tipo BNC)

Defina o formato de saída usando o menu [Monitoring] no menu web ou no menu da câmara.
Utilize um cabo coaxial de 75 Ω comercialmente disponível para a ligação.

Nota

Certifique-se de que a ligação entre o aparelho e o dispositivo externo está ligada à terra antes de ligar os dispositivos.

É aconselhável que o aparelho e o dispositivo externo sejam ligados após ligar o cabo coaxial de 75 Ω.
Se o dispositivo externo tiver de ser ligado ao aparelho enquanto o aparelho está ligado, ligue primeiro o cabo coaxial de
75 Ω ao dispositivo externo e, de seguida, ligue-o ao aparelho.

Iniciar a gravação no aparelho e no dispositivo externo simultaneamente
Com a saída de sinal SDI ativada, defina [Project] > [SDI/HDMI Rec Control] > [Setting] para [SDI/HDMI Remote I/F] ou
[Parallel Rec] no menu da câmara, para ativar a saída de um sinal de acionamento REC para o dispositivo externo
ligado ao conector SDI OUT. Isto vai sincronizar a gravação no dispositivo externo com o aparelho.

Nota

Se um dispositivo externo ligado não suportar um sinal de acionamento REC, o dispositivo não pode ser utilizado.

Quando [Project] > [SDI/HDMI Rec Control] > [Setting] está definido para [SDI/HDMI Remote I/F] no menu da câmara, apenas o
sinal de acionamento REC é emitido, quando não existe um suporte de gravação inserido e o botão de gravação START/STOP é
acionado.

443



Conector HDMI OUT (conector Type A)

Defina a definição de saída On/Off e o formato de saída no menu [Monitoring], no menu da câmara.

Iniciar a gravação no aparelho e no dispositivo externo simultaneamente
Com a saída do sinal HDMI ativada, defina [TC/Media] > [HDMI TC Out] > [Setting] para [On] e [Project] > [SDI/HDMI
Rec Control] > [Setting] para [SDI/HDMI Remote I/F] ou [Parallel Rec] no menu da câmara, para ativar a saída de um
sinal de acionamento REC para o dispositivo externo ligado ao conector HDMI OUT. Isto vai sincronizar a gravação no
dispositivo externo com o aparelho.

Nota

Se um dispositivo externo ligado não suportar um sinal de acionamento REC, o dispositivo não pode ser utilizado.

Quando [Project] > [SDI/HDMI Rec Control] > [Setting] está definido para [SDI/HDMI Remote I/F] no menu da câmara, apenas o
sinal de acionamento REC é emitido, quando não existe um suporte de gravação inserido e o botão de gravação START/STOP é
acionado.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Ligar com um RCP/MSU

Algumas das funções do aparelho podem ser controladas remotamente ligando um painel de controlo remoto (RCP), tal
como o RCP-3500/3501 ou uma unidade de configuração principal (MSU), tal como a MSU-3500 ao aparelho através de
um cabo LAN.
O método de ligação irá variar consoante a configuração dos dispositivos relacionados e a aplicação.

Para informações sobre uma ligação ponto a ponto entre o aparelho e um RCP, consulte “Ligação ponto a ponto
entre o aparelho e um RCP”.
Para informações sobre ligar várias câmaras usando uma MSU ou software de controlo da câmara, consulte “Utilizar
o aparelho num ambiente multicâmara com uma MSU/software de controlo remoto da câmara”.

Tópico relacionado

Ligação ponto a ponto entre o aparelho e um RCP

Utilizar o aparelho num ambiente multicâmara com uma MSU/software de controlo remoto da câmara

5-041-957-53(1) Copyright 2022 Sony Corporation
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Ligação ponto a ponto entre o aparelho e um RCP

Nota

Consulte a “Lista de funções compatíveis” e configure o aparelho de forma a cumprir as condições de funcionamento para as
funções que pretende utilizar e, em seguida, permita a ligação com um RCP através do seguinte procedimento.

Tópico relacionado
Lista de funções compatíveis

5-041-957-53(1) Copyright 2022 Sony Corporation

Ligue todos os dispositivos.1

Defina [Technical] > [RCP/MSU] > [CNS Mode] para [Bridge] no menu web da câmara.2

Configure as seguintes definições no RCP.

Para mais informações sobre a configuração, consulte o manual de instruções do RCP.

3

Defina o modo de ligação para o modo Bridge.1.
Registe o endereço IP da câmara.2.
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Utilizar o aparelho num ambiente multicâmara com uma MSU/software de controlo
remoto da câmara

Pode ligar várias câmaras utilizando uma MSU ou software de controlo remoto da câmara.

Nota

Consulte a “Lista de funções compatíveis” e configure o aparelho de forma a cumprir as condições de funcionamento para as
funções que pretende utilizar e, em seguida, permita a ligação com uma MSU ou software de controlo remoto da câmara através
do seguinte procedimento.

Tópico relacionado

Lista de funções compatíveis

5-041-957-53(1) Copyright 2022 Sony Corporation

Ligue todos os dispositivos.1

Configure as definições de rede do sistema utilizando a MSU ou o software de controlo remoto da câmara.

Para mais informações sobre a configuração, consulte o manual de instruções da MSU ou do software de controlo
remoto da câmara.

2

Configure as seguintes definições através de [Technical] > [RCP/MSU] no menu web da câmara.3

Se utilizar uma MSU, defina [CNS Mode] para [MCS]. Se utilizar o software de controlo remoto da câmara,
defina [CNS Mode] para [PC Control].

1.

Defina o endereço IP da MSU principal ou do software de controlo remoto da câmara em [Master IP Address].2.
Defina o número de câmara no qual a câmara será registada [Camera No.].3.
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Lista de funções compatíveis

A tabela seguinte mostra as funções compatíveis e condições de funcionamento correspondentes.

Painel de
operações Funções do aparelho Condições de funcionamento

IRIS Ajustar manualmente a íris –

AUTO IRIS Ativar/desativar Auto Iris –

ND
Mudar a posição predefinida do filtro ND
(Clear/Preset1 para Preset3)

Esta função está ativada quando [Shooting] > [ND
Filter] > [Mode] está definido para [Preset] no menu
da câmara.

MASTER
GAIN

Ajustar manualmente o ganho (aparelhos de
3 dB)

Ativado quando o modo de filmagem está definido
para o modo Custom e [Shooting] > [ISO/Gain/EI] >
[Mode] está definido para [dB] no menu da câmara.

WHITE (R/B)
Ajustar manualmente o equilíbrio de brancos
(R Gain/B Gain)

Ativado quando [White Mode] está definido para
[Memory A(R/B)] ou [Memory A(T/T)].WHITE

(Color Temp)

Ajustar manualmente o equilíbrio de brancos
(temperatura/tom de cor)

RCP – [Color Temp]: temperatura de cor
do equilíbrio de brancos
RCP – [Balance]: valor de tom do
equilíbrio de brancos

ATW
Ativar/desativar a função ATW (seguimento
automático do equilíbrio de brancos)

Ativado quando o modo de filmagem está definido
para o modo Custom.

BLACK R/B Ajustar o equilíbrio de pretos
Ativado quando o modo de filmagem está definido
para o modo Custom.
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Nota

Configure o aparelho de forma a cumprir as condições de funcionamento para as funções que pretende utilizar e, em seguida,
permita a ligação com um RCP/MSU. Se as condições de funcionamento forem ajustadas após a ligação ser ativada, poderá
ocorrer um comportamento indesejado.

Painel de
operações Funções do aparelho Condições de funcionamento

MASTER
BLACK

Ajustar o nível de preto principal

Ativado quando o modo de filmagem está
definido para o modo Custom.
H/V Ratio e Crispening estão ativados quando
[Paint/Look] > [Detail] > [Manual Setting] está
definido para [On] no menu da câmara.

DETAIL

Ativar/desativar a função de detalhes
Definir o nível de detalhe
Definir H/V Ratio
Definir Crispening

User Matrix

Ativar/desativar a função de correção da
matriz de utilizador
Definir os valores de correção da matriz
(R-G/R-B/G-R/G-B/B-R/B-G)

Multi Matrix

Ativar/desativar a função de correção
multi-matriz
Definir a tonalidade e a saturação da cor
utilizada para a correção multi-matriz

Knee

Ativar/desativar a função de correção de
ângulo
Ativar/desativar a função de ângulo
automático
Definir o ponto de ângulo e a inclinação de
ângulo

BARS Ativar/desativar as barras de cor

SHUTTER

Ligar/desligar a função de obturador
Definir o valor da velocidade do obturador
(Ligar/desligar o obturador automático,
definir o obturador angular, definir o
obturador lento, definir ECS não
suportado)

Nota

As definições do obturador RCP
poderão não ser apresentadas,
dependendo do valor configurado da
velocidade do obturador.

As definições do obturador RCP
poderão não ser apresentadas
corretamente se o obturador não puder
ser controlado a partir do RCP.

Quando o obturador automático está ligado, o
obturador automático continuará a funcionar mesmo
que ligue/desligue o obturador ou altere o valor da
velocidade do obturador a partir do RCP.
Quando o obturador está definido para [Angle], não é
possível ligar/desligar o obturador ou alterar a
definição da velocidade do obturador a partir do RCP.
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Sobre o funcionamento utilizando um controlo remoto RM-IP500 (opção)

Pode controlar o aparelho utilizando um controlo remoto RM-IP500 da Sony a executar a versão de software 2.2 ou
posterior. Os dispositivos comunicam através de VISCA over IP (LAN).
Dependendo do item pretendido a controlar, poderá ter de visualizar a apresentação do ecrã do aparelho. Prepare um
monitor que possa ser utilizado para verificar a apresentação do ecrã.
As operações seguintes são compatíveis com um controlo remoto RM-IP500.

Selecionar a câmara pretendida
Ajustar o enquadramento (deslocamento, inclinação, zoom)
Ajustar a focagem (exclui operação tátil)
Registar e aceder às posições predefinidas
Utilizar o menu do aparelho (exceto o menu web)
Ajustar a luminosidade
Ajustar o equilíbrio de brancos
Ajustar o equilíbrio de pretos
Ajustar o nível de entrada do áudio
Iniciar/parar a gravação
Executar funções de botão atribuível do aparelho

Para mais informações sobre o funcionamento do RM-IP500, consulte o manual de instruções para o RM-IP500.

Sugestão

Ao utilizar um RM-IP500, utilize a folha do painel para este aparelho fornecida com o RM-IP500.

RM-IP500 (utilizar a folha do painel para este aparelho)
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Ligar um controlo remoto RM-IP500

Para mais informações sobre a atribuição das funções, consulte o manual de instruções para o RM-IP500.

5-041-957-53(1) Copyright 2022 Sony Corporation

Coloque o interruptor SETUP 3 do aparelho na posição ON para ativar a comunicação VISCA over IP.

Nota

A definição do interruptor é aplicada quando o aparelho é ligado.

1

Ligue o RM-IP500 à mesma rede do aparelho.2

Siga o procedimento no manual de instruções do RM-IP500 para configurar a ligação VISCA over IP (LAN)
no RM-IP500.

Atribua este aparelho através do menu RM > AUTO IP SETUP > ASSIGN CAM.

3

Atribua as funções deste aparelho para botões e manípulos, conforme necessário, através dos seguintes
itens do menu RM do RM-IP500.

SW ASSIGN
AE CONFIG2
WB MODE

4

453



Guia de ajuda

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Sobre a sincronização com um dispositivo externo

Ao filmar com vários aparelhos, os aparelhos podem ser sincronizados para um sinal de referência ou código de hora
específico, através do conector GENLOCK dos aparelhos.

Para mais informações sobre Genlock, consulte “Sincronizar a fase do sinal de vídeo (Genlock)”.
Para mais informações sobre a sincronização dos códigos de hora, consulte “Bloquear o código de hora para outros
dispositivos”.

Tópico relacionado

Sincronizar a fase do sinal de vídeo (Genlock)

Bloquear o código de hora para outros dispositivos
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Sincronizar a fase do sinal de vídeo (Genlock)

Pode fornecer um sinal de referência para o conector GENLOCK para ativar Genlock.
Os sinais de referência de entrada que podem ser utilizados variam consoante a frequência de sistema do formato de
gravação selecionado.

Pode alterar o estado de sincronização externa, usando [Technical] > [Genlock] > [Reference] no menu da câmara.

Nota

Se o sinal de referência estiver instável, não é possível obter Genlock.

A subportadora não está sincronizada.

5-041-957-53(1) Copyright 2022 Sony Corporation

Frequência do sistema do formato de gravação Sinais de referência de entrada compatíveis

59.94P
1920×1080 59.94i
720×486 59.94i

50P
1920×1080 50i
720×576 50i

29.97P 1920×1080 59.94i
720×486 59.94i

25P
1920×1080 50i
720×576 50i

24P
1920×1080 24PsF
1920×1080 24P

23.98P
1920×1080 23.98PsF
1920×1080 23.98P

59.94i 1920×1080 59.94i
720×486 59.94i

50i
1920×1080 50i
720×576 50i
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Bloquear o código de hora para outros dispositivos

Defina o aparelho que fornece o código de hora para um modo no qual a saída do código de hora continue a funcionar
(tal como Free Run ou Clock).

Nota

Certifique-se de que o código de hora de referência fornecido e o sinal de vídeo de referência se encontram numa relação de
fase em conformidade com a norma do código de hora SMPTE.

Ao utilizar com bloqueio externo, o código de hora obtém instantaneamente o bloqueio com o código de hora externo e o valor
do código de hora externo aparece na área de apresentação de dados de hora. No entanto, não inicie imediatamente a
gravação. Aguarde alguns segundos até o gerador do código de hora estabilizar antes da gravação.

Se a frequência do sinal de vídeo referência e a frequência do fotograma no aparelho não forem a mesma, o bloqueio não é
obtido e o aparelho não vai funcionar corretamente. Se isto ocorrer, o código de hora não vai bloquear com sucesso com o
código de hora externo.

Se a fonte do código de hora externo for desligada, o código de hora poderá mudar um fotograma por hora em relação ao código
de hora de referência.

Libertar o bloqueio externo
Mude a definição [TC/Media] > [Timecode] no menu da câmara.
A sincronização externa também é libertada se a frequência do sistema for alterada e quando começa a gravar num
modo de gravação especial (Câmara lenta e movimento rápido e Interval Rec).
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Defina o seguinte, usando [TC/Media] > [Timecode] no menu da câmara.

Defina [Mode] para [Preset].
Defina [Run] para [Free Run].

1

Prima um botão atribuível atribuído à função [DURATION/TC/U-BIT] para apresentar o código de hora no
ecrã.

2

Forneça um sinal de vídeo de referência HD ou SD para o conector GENLOCK e o código de hora de
referência para o conector TC IN.

O gerador do código de hora do aparelho bloqueia com o código de hora de referência e aparece “EXT-LK” no
ecrã.
Ao fim de cerca de dez segundos após o bloqueio do código de hora, o estado de bloqueio externo é mantido
mesmo que a fonte do código de hora de referência externo seja desligada.

3
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Ligar um microfone externo ou dispositivo de áudio externo

Pode inserir o sinal de um microfone externo ou dispositivo de áudio externo e integrar o áudio no vídeo gravado ou
vídeo de saída do aparelho.

Ligue um microfone externo ou dispositivo de áudio externo utilizando cabo XLR.

Quando o áudio está definido para [LINE] usando [Audio] > [Audio Input] > [AUDIO IN Select] no menu da câmara,
o conector AUDIO IN funciona como os conectores AUDIO IN CH-1 e AUDIO IN CH-2.

1

N.º pino Função

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1− (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2− (COLD)

Desligue o aparelho e ligue o cabo XLR ao conector AUDIO IN.2

Defina o interruptores SETUP 2 para ativar a fonte de alimentação fantasma, conforme necessário.

Mude a fonte de alimentação +48 V (alimentação fantasma), conforme descrito abaixo.
Interruptor 2
Define se a fonte de alimentação +48 V (alimentação fantasma) é ligada/desligada quando é ligado um dispositivo
de entrada de áudio.

3

Definição Descrição

OFF
(predefinição)

Isto desliga a fonte de alimentação fantasma de +48 V e define a entrada LINE ou MIC como
a fonte de áudio CH-1 e CH-2.
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Nota

Colocar o interruptor na posição ON e ligar um microfone que não é compatível com uma fonte de +48 V poderá danificar o
dispositivo ligado. Verifique a definição antes de ligar o dispositivo.

Definição Descrição

ON
Isto liga a fonte de alimentação fantasma de +48 V e define o microfone compatível com uma
fonte de alimentação fantasma como a fonte de áudio CH-1 e CH-2.

Ligue o aparelho e defina o tipo de dispositivo ligado, usando [Audio] > [Audio Input] > [AUDIO IN Select]
no menu da câmara.

4
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Gerir/editar clips utilizando um computador

Pode gerir/editar clips utilizando um computador.

Importar clips utilizando um leitor de cartões (opção)

Ligue um leitor de cartões CFexpress Type A ou um leitor de cartões SD ao seu computador e utilize software
compatível com o formato de gravação deste aparelho, tal como Catalyst Browse, para importar os clips.

Utilizar um sistema de edição não linear

Num sistema de edição não linear, é necessário um software de edição (opção) compatível com os formatos gravados
pelo aparelho.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Emitir um sinal de fibra ótica

Pode emitir um sinal SDI convertido para um sinal ótica ao ligar um módulo SFP+ (opção) ao conector OPTICAL do
aparelho. Utilize um módulo SFP+ que corresponda à banda de sinal de cada formato.
Banda de sinal

4K (59.94p, 50p): 12G
4K (que não 59.94p, 50p): 6G
HD (59.94p, 50p): 3G
HD (que não 59.94p, 50p): 1.5G

Nota

Use um módulo que esteja em conformidade com as normas seguintes:

Normas SFF
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

Normas SDI
ST297/ST292/ST424/ST425/ST2081/ST2082

O mesmo sinal do conector de saída SDI é emitido para o módulo SFP+.

O aparelho não é compatível com entrada de sinal de fibra ótica.

Utilize um módulo SFP+ para saída de sinal de fibra ótica. Para mais informações sobre os módulos SFP+, contacte o seu
representante de assistência Sony.

5-041-957-53(1) Copyright 2022 Sony Corporation

* Power Level I (1,0 W)
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Ligar um sinal indicador

Este tópico descreve o controlo do sinal indicador.

Acender a luz indicadora através de um sinal de um controlo remoto

Pode acender a luz indicadora através de um comando VISCA over IP a partir de um dispositivo externo, tal como o RM-
IP500.
Defina [Technical] > [Tally] > [Tally Control] para [External] no menu web ou no menu da câmara.

Acender a luz indicadora a partir de um dispositivo externo

Pode acender a luz indicadora do aparelho a vermelho ou verde a partir de um dispositivo externo, tal como o RM-IP500
ou um comutador. Pode controlar o indicador através de comandos transmitidos na rede ou através de uma entrada de
sinal indicador no conector OPTION do aparelho.
Defina [Technical] > [Tally] > [Tally Control] para [External] no menu web ou no menu da câmara.
Ao inserir um sinal indicador no conector OPTION, pino de curto-circuito 7 para GND (pino 4 ou 5) para acender a luz
indicadora verde ou pino 8 para GND (pino 4 ou 5) para acender a luz indicadora vermelha.

Nota

Quando [Tally Control] está definido para [External], o estado de gravação do aparelho não é indicado pela luz indicadora.

Quando uma luz indicadora vermelha e uma luz indicadora verde são inseridas simultaneamente, a luz indicadora do aparelho
acende-se a vermelho.

Especificações do pino do conector OPTION

N.º
pino

Direção do
sinal Especificações do sinal

1 – Sinal TX RS-232C (para controlador da objetiva)

2 – Sinal RX RS-232C (para controlador da objetiva)

3 OUT

Luz indicadora de saída verde
Quando a luz indicadora verde está acesa, indica saída de nível baixo.
Hi-Z (emissão Open Drain) quando a luz indicadora verde não está acesa.

4 – GND (Ligação à terra)

5 – GND (Ligação à terra)
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Acender a luz indicadora de um dispositivo externo através de um sinal do aparelho

Pode acender a luz indicadora de um dispositivo externo através de um sinal do aparelho ligado o pino 3 e o pino 6 do
conector OPTION, conforme mostrado abaixo.
Exemplo de ligação dos pinos 3 e 6 do conector OPTION

Nota

Não aplique tensão aos pinos 7 e 8.

Não ligue um dispositivo externo que possa aplicar tensão ao conector OPTION.

Se for aplicada uma tensão de irrupção ou reversa ao pino 3 ou 6 que exceda a classificação, poderá causar uma avaria, fumo
ou incêndio.

Defina o sinal de saída, usando [Technical] > [Tally] > [Tally Control] no menu web ou no menu da câmara.
[Internal]: estado da operação de gravação do aparelho
[External]: AND lógica dos sinais vermelho/verde recebidos pelo aparelho, através dos sinais IN e dos controladores remotos.
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N.º
pino

Direção do
sinal Especificações do sinal

6 OUT

Luz indicadora de saída vermelha
Quando a luz indicadora vermelha está acesa, indica saída de nível baixo.
Hi-Z (emissão Open Drain) quando a luz indicadora vermelha não está acesa.

7 IN
Luz indicadora verde de entrada de controlo externo
Curto-circuito para terra (pino 4 ou 5) faz com que a luz indicadora do aparelho acenda a
verde.

8 IN
Luz indicadora vermelha de entrada de controlo externo
Curto-circuito para terra (pino 4 ou 5) faz com que a luz indicadora do aparelho acenda a
vermelho.
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Emitir dados de seguimento (free-d)

O aparelho pode emitir informações de deslocamento/inclinação/zoom, focagem e seguimento de íris sincronizadas com
um sinal de sincronização.
A saída de dados está em conformidade com o protocolo free-d, um padrão da indústria. Pode selecionar o método de
saída, escolhendo entre saída constante e saída a pedido dos clientes. Selecione o método de saída de acordo com o
seu sistema VR/AR.

Formato de saída dos dados

Sugestão

Os pormenores técnicos são fornecidos no “Manual de integração para free-d”. Contacte um representante de vendas da Sony.

Os dados de seguimento emitidos pelo aparelho incluem os seguintes dados, de acordo com o formato especificado no
Type D0/D1 do protocolo free-d.
Type D0 – poll/command

Certifique-se de que o aparelho está ligado.1

Defina o método de saída dos dados de seguimento.

Para saída constante

Para saída a pedido dos clientes

2

Defina [Technical] > [Tracking Data Output] > [Transfer Mode] para [Always] no menu web.1.
Defina a ID do aparelho em [Camera ID].2.
Especifique o endereço IP de destino de saída em [Destination Address].3.
Especifique o número da porta de destino da saída em [Destination Port].4.
Prima o botão [OK].5.

Defina [Technical] > [Tracking Data Output] > [Transfer Mode] para [On Demand] no menu web.1.
Defina a ID do aparelho em [Camera ID].2.
Especifique o número da porta para ouvir os pedidos dos clientes em [Listen Port].3.
Prima o botão [OK].4.

Símbolo Conteúdo Descrição

<D0> Message type

<CA> Camera ID

<CD> comando

Suporta os seguintes comandos:

00 Stop stream mode
01 Start stream mode

<CK> Checksum
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Type D1 – camera position/orientation data

Nota

Os dados de seguimento poderão sofrer atrasos ou os valores poderão não ser atualizados nas seguintes situações:

Ao produzir vídeo RAW
Quando a opção Câmara lenta e movimento rápido está ativada
Ao apresentar o menu da câmara
Ao apresentar o ecrã de miniaturas
Ao reproduzir clips gravados
Ao apresentar o menu web
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Símbolo Conteúdo Descrição

<D1> Message type

<CA> Camera ID

<PH><PM><PL> Camera Pan Angle Ângulo de deslocamento (-170° a +170°)

<TH><TM><TL> Camera Tilt Angle Ângulo de inclinação (-30° a +195°)

<RH><RM><TL> Camera Roll Angle Não suportado (sempre 0)

<XH><XM><XL> Camera X-Position Não suportado (sempre 0)

<YH><YM><YL> Camera Y-Position Não suportado (sempre 0)

<HH><HM><HL> Camera Height Não suportado (sempre 0)

<ZH><ZM><ZL> Camera Zoom Distância focal

<FH><FM><FL> Camera Focus Distância de focagem

<SH><SL> Spare/User Defined Posição da íris

<CK> Checksum
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Ligar um controlador da objetiva

Pode operar o zoom de uma objetiva de zoom manual a partir da Web App, RM-IP500 (opção) ou do controlo remoto de
infravermelhos, ligando um controlador da objetiva comercialmente disponível (opção) que seja compatível com este
aparelho.
Para mais informações sobre a ligação de um controlador da objetiva, consulte o manual de instruções do controlador
da objetiva.
Para mais informações sobre o ajuste usando um controlador da objetiva, consulte “Ajustar o zoom através de um
controlador da objetiva”.

Nota

Antes de usar um controlador da lente, leia atentamente as instruções de funcionamento do controlador da objetiva e certifique-
se de que compreende totalmente a sua utilização. A Sony não será responsável por quaisquer reclamações de qualquer tipo
resultantes da utilização de um controlador da objetiva.

O Zoom de Imagem Clara não está disponível quando um controlador da objetiva está ativado. Recomenda-se que defina a
proporção do Zoom de Imagem Clara para 1.0× ou desative o Zoom de Imagem Clara.

Quando o controlador da objetiva está ativado, as operações de enquadramento da câmara não podem ser gravadas ou
reproduzidas.

Tópico relacionado
Ajustar o zoom através de um controlador da objetiva
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Ajustar o zoom através de um controlador da objetiva

Utilize o procedimento seguinte para instalar um controlador da objetiva (opção) e ajustar o zoom.

Para verificar o estado do controlador da objetiva
Prima o botão  (Estado da câmara) na área comum do ecrã da Web App para apresentar o ecrã de estado da
câmara.

Ligue um controlador da objetiva ao conector OPTION no bloco de conectores do aparelho.

Para mais informações sobre a instalação, consulte o manual de instruções do controlador da objetiva.

1

Configure o controlador da objetiva para a sua objetiva de zoom.

Para mais informações, consulte o manual de instruções do controlador da objetiva.

2

Bloqueie o deslocamento/inclinação do aparelho e instale a objetiva de zoom.

Para mais informações, consulte “Instalar uma objetiva”.

3

Ajuste o controlador da objetiva de modo a que possa controlar a objetiva de zoom.4

Mantenha o equilíbrio para a frente/para trás da cabeça da câmara para que a base deslizante seja
horizontal.

Para mais informações, consulte as instruções de funcionamento do controlador da objetiva e “Instalar uma
objetiva”.

5

Defina [Technical] > [Lens Controller] > [Setting] para [On] no menu web e prima o botão [OK].

O aparelho irá reiniciar. Aguarde até que a operação de reposição do deslocamento/inclinação esteja concluída.

6

Prima o botão  (Inicializar controlador da objetiva) no separador  (Others) no painel de
controlo da câmara no ecrã de operações em gravação da Web App.

O controlador da objetiva move-se para detetar a amplitude do zoom. Para mais informações, consulte o manual
de instruções do controlador da objetiva.
Quando a indicação  (Erro do controlador da objetiva) muda para  (Controlador da objetiva pronto) no canto
superior esquerdo do painel de imagem da câmara, a preparação está concluída.

Nota

Atente que a amplitude de funcionamento da objetiva ao inicializar o controlador da objetiva.

7

Ajuste o zoom usando o controlo de deslize [Zoom] na Web App ou os botões de controlo de zoom do
controlo remoto de infravermelhos.

8
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Pode verificar o estado do controlador da objetiva neste ecrã.

Nota

Quando trocar a objetiva, inicialize o controlador da objetiva.

O Zoom de Imagem Clara não está disponível quando um controlador da objetiva está ativado. Recomenda-se que defina a
proporção do Zoom de Imagem Clara para 1.0× ou desative o Zoom de Imagem Clara.
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Estado Descrição

Off Utilize o zoom motorizado numa objetiva com encaixe E.

Communication
Error

Ocorreu um erro de comunicação entre o aparelho e o controlador da objetiva.
Verifique a ligação entre o aparelho e o controlador da objetiva, em seguida, consulte as
instruções de funcionamento do controlador da objetiva e inicialize o controlador da objetiva.

Uninitialized Execute a inicialização.

Initializing Aguarde até a inicialização estar concluída.

Initialization
Failed

Verifique a ligação entre o aparelho e o controlador da objetiva, em seguida, consulte as
instruções de funcionamento do controlador da objetiva e inicialize o controlador da objetiva.

Working Controle o zoom usando o controlador da objetiva.

Rotation Error
A amplitude de movimento do zoom e a amplitude de movimento da objetiva armazenadas
poderão não corresponder. Inicialize o controlador da objetiva.

System Error Verifique a ligação entre o aparelho e o controlador da objetiva, consulte as instruções de
funcionamento do controlador da objetiva e inicialize o controlador da objetiva ou desligue e ligue
o aparelho e o controlador da objetiva.Unknown Error
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Precauções para utilização

Precauções durante o transporte e a embalagem
Ao transportar ou embalar o aparelho, mantenha as seguintes condições e evite sujeitá-lo a fortes vibrações ou
choques.

Retire a objetiva e coloque a tampa do corpo.
Após mover a cabeça da câmara (A) para a frente, rode a alavanca de bloqueio da cabeça da câmara (B) no sentido
da seta para bloquear a cabeça da câmara.

Oriente a cabeça de câmara de modo a que fique virada para a frente e bloqueie-a utilizando a alavanca de bloqueio
de deslocamento/inclinação.

Retire os cabos de ligação.

Condensação
Se o aparelho for transportado repentinamente de um local frio para um local quente ou se a temperatura ambiente
aumentar subitamente, poderá formar-se humidade na superfície exterior do aparelho e/ou no interior do mesmo. A isto
chama-se condensação. Se tiver ocorrido condensação, desligue o aparelho e aguarde até a condensação se dissipar
antes de operar o aparelho. Operar o aparelho com humidade presente poderá danificá-lo.

Fenómenos do sensor de imagem CMOS da câmara

Nota

Os fenómenos seguintes que poderão ocorrer nas imagens são específicos dos sensores de imagem. Não representam uma
avaria.

Manchas brancas
Apesar dos sensores de imagem serem produzidos com tecnologias de alta precisão, em raros casos poderão ser
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geradas manchas brancas no ecrã, causadas por raios cósmicos, etc.
Isto está relacionado com o princípio dos sensores de imagem e não é uma avaria. Execute APR regularmente.
As manchas brancas tendem a ser vistas nos seguintes casos:

Ao utilizar a uma temperatura ambiente alta
Quando tiver aumentado o ganho (sensibilidade)

Cintilação
Em caso de filmagem sob iluminação produzida por luzes fluorescentes, lâmpadas de sódio, lâmpadas de vapor de
mercúrio ou LED, o ecrã poderá cintilar ou as cores poderão variar.

Unidades de acionamento da objetiva e de deslocamento/inclinação
Se o mecanismo de acionamento da objetiva e do deslocamento/inclinação não for utilizado durante um longo período
de tempo, a viscosidade da massa lubrificante aplicada no interior poderá aumentar, impedindo o mecanismo de se
mover. Utilize regularmente o mecanismo da objetiva e do deslocamento/inclinação.

Sobre peças consumíveis
A ventoinha e a bateria recarregável incorporada são consumíveis, pelo que requerem substituição periódica.
Ao funcionar à temperatura ambiente, o ciclo de substituição normal será de cerca de 5 anos. Todavia, este ciclo de
substituição representa apenas uma orientação geral e não implica que a vida útil destas peças seja garantida.
Para obter informações sobre a substituição das peças, contacte o seu agente ou centro de assistência Sony.

A vida útil do transformador de CA e do condensador eletrolítico é de cerca de 5 anos com temperaturas normais de
funcionamento e utilização normal (8 horas por dia, 25 dias por mês). Se a utilização ultrapassar a frequência de
utilização normal, a vida útil poderá diminuir em conformidade.

As inspeções periódicas são recomendadas para manter o aparelho a funcionar corretamente e para prolongar a vida
útil. Para mais informações sobre as inspeções, contacte um representante de assistência Sony.

Sobre a bateria recarregável integrada
O aparelho tem uma bateria recarregável para armazenar a data, hora e outras definições mesmo quando o aparelho
está desligada. A bateria recarregável integrada estará carregada após terem decorrido 24 horas se o aparelho estiver
ligado a uma tomada de alimentação através do adaptador AC ou se for alimentada através de PoE++,
independentemente do aparelho estar ligado/desligado. A bateria recarregável ficará completamente descarregada no
espaço de 2 meses se o adaptador AC não estiver ligado a uma fonte de alimentação. Utilize o aparelho após carregar a
bateria. No entanto, mesmo que a bateria recarregável não esteja carregada, o funcionamento do aparelho não será
afetado desde que não necessite de gravar a data.

Localizações de utilização e armazenamento
Armazene num local nivelado e ventilado.
Evite utilizar ou armazenar o aparelho nos seguintes locais.

Localizações expostas à chuva ou água (incluindo debaixo de beirais)
Ambientes exteriores e locais com temperatura superior a 40 °C
Lembre-se de que, no verão, nos climas quentes, a temperatura do interior de um veículo com os vidros fechados
pode facilmente exceder 50 °C.
Localizações mais frias do que 0 °C.
Em localizações húmidas ou poeirentas. Localizações onde o aparelho possa estar exposto à chuva
Localizações sujeitas a vibrações ou choques
Localizações onde a radiação, raios-X e fortes campos magnéticos são gerados.
Próximo de transmissores de rádio ou TV que produzam campos eletromagnéticos fortes.
Sob luz solar direta ou próximo de aquecedores durante longos períodos de tempo

Notas sobre feixes de laser
Os feixes de laser poderão danificar o sensor de imagem CMOS. Se filmar uma cena que inclua um feixe de laser, tenha
cuidado para não permitir que o feixe de laser seja direcionado para o sensor de imagem CMOS da câmara.
Especificamente, os feixes de laser de alta potência dos dispositivos médicos ou outros dispositivos poderão causar
danos devido à luz refletida e luz difusa.
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Para impedir interferências eletromagnéticas dos dispositivos de comunicação portáteis
A utilização de telefones portáteis e outros dispositivos de comunicação próximo desta unidade pode resultar em avarias
e interferência com os sinais de áudio e vídeo. É aconselhável que os dispositivos de comunicação portáteis próximos
da unidade sejam desligados.

Não coloque este produto perto de dispositivos médicos
Este produto (incluindo os acessórios) tem íman(es) que pode(m) interferir com pacemakers, válvulas de derivação
programáveis para o tratamento de hidrocefalia ou outros dispositivos médicos. Não coloque este produto perto de
pessoas que utilizam esses dispositivos médicos. Consulte o seu médico antes de utilizar este produto se utilizar
qualquer um desses dispositivos médicos.

Precauções de segurança
A SONY NÃO É RESPONSÁVEL POR QUALQUER TIPO DE DANOS RESULTANTES DA NÃO IMPLEMENTAÇÃO
DE MEDIDAS DE PROTEÇÃO ADEQUADAS EM DISPOSITIVOS DE TRANSMISSÃO, FUGAS DE DADOS
INEVITÁVEIS RESULTANTES DAS ESPECIFICAÇÕES DA TRANSMISSÃO OU QUALQUER TIPO DE PROBLEMA
DE SEGURANÇA.
Dependendo do ambiente de funcionamento, terceiros não autorizados na rede podem ter acesso à unidade. Ao ligar
a unidade à rede, certifique-se de que a rede está bem protegida.
Do ponto de vista da segurança, ao utilizar a unidade ligada à rede é altamente recomendado aceder à janela de
controlo através de um navegador da internet e alterar as predefinições de limitação de acesso. É também
recomendado definir uma palavra-passe suficientemente longa e difícil de adivinhar por terceiros e guardar a mesma
em segurança.
Ao ligar este produto a uma rede, ligue através de um sistema com uma função de proteção, tal como um router ou
firewall. Se ligado sem tal proteção, poderão ocorrer problemas de segurança.

Fonte de alimentação
O aparelho não está equipado com um interruptor de alimentação. Para desligar o aparelho, certifique-se de que
todas as operações terminaram e de que o aparelho se encontra no estado de espera de alimentação, de seguida,
desligue o adaptador AC. Ao utilizar a alimentação PoE++, desligue o cabo LAN.
Sempre que possível, utilize uma fonte de alimentação de um local onde seja fácil inserir e remover a ficha de
alimentação.
Se utilizar uma tomada num local poeirento, limpe regularmente a área à volta da tomada para evitar a dispersão do
pó.
Desligue a fonte de alimentação quando não estiver a ser utilizada.

Precauções para peças móveis
Certifique-se de que não entram substâncias estranhas para as peças móveis.
Não aplique uma carga excessiva ao mover peças à mão. Caso contrário, poderá causar uma avaria.
Não interfira com o funcionamento das peças móveis durante o movimento. Caso contrário, poderá causar um
ferimento ou avaria.
As peças móveis poderão não funcionar normalmente se o aparelho não for utilizado por um longo período de
tempo. Utilize regularmente as funções de deslocamento/inclinação do aparelho.

Precauções para funcionamento contínuo
O aparelho pode ser alimentado 24 horas por dia, 365 dias por ano (estado de espera de alimentação).
Efetue sempre um teste de filmagem e verifique se o aparelho funciona normalmente.

Não é garantida a filmagem contínua durante períodos superiores a 24 horas.
Se estiver a filmar durante mais de 24 horas, coloque o aparelho no estado de espera de alimentação e, em
seguida, reinicie o aparelho.

Tenha em atenção que a Sony não será responsável por qualquer tipo de indemnização pelo conteúdo das imagens
se não conseguir filmar devido a qualquer avaria durante a utilização deste aparelho.
Verifique sempre se a unidade está a funcionar correctamente antes de a usar. A SONY NÃO SE RESPONSABILIZA
POR DANOS DE QUALQUER TIPO, INCLUINDO, MAS NÃO LIMITADOS A, COMPENSAÇÃO OU REEMBOLSO
DEVIDO A PERDA DE LUCROS ACTUAIS OU FUTUROS NO DECORRER DE AVARIA DESTA UNIDADE, QUER
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DURANTE O PERÍODO DE GARANTIA QUER APÓS A EXPIRAÇÃO DA GARANTIA OU POR QUALQUER OUTRA
RAZÃO.
A SONY NÃO SE RESPONSABILIZA POR QUEIXAS DE QUALQUER TIPO APRESENTADAS POR
UTILIZADORES DESTA UNIDADE OU POR TERCEIROS.
A SONY NÃO SE RESPONSABILIZA PELO TÉRMINO OU DESCONTINUAÇÃO DE QUAISQUER SERVIÇOS
RELACIONADOS COM ESTA UNIDADE QUE POSSAM RESULTAR DEVIDO A CIRCUNSTÂNCIAS DE
QUALQUER TIPO.

Precauções para a função de gravação
Faça sempre uma gravação de teste e verifique se foi bem sucedida. A SONY NÃO SE RESPONSABILIZA POR
DANOS DE QUALQUER TIPO, INCLUINDO MAS NÃO LIMITADOS A, COMPENSAÇÃO OU REEMBOLSO
DEVIDO A AVARIA DESTA UNIDADE OU DOS RESPECTIVOS MEIOS DE GRAVAÇÃO OU QUAISQUER OUTROS
MEIOS OU SISTEMAS DE ARMAZENAMENTO PARA REGISTAR CONTEÚDO DE QUALQUER TIPO.
Verifique sempre se a unidade está a funcionar correctamente antes de a usar. A SONY NÃO SE RESPONSABILIZA
POR DANOS DE QUALQUER TIPO, INCLUINDO, MAS NÃO LIMITADOS A, COMPENSAÇÃO OU REEMBOLSO
DEVIDO A PERDA DE LUCROS ACTUAIS OU FUTUROS NO DECORRER DE AVARIA DESTA UNIDADE, QUER
DURANTE O PERÍODO DE GARANTIA QUER APÓS A EXPIRAÇÃO DA GARANTIA OU POR QUALQUER OUTRA
RAZÃO.
A SONY NÃO SE RESPONSABILIZA POR QUEIXAS DE QUALQUER TIPO APRESENTADAS POR
UTILIZADORES DESTA UNIDADE OU POR TERCEIROS.
A SONY NÃO SE RESPONSABILIZA PELA PERDA, REPARAÇÃO OU REPRODUÇÃO DE QUAISQUER DADOS
GRAVADOS NO SISTEMA DE ARMAZENAMENTO INTERNO, SUPORTES DE GRAVAÇÃO OU EM QUAISQUER
OUTROS SUPORTES OU SISTEMAS DE ARMAZENAMENTO.
A SONY NÃO SE RESPONSABILIZA PELO TÉRMINO OU DESCONTINUAÇÃO DE QUAISQUER SERVIÇOS
RELACIONADOS COM ESTA UNIDADE QUE POSSAM RESULTAR DEVIDO A CIRCUNSTÂNCIAS DE
QUALQUER TIPO.

5-041-957-53(1) Copyright 2022 Sony Corporation
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Formatos de saída e limitações

Este tópico descreve os formatos de saída e limitações.

Nota

A resolução do formato de saída é limitada pelas definições de [Project] > [Rec Format] > [Frequency], [Codec] e [Video Format]
no menu web ou no menu da câmara.

A resolução do formato de saída também é limitada pela combinação com a taxa de fotogramas S&Q. Para além da tabela de
formatos de saída de conectores SDI OUT/HDMI OUT abaixo indicada, a saída HDMI é alterada para Full HD ou inferior quando
todas as condições forem respeitadas.

[Shooting] > [S&Q Motion] > [Setting] está definida para [On]
[Shooting] > [S&Q Motion] > [Frame Rate] é superior a 60fps

Quando as condições acima se verificam, as opções de seleção 4096×2160P e 3840×2160P da saída HDMI para [Monitoring] >
[Output Format] > [SDI/HDMI] estão desativadas e não podem ser selecionadas.

A imagem não é apresentada na saída se estiver configurada uma resolução superior à da resolução da imagem de reprodução.

Formatos de saída do conector SDI OUT/HDMI OUT

Quando a frequência do sistema é 50/59.94 Hz

Definição Formato de saída selecionável

Modo de
gravação/reprodução

Resolução de saída
RAW/

Resolução de gravação
interna

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
(predefinição)
1920×1080i

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
(predefinição)
1920×1080i
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Quando a frequência do sistema é 25/29.97 Hz

Definição Formato de saída selecionável

Modo de
gravação/reprodução

Resolução de saída
RAW/

Resolução de gravação
interna

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)1)
4096×2160P
1920×1080P
1920×1080i

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(predefinição)

1920×1080P
(predefinição)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(predefinição)

1920×1080P
(predefinição)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (Level A)
(predefinição)

1920×1080P
(predefinição)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

(Saída parada)
720×480P2)

720×576P3)

A apresentação do ecrã não pode ser sobreposta.1)

Quando a frequência do sistema é 59.942)

Quando a frequência do sistema é 503)
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Quando a frequência do sistema é 23.98 Hz

Definição Output Format (resolução de saída)

Modo de
gravação/reprodução

Resolução de saída RAW/
Resolução de gravação

interna
SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i
(predefinição)

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
1920×1080i
(predefinição)

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(predefinição)

1920×1080i
(predefinição)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(predefinição)

1920×1080i
(predefinição)

1920×1080
1920×1080P
1920×1080PsF

1920×1080P
1920×1080i

Definição Output Format (resolução de saída)

Modo de
gravação/reprodução

Resolução de saída RAW/
Resolução de gravação

interna
SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
(predefinição)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P
(predefinição)
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Quando a frequência do sistema é 24 Hz

5-041-957-53(1) Copyright 2022 Sony Corporation

Definição Output Format (resolução de saída)

Modo de
gravação/reprodução

Resolução de saída RAW/
Resolução de gravação

interna
SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P
(predefinição)

1920×1080P
(predefinição)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P
(predefinição)

1920×1080P
(predefinição)

1920×1080
1920×1080P
(predefinição)

1920×1080P
(predefinição)

Definição Output Format (resolução de saída)

Modo de
gravação/reprodução

Resolução de saída RAW/
Resolução de gravação

interna
SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
1920×1080P
(predefinição)

XAVC-I 4096×2160
4096×2160 (2SI)
1920×1080P
(predefinição)

4096×2160P
1920×1080P
(predefinição)
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Resolução de problemas

Fonte de alimentação

Saída de imagem

Sintoma Causa Solução

O aparelho
não liga.

O adaptador AC não está bem ligado ao conector
DC IN.

Insira ao máximo o cabo de alimentação.

O cabo de alimentação não está bem inserido no
adaptador AC ou na tomada AC.

Insira ao máximo o cabo de alimentação.

O cabo LAN não está bem ligado entre o dispositivo
de alimentação PoE++ e o aparelho.

Certifique-se de que o cabo é inserido até
bloquear.

O cabo LAN está ligado ao conector OPTION, mas
não ao conector LAN.

Ligue corretamente o cabo LAN ao conector
LAN.

O aparelho está ligado a um dispositivo de
alimentação não compatível com PoE++ (em
conformidade com IEEE802.3bt, Tipo 4 Classe 8).

Ligue a um dispositivo de alimentação não
compatível com PoE++ (em conformidade com
IEEE802.3bt, Tipo 4 Classe 8).

O consumo total de energia excede a classificação
máxima do dispositivo de alimentação PoE++.

Consulte o manual de instruções para o
dispositivo de alimentação PoE++.

Está ligado um cabo de rede com classificação de
categoria não compatível com a alimentação PoE++.

Utilize um cabo de rede de categoria 5e ou
superior ligado ao conector LAN.

A câmara, o dispositivo de alimentação PoE++ e os
dispositivos periféricos não estão ligados à terra.

Ligue a câmara, o dispositivo de alimentação
PoE++ e os dispositivos periféricos à terra.

Sintoma Causa Solução

Não é emitida imagem.

Os dispositivos ligados não estão ligados corretamente.
Ligue corretamente os
dispositivos.

A configuração inicial não foi concluída.
Conclua a configuração inicial
através da Web App.

Não é emitida imagem
a partir do conector
HDMI.

Está configurado um sinal que não é suportado pelo
dispositivo de destino da saída HDMI.

Altere a definição do formato
de saída HDMI ou utilize um
dispositivo compatível com o
sinal de saída.

Está a ser utilizado um cabo não compatível com a norma
da saída HDMI.

Utilize um cabo compatível
com a norma da saída HDMI.
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Controlo remoto

Controlo remoto de infravermelhos

Sintoma Causa Solução

Não é emitida imagem
a partir do conector
SDI.

Está a ser utilizado um cabo não compatível com a norma
da saída SDI.

Utilize um cabo compatível
com a norma da saída SDI.

O monitor ligado ao conector SDI não é compatível com o
sinal de saída.

Utilize um monitor compatível
com a norma da saída SDI.

O formato de gravação está definido para saída RAW.
Altere o formato de gravação
para uma definição que não
saída RAW.

A saída HDMI está definida para a resolução SD. Defina a saída HDMI para uma
resolução que não SD.

Não é emitida imagem
a partir da fibra ótica ou
a imagem está
distorcida.

O módulo em utilização não está em conformidade com
as normas SFF ou SMPTE ou não cumpre Power Level I
(1,0 W).

Consulte “Emitir um sinal de
fibra ótica”.

Não é emitida imagem
ou fica distorcida ao
utilizar sincronização
externa.

Não está a ser inserido um sinal de sincronização externa
para o formato do sinal de vídeo configurado.

Insira um sinal de
sincronização externa
adequado ao formato do sinal
de vídeo configurado.

Ruído no áudio.

A câmara, o dispositivo de alimentação PoE++ e os
dispositivos periféricos não estão ligados à terra.

Ligue o aparelho, o dispositivo
de alimentação PoE++ e os
dispositivos periféricos à terra.

O aparelho está a ser utilizado num ambiente com
dispositivos que geram fortes campos elétricos e
magnéticos (tais como antenas transmissoras de
TV/rádio, transmissores de rádio amadora, motores de ar
condicionado, transformadores de fonte de alimentação).

Mantenha-se afastado de
dispositivos que geram fortes
campos elétricos e
magnéticos.

A objetiva, o apoio da objetiva e a unidade de
acionamento estão em contacto com o aparelho ou um
objeto no ambiente envolvente e é emitido um ruído
anormal.

Instale corretamente a
objetiva.

Verifique se existem
obstáculos perto da
câmara.

Sintoma Causa Solução

O controlo remoto de
infravermelhos não funciona
quando premido.

O funcionamento do controlo remoto de
infravermelhos está desativado.

Defina [Technical] > [IR Remote] >
[Setting] para [On] no menu web.

A bateria está descarregada ou a
polaridade da bateria está incorreta.

Utilize o controlo remoto de
infravermelhos próximo do sensor IR
do aparelho. Se o LED de
alimentação piscar, substitua a
bateria.

A configuração inicial não foi concluída.
Conclua a configuração inicial
através da Web App.
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RM-IP500

Web App

Sintoma Causa Solução

A velocidade operacional de
deslocamento/inclinação está
lenta.

A velocidade do deslocamento/inclinação a
partir do controlo remoto de infravermelhos
está definida para o modo normal.

Coloque o interruptor SETUP 4 na
posição ON no bloco de conectores
do aparelho.

A operação selecionou uma
câmara que não a câmara
prevista.

O sinal de infravermelhos foi recebido por
uma câmara que não a câmara prevista.

Defina [Technical] > [IR Remote] >
[Setting] para [Off] no menu web da
câmara que não pretende controlar.

Sintoma Causa Solução

A câmara não pode ser controlada
a partir do controlo remoto RM-
IP500.

A fonte de alimentação da
câmara não está ligada.

Certifique-se de que a luz POWER do aparelho
acende-se a verde ou cor de laranja.

A câmara ou o controlo
remoto não estão ligados à
rede.

Verifique as ligações do aparelho e do controlo
remoto.

A configuração inicial da
câmara não foi concluída.

Conclua a configuração inicial através da Web
App.

A comunicação VISCA over
IP não está ativada.

Coloque o interruptor SETUP 3 na posição ON
no painel do conector do aparelho e reinicie o
aparelho.

Endereço IP da câmara
alterado.

Verifique o endereço IP da câmara, usando
[Network] > [Wired LAN] no menu web ou no
menu da câmara.

O endereço IP da câmara foi
alterado através de AUTO IP
SETUP no controlo remoto RM-
IP500.

Passaram, pelo menos, 20
minutos desde que a câmara
foi ligada.

Reinicie o aparelho. O endereço IP pode ser
alterado através de AUTO IP SETUP nos
primeiros 20 minutos após ligar o aparelho.
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Não é possível ligar através de um
browser web.

Não está ligado um cabo LAN
de categoria 5e ou superior.

Ligue um cabo LAN de categoria 5e ou
superior.

Não ligado corretamente à
LAN ou a rede ligada não
está a funcionar
normalmente.

Certifique-se de que o LED Link para o
conector LAN está aceso. Se o LED Link
não estiver aceso, contacte o seu
administrador de rede.

A fonte de alimentação da
câmara não está ligada.

Consulte a secção “Fonte de alimentação”
acima.

Não está configurado um
endereço IP válido para o
aparelho.

Efetue uma reinicialização de rede.

O endereço IP configurado
está a ser utilizado noutro
dispositivo.

Certifique-se de que os endereços IP dos
dispositivos periféricos são únicos.

A máscara de subrede
configurada não corresponde
à máscara de subrede
utilizada.

Efetue uma reinicialização de rede.

O aparelho está a ser acedido
na mesma rede local através
de um servidor proxy.

Altere a configuração para que não seja
utilizado um servidor proxy.

O gateway predefinido
configurado para o aparelho
está incorreto.

Efetue uma reinicialização de rede.

O URL inserido está incorreto. Insira o URL correto e tente novamente.

HTTP Port incorreta.

Apresente o menu da câmara num monitor
externo e verifique a definição de [Network]
> [Wired LAN] > [HTTP Port]. Se estiver
configurado um valor que não 80, adicione o
número da HTTP Port ao nome do anfitrião
ou endereço IP inserido no browser web.
Exemplo: se a HTTP Port estiver definida
para 8080, insira http://<IP Address>:8080

O número da HTTP Port do
aparelho está a ser filtrado ou
bloqueado.

Altere o número da HTTP Port do aparelho
para uma porta que não esteja a ser filtrada
ou bloqueada.

A cache antiga do browser
web está a ter um efeito
adverso.

Elimine a cache do browser da web.
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Não é possível ligar à Web App
utilizando código 2D (código QR).

O dispositivo em utilização
não é compatível com mDNS.

Utilize um dispositivo compatível com
mDNS.
Se estiver a usar um dispositivo não
compatível como mDNS, insira o endereço
IP diretamente no navegador de internet.

O tablet ou computador está
ligado a uma rede que não a
da câmara.

Ligue o tablet ou computador à mesma rede
local do aparelho.

Não é possível ligar à Web App
inserindo manualmente o URL.

O dispositivo em utilização
não é compatível com mDNS.

Utilize um dispositivo compatível com
mDNS.

O tablet ou computador está
ligado a uma rede que não a
da câmara.

Ligue o tablet ou computador à mesma rede
local do aparelho.

O ecrã de autenticação é apresentado
continuamente.

Não foi inserido o nome de
utilizador ou palavra-passe
corretos.

Insira o nome de utilizador registado e a
correspondente palavra-passe. Se se tiver
esquecido das informações de utilizador
registadas, consulte “Interruptor RESET” em
“Bloco de conectores” para iniciar as
informações de utilizador para ligação de
rede.

O nome de utilizador e a
palavra-passe poderão ter
sido alterados por um
utilizador com sessão iniciada
noutro browser da web.

Confirme o nome de utilizador e a palavra-
passe corretos com o administrador do
aparelho.

A imagem da câmara não é
apresentada na Web App.

A saída HDMI da câmara está
definida para 720×480 ou
720×576.

Altere a resolução da saída HDMI do
aparelho.

Está ligado um monitor HDMI
que não é compatível com o
sinal de saída HDMI da
câmara.

Remova o monitor HDMI ou utilize um
monitor HDMI compatível com as definições
de saída HDMI.

O aparelho foi reiniciado e a
sessão foi terminada.

Aguarde cerca de um minuto e recarregue o
browser da web.

A cache antiga do browser
web está a ter um efeito
adverso.

Elimine a cache do browser da web.

A resolução da imagem da câmara
apresentada na Web App é baixa.

A resolução para a
transmissão de vídeo 3
utilizada pela Web App tem
uma definição baixa.

Aumente o valor, usando [Stream] > [Video
Stream] > [Size 3] no menu web.

O menu da câmara não aparece
quando prime o botão [Menu].

O menu da câmara está
configurado de forma a não
ser integrado no sinal da
saída HDMI.

Defina [Monitoring] > [Output Display] >
[HDMI/Stream] para [On] no menu web.
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Filmagem

Câmera

Sintoma Causa Solução

O valor de uma definição o ecrã de
definições não é
atualizado/apresentado corretamente.

O ecrã de definições da Web
App não reflete
automaticamente as
definições alteradas noutra
Web App.

Prima o botão [Reload] na parte inferior do
ecrã de definições da Web App. Os valores
das definições no ecrã de configuração
apresentado são recarregados e
atualizados.

As definições dos ficheiros
temporários da internet estão
a afetar.

Elimine a cache do browser da web.

Não é possível transferir o ficheiro ou
registo de configuração.

A função do ficheiro de
transferência do browser da
web está desativada.

Ative a função do ficheiro de transferência
do browser da web.

O ecrã de definições da Web App está
acessível, mas não pode efetuar
operações no ecrã de operações em
gravação e ecrã de operações em
reprodução.

O ecrã de operações da Web
App está bloqueado.

Coloque o interruptor de bloqueio de
operações no canto superior direito na Web
App para a posição  (Desbloqueio das
operações).

O ecrã da Web App demora algum
tempo a surgir.

A imagem da transmissão do
aparelho está a ser
visualizada por vários
utilizadores simultaneamente.

Reduza o número de utilizadores que
podem aceder simultaneamente à Web App.

A imagem está distorcida ou tremida.

As informações do vídeo não
são devidamente transmitidas
devido a congestão no
caminho das comunicações.

Reduza a taxa de bits da transmissão,
defina [Video Stream 3] > [Size] para a
opção mais pequena ou reduza a taxa para
criar uma margem na banda de
comunicação.

Vários browsers da web estão
a ser executados no tablet e
estão a ocupar memória.

Feche todos os browsers da web que
estejam a ser executados em segundo
plano.

Estão abertos demasiados
separadores do browser da
web, o que torna o
funcionamento mais lento.

Feche os separadores que não estão a ser
usados.

A acumulação excessiva da
cache do browser da web e
do histórico de navegação
está a tornar o funcionamento
mais lento.

Elimine a cache do browser da web.

Sintoma Causa Solução

A imagem parece distorcida no início e fim
da operação de deslocamento/inclinação.

A imagem poderá ficar distorcida se a
função de estabilização da imagem da
objetiva estiver ativada.

Desative a função de
estabilização da imagem da
objetiva.

Ângulo de visualização alterado sem
operação do utilizador.

Ocorreu uma deslocação da objetiva.
Consulte “Compensação de
respiração”.
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Deslocamento/inclinação

Sintoma Causa Solução

Não é possível utilizar a focagem, o zoom
ou a íris.

As definições dos interruptores na
objetiva poderão estar incorretas.

Consulte “Verificar os
interruptores da objetiva”.

Sintoma Causa Solução

Não é possível repor o
deslocamento/inclinação.

A alavanca de bloqueio de
deslocamento/inclinação está na
posição LOCK.

Deslize a alavanca de bloqueio de
deslocamento/inclinação para a posição
UNLOCK.

A câmara não para na posição
prevista.

O bloqueio da câmara está
desequilibrado.

Mova o bloqueio da câmara para a
frente/para trás para uma posição adequada,
conforme descrito em “Instalar uma objetiva”
e, de seguida, volte a ligar o aparelho.

Está instalada uma objetiva não
compatível com
deslocamento/inclinação.

Consulte as informações de compatibilidade
da objetiva e instale uma objetiva compatível
com deslocamento/inclinação e, de seguida,
volte a ligar o aparelho.

Não é possível executar a
reposição do
deslocamento/inclinação. Execute uma reposição do

deslocamento/inclinação, conforme descrito
em “Repor o deslocamento/inclinação”.

Foi aplicada uma força inesperada
na cabeça da câmara, causando
um erro no controlo do
deslocamento/inclinação.

A câmara não regressa à parte
frontal quando prime o botão

 (Posição inicial de
deslocamento/inclinação).

Foi ativado o modo de fixação no
teto.

Defina [Pan-Tilt] > [P/T Direction] > [Ceiling]
no menu web de acordo com a instalação e,
em seguida, volte a ligar o aparelho. Quando
fixado num teto, o bloco de conectores estará
na parte frontal da câmara.

A operação de
deslocamento/inclinação está
restrita.

O limite da amplitude de
deslocamento/inclinação está
configurado.

Apague as definições do limite da amplitude
de deslocamento/inclinação, conforme
descrito em “P/T Range Limit”.

Foi aplicada uma força inesperada
na cabeça da câmara, causando
um erro no
deslocamento/inclinação.

Execute uma reposição do
deslocamento/inclinação, conforme descrito
em “Repor o deslocamento/inclinação”.

A operação de
deslocamento/inclinação
moveu-se na direção oposta.

A definição do modo de fixação no
teto é diferente do estado de
fixação real.

Defina [Pan-Tilt] > [P/T Direction] > [Ceiling]
no menu web, de acordo com a instalação
real.

As definições relacionadas com a
direção de deslocamento/inclinação
foram alteradas.

Verifique as definições de [Pan-Tilt] > [P/T
Direction] no menu web.
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A imagem não se move sem
percalços no início e fim da
operação de
deslocamento/inclinação.

A definição de
aceleração/desaceleração da
operação de
deslocamento/inclinação é
demasiado alta.

Reduza a definição de
aceleração/desaceleração da operação de
deslocamento/inclinação, para tornar o
movimento no início e no fim da operação de
deslocamento/inclinação mais suave, usando
[Pan-Tilt] > [P/T Acceleration] > [Ramp Curve]
no menu web ou no menu da câmara. Atente
que isto significará que a objetiva demora
mais tempo a alcançar a velocidade máxima.

Operação de
deslocamento/inclinação
parada.

O bloqueio da câmara está
desequilibrado.

Mova o bloqueio da câmara para a
frente/para trás para uma posição adequada,
conforme descrito em “Instalar uma objetiva”
e, de seguida, volte a ligar o aparelho.

A definição da curva da rampa
(aceleração/desaceleração) é
demasiado alta para a objetiva
instalada.

Se estiver instalada uma objetiva grande,
reduza o valor de [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] no menu web
ou no menu da câmara.

Está a ser utilizada uma objetiva
grande.

Contacte o representante de assistência
Sony.

O aparelho é obstruído
quando utiliza o
deslocamento/inclinação.

A alavanca de aperto do parafuso
de instalação da base de apoio da
objetiva choca com a câmara.

Rode a alavanca de aperto do parafuso de
instalação da base de apoio da objetiva para
que fique a apontar para cima.

A alavanca de aperto do apoio da
objetiva choca com a câmara.

Rode a alavanca de aperto do apoio da
objetiva para que fique a apontar para cima.

A alavanca de bloqueio da cabeça
da câmara choca com a câmara.

Certifique-se de que a alavanca de bloqueio
da cabeça da câmara está totalmente na
posição LOCK.

Ocorre ruído anormal durante
a operação de
deslocamento/inclinação.

A câmara está desequilibrada.
Mova a cabeça da câmara para a frente/para
trás para uma posição adequado para que a
base deslizante fique na horizontal.

A definição da curva da rampa
(aceleração/desaceleração) é
demasiado alta para a objetiva
instalada.

Se estiver instalada uma objetiva grande,
reduza o valor de [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] no menu web
ou no menu da câmara.

A cabeça da câmara não está fixa
na posição e existe um ruído de
movimento durante o
funcionamento.

Coloque a alavanca de bloqueio da cabeça
da câmara na posição LOCK.

Não é possível guardar uma
posição de predefinição.

Não é possível guardar uma
predefinição se o Zoom de Imagem
Clara estiver a funcionar.

Volte a definir a proporção do Zoom de
Imagem Clara para 1×. (estado em que a
proporção não é apresentada à direita de

 (Proporção de zoom))
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Gravação / reprodução
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O enquadramento sofre um
desvio ao reproduzir uma
posição de predefinição.

A temperatura do ambiente poderá
ter-se alterado significativamente
entre o momento em que uma
posição de predefinição foi
guardada e o momento em que é
reproduzida.

Guarde novamente a posição da
predefinição.

A calibragem da objetiva não é
efetuada.

Execute a calibragem, usando [Technical] >
[Lens] > [Lens Calibration] no menu da
câmara.

Está instalada uma objetiva
diferente da que estava instalada
quando a predefinição foi guardada.
Ou a posição de zoom para o zoom
manual é diferente.

Guarde novamente a posição da
predefinição.

O painel de controlo do
enquadramento da Web App
está desativado e não pode
ser utilizado.

A operação de
deslocamento/inclinação não está
disponível enquanto o ecrã de
miniaturas é apresentado durante a
reprodução.

Apresente o ecrã de controlo da reprodução e
feche a apresentação do ecrã de miniaturas
ou pare a reprodução.

A operação de
deslocamento/inclinação não está
disponível quando a imagem da
câmara não pode ser apresentada
na Web App.

Consulte “Web App” em “Resolução de
problemas”.

A alavanca de bloqueio de
deslocamento/inclinação está na
posição LOCK.

Deslize a alavanca de bloqueio de
deslocamento/inclinação para a posição
UNLOCK.

“Execute Pan-Tilt Reset” é
apresentado por baixo do
painel de controlo do
enquadramento, na Web App.

Foi aplicada uma força inesperada
na cabeça da câmara, causando
um erro no
deslocamento/inclinação.

Execute uma reposição do
deslocamento/inclinação, conforme descrito
em “Repor o deslocamento/inclinação”.

Sintoma Causa Solução

A gravação não inicia
quando prime o botão
START/STOP
gravação.

O cartão de memória está cheio.
Substitua o cartão de memória por um com
espaço suficiente.

O cartão de memória necessita de
restauro.

Restaure o cartão de memória, conforme
descrito em “Restaurar cartões de memória”.

A luz de gravação/indicadora está
configurada como uma luz indicadora, por
isso, o estado de gravação não pode ser
determinado pela luz.

Configure a luz de gravação/indicadora para
funcionar como uma luz de gravação,
conforme descrito em “Ligar um sinal
indicador”.
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Transferência de ficheiros

Transmissão IP

Sintoma Causa Solução

A gravação de áudio
não é possível.

Não está ligado um microfone.
Ligue um microfone ou dispositivo de áudio ao
conector AUDIO IN no bloco de conectores.

A definição [Master Input Level] encontra-
se no valor mínimo.

Ajuste [Master Input Level].

O som gravado está
distorcido.

A definição do nível de entrada de áudio
está demasiado alta.

Ajuste [CH1 Input Level] para [CH4 Input Level]
e [Master Input Level].

Ao utilizar um microfone num ambiente
ruidoso, como um local de música ao vivo,
ajuste primeiro [AUDIO IN CH1 MIC Ref.] e
[AUDIO IN CH2 MIC Ref.].

O som gravado tem um
nível de ruído alto.

A definição do nível de entrada de áudio
está demasiado baixa.

Ajuste as definições de [Audio Input Level] e
[Audio] > [Audio] > [Audio Input] > [AUDIO IN
CH1 MIC Ref.] ou [AUDIO IN CH2 MIC Ref.].

Os clips não são
reproduzidos.

O clip está a ser editado.

Os clips não podem ser reproduzidos se tiver
modificado os nomes dos ficheiros ou pastas
ou se o clip estiver em utilização num
computador. Isto não é uma avaria.

O clip foi gravado utilizando uma câmara
que não este aparelho.

Os clips gravados utilizando uma câmara que
não este aparelho poderão não ser
reproduzidos ou poderão ser apresentados no
tamanho incorreto. Isto não é uma avaria.

Sintoma Causa Solução

Falha ao
carregar ficheiro.

O nome de utilizador e a palavra-
passe no servidor não estão corretos.

O nome de utilizador e a palavra-passe no servidor
poderão não estar corretos. Insira as entradas corretas.
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Transmissão não disponível.

O nome de utilizador ou a
palavra-passe introduzidos na
aplicação do cliente para
visualizar a transmissão a partir
do aparelho estão incorretos.

Se o formato de transmissão do aparelho
estiver definido para [RTSP], [SRT-Listener],
ou [NDI|HX], é necessário introduzir o nome de
utilizador e a palavra-passe definidos para este
aparelho na aplicação do cliente. Insira o nome
de utilizador e a palavra-passe corretos.

O protocolo de transmissão não
está definido.

Selecione o protocolo pretendido, usando
[Stream] > [Stream Setting] no menu web.

Foram definidas seis ou mais
sessões RTSP.

Defina o número de sessões para cinco ou
menos.

O número da porta UDP não
está definido corretamente.

Defina o número da porta e outras definições
para o protocolo pretendido, usando [Stream] >
[Stream] > [Stream Setting] no menu web.

A comunicação UDP está
bloqueada.

Verifique as definições do software de
segurança.

O áudio não está a ser
transmitido.

A transmissão da saída de áudio
está definida para [Off].

Defina [Stream] > [Audio Stream] > [Setting]
para [On] no menu web.

A transmissão foi desligada.

A definição do protocolo ou as
definições do codec de
transmissão foram alteradas
durante a transmissão.

Defina a definição do protocolo e as definições
do codec de transmissão antes de iniciar a
transmissão.

O tamanho da imagem de [Video
Stream 1] não pode ser definido
para 4096×2160 ou 3840×2160.

O tamanho da imagem é
1920×1080, quando [Output
Format] está definido para
HDMI.

O tamanho da imagem para transmissão não
pode ser definido acima do tamanho de
imagem HDMI. Altere o tamanho da imagem
HDMI, usando [Monitoring] > [Output Format]
no menu web.

A taxa de fotogramas de [Video
Stream 1] não pode ser definida
para 60 FPS ou 50 FPS.

A taxa de fotogramas da
transmissão está definida para
29.97 ou menos.

A taxa de fotogramas utilizada para
transmissão está limitada pela frequência do
sistema. Altere a frequência do sistema,
usando [Rec Format] > [Frequency] no menu
web.

Não é possível aceder à
transmissão [Video Stream 3].

[Video Stream 3] não é
compatível com RTSP/SRT/NDI.

Use [Video Stream 1] ou [Video Stream 2].

O ecrã RTSP/SRT não é
atualizado/apresentado
corretamente.

O número de porta utilizado
para RTSP ou SRT está a ser
filtrado ou bloqueado.

Altere o número da porta RTSP ou SRT para
uma porta que não esteja a ser filtrada ou
bloqueada por dispositivos de receção da
transmissão. Ou altere o número da porta
utilizado para RTSP ou SRT no aparelho.

A imagem está distorcida ou
tremida.

As informações do vídeo não
são devidamente transmitidas
devido a congestão no caminho
das comunicações.

Reduza a taxa de bits da transmissão ou
defina [Video Stream 2] codec ([Codec 2]) para
[Off], para criar uma margem na banda de
comunicação.

A ordem dos pacotes de vídeo
mudou no canal de
comunicações.

Utilize o mesmo fornecedor de serviço de
internet no aparelho e no recetor.
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Ligação a dispositivos externos

Sincronização externa

Tally

Controlador da objetiva

Sintoma Causa Solução

Não detetado como dispositivo
NDI.

O protocolo de transmissão não
está definido para NDI|HX.

O protocolo de transmissão tem de ser
definido para NDI|HX para detetar o aparelho
como um dispositivo NDI. Defina [Stream] >
[Stream Setting] para [NDI|HX] no menu web.

Não pode ser utilizado como um
dispositivo NDI.

Não está instalada uma licença
NDI|HX.

Instale uma licença NDI|HX. Pode verificar se
existe uma licença NDI|HX, usando [Stream] >
[Stream] > [Stream Setting] > [NDI|HX] >
[License] no menu web.

Sintoma Causa Solução

Não é possível
sincronizar com a
fonte externa.

Não está a ser inserido um sinal de
sincronização externa para o formato do
sinal de vídeo configurado.

Insira um sinal de sincronização externa adequado
ao formato do sinal de vídeo configurado.

O aparelho tem dupla terminação.
O aparelho tem um terminador de 75 Ω integrado.
Ligue diretamente a uma fonte de sinal (um para
um) ou use um distribuidor (repartidor).

Sintoma Causa Solução

A luz
indicadora não
acende.

A luminosidade da luz indicadora está
definida para Off.

Defina a luminosidade adequada, usando
[Technical] > [Tally] > [Tally Lamp Brightness] no
menu web.

A luz de gravação/indicadora está
configurada como uma luz de gravação.

Configure a luz de gravação/indicadora para
funcionar como uma luz indicadora, conforme
descrito em “Ligar um sinal indicador”.

Um RM-IP500 está ligado e VISCA over IP
está desativada.

Coloque o interruptor SETUP 3 na posição ON no
bloco de conectores do aparelho.

A ligação do conector OPTION está
incorreta ou o pino pretendido não está em
curto-circuito para GND.

Curto-circuito do pino 7 ou pino 8 do conector
OPTION para GND, conforme descrito em “Ligar
um sinal indicador”.

Sintoma Causa Solução

[Communication Error] é
apresentado em 
(Estado da câmara).

A câmara não consegue
comunicar com o
controlador da objetiva.

Verifique a ligação entre o aparelho e o controlador da
objetiva e, em seguida, desligue e ligue o aparelho e o
controlador da objetiva.
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Tópico relacionado

Emitir um sinal de fibra ótica

Bloco de conectores

Compensação de respiração

Verificar os interruptores da objetiva

Instalar uma objetiva

Repor o deslocamento/inclinação

P/T Range Limit

Restaurar cartões de memória

Ligar um sinal indicador
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[Rotation Error] é
apresentado em 
(Estado da câmara).

Ocorreu um erro de
rotação no controlador
da objetiva.

A amplitude de movimento do zoom e a amplitude de
movimento da objetiva armazenadas poderão não
corresponder. Inicialize o controlador da objetiva.
Se o problema persistir, contacte o representante do
fabricante do controlador da objetiva.

[System Error] é
apresentado em 
(Estado da câmara).

Ocorreu um erro de
sistema no controlador
da objetiva.

Verifique a ligação entre o aparelho e o controlador da
objetiva, consulte as instruções de funcionamento do
controlador da objetiva e inicialize o controlador da objetiva
ou desligue e ligue o aparelho e o controlador da objetiva.
Se o problema persistir, contacte o representante do
fabricante do controlador da objetiva.

[Unknown Error] é
apresentado em 
(Estado da câmara).

Ocorreu um erro
desconhecido no
controlador da objetiva.

Verifique a ligação entre o aparelho e o controlador da
objetiva, consulte as instruções de funcionamento do
controlador da objetiva e inicialize o controlador da objetiva
ou desligue e ligue o aparelho e o controlador da objetiva.
Se o problema persistir, contacte o representante do
fabricante do controlador da objetiva.
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Mensagens de erro/aviso

Se surgir no aparelho uma situação de aviso, atenção ou funcionamento que exija confirmação, é apresentada uma
mensagem no painel de imagem da câmara e as luzes POWER e NETWORK no painel frontal, bem como a luz de
gravação/indicadora, começam a piscar.

Nota

A indicação intermitente da luz de gravação/indicadora só é ativada quando [Technical] > [Tally] > [Tally Control] estão definidos
para [Internal] e [Tally Lamp Brightness] não estão definido para [Off] no menu web ou no menu da câmara.

Mensagens de erro

Se as luzes POWER e NETWORK estiverem a piscar, conforme descrito abaixo, tome as seguintes medidas.

O aparelho vai parar o funcionamento quando ocorre a seguinte apresentação.

Mensagens de aviso

Siga as instruções fornecidas se ocorrer a apresentação seguinte.

Luz POWER Luz NETWORK Causa e solução

A piscar
lentamente a cor
de laranja

A piscar
lentamente a
verde

O aparelho não pode funcionar normalmente. Para mais informações,
consulte [Maintenance] > [System Log] no menu web. Se o problema persistir
mesmo após colocar o aparelho no modo de espera ou desligar a alimentação
e voltar a ligar, contacte o representante de assistência Sony.

A piscar
rapidamente a cor
de laranja

A piscar
rapidamente a
verde

Ocorreu uma avaria no aparelho. Contacte o representante de assistência
Sony.

Apresentação
da mensagem

Luz de
gravação/indicadora Causa e solução

E + código de
erro

A piscar muito
rapidamente

Indica uma anomalia no aparelho. A gravação para, mesmo que ●REC
seja apresentado no painel de imagem da câmara.
Desligue o aparelho e verifique relativamente a problemas nos
dispositivos, cabos ou suportes ligados. Se o erro persistir quando o
aparelho for novamente ligado, contacte o seu representante de
assistência Sony. Uma apresentação de erro ou som de aviso poderá
não ocorrer dependendo do estado do aparelho.

Apresentação da
mensagem

Luz de
gravação/indicadora Causa e solução

Temperature High A piscar
A temperatura interna está alta.
Desligue a câmara de vídeo e permita que arrefeça antes de
voltar a utilizá-la.
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Apresentação da
mensagem

Luz de
gravação/indicadora Causa e solução

Media Temperature
High

A piscar
A temperatura do cartão CFexpress está alta.
Substitua o cartão ou permita que arrefeça antes de voltar a
utilizá-lo.

Voltage Low A piscar
A tensão DC IN está fraca (nível 1). Verifique a fonte de
alimentação.

Insufficient Voltage
A piscar muito
rapidamente

A tensão DC IN está demasiado fraca (nível 2). A gravação está
desativada.
Ligue uma fonte de alimentação diferente.

Media Near Full A piscar
A capacidade restante no cartão de memória está a ficar fraca.
Substitua assim que possível.

Media Full
A piscar muito
rapidamente

Não foi possível gravar ou copiar clips porque não há
capacidade restante no cartão de memória.
Substitua imediatamente.

Clips Near Full A piscar
O número de clips adicionais que podem ser gravados num
cartão de memória é cada vez menor.
Substitua assim que possível.

Clips Full
A piscar muito
rapidamente

Atingido número máximo de clips que podem ser gravados no
cartão de memória.
A gravação ou cópia de mais clips não é possível. Substitua
imediatamente.

Last Clip Recording A piscar
O clip em gravação é o último clip que pode ser gravado, uma
vez que foi atingido o número máximo de clips.
Prepare um novo cartão de memória.

Media(A) Life Near
End1) A piscar

O cartão de memória está a aproximar-se do fim da vida útil.
Substitua assim que possível.

Media(A) Life End1) A piscar muito
rapidamente

O cartão de memória atingiu o fim da vida útil. Substitua
imediatamente.

Media(A) Near Full1) A piscar Ao utilizar a função Simul Rec

Media(A) Full1) A piscar muito
rapidamente

Ao utilizar a função Simul Rec

Media(A) Clips Near
Full1) A piscar Ao utilizar a função Simul Rec

Media(A) Clips Full1) A piscar muito
rapidamente

Ao utilizar a função Simul Rec

Media(A) Last Clip
Rec1) A piscar Ao utilizar a função Simul Rec

(Sem apresentação) A piscar

Ocorreu um erro desconhecido no controlador da objetiva.
Verifique o estado no estado da câmara na Web App.
Para obter informações detalhadas, verifique o registo do
sistema na Web App.

“(B)” é apresentado para o cartão na ranhura B.1)
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Mensagens de atenção e de funcionamento

As seguintes mensagens de atenção e de funcionamento poderão aparecer no centro do ecrã. Siga as instruções
fornecidas para resolver o problema.

Mensagem de apresentação Causa e solução

Backup Battery End
Please Change

A capacidade restante da bateria de reserva é insuficiente.
Ligue o aparelho a uma fonte de alimentação durante pelo menos 24
horas para carregar a bateria de reserva.

Unknown Media(A)1)

Please Change

Foi inserido um cartão de memória que foi particionado ou um cartão de
memória com mais clips do que aqueles que o aparelho consegue lidar.
O cartão não pode ser utilizado no aparelho e tem de ser substituído.

Cannot Use Media(A)1)

Unsupported File System

Foi inserido um cartão que utiliza um sistema de ficheiros diferente ou
um cartão não formatado.
O cartão não pode ser utilizado no aparelho e tem de ser substituído ou
formatado com o aparelho.

Media Error
Media(A) Needs to be Restored1)

Ocorreu um erro no cartão de memória e o cartão tem de ser
restaurado.
Restaure o cartão de memória.

Media Error
Cannot Record to Media(A)1)

O cartão de memória poderá estar danificado e não pode ser utilizado
para gravação.
A reprodução é possível, por isso, é aconselhável efetuar uma cópia e
substituir o cartão de memória.

Media Error
Cannot Use Media(A)1)

O cartão de memória poderá estar danificado e não pode ser utilizado
para gravação ou reprodução.
O cartão não pode ser utilizado no aparelho e tem de ser substituído.

Media(A) Error1)

Recording Halted
Playback Halted

A gravação e reprodução foi parada porque ocorreu um erro ao utilizar o
cartão de memória.
Se o problema persistir, substitua o cartão de memória.

Media Reached Rewriting Limit
Change Media(A)1)

O cartão de memória atingiu o fim da vida útil.
Efetue uma cópia de segurança e substitua imediatamente o cartão. Se
continuar a utilizar o cartão, o cartão poderá não conseguir efetuar a
gravação ou reprodução.
Para mais informações, consulte o manual de instruções para o cartão
de memória.

The specified address is invalid.
O endereço especificado é inválido.
Certifique-se de que a definição está correta.

Cannot Use Specified Port Number
O número da porta especificado é inválido.
Certifique-se de que a definição está correta.

Lens I/F Error(xx:xx)

Foi detetado um erro da objetiva na comunicação I/F da objetiva quando
foi instalada uma objetiva com encaixe E.
Verifique o estado da ligação com a objetiva com encaixe E.
Se o problema persistir, contacte o seu representante de assistência
Sony com o código de erro (cinco caracteres entre parêntesis).

Cannot add auto upload job of Proxy file
because maximum number of upload jobs
was reached.

Atingido número máximo das tarefas de transferência.
Apague as tarefas indesejadas. A definição de destino do carregamento
automático para ficheiros proxy também poderá estar incorreta.
Certifique-se de que a definição está correta.
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Informações do erro de transmissão RTMP

As seguintes informações do erro poderão ser apresentadas no aparelho. Execute as seguintes ações, conforme
necessário.

Informações do erro da transmissão SRT

As seguintes informações do erro poderão ser apresentadas no aparelho. Execute as seguintes ações, conforme
necessário.

Mensagem de apresentação Causa e solução

Fan Stopped

A ventoinha parou de funcionar.
Verifique se não está bloqueada com pó ou alguma matéria estranha.
Se o erro persistir depois de remover algum pó ou matéria estranha,
contacte um centro de assistência Sony.

“(B)” é apresentado para o cartão na ranhura B.1)

Código de erro
Descrição Solução

RTMP RTMPS

1002
1004

2002
2004

Não é possível ligar ao servidor
RTMP.

Certifique-se de que a definição do URL do servidor está
correta.
Verifique a ligação de rede.

1003 2003
Não é possível resolver o nome
do domínio.

Certifique-se de que a definição do URL do servidor está
correta.
Verifique a ligação do servidor DNS.

–
2005
2008

Erro de CRL

Certifique-se de que a definição do URL do servidor está
correta.
Certifique-se de que o destino da ligação é um site de
confiança.

2006 Erro do certificado CA
Certifique-se de que a definição do relógio está correta.
Certifique-se de que o certificado CA está correto.

– 2007

Não está instalado um
certificado CA.
Erro de autenticação do
certificado do servidor.

Instale um certificado CA.
Certifique-se de que o destino da ligação é um site de
confiança.

4002 A sessão RTMP foi terminada.
O aparelho poderá ter sido desligado no servidor RTMP.
Certifique-se de que as definições correspondem ao parâmetro
de codec recomendado para o serviço.

4003
A qualidade da ligação de rede
é baixa.

Verifique a ligação de rede.

Outro Outros erros.
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Código de
erro Descrição Solução

SRT-Caller

1001 Erro inesperado
O aparelho poderá não estar a funcionar normalmente.
Desligue e ligue o aparelho.

1002
Comunicação interrompida devido a
alteração das definições

A comunicação foi interrompida porque as definições
foram alteradas.
Restabeleça a ligação.

5001 Erro inesperado O aparelho poderá não estar a funcionar normalmente.
Desligue e ligue o aparelho.

5005 Falha de ligação
Certifique-se de que a definição do destino da ligação
está correta.

5006 Erro de encriptação
Certifique-se de que a definição de encriptação está
correta.

5007 Erro inesperado O aparelho poderá não estar a funcionar normalmente.
Desligue e ligue o aparelho.5008 Erro inesperado

5009 Falha de transmissão O aparelho foi desligado durante a comunicação.
Verifique a ligação de rede.
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Lista de itens de menu

As tabelas seguintes enumeram os itens de menu do aparelho.

Legenda
“Menu da câmara” e “menu web”
●: disponível
▲: alguns itens disponíveis
–: não disponível

“All File” e “Scene File”
Sim: item guardado num ficheiro ALL ou num ficheiro de cena
Não: item não guardado

“All Reset (except for Network Settings)”
Quando [Reset]> [Reset] > [All Reset (except for Network Settings)] no menu web é executado:
Sim: item inicializado (exceto definições de rede)
Não: não aplicável

“Network Reset”
Quando [Reset]> [Reset] > [Network Reset] no menu web é executado:
Sim: item inicializado (definição de rede)
Não: não aplicável

“Factory Default”
Sim: item reposto na predefinição
Não: não aplicável

Shooting

Item
(nível 2)

Menu da
câmara

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

ISO/Gain/EI ● – Sim Sim Sim Sim Sim

ND Filter ● – Sim Sim*1 Sim Não Sim

Shutter ● – Sim Sim Sim Não Sim

Iris ● – Sim Sim Sim Não Sim

Auto Exposure ● – Sim Sim*2 Sim Não Sim

White ● – Sim Sim*3 Sim Não Sim

White Setting ● – Sim Não Sim Não Sim

Offset White ● – Sim Não Sim Não Sim

Focus ● ▲ Sim Não Sim Não Sim

S&Q Motion ● – Sim Não Sim Não Sim
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Project

Paint/Look

Item
(nível 2)

Menu da
câmara

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

LUT On/Off ● – Sim Não Sim Não Sim

Noise
Suppression

● – Sim Sim Sim Não Sim

Flicker Reduce ● – Sim Não Sim Não Sim

SteadyShot ● – Sim Não Sim Não Sim

[Mode] não aplicável*1

[Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position], [Custom V Position] não aplicável*2

[Preset White] não aplicável*3

Item
(nível 2)

Menu da
câmara

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Base Setting ● ● Sim Não Sim Não Sim

Rec Format ● ● Sim Não Sim*1 Não Sim

Cine
EI/Flex.ISO Set

● – Sim Não Sim Não Sim

Simul Rec ● ● Sim Não Sim Não Sim

Proxy Rec ● ▲ Sim Não Sim Não Sim

Interval Rec ● ● Sim*2 Não Sim Não Sim

Picture Cache
Rec

● ● Sim*2 Não Sim Não Sim

SDI/HDMI Rec
Control

● – Sim Não Sim Não Sim

Assignable
Button

● – Sim Não Sim Não Sim

All File – ● Não Não Não Não Não

[Frequency] não aplicável*1

[Setting] não aplicável*2

Item
(nível 2)

Menu da
câmara

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Scene File ● – Não Não Não Não Não

Base Look ● ▲ Sim*1 Não Sim*1 Não Sim*1

Reset Paint
Settings

● – Não Não Não Não Não
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Pan-Tilt

TC/Media

Monitoring

Item
(nível 2)

Menu da
câmara

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Black ● – Sim Sim Sim Não Sim

Knee ● – Sim Sim Sim Não Sim

Detail ● – Sim Não Sim Não Sim

Matrix ● – Sim Sim Sim Não Sim

Multi Matrix ● – Sim*2 Sim*2 Sim Não Sim

Dados LUT importados como aspeto base não aplicável*1

[Axis] não aplicável*2

Item
(nível 2)

Menu da
câmara

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

P/T Speed – ● Não Não Sim Não Não

P/T
Acceleration

● ● Não Não Sim Não Não

P/T Range
Limit

– ● Não Não Sim Não Não

P/T Direction – ● Não Não Sim Não Não

P/T Preset – ● Não Não Sim Não Não

Item
(nível 2)

Menu da
câmara

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Timecode ● – Sim*1 Não Sim Não Sim

TC Display ● – Sim Não Sim Não Sim

Users Bit ● – Sim*1 Não Sim Não Sim

HDMI TC Out ● – Sim Não Sim Não Sim

Clip Name
Format

● – *2 Não Sim Não Sim

Update Media ● – Não Não Não Não Não

Format Media ● – Não Não Não Não Não

Media Life ● – Não Não Não Não Não

[Setting] não aplicável*1

[Auto Naming] aplicável, [Camera ID] não aplicável*2
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Audio

Thumbnail

Technical

Item
(nível 2)

Menu da
câmara

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Output
Format

● ● Sim Não Sim Não Sim

Output
Display

– ● Sim Não Sim Não Sim

Display
On/Off

● – Sim Não Sim Não Sim

Video Signal
Monitor

● – Sim Não Sim Não Sim

Marker ● – Sim Não Sim Não Sim

Item
(nível 2)

Menu da
câmara

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Audio
Input

● ▲ Sim Não Sim Não Sim

Audio
Output

● ▲ Sim Não Sim Não Sim

Item
(nível 2)

Menu da
câmara

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Display Clip
Properties

● – Não Não Não Não Não

Set Clip Flag ● – Não Não Não Não Não

Lock/Unlock Clip ● – Não Não Não Não Não

Delete Clip ● – Não Não Não Não Não

Transfer Clip ● – Não Não Não Não Não

Transfer Clip
(Proxy)

● – Não Não Não Não Não

Filter Clips ● – Não Não Não Não Não

Customize View ● – Sim Não Sim Não Sim

Item
(nível 2)

Menu da
câmara

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Color
Bars

● – *1 Não *1 Não Sim
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Network

Stream

Item
(nível 2)

Menu da
câmara

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Genlock ● – Não Não Não Não Não

Tally ● ● Sim Não Sim Não Sim

Rec
Review

● – Sim Não Sim Não Sim

Zoom ● – Sim Não Sim Não Sim

IR
Remote

– ● Não Não Sim Não Sim

Lens ● – Sim Não Sim Não Sim

APR ● – Não Não Não Não Não

[Type] aplicável, [Setting] não aplicável*1

Item
(nível 2)

Menu da
câmara

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Camera Name – ● Não Não Não Não Sim

User – ● Não Não Não Sim Sim

Wired LAN*1 ▲ ● Não Não Não Sim Não

File Transfer ● ▲ Sim Não Sim Sim Sim

FTP Server 1 – ● Não Não Sim Não Sim

FTP Server 2 – ● Não Não Sim Não Sim

FTP Server 3 – ● Não Não Sim Não Sim

SSL – ● Não Não Não Sim Sim

Referer Check – ● Não Não Não Sim Sim

Brute Force Attack
Protection

– ● Não Não Não Sim Sim

Não configurável usando o menu da câmara (apenas ecrã)*1

Item
(nível 2)

Menu da
câmara

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Stream
Setting

– ● Não Não Sim*1 Não Sim*1

Video
Stream

– ● Sim Não Sim Não Sim
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Item
(nível 2)

Menu da
câmara

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Audio
Stream

– ● Sim Não Sim Não Sim

[NDI|HX] > [License] não aplicável*1

Item
(nível 2)

Menu da
câmara

Menu
web

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Language ● ● Sim Não Sim Não Sim

Accessibility – ● Sim Não Não Não Sim

Clock Set ● ● Sim*1 Não Sim*2 Não Sim

Reset – ● Não Não Não Não Não

Hours Meter ● – Não Não Não Não Não

Information – ● Não Não Não Não Não

System Log – ● Não Não Não Não Sim

HTTP Access
Log

– ● Não Não Não Não Sim

Service – ● Não Não Não Não Não

EULA – ● Não Não Não Não Não

Software – ● Não Não Não Não Não

Informação de data e hora não aplicável*1

[Time Zone], informação de data e hora não aplicável*2
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Itens guardados na posição predefinida

“Sim” indica uma definição que é guardada para a posição predefinida e “Não” indica uma definição que não é
guardada.

Itens de deslocamento/inclinação

Itens de zoom

Itens de focagem

Localização de apresentação Item Guardar
alvo

Painel de controlo do enquadramento ou ecrã de operações
em gravação

Posição de deslocamento/inclinação Sim

[Pan-Tilt Speed] Não

[Pan-Tilt] no menu web

[P/T Speed] Não

[P/T Acceleration] Não

[P/T Range Limit] Não

[P/T Direction] Não

[P/T Preset] > [Pan-Tilt] Não

[P/T Preset] > [Default] > [Pan-Tilt
Speed] Sim1)

Os valores das definições ao guardar uma posição de predefinição são guardados como os valores dessa posição da predefinição. Depois de
os valores serem guardados, é possível alterar os valores para cada posição da predefinição. Para mais informações, consulte “Alterar a
velocidade de transição (Deslocamento-Inclinação/Zoom/Focagem) das posições das predefinições usando a Web App”.

1)

Localização de apresentação Item Guardar
alvo

Painel de controlo do enquadramento ou ecrã de operações em
gravação

Posição de zoom (distância de
focagem)

Sim

[Zoom Speed] Não

[Pan-Tilt] > [P/T Preset] > [Default] no menu web
[Zoom Sync] Sim1)

[Zoom Speed] Sim1)

[Technical] > [Zoom] no menu da câmara [Zoom Type] Não

Os valores das definições ao guardar uma posição de predefinição são guardados como os valores dessa posição da predefinição. Depois de
os valores serem guardados, é possível alterar os valores para cada posição da predefinição. Para mais informações, consulte “Alterar a
velocidade de transição (Deslocamento-Inclinação/Zoom/Focagem) das posições das predefinições usando a Web App”.

1)
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Tópico relacionado
Alterar a velocidade de transição (Deslocamento-Inclinação/Zoom/Focagem) ao restaurar uma posição de
predefinição
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Localização de apresentação Item Guardar
alvo

Painel de imagem da câmara do ecrã de
operações em gravação

Alvo de deteção especificado para AF de deteção
em tempo real

Não

Coordenadas especificadas para a função Spot
Focus

Não

Separador  (Focus) do ecrã de operações em
gravação

Interruptor [Touch Focus] Não

Interruptor [Auto Focus] Sim

Estado do botão [Focus Hold] Não

Estado do botão [Push AF/MF] Não

[Face/Eye Detection AF] Sim

[AF Subj. Shift Sens.] Sim

[AF Transition Speed] Sim

Posição de focagem Sim1)

[Shooting] > [Focus] no menu web

[Push AF Mode] (incluindo definições que usam
botões atribuíveis)

Não

[Touch Function in MF] Não

[AF Assist Control] Não

[Pan-Tilt] > [P/T Preset] > [Default] no menu web
[Focus Recall] Sim2)

[MF Speed] Sim2)

[Shooting] > [Focus] no menu da câmara

Tamanho e posição da área de focagem definidos
usando [Focus Area]

Sim

Posição da área de focagem definida usando
[Focus Area (AF-S)]

Sim

Não reposto quando o interruptor [Auto Focus] está na posição On. Reposto quando está na posição Off.1)

Os valores das definições ao guardar uma posição de predefinição são guardados como os valores dessa posição da predefinição. Depois de
os valores serem guardados, é possível alterar os valores para cada posição da predefinição. Para mais informações, consulte “Alterar a
velocidade de transição (Deslocamento-Inclinação/Zoom/Focagem) ao restaurar uma posição de predefinição”

2)
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Diagramas de blocos

Audio Input

Audio Output

5-041-957-53(1) Copyright 2022 Sony Corporation
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Atualizar o software da objetiva com encaixe E

Pode atualizar o software de uma objetiva com encaixe E através do aparelho.
Consulte o website da objetiva relativamente a objetivas que podem ser atualizadas e o respetivo software.
O software está atualizado através do menu web.

Nota

Não efetue as ações seguintes até a atualização ter sido concluída.

Desligar a rede
Remover uma objetiva
Desligar a alimentação

Se for apresentada uma mensagem a indica que a atualização falhou, verifique a descrição apresentada e tente novamente a
atualização.

5-041-957-53(1) Copyright 2022 Sony Corporation

Instale uma objetiva com encaixe E no aparelho.1

Verifique [Maintenance] > [Information] > [Lens] > [Model Name] e [Version Number] no menu web.

O número da versão de software da objetiva com encaixe E é apresentado na parte lateral.
Verifique o número da versão de software e, de seguida, atualize o software, conforme necessário.

2

Transfira o ficheiro de atualização do software da objetiva para Windows (extensão .exe) para o dispositivo
a executar a Web App.

3

Em [Maintenance] > [Information] > [Lens] > [Version Up], prima o botão [Choose File] e selecione o ficheiro
de atualização transferido.

4

Siga as instruções no ecrã.5
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Instalar a tampa do botão de libertação da objetiva

Pode evitar a remoção acidental da objetiva instalando a tampa do botão de libertação da objetiva fornecida com o
Suporte de teto CIB-PCM1 (opção) no botão de libertação da objetiva.

Nota

Isto não impede que a objetiva seja completamente removida.

Tópico relacionado

Instalar uma objetiva

Instale uma objetiva.

Para mais informações sobre a instalação de uma objetiva, consulte “Instalar uma objetiva”.

1

Deslize a alavanca de bloqueio de deslocamento/inclinação para a posição LOCK para bloquear o
deslocamento/inclinação da cabeça da câmara.

2

Mova o bloco da câmara para uma posição de modo a que a tampa de ejeção da objetiva possa ser
instalada.

3

Instale a tampa de ejeção da objetiva de modo a cobrir o botão de libertação da objetiva.4

Fixe a tampa de ejeção da objetiva utilizando o parafuso de retenção da tampa de ejeção da objetiva.5
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Licenças

MPEG-4 AVC Patent Portfolio License

ESTE PRODUTO ESTÁ LICENCIADO AO ABRIGO DA AVC PATENT PORTFOLIO LICENSE PARA A UTILIZAÇÃO
PESSOAL POR UM CONSUMIDOR OU OUTRAS UTILIZAÇÕES NAS QUAIS NÃO RECEBE REMUNERAÇÃO POR
(i) CODIFICAR VÍDEO EM CONFORMIDADE COM AVC STANDARD (“AVC VIDEO”) E/OU
(ii) DESCODIFICAR AVC VIDEO QUE FOI CODIFICADO POR UM CONSUMIDOR ENVOLVIDO NUMA ATIVIDADE
PESSOAL E/OU FOI OBTIDO POR UM FORNECEDOR DE VÍDEO LICENCIADO PARA FORNECER AVC VIDEO.
NENHUMA LICENÇA SERÁ CONCEDIDA OU SUGERIDA PARA QUALQUER OUTRA UTILIZAÇÃO. É POSSÍVEL
OBTER MAIS INFORMAÇÕES ATRAVÉS DA MPEG LA, L.L.C. CONSULTE HTTP://WWW.MPEGLA.COM

Obter software ao abrigo da licença GPL/LGPL

Este produto utiliza software ao qual se aplica GPL/LGPL. Isto informa-o de que tem o direito de aceder, modificar e
redistribuir o código-fonte para estes programas de software ao abrigo das condições da GPL/LGPL.
O código-fonte é fornecido na internet. Utilize o URL seguinte e siga as instruções de transferência.
https://oss.sony.net/Products/Linux/
Agradecíamos que não nos contactasse sobre os conteúdos do código-fonte.

Código-fonte μT-Kernel

Este produto usa o código-fonte de μT-Kernel, sob uma licença T-License 2.1, concedida pelo Fórum TRON
(www.tron.org).

5-041-957-53(1) Copyright 2022 Sony Corporation
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Especificações

Geral

Peso
Aprox. 4,6 kg (apenas corpo)
Aprox. 6,0 kg (incluindo objetiva SELP28135G)

Dimensões
Consulte “Dimensões externas”.

Requisitos de alimentação
19,5 V DC
PoE++ (Em conformidade com IEEE802.3bt, Tipo 4, Classe 8)

Consumo de energia
19,5 V DC: 80,0 W (máx.)
PoE++: 71,3 W (máx.)　

Temperatura de funcionamento
0 °C a 40 °C

Temperatura de armazenamento
−20 °C a +60 °C

Formato de gravação (vídeo)
XAVC Intra
Modo XAVC-I 4K/QFHD: VBR, taxa de bits 600 Mbps (máx.), MPEG-4 AVC/H.264
Modo XAVC-I HD: CBG, 223 Mbps (máx.), MPEG-4 AVC/H.264

XAVC Long
Modo XAVC-L QFHD: VBR, taxa de bits 150 Mbps (máx.), MPEG-4 H.264/AVC
Modo XAVC-L HD 50: VBR, 50 Mbps (máx.), MPEG-4 H.264/AVC
Modo XAVC-L HD 35: VBR, 35 Mbps (máx.), MPEG-4 H.264/AVC

Formato de gravação (áudio)
LPCM 24 bits, 48 kHz, 4 canais

Taxa de fotogramas de gravação

XAVC Intra
Modo XAVC-I 4K: 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
Modo XAVC-I QFHD: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Modo XAVC-I HD: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
Modo XAVC-L QFHD: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Modo XAVC-L HD 50: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
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Modo XAVC-L HD 35: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

Tempo de gravação/reprodução
XAVC Intra
Modo XAVC-I QFHD: 59.94P, aprox. 30 minutos (através de CEA-G160T)
Modo XAVC-I HD: 59.94P, aprox. 78 minutos (através de CEA-G160T)

XAVC Long
Modo XAVC-L QFHD: 59.94P, aprox. 115 minutos (através de CEA-G160T)
Modo XAVC-L HD 50: 59.94P, aprox. 155 minutos (através de CEA-G80T)
Modo XAVC-L HD 35: 59.94P, aprox. 210 minutos (através de CEA-G80T)

Nota

O tempo de gravação/reprodução poderá variar devido às condições de utilização e às características da memória. O tempo de
gravação e de reprodução diz respeito à gravação contínua como um único clip. Os tempos reais poderão ser mais curtos
dependendo do número de clips gravados.

Secção de acionamento do deslocamento/inclinação

Velocidade de deslocamento mínima: 0,02 graus/s
Velocidade de inclinação mínima: 0,02 graus/s
Velocidade de deslocamento máxima: 60 graus/s
Velocidade de inclinação máxima: 60 graus/s
Amplitude de deslocamento: −170 graus a +170 graus
Amplitude de inclinação: -30 graus a +195 graus
Classificação do critério relativo ao ruído: NC35 ou inferior
Posições predefinidas: 100

Secção da câmara

Dispositivo de imagem
35 mm de tamanho completo (35,6 × 23,8 mm), sensor Exmor R CMOS

Número de píxeis
Cerca de 12,9 megapíxeis (total de píxeis)
Cerca de 10,3 megapíxeis (píxeis reais)

Focagem automática
Método de deteção: deteção de fase/deteção de contraste

Filtros ND internos
CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
ND variável linearmente: 1/4ND a 1/128ND

Sensibilidade ISO
ISO 800/12800 (Modo Cine EI, Fonte de luz D55)

Encaixe de objetiva
Encaixe E

Latitude

508



Mais de 15 níveis

Velocidade do obturador
64F a 1/8000 seg. (23.98P)

Ângulo do obturador
5,6° a 360°, 2 a 64 fotogramas

Câmara lenta e movimento rápido
XAVC QFHD: 1 fps a 120 fps
XAVC HD: 1 fps a 240 fps
XAVC 4K: 1 fps a 60 fps
XAVC HD (S35): 1 fps a 120 fps

Equilíbrio de brancos
2000 K a 15000 K

Ganho
−3 dB a +30 dB (Incrementos de 1 dB)

Aspeto base
S-Cinetone, Standard, Still, ITU709, 709tone, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Secção de áudio

Frequência de amostra
48 kHz

Quantização
24 bits

Resposta de frequência
Modo MIC da entrada XLR: 20 Hz a 20 kHz (±3 dB ou menos)
Modo LINE da entrada XLR: 20 Hz a 20 kHz (±3 dB ou menos)

Alcance dinâmico
Modo MIC da entrada XLR: 80 dB (Típico)
Modo LINE da entrada XLR: 90 dB (Típico)

Distorção
Modo MIC da entrada XLR: 0,08% ou inferior (Nível de entrada −40 dBu)
Modo LINE da entrada XLR: 0,08% ou inferior (Nível de entrada +14 dBu)

Secção de entrada/saída

Entradas
DC IN

Em conformidade com EIAJ, 19,5 V DC

AUDIO IN

Tipo XLR, 5 pinos, fêmea
LINE/MIC/MIC+48 V comutável
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MIC: Reference −30 dBu a −80 dBu

GENLOCK IN

Conector BNC, 1,0 Vp-p, 75 Ω

TC IN

Conector BNC

Saídas
SDI OUT

Conector BNC, 12G-SDI, 6G-SDI, 3G-SDI (nível A/B), HD-SDI

HDMI

Conector Type A

Conector de saída OPTICAL

Em conformidade com SFP+
* Este aparelho não suporta entrada de sinal ótico.

Entrada/saída
Conector LAN

RJ-45, 1000BASE-T

Conector OPTION

Conector indicador de entrada/saída RJ-45

Secção da ranhura para multimédia

Ranhura para cartões CFexpress Type A / SD (2)

Acessórios fornecidos

Adaptador AC (1)
Cabo de alimentação (1)
Controlo remoto de infravermelhos (1)
Tampa do corpo (1) (instalada no aparelho)
Placa de fixação do cabo HDMI (1)
Antes de Utilizar este Aparelho (1)
Documento da garantia (1)

Dimensões externas

As dimensões são valores aproximados.
Unidade: mm

Corpo da câmara
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Suporte de teto
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A concepção e as especificações estão sujeitas a alterações sem aviso prévio.
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Marcas comerciais

 é uma marca comercial da Sony Group Corporation.
XAVC e  são marcas comerciais registadas da Sony Group Corporation.
Os termos HDMI e High-Definition Multimedia Interface e o logotipo HDMI são marcas ou marcas registradas da
HDMI Licensing Administrator, Inc. nos Estados Unidos e em outros países.
Microsoft e Windows são marcas comerciais ou marcas comerciais registadas da Microsoft Corporation nos Estados
Unidos e/ou noutros países.
Mac e macOS são marcas comerciais registadas da Apple Inc. nos Estados Unidos e noutros países.
O logótipo “Catalyst Browse” é uma marca comercial ou marca comercial registada da Sony Group Corporation.
IOS é uma marca comercial ou marca registada da Cisco nos EUA e noutros países e é utilizada sob licença.
iPadOS, Safari e iPad são marcas comerciais da Apple Inc., registadas nos Estados Unidos e noutros países e
regiões.
Android e Google Chrome são marcas comerciais ou marcas comerciais registadas da Google LLC.
Wi-Fi é uma marca registada da Wi-Fi Alliance.
O logótipo SDXC é uma marca comercial da SD-3C, LLC.
CFexpress e o logótipo CFexpress Type A são marcas comerciais da CompactFlash Association.
NewTek™ e NDI® são marcas comerciais ou marcas comerciais registadas da NewTek, Inc.
JavaScript é uma marca comercial registada da Oracle e/ou respetivas afiliadas.
Intel, o logótipo Intel e Intel Core são marcas comerciais da Intel Corporation ou respetivas subsidiárias.
QR Code é uma marca comercial da Denso Wave Inc.
Todo os outros nomes de empresas e nomes de produtos são marcas comerciais registadas ou marcas comerciais
dos respetivos proprietários. Os itens de marca registada não são indicados pelos símbolo ™ ou ® neste
documento.

5-041-957-53(1) Copyright 2022 Sony Corporation
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